Contents

1 Working collaboratively within a Tekla Structures model...... 9
  1.1 What is Tekla Model Sharing................................................................. 10
    Prerequisites for Tekla Model Sharing...................................................... 11
    Tekla Model Sharing licenses................................................................... 12
    How Tekla Model Sharing uses the sharing service.................................... 12
    Get to know Tekla Model Sharing basic working methods.......................... 13
  1.2 Work with Tekla Model Sharing ....................................................... 16
    Share a model in Tekla Model Sharing...................................................... 17
      Start sharing a model............................................................................... 17
      User roles in Tekla Model Sharing............................................................ 18
      Information on users and sharing actions in Tekla Model Sharing............... 20
    Join a shared model in Tekla Model Sharing............................................. 21
      Join a shared model.................................................................................. 21
      Information on shared models in Tekla Model Sharing............................ 22
    Share your model changes in Tekla Model Sharing.................................... 23
      Write out..................................................................................................... 24
      Read in......................................................................................................... 24
      Reserve the next write out......................................................................... 25
      Share your model changes automatically................................................ 26
    Detect sharing changes and view sharing history in Tekla Model Sharing...... 27
      Sharing change detection........................................................................... 27
      Sharing history............................................................................................ 30
      Object locks, drawing locks, and privileges in Tekla Model Sharing.......... 31
        Object locks.............................................................................................. 31
        Drawing locks........................................................................................... 33
        Privileges................................................................................................. 33
    Create a baseline for a model in Tekla Model Sharing............................... 34
    Tekla Model Sharing settings......................................................................... 35
    Exclude a model from the sharing service in Tekla Model Sharing.............. 38
    Convert a shared model to a multi-user model in Tekla Model Sharing......... 39
  1.3 What is shared in Tekla Model Sharing............................................. 40
    How data is shared....................................................................................... 41
    Exclude files and folders from Tekla Model Sharing..................................... 45
    How to share catalog updates...................................................................... 46
    How to share Organizer data........................................................................ 47
    How different object types work in shared models...................................... 47
  1.4 Best practices in Tekla Model Sharing.............................................. 50
    Collect model history in Tekla Model Sharing.......................................... 50
    How object IDs work in shared models...................................................... 51
    Backing up shared models.......................................................................... 52
    Restoring shared models............................................................................ 52
    Cache service for Tekla Model Sharing....................................................... 53
    Rejoin the model if the model is not saved after write out.......................... 56
    How to get support for sharing issues......................................................... 57
  1.5 Multi-user mode .................................................................................. 57
Multi-user system........................................................................................................ 58
Tekla Structures multi-user server as a service............................................................. 58
Install Tekla Structures multi-user server as a service................................................. 59
Change the server of a multi-user model................................................................. 59
Convert a multi-user model to a single-user model...................................................... 60
Convert a single-user model to a multi-user model...................................................... 60
How multi-user works ............................................................................................. 62
Locks for models in multi-user mode........................................................................ 63
Saving in multi-user mode ....................................................................................... 63
Autosaving in multi-user mode................................................................................ 64
Model history in multi-user mode.............................................................................. 65
Shutting down the model in multi-user mode........................................................... 66
Copy multi-user models............................................................................................ 66
Display active multi-users....................................................................................... 67
Error messages in multi-user mode .......................................................................... 67
Recommendations for multi-user setup....................................................................... 68
Remove inconsistencies from a multi-user database................................................. 69
Modeling in multi-user mode................................................................................... 70
Numbering setup in multi-user mode ..................................................................... 74
Synchronize numbering with the master model...................................................... 75
Drawings in multi-user mode.................................................................................... 75
Guidelines for multi-user drawings......................................................................... 76
Locks for drawings in multi-user mode................................................................. 77
Remove unnecessary drawing files in multi-user mode.......................................... 77
Access rights in multi-user mode............................................................................. 78
Change access rights in the privileges.inp file......................................................... 78
Options in the privileges.inp file............................................................................ 79
User-defined attribute Locked................................................................................ 81
Control access to lock and unlock objects in a multi-user model.......................... 81
Control access to numbering in a multi-user model.............................................. 82
Control access to save standard files in a multi-user model.................................. 82
Control access to remove users from a multi-user model....................................... 82
1.6  Trimble Connector............................................................................................ 83
Download a reference model from and upload a reference model to Trimble Connect................................................................. 84
Launch Trimble Connect and Trimble Connector from ribbon or Quick Launch...... 84
Link a Tekla Structures model to a Trimble Connect project.................................... 85
Download a reference model from a Trimble Connect project to a Tekla Structures model........................................................................................................... 86
Download a reference model update from a Trimble Connect project to a Tekla Structures model................................................................................................. 87
Upload a Tekla Structures reference model to a Trimble Connect project .............. 87
Upload a Tekla Structures reference model update to a Trimble Connect project..... 87
Export Tekla Structures model objects as an .ifc reference model to a Trimble Connect project................................................................. 87
Use base point instead of alignment offset............................................................. 88
ToDos..................................................................................................................... 88
Collaborate with Trimble Connect Desktop............................................................... 94
2  Get started with import and export formats......................................................... 95
2.1  Industry standards............................................................................................ 95
2.2  Compatible formats........................................................................................... 96
2.3  Compatible software.......................................................................................... 98
3 Import to and export from Tekla Structures................. 114

3.1 Conversion files......................................................... 116
Create conversion files........................................... 116
Twin profile conversion files................................... 119

3.2 Reference models and compatible formats..................... 119
Insert a reference model........................................... 121
View reference models............................................. 123
Modify reference model details.................................. 127
Lock reference models............................................. 128
Detect changes between reference model versions........... 129
Define a comparison set for reference model change detection............. 134
    Create a new comparison set................................. 135
    Properties in comparison property set.................. 136
    Define property comparison tolerances.................. 138
Export change detection results to Excel...................... 139
Inquire reference model contents............................. 142
Reference model objects......................................... 143
Examine reference model hierarchy and modify reference model objects..... 144
Reference model assemblies...................................... 148

3.3 IFC.............................................................................. 149
IFC interoperability concepts.................................... 149
IFC insert................................................................. 152
Convert IFC objects into native Tekla Structures objects........ 153
    Check and change the IFC object conversion settings .... 154
Convert selected IFC objects at one go........................ 156
Convert IFC objects using conversion change management - first conversion.... 158
Convert IFC objects using conversion change management - update conversion ...
160
Macro for selecting converted IFC objects..................... 161
Class values............................................................. 161
Profile conversion logic in IFC object conversion............... 162
Example: Convert IFC objects into Tekla Structures objects in one go........ 164
Limitations in IFC object conversion........................ 167
IFC export............................................................... 168
    Define additional property sets for IFC export......... 169
Export a Tekla Structures model or selected model objects to an IFC file........ 172
    Check the exported IFC model............................... 182
IFC base quantities in exported IFC model...................... 182
    Property set configuration files used in IFC export.... 183

3.4 DWG and DXF............................................................. 186
Import a 2D or 3D DWG or DXF file.............................. 187
Export a model to a 3D DWG or DXF file....................... 188
Export a drawing to a 2D DWG or DXF file.................... 190
    Start DWG/DXF export ....................................... 191
    Define export settings and export to DWG/DXF......... 193
    Layer rule example............................................ 199
    Tips........................................................................ 201
    To use old DWG/DXF export................................. 201
Export a drawing to 2D DWG or DXF (old export).............. 201
    Layers in exported DWG/DXF drawings (old export)... 203
    Create layers in DWG/DXF files for drawing export (old export).................. 204
    Assign objects to layers in drawing export (old export).................. 205
Example: Create a rule for exporting beam marks to their own layer in drawing export (old export).................................................................................................................................................................................. 206
Copying export layer settings to another project (old export) ........................................................................................................... 207
Define customized line type mappings in drawing export (old export) .......................................................................................... 207
Default line types in drawings (old export)................................................................................................................................. 211
Example: Set up layers and export to DWG (old export)................................................................................................................. 212

3.5 DGN............................................................................................................................................................................................ 218
Insert DGN files.................................................................................................................................................................................. 219
Export to 3D DGN files....................................................................................................................................................................... 221

3.6 LandXML.................................................................................................................................................................................. 222

3.7 PDF.......................................................................................................................................................................................... 224

3.8 SketchUp.................................................................................................................................................................................. 224

3.9 Point clouds.............................................................................................................................................................................. 225
Attach a point cloud to the model ................................................................................................................................................ 226
Detach a point cloud from a model............................................................................................................................................ 227
Set the default maximum point count in a view ........................................................................................................................................ 228
Clip point clouds and reference models only....................................................................................................................................... 228
Point cloud example.................................................................................................................................................................................. 228
Share point clouds with other users.................................................................................................................................................. 232

3.10 Layout manager........................................................................................................................................................................ 235
Set up groups in Layout manager .................................................................................................................................................. 236
Base points in Layout manager.................................................................................................................................................... 236
Define a default coordinate system for groups........................................................................................................................................ 238
Define numbering settings for groups.................................................................................................................................................. 238
Create a group in Layout manager.................................................................................................................................................. 239
Create a layout point.............................................................................................................................................................................. 241
Create a layout line.............................................................................................................................................................................. 242
Export layout data from Layout manager........................................................................................................................................ 243
Export layout data.............................................................................................................................................................................. 243
Define default export settings.......................................................................................................................................................... 245
Define the drawing scale..................................................................................................................................................................... 245
Import layout data to Layout manager.................................................................................................................................................. 246
Import layout data.............................................................................................................................................................................. 246
Define point file columns................................................................................................................................................................. 248
Measured points in Layout manager.................................................................................................................................................. 249
Example: Base point use in Layout manager........................................................................................................................................ 251

3.11 Analysis and design systems.................................................................................................................................................. 255
Analysis and design direct links......................................................................................................................................................... 255
Tekla Structural Designer................................................................................................................................................................. 256
Example workflow of integration between Tekla Structures and Tekla Structural Designer........................................................................................................................................................................ 257
Import from Tekla Structural Designer............................................................................................................................................ 258
Re-import from Tekla Structural Designer........................................................................................................................................ 260
Export to Tekla Structural Designer.................................................................................................................................................. 261
Robot........................................................................................................................................................................................... 262
SAP2000....................................................................................................................................................................................... 262
STAAD.Pro..................................................................................................................................................................................... 263
ISM............................................................................................................................................................................................. 263
S-Frame......................................................................................................................................................................................... 264
FEM.......................................................................................................................................................................................... 265
Import FEM.................................................................................................................................................................................... 266
Export FEM.................................................................................................................................................................................... 269
Supported DSTV entities.................................................................................................................................................................. 270
3.12 **Steel fabrication** .......................................................... 271

- NC files.................................................................................. 272
  - Create NC files in DSTV format............................................. 273
  - NC file settings...................................................................... 275
  - Create pop-marks in NC files.................................................. 286
  - Create contour marking in NC files...................................... 290
  - Fittings and line cuts in NC files.......................................... 292
  - DSTV file description............................................................ 293
  - Create NC files in DXF format using **Convert DSTV files to DXF** macro.................................................... 294
  - Create NC files in DXF format using tekla_dstv2dxf.exe.................................................................................. 295
  - tekla_dstv2dxf_<env>.def file description.... ....................... 296
  - Create tube NC files ............................................................. 306
- MIS lists.................................................................................... 306
- CIS and CIMSteel models....................................................... 307
  - Import a CIMSteel model....................................................... 308
  - Export to a CIMSteel analysis model................................. 310
  - Export to a CIMSteel design/manufacturing model............. 311
  - CIMSteel conversion files..................................................... 312
- FabTrol XML files.................................................................... 314
- PDMS/E3D files........................................................................ 315
- ASCII files............................................................................... 315
  - Import a model in the ASCII format...................................... 315
  - Export a model to the ASCII format..................................... 315
  - ASCII file description.......................................................... 316

3.13 **Concrete fabrication** ...................................................... 318

- Unitechnik................................................................................. 319
  - Export to Unitechnik format................................................ 321
  - Limitations in Unitechnik export......................................... 324
  - Unitechnik export: Main tab............................................... 325
  - Unitechnik export: TS configuration tab............................. 330
  - Unitechnik export: Embeds tab.......................................... 341
  - Unitechnik export: Reinforcement tab................................. 349
  - Unitechnik export: Validation tab....................................... 359
  - Unitechnik export: Reinf. data specification tab................ 361
  - Unitechnik export: HEADER block data specification tab...... 364
  - Unitechnik export: SLABDATE block data specification...... 366
  - Unitechnik export: Mounting part data specification tab..... 368
  - Unitechnik export: Line attributes tab............................... 369
  - Unitechnik export: Pallet tab.............................................. 374
  - Unitechnik export: Log files tab......................................... 375
- BVBS........................................................................................ 376
  - Export to the BVBS format.................................................. 376
  - Export settings..................................................................... 377
  - Reinforcing bar length calculation in BVBS export............... 384
- ELiPLAN..................................................................................... 385
  - Export an ELiPLAN data file................................................. 385
  - Import an ELiPLAN status data file..................................... 386
  - ELiPLAN user-defined attributes....................................... 386
  - ELiPLAN export settings..................................................... 388
- HMS.......................................................................................... 395
  - Export to the HMS format.................................................... 395
  - HMS Export settings.......................................................... 396

3.14 **CAD** .............................................................................. 400
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Tekla Warehouse</td>
<td>402</td>
</tr>
<tr>
<td>5</td>
<td>Disclaimer</td>
<td>404</td>
</tr>
</tbody>
</table>
To work collaboratively within a Tekla Structures model, you can select out of the following different methods:

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tekla Model Sharing</strong> (page 10)</td>
<td>With Tekla Model Sharing a global team can work efficiently within one model regardless of the team location and time zones. The team members can work both simultaneously and at different times. Each user has a local version of the model on their computer. The model data is shared and synchronized over the Internet, and stored to a cloud-based Tekla Model Sharing service. It is possible to work also offline. The Internet connection is needed only when you want to share your model changes. Tekla Model Sharing requires a license.</td>
</tr>
<tr>
<td><strong>Multi-user mode</strong> (page 57)</td>
<td>Multi-user mode also allows several users to access the same model simultaneously. Multi-user mode is suitable for local teams with projects where the team members do not necessarily have an Internet connection. In the multi-user mode a server computer runs the multi-user server, a file server computer contains the multi-user master model and client computers run Tekla Structures. The multi-user model consists of a single master model on the file server computer and local views to the master model, called working models, on each users' computer. The model synchronization is done by saving the working model to the master model.</td>
</tr>
<tr>
<td><strong>Trimble Connector</strong> (page 83)</td>
<td>The Trimble Connector adds automatic file synchronization to the Trimble Connect cloud. You can use it to exchange files and information such as reference models and comments. Trimble Connect supports various</td>
</tr>
</tbody>
</table>
different products and file formats, so it allows smooth collaboration within the whole project.

If you do not need to work simultaneously with other users on the same model, or you only need to give others viewing access to the model, you can also synchronize the Tekla Structures model (or parts of it) to Trimble Connect. This method is not suitable for different people making changes in the same Tekla Structures model simultaneously, because users can easily overwrite each others’ changes.

**NOTE** Tekla Model Sharing and the multi-user mode do not work together. When you want to work collaboratively, you need to select which one of the methods to use.

### 1.1 What is Tekla Model Sharing

Tekla Model Sharing enables efficient global collaborative modeling within one Tekla Structures model. Tekla Model Sharing gives users the freedom to work with the same model at the same time in different locations and time zones.

With Tekla Model Sharing you can work locally and share the model changes globally. For example, one Tekla Model Sharing team of users can work in New York, one in London and one in Bangkok. They all contribute to the same model, working around the globe during their office hours in different time zones while the model keeps building up all the time.

In Tekla Model Sharing each user has a local version of the model on their computer or on a network drive, and the model data is shared and
synchronized over the Internet using a Microsoft Azure cloud sharing service. When a model is shared, it is connected to the cloud-based sharing service. You can check the status of the service at any time.

To easily share your model changes, write them out to the sharing service. When you want to update your model with the changes made by other users, read in the changes from the sharing service.

Even though the changes are shared over the Internet, you do not need to be connected to the sharing service all the time. You need to be online only when you want to write out or read in the changes. This enables offline work if your Internet connection is not always available.

**NOTE** Tekla Model Sharing requires a single-user model.

A model cannot be simultaneously shared and used in multi-user mode (page 61). If you want to start using multi-user mode as a means to share your model instead of Tekla Model Sharing, you need to first exclude your local version of the model from the sharing service and then convert (page 39) it to a multi-user model.

The excluded model has no connection to the original shared model in the sharing service. This means that if you exclude your local version of the model from the sharing service and start to use the model in multi-user mode, you cannot later merge the original shared model and the multi-user model.

---

**Prerequisites for Tekla Model Sharing**

Before you can start using Tekla Model Sharing and share your models, the following prerequisites need to be met:

- **Internet connection**
  
  You need to establish a connection to the Tekla Model Sharing service to perform any model sharing actions.

- **TCP port 443 (the default HTTPS) outbound must be open.**
  
  If an HTTP proxy is used, it must support HTTP 1.1.

- **Trimble Identity**
  
  All sharing actions require authentication, and the authentication is done with Trimble Identity username and password.

  **If you do not have** a Trimble Identity, go to Tekla Online services and click **Log in**.

- **License**
  
  All sharing actions require a valid Tekla Model Sharing license. Tekla Model Sharing licenses are tied to users' Trimble Identities. The organization's administrator assigns and manages the licenses in the Tekla Online Admin Tool.
• Tekla Structures
  The users of the same shared model need to have the same Tekla Structures version, and use the same latest service pack.

**Tekla Model Sharing licenses**
Tekla Model Sharing requires a valid Tekla Model Sharing license.

Tekla Model Sharing licenses are assigned and managed in the [Tekla Online Admin Tool](#). To obtain a Tekla Model Sharing license, contact your organization's administrator. For details about model sharing licenses, see [Manage Trimble Identities and Tekla Online licenses](#).

Tekla Model Sharing uses enterprise-type licenses that are purchased as a yearly subscription. The license use is limited to a maximum number of concurrent users. A license is reserved when a user starts read in or write out in a shared model. The license is released within three hours after the user logs out of Tekla Structures by shutting down Tekla Structures.

Note that users can work on a shared model offline without reserving a license. Licenses can be temporarily assigned outside of your organization to any users.

The configuration, type and maintenance status of your Tekla Structures license has no effect on your Tekla Model Sharing license. Keep track of the number of licenses and users as well as your license expiration dates to ensure continued service.

**How Tekla Model Sharing uses the sharing service**
When you start to share a model using Tekla Model Sharing, the model is connected to the cloud-based sharing service.

• To send model changes to the sharing service, you need to write out (page 23).
• To fetch other users' model changes from the sharing service, you need to read in (page 23).

When you read in other users' changes, the updates to your local version of the shared model are delivered to you as incremental packets. This means that when you read in, the data that is fetched from the sharing service is merged with the data on your computer. You need to read in all shared changes before you can write out your own changes to the sharing service.

Note that there is no central model in the sharing service as such, only a model instance that consists of a model baseline and incremental updates. You cannot open the model in the sharing service or access any files.

The image below shows how the model data is stored to the sharing service. Each user fetches the model data from the sharing service to their local...
versions of the model when they read in. User authentication is based on Trimble Identity.

NOTE You can install a separate Tekla Model Sharing Cache service (page 50) that downloads and caches the model changes on behalf of the Tekla Structures client workstations. The cache service speeds up the workflow as users can fetch the changes to their local versions of the model from the LAN instead of the Tekla Model Sharing sharing service. The cache service is useful especially when there are at least two Tekla Model Sharing users in the same office, and in regions where the download speed may be limited.

Get to know Tekla Model Sharing basic working methods
Tekla Model Sharing is available in all configurations of Tekla Structures. You can find all the Tekla Model Sharing commands in File --> Sharing.
To start using Tekla Model Sharing you need to have:
• Tekla Structures installed
• Personal Trimble Identity that is connected to a company account
• Internet connection to share and download changes
• Valid Tekla Model Sharing license

Tekla Model Sharing uses enterprise-type licenses that are purchased as a yearly subscription. The company administrator assigns Tekla Model Sharing licences to the users in Tekla Online Admin Tool.

How does Tekla Model Sharing work?
Tekla Model Sharing requires a single-user model that is shared. When a model is shared, it is connected to a cloud-based sharing service. Each user of the model has a local version of the model on their computer or on a network drive.

When you work with a shared model, you do the modeling and editing offline. You need an Internet connection when you want to share the changes that you have made to the model and when you download changes from other users of the model. Typically, you may want to do this a couple of times a day to keep everyone updated. Model changes are collected to packets that are very fast to download and upload.

The shared model has a baseline that contains the whole model. The model has one or more owners who typically create the baseline once a week. Joining the baseline is beneficial for users who join the model when there already are many changes made.

How do I join a shared model?
You can either join a model someone has shared with you, or you can start sharing your own model. The shared model has an Owner who can invite other users to the model. The Owner can send an email notification to the invited users.

You can also join a model you have been invited to without the email notification. If you have been added as a user to the model, you will find all the shared models in which you are a user in File --> Sharing --> Browse shared models. Just select the model from the list and click Join. The model is downloaded, and you can start working with it.

How do I keep my model up to date?
When you want get up to date and receive the changes made by the other users of the model, you can Read in the changes from the sharing service. You can either go to File --> Sharing --> Read in, or click on the Quick Access Toolbar.

The Read in icon shows the number of packets that are available to be read in. Only the changed data is read in. Each packet contains one or more changes done by another user. After reading in all the packets, the changes are listed in a table at the bottom of the screen.

The changes are color coded:
• Red for deleted objects
• Yellow for modified objects
• Green for new objects

How do I share my changes?
When you have made changes to your local model, you can share your changes to other users of the model by writing out the changes to the sharing service. Before you write out, you always need to read in first if other users have made changes to the model. This is done to solve any conflicting changes made by other users.

After you have read in, you will see a green arrow on the Write out icon. You can now write out your changes.

When you write out, only the changes that you have made are sent to the sharing service. These changes are then available for other users to read in.

How do I share my model?
In addition to joining models other users share, you can start sharing your own model.

Open a single-user model that you want to share, or create a new single-user model. Before you can start sharing your models in Tekla Model Sharing, you need to be logged in with your Trimble Identity in Tekla Structures. If you are not logged in, the Trimble Identity log in dialog box opens.

Go to File --> Sharing --> Start sharing to open the Start sharing dialog box. You can invite other users to join the model and send an email invitation to them, or you can add users later. When you start sharing, you become the Owner of the model.

When you start sharing your model, a model baseline is uploaded to the sharing service. The baseline is a snapshot of the current state of the model.

Who can use the shared model?
With Tekla Model Sharing, you can add new users to your shared model without limitations. Tekla Model Sharing has four roles that define what a user can do in the shared model.

• When you share your model, you automatically get the Owner role. You can invite more users and assign appropriate roles for them. In a typical situation you may have one or two owners who can control everything in the shared model. The users of a model and their roles are listed in File --> Sharing --> Users. The Owner can change the roles if needed.
• Editor can perform all modeling and drawing tasks.
• Viewer role is targeted for those who just want to follow-up on the project.
• Project viewer is for those who use the model information and need to update the fabrication status, for example.
The permissions of each role are shown in the table below:

<table>
<thead>
<tr>
<th></th>
<th>Owner</th>
<th>Editor</th>
<th>Viewer</th>
<th>Project viewer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read in</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Write out</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Modify objects and drawings</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Modify UDAs</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Invite/remove users, change roles, baseline, exclude from sharing</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

**Owner** has all permissions, **Editor** has all permissions except model administration, **Viewer** can only read in, and **Project viewer** can read in and write out, but cannot modify objects or drawings, only the UDAs that do not affect numbering.

In addition to the **Owner**, the company administrator can list all the shared models of the organization and the users and their roles in the web-based Management Console for Tekla Model Sharing. The administrator can change the roles in Management Console without opening Tekla Structures.

**See also**
- Work with Tekla Model Sharing (page 16)
- What is shared in Tekla Model Sharing (page 40)
- Best practices in Tekla Model Sharing (page 50)

**1.2 Work with Tekla Model Sharing**

This section explains how to work with Tekla Model Sharing.

Click the links below to find out more:

- Share a model in Tekla Model Sharing (page 17)
- Join a shared model in Tekla Model Sharing (page 20)
- Share your model changes in Tekla Model Sharing (page 23)
- Detect sharing changes and view sharing history in Tekla Model Sharing (page 27)
- Object locks, drawing locks, and privileges in Tekla Model Sharing (page 31)
Share a model in Tekla Model Sharing

When you start sharing your model in Tekla Model Sharing, you need to be logged in with your Trimble Identity in Tekla Structures. If you are not logged in, the Trimble Identity log in dialog box opens. You can invite other users to the models that you share.

Start sharing a model

1. Open a single-user model that you want to share.

2. On the File menu, click Sharing --> Start sharing.
   The Start sharing dialog box opens.

3. Select the service from the Service list.
   When you use Tekla Model Sharing for the first time and the on-premises sharing service is enabled, you need to select the service from the Service list. You can set up and use an on-premises service connection, or you can use the Tekla service. Tekla Model Sharing on-premises server requires a separate license and installation.

4. If needed, enter a Code and a Description for the model.
   - Code can be a site number, a project number, or an accounting number, for example.
   - Add Description according to your company conventions.

5. Invite other users to share your model by entering their email addresses to the Invite users box and set their user role either to Editor, Owner, Project viewer, or Viewer.
   You can add several users at one go. Separate the email addresses with semicolons. If you add several users at one go, they all get the same user role. The role can be changed later.

6. Click the Add button to add the users to the model.

7. Select the Send e-mail notification to user. check box to send a notification email to the invited users, and write a message to the users.

8. Click the Start button to start sharing your model.
   The model is saved and written out to the sharing service (page 10).
When you open the model the next time, you have two alternatives:

- In the Tekla Structures start screen when you open Tekla Structures:
  1. Go to the **Shared models** tab and log in with your Trimble Identity.
  2. Click **Continue** to open the **Shared models** dialog box.
  3. Select the **Show shared models on this computer** check box to list the models.
  4. Click **Join**.

You can also open shared models on the **Recent** or **All models** tabs. Log in with your Trimble Identity to read in and write out.

- In **File --&gt; Open --&gt; Browse shared models**.

**User roles in Tekla Model Sharing**

User roles define a user's permission level to the model. There are four different user roles in Tekla Model Sharing: **Owner**, **Editor**, **Project viewer** and **Viewer**. When you start sharing your model in Tekla Model Sharing, you become the **Owner** of the model. The **Owner** can invite other users and give them one of the four different roles.

The permission levels of the four different user roles are described in the table below:

<table>
<thead>
<tr>
<th>Role</th>
<th>Permission level</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Owner</strong></td>
<td>• Read in other users' changes and write out your own changes to the sharing service</td>
</tr>
<tr>
<td></td>
<td>• Invite new users</td>
</tr>
<tr>
<td></td>
<td>• List other users and change their roles</td>
</tr>
<tr>
<td></td>
<td>• Remove users from the model</td>
</tr>
<tr>
<td></td>
<td>• Remove the model instance and all the model related data from the sharing service</td>
</tr>
<tr>
<td></td>
<td>• Change the model code and description properties</td>
</tr>
</tbody>
</table>

As an **Owner** you can select the roles when you invite users to a shared model, or any time during a project. If you change the role of a user in **File --&gt; Sharing --&gt; Users**, you can send a notification email to the user. If you include a short message in the email, all the invited users and the users whose role has been changed receive the same message.

Several users can have the **Owner** role within one model. The **Owner** who has started to share the
<table>
<thead>
<tr>
<th>Role</th>
<th>Permission level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>The model can give the <strong>Owner</strong> role to any selected user.</td>
</tr>
</tbody>
</table>
| Editor     | • Read in other users' changes and write out your own changes to the sharing service  
• Edit the model  
• List other users                                                                                                                                 |
| Project viewer | • Read in other users' changes and write out your own changes to the sharing service  
• View the model but you cannot modify the model objects  
• List other users  
With the **Project viewer** role you cannot  
• Modify user-defined attributes that affect numbering  
• Insert and modify grids  
• Import and update models that would create beams and other objects, for example  
Note that when you open the model in the **Project viewer** role, Tekla Structures restart is required.  
The permission level of the **Project viewer** role in a shared model corresponds with the set of functionalities available in the Project Viewer configuration. |
| Viewer     | • Read in other users' changes but you cannot write out any changes to the sharing service  
• View the model but you cannot modify the model objects and you cannot use the export commands  
Note that when you open the model in the **Viewer** role, Tekla Structures restart is required. |

Note that your permission to the shared model is removed when you detach the model from the sharing using one of the following methods:

• **Exclude the model from the sharing (page 38)** using the **Exclude from sharing** command  
• Upgrade to the next Tekla Structures version  
• Use the **Save as** command to save the model
**Information on users and sharing actions in Tekla Model Sharing**

When you want to check the Tekla Model Sharing users and the basic sharing actions on the model, or invite new users to the shared model, open the **Users** dialog box in File --> Sharing --> Users.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the user.</td>
</tr>
<tr>
<td>E-mail</td>
<td>Email address of the user.</td>
</tr>
<tr>
<td>Role</td>
<td>Role of the user: <strong>Owner</strong>, <strong>Editor</strong>, <strong>Project viewer</strong>, or <strong>Viewer</strong>. When you start to share a model, you become the <strong>Owner</strong> of the model and you can set other users' roles. The roles can be changed later, if needed. Use the different roles to control the permission levels to the model. Note that there can be more than one <strong>Owner</strong> within one model.</td>
</tr>
<tr>
<td>Joined</td>
<td>Indicates whether the invited user has joined the model.</td>
</tr>
<tr>
<td>Date</td>
<td>Date when the user has joined the model.</td>
</tr>
<tr>
<td>By</td>
<td>Person who invited the user or changed the user role the last.</td>
</tr>
<tr>
<td>Last read in</td>
<td>Date when the user last read in.</td>
</tr>
<tr>
<td>↓</td>
<td>Number with the arrow down indicates the total number of update packets available in the sharing service. The number next to the arrow indicates how many of the packets the user has read in.</td>
</tr>
<tr>
<td>Last write out</td>
<td>Date when the user last wrote out.</td>
</tr>
<tr>
<td>↑</td>
<td>Number with the arrow up indicates the total number of update packets available in the sharing service. The number next to the arrow indicates the number of the last packet that the user has written out.</td>
</tr>
<tr>
<td>❌</td>
<td>Remove the selected user’s permission to the model. Only <strong>Owner</strong> can remove other users from the sharing service.</td>
</tr>
</tbody>
</table>
Join a shared model in Tekla Model Sharing

When someone using Tekla Model Sharing has invited you to join a shared Tekla Structures model, you may receive an invitation email.

The email contains information about the model, the used environment, and your user role. The user role is your level of permission to the model. You can join a model at any stage of sharing, and as many times as you need.

**Join a shared model**

1. On the **File** menu, click **Sharing --> Browse shared models**. The **Shared models** dialog box opens.

2. Select the service from the **Service** list. When you use Tekla Model Sharing for the first time and the on-premises sharing service is enabled, you need to select the service from the **Service** list. You can set up and use an on-premises service connection, or you can use the Tekla service. Tekla Model Sharing on-premises server requires a separate license and installation.

3. In **Save in**, browse for the location where you want to save your local version of the model. If you later want to join the same model again, you need to save a new local version of the model on your computer. If you use the same name for the model, the local versions of the model need to be saved in different locations on your computer, because you cannot have two or more models of the same name in the same folder.

4. From the **Shared models** list, select the model you have been invited to. You can find the name of the model in the invitation email.

5. Click the **Join** button.

When you join the model:

- Tekla Structures checks that the local version of the model does not already exist in the selected folder. A warning message is displayed if the selected folder already contains the model. In that case, you need to browse for a different folder where to save the model.

- Tekla Structures checks the environment you are using and displays a message if you are using a different environment than the shared model. We recommend that all users within the same shared model use the same environment.

The **Available updates** list opens.

6. From the list of available updates, select an update or a baseline (page 34) that you want to join.
You can select any baseline, which is a snapshot of the model state on a certain date, or update to join, not only the latest. Selecting a baseline is beneficial if you join the model when there already are many changes made. Joining a baseline instead of an update is also faster.

By joining an earlier baseline or update you can go back in the model history, and, for example, check the model state on a certain date.

7. Start working with the model and share your model changes (page 23).

When you read in, only incremental update packets are fetched from the sharing service.

Information on shared models in Tekla Model Sharing
When you want to join a shared model in Tekla Model Sharing, you select the model to join in the Shared models dialog box, in File --> Sharing --> Browse shared models.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service</td>
<td>Sharing service that is being used.</td>
</tr>
<tr>
<td>Save in</td>
<td>Location where the local version of the model is saved on your computer. If you want to save to another location, click the Browse button.</td>
</tr>
<tr>
<td>Shared models</td>
<td>List of models that you have shared or that have been shared with you.</td>
</tr>
<tr>
<td>• Show also hidden</td>
<td>If you have hidden some models from the Shared models list, select the Show also hidden check box to see the full list of models that have been shared with you, or that you have shared.</td>
</tr>
<tr>
<td>• Show shared models on this computer</td>
<td>Select the Show shared models on this computer check box to see the models that you have locally saved on your computer.</td>
</tr>
<tr>
<td></td>
<td>Click to hide the model from the Shared models list. If you have many models on the list, it can be useful to hide the models you are not actively working with.</td>
</tr>
<tr>
<td>Code</td>
<td>Code of the model. The code can be, for example, a site number, a project number, or an accounting number.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the model.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the model.</td>
</tr>
<tr>
<td>Environment</td>
<td>Environment of the model.</td>
</tr>
<tr>
<td>From</td>
<td>Person who has invited you to the shared model, or has changed your role the last.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Date</td>
<td>Date when the sharing of the model was started.</td>
</tr>
<tr>
<td>Your role</td>
<td>Your role and your access level to the model.</td>
</tr>
<tr>
<td></td>
<td>The options are: <strong>Owner</strong>, <strong>Editor</strong>, <strong>Project viewer</strong>, or <strong>Viewer</strong>.</td>
</tr>
<tr>
<td></td>
<td>Only the <strong>Owner</strong> can change the roles of the other users.</td>
</tr>
<tr>
<td>!</td>
<td>If you are the <strong>Owner</strong>, you can edit the <strong>Code</strong> and the Description of the model.</td>
</tr>
<tr>
<td>!</td>
<td>If you are the <strong>Owner</strong>, you can invite new users to the model, or remove existing users.</td>
</tr>
<tr>
<td>!</td>
<td>If you are the <strong>Editor</strong>, you can see which users have been invited or have joined the shared model.</td>
</tr>
<tr>
<td>!</td>
<td>If you are the <strong>Owner</strong>, you can remove the model from the sharing service.</td>
</tr>
<tr>
<td></td>
<td>This discontinues the sharing, and the users who have been working with the shared model cannot share changes anymore.</td>
</tr>
<tr>
<td>Local copies of selected model on this computer</td>
<td>When you select a model from the Shared models list, the model information is displayed here.</td>
</tr>
<tr>
<td>• Edited</td>
<td>• The date when the local version of the model has been edited.</td>
</tr>
<tr>
<td>• Model</td>
<td>• The location of the local version of the model on your computer.</td>
</tr>
<tr>
<td>• □</td>
<td>• Click □ to open the selected local version of the model.</td>
</tr>
<tr>
<td>• ✗</td>
<td>• Click ✗ to remove the selected local version of the model from your computer.</td>
</tr>
</tbody>
</table>

**Share your model changes in Tekla Model Sharing**

After you have modified your local version of the shared model, you can share your changes with other users who are working with the model.

To share your changes with other users, send your changes to the sharing service by writing them out.

To update your model with the changes done by other users, fetch the changes from the sharing service by reading them in. You always need to read the most current changes to a model before you can write out.

To ensure that other users will not write out while you are making changes in the model, you can reserve the next write out.
Write out

1. On the File menu, click Sharing --> Write out, or click on the Quick Access Toolbar.

The Write out icon shows a green arrow when there are no packets that need to be read in before you can write out. You can write out changes immediately.

The Write out icon shows a gray arrow when there are packets that need to be read in before you can write out changes.

When you write out, Tekla Structures saves the model, creates a packet of the model changes, writes out the changes to the sharing service and saves the model again.

Only new or changed data is written out. If you attempt to write out your changes, but some other user has shared some changes earlier and you have not yet read in all the available updates, you are asked to read in first. If there is no new data to be read in, Tekla Structures writes out your changes to the sharing service immediately.

If one of the users who shares the model has selected the Enable write out revision comment option in the Sharing settings (page 35) dialog box, you can enter a code or a comment for the update that you are writing out.

If you delete objects and share the deletion to the sharing service, the deletion is shared with other users, and the deleted objects cannot be recovered.

2. Continue working with the model.

Note that if several users modify the same objects at the same time, the model will contain the changes by the user who first wrote out the changes.

Read in

1. On the File menu, click Sharing --> Read in, or click on the Quick Access Toolbar.

The Read in icon shows the number of packets that are available to be read in.

If one of the users who shares the model has selected the Show available updates when reading in the changes option in the Sharing settings
(page 35) dialog box, the **Available updates** list opens after you have clicked the **Read in** icon.

The dialog box lists all the available packets. You can read in the changes packet-by-packet, if you want to check the model changes in phases. If you want to receive all the updates at once, you can select the latest packet and all the previous packets are read in as well.

When you read in, the updates to the shared model are delivered as incremental packets that only include the changed data. You need to read in all shared changes before you can again write out your own changes to the sharing service.

If you have selected the **Show changes after read in** option in the **Sharing settings (page 35)** dialog box, a list of sharing changes opens at the bottom pane after the selected packets are read in. The list shows the changes according to how they affect the model.

2. **Continue working with the model.**

**NOTE** If you encounter problems with sharing, check the sharing related **log files** in the current model folder and in `..\Users\<user>\AppData\Local\Tekla DataSharing` for troubleshooting.

If Tekla Model Sharing detects changes that should not appear in the local version of the model after read in, Tekla Structures displays a message and the changes are recorded in the `modelsharing.log`. We recommend that you contact your local support to solve the issue.

---

**Reserve the next write out**

1. On the **File** menu, click **Sharing --> Reserve next write out**.
2. In the **Reserve next write out** dialog box, write a comment about why you are reserving the next write out.
3. Click **Reserve**.

When you have reserved the next write out, the **Write out** icon on the Quick Access Toolbar shows a yellow arrow for all users of the model. Placing the mouse pointer on top of the icon shows who has reserved the next write out and the comment written in the **Reserve next write out** dialog box.

Other users cannot write out while you have the next write out reserved. If another user has started writing out when you reserve the next write out, the write out of the other user is canceled only if data transfer has not started yet. The other user will get a notification if the write out is canceled.
4. To write out the changes you have made, on the **File** menu, click **Sharing** --&gt; **Write out**.

   Note that you may need to read in before you can write out.

5. In the **Reserve next write out** dialog box, enter a comment about the changes that you have made.

6. Click **Release**.

   When you have written out, the arrow in the **Write out** icon on the Quick Access Toolbar changes to green again ☁️. Other users can now write out normally.

You can also release your write out reservation without writing out. To do this, on the **File** menu, click **Sharing** --&gt; **Release reservation without write out**.

   Note that if you do not write out or release the reservation within 24 hours, Tekla Structures will automatically release the reservation. An administrator can also release the write out reservation in **Management Console for Tekla Model Sharing** at any time.

---

**Share your model changes automatically**

If you want to automate sharing your model changes, you can use the **Sharing automation tool** from the **Applications & components** catalog.

The **Sharing automation tool** first reads in and then tries to write out the changes until it succeeds. The tool is useful if there are many packets to read in and you want to make sure you get the write out done, or if you want to have the packets read in when you arrive at the office.

You can also use the tool just to automate read in to keep your local model updated with changes made by other users of the model. You can select the date and set the time for the read in.

1. Click the **Applications & components** button 🌊 in the side pane to open the **Applications & components** catalog.

2. Define the settings that you want to use:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Write out now until successful</strong></td>
<td>Select this option to write out your changes immediately. Note that before writing out, the tool reads in other users' changes.</td>
</tr>
<tr>
<td><strong>Create baseline</strong></td>
<td>If you are the <strong>Owner</strong> of the shared model, you can select this option to create a baseline (page 34) when writing out.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Close Tekla Structures after successful write out</td>
<td>Select to close Tekla Structures after write out. Closing Tekla Structures releases licenses and may help with license management.</td>
</tr>
<tr>
<td>Code</td>
<td>Enter the code of the model, for example.</td>
</tr>
<tr>
<td>Comment</td>
<td>Enter a comment, if needed.</td>
</tr>
<tr>
<td>Delayed read in at</td>
<td>Select the date and set the time at which you want to read in. If you have not selected <strong>Write out now until successful</strong>, the tool only reads in.</td>
</tr>
<tr>
<td></td>
<td>If you have selected <strong>Write out now until successful</strong>, the tool first reads in and writes out, and then starts waiting to read in at the set date and time.</td>
</tr>
<tr>
<td></td>
<td>Using the tool to only read in can be useful if your local model has changes that you do not wish to share but you want to get changes from others.</td>
</tr>
</tbody>
</table>

3. Click **OK** to start to tool.

**See also**

*What is shared in Tekla Model Sharing* (page 40)

*Detect sharing changes and view sharing history in Tekla Model Sharing* (page 27)

*Best practices in Tekla Model Sharing* (page 50)

**Detect sharing changes and view sharing history in Tekla Model Sharing**

To see how the model has been changing and who has shared their model changes, use the sharing change detection and sharing history to see what kind of changes the model includes.

**Sharing change detection**

After you have read in (page 23) the model changes from the sharing service (page 10), you can check the changes included in the packets in more detail. A list of sharing changes is shown at the bottom of the screen. The changes are visualized with colors both in the changes list and in the model.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open the changes list</td>
<td>Do one of the following:</td>
</tr>
<tr>
<td><strong>To</strong></td>
<td><strong>Do this</strong></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
</tbody>
</table>
|  | • On the Quick Access Toolbar, click the Show read in changes icon.
|  | • Click File --> Sharing --> Show read in changes.
<p>|  | • To automatically show the list after each read in, select the Show changes after read in option in File --&gt; Sharing --&gt; Sharing settings. |
| <strong>View changes in the list</strong> | Click the separate tabs to see the changes according to how they affect the model. The changes are divided to the following tabs: <strong>Physical objects, Other objects, Drawings, Options, Attribute definitions, Model folder files</strong>, and <strong>UDA changes</strong>. The changes are visualized with colors in the list. Deleted objects are listed in the changes list but they do not have any information available in the Name column. The <strong>UDA changes</strong> tab includes user-defined attributes that have a definition included in the environment.db file. Reference objects are detected as changed if there are physical or material changes. Tabs do not exist if there are no items on the tab. If the tab content becomes empty because of filtering, the tab is not shown. |
| <strong>View changes in the model</strong> | Select the Select objects in the model check box and a row in the list to highlight the changed objects in the model. The changes are visualized with colors in the model. Deleted objects are not visualized in the model. • Added objects = green • Modified objects = yellow • Conflicting objects = orange • Existing objects that have not been modified by another user = gray |</p>
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>View changes in drawings</td>
<td>You can list the different versions of the same drawing in conflict situations, show their snapshots, and change the current drawing version. You can also view a modified drawing and its snapshot. When users modify the same drawing in their local version of the model and one user writes out, the Changes list will show a conflict in other users’ local version of the model when they read in. You can open the Drawing versions dialog box from the Changes list. Select the changed drawing, right-click and select Open versions to view the drawing versions and the changes made to the drawing.</td>
</tr>
<tr>
<td>Filter changes in the list</td>
<td>On each tab, you can filter the changes in every column. Click the filter icon and select how to filter the changes.</td>
</tr>
<tr>
<td>Edit the filter</td>
<td>Click the filter icon and select a filter from the filter list. The name of the selected filter is visible in the bottom left corner of the list.</td>
</tr>
<tr>
<td>To</td>
<td>Do this</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>To do this</td>
<td>If you right-click the filter icon ![filter icon], you can, for example, sort the columns. To edit the filter, right-click the filter icon and select <strong>Filter editor</strong>. The <strong>Filter editor</strong> dialog box opens and you can create or edit the filter as needed.</td>
</tr>
<tr>
<td>Zoom to changed objects in the model</td>
<td>Select the <strong>Zoom to selected</strong> check box and a row in the list to zoom to the changed object in the model.</td>
</tr>
<tr>
<td>Search for specific changes</td>
<td>Type a search word to the search box on the bottom right corner of the list.</td>
</tr>
</tbody>
</table>
| Move the changes list somewhere else on the screen | You can  
  • move the list around the screen  
  • drag the list to a second screen  
  • dock the list to the side pane or to the bottom of the screen  

  The list has a button, ![Dock button], in the side pane. If you drag the list to a second screen, click the button to return the list to the main screen.                                                                                                                                                     |

**Sharing history**

After you have read in and written out (page 23) model changes, you can check the sharing history of the model. The **Sharing history** dialog box shows all your read in and write out events, and the packets included in each event. You can check the sharing history event-by-event, and see how the model has evolved by the changes made by other users.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open the sharing history</td>
<td>On the <strong>File</strong> menu, click <strong>Sharing --&gt; Sharing history</strong>.</td>
</tr>
<tr>
<td>Check the read in and write out events</td>
<td>Click the <strong>Collapse all</strong> button to see all your read in or write out events and their date and time.</td>
</tr>
</tbody>
</table>
| Check the packet information             | Click the **Expand all** button to see all the packets in each read in or write out event.  
The packet number, the person who wrote out the packet and the packet upload date and time is shown.                                                                                                                                                                     |
To | Do this
---|---
View the model changes included in a single event | Select the event and click the **Show changes** button. A list of model changes is displayed at the bottom pane of Tekla Structures.

The **Undo history** dialog box lists all the commands that you have run and the modifications that you have done in your local version of the model. The **Undo history** list is cleared when you read in or write out.

**See also**
What is shared in Tekla Model Sharing (page 40)
Best practices in Tekla Model Sharing (page 50)

**Object locks, drawing locks, and privileges in Tekla Model Sharing**
You can use object locks, drawing locks, and privileges to control user access and editing rights to the shared model objects and the shared drawings.

**Object locks**
You can lock assemblies and cast units, and model objects to prevent accidental modification and numbering of objects. This is useful when there are multiple organizations working with the same shared model, and the organizations want to prevent changes to the assemblies, cast units, and model objects that they have created.

Organization lock means that assemblies, cast units and model objects are locked so that users who are not employees of a particular organization cannot modify them. The assemblies, cast units and model objects are marked as locked **For others** in the **Object locks** dialog box (**Manage > Locks**). We recommend that you use the **Assemblies** option for locking as this also prevents the editing of objects in the assembly.

**NOTE** The organization information is based on the Windows user account, not on the Trimble Identity.

We recommend that you use the **XS_OBJECTLOCK_DEFAULT** advanced option to set the default lock status to **ORGANIZATION** so that assemblies, cast units and model objects are automatically locked **For others** when they are created.

**Set the default organization lock status**
You can automatically set the default lock status for all new assemblies and cast units when they are created. Use the **XS_OBJECTLOCK_DEFAULT** advanced option to set the default lock status. The default lock status can be **ORGANIZATION** or **NO**. When you start to share the model, the default lock
status is set for all assemblies and cast units that do not have any lock status yet.

To set the default organization lock status:
2. Set the XS_OBJECTLOCK_DEFAULT advanced option to ORGANIZATION.
3. Click OK.

All new assemblies and cast units are locked for your organization, and their lock status in the Object locks dialog box is For others. The users in your organization can modify the objects in the assemblies and cast units. Note that users who are not in your organization see the locked status as For us.

**Change the lock statuses**

To change the lock statuses:
1. On the Manage tab, click Locks.

   The Object locks dialog box opens.
2. Select the objects in the model.

   You can select the objects on the assembly and cast unit level, or on the model object level. Use the Assemblies and All object types options, and the Sub-objects check box to define the level of selection.
3. Click the Add objects button to add the assemblies, cast units, or the objects to the list.

   Once the objects are on the list, you can check their Object type, Name and Locked status.
4. To change the status of the locks, select the assemblies or objects in the list or in the model, and a new lock value from the list at the bottom of the dialog box, and click Set.

   The lock status is changed.

<table>
<thead>
<tr>
<th>How the object locks are set</th>
<th>What is locked</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assembly is set to <strong>Organization</strong> (the Locked status is <strong>For others</strong>) and the objects in the assembly are set to <strong>No</strong>.</td>
<td>Assembly and the objects in the assembly are locked for your organization, and users in your organization can modify the assembly or the objects in the assembly. Users in other organizations cannot modify the assembly or the objects in the assembly. Assembly and the objects in the assembly are green in the model.</td>
</tr>
<tr>
<td>How the object locks are set</td>
<td>What is locked</td>
</tr>
<tr>
<td>----------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Assembly is set to <strong>Yes</strong> and the objects in the assembly are set to <strong>No</strong>.</td>
<td>Assembly and the objects in the assembly are locked for all users, no one can modify the object. Assembly and the objects in the assembly are red in the model. It is not possible to delete, modify or number the assembly or the object.</td>
</tr>
<tr>
<td>Assembly is set to <strong>No</strong> and the objects in the assembly are set to <strong>No</strong>.</td>
<td>Assembly or the objects in the assembly do not have any locks, anyone can modify the objects. Assembly and the objects in the assembly are green in the model.</td>
</tr>
</tbody>
</table>

If you want to clear the list, click the **Reset data** button.

You can use the following template fields in report templates to report the lock statuses: `ASSEMBLY.OBJECT_LOCKED`, `ASSEMBLY.OWNER_ORGANIZATION` and `ASSEMBLY.LOCK_PERMISSION`.

In addition, you can use the object representation to visualize the locks. When you share the object representations, other members in the project can visually check the lock statuses.

**Drawing locks**

You can lock drawings to prevent accidental modifications and to reserve drawings for editing. If a drawing is locked and the lock is shared, other users cannot make any changes to the drawing.

1. Read in (page 23) all the model changes.

2. Open **Document manager**, enable direct editing, and click the **Lock** column next to the drawing.

   The **Locked by** column in the **Document manager** shows the user who has locked the drawing.

3. Write out (page 23) to share the drawing lock information.

4. To edit the drawing, open the drawing locks.

5. Edit the drawing as needed.

6. Write out to share the updated drawings.

**Privileges**

The user who has created the model, or anyone in the same organization, can control certain access rights to the model using **privileges (page 77)**. In
practice, the privileges of the model are controlled via the privileges.inp file. All users can change the status of locks unless the access rights are limited in the privileges.inp.

By modifying the privileges.inp file you can control the access to

- modify user-defined attributes (page 77)
- modify numbering settings (page 77)
- save standard files (page 77)

To change the access rights:

1. Close the model.
2. Open the privileges.inp file in any text editor.
3. Change the desired settings and save the privileges.inp file to your model folder.
4. Re-open the model.
5. Write out (page 23) to share the privileges information.

See also
Share a model in Tekla Model Sharing (page 17)

Create a baseline for a model in Tekla Model Sharing

If you are the Owner of a model in Tekla Model Sharing, and you want to keep a record of the current progress in the model or you want to make the model faster to join for a new user, you can create a new starting point for the model in the sharing service. This new starting point is a baseline. Baseline is a snapshot of the current state of the model. When you create a baseline, a full model is always written out to the sharing service. We recommend the Owner to create a new baseline when a new user has been invited to the model.

1. On the File menu, click Sharing --> Create baseline.
2. Enter a code or a comment, if entering revision comments has been enabled in the Sharing settings (page 35) dialog box.
   A full model is written out (page 23) to the sharing service. Files and folders that have been excluded from the sharing are not included in the baseline.
   If you need to read in while you are creating the baseline, you need to repeat the Create baseline command after you have read in other users' changes.
3. If needed: Invite someone to join (page 20) the model.
When the new user joins the model, the **Available updates** list opens.

The user can then select a baseline or an update to join. The **Available updates** list shows all the baselines and the updates after the latest baseline. You can select any baseline or update to join, not only the latest. By joining an earlier baseline or update you can go back in the model history, and, for example, check the model state on a certain date.

Joining a baseline is beneficial for users who join the model when there already are many changes made. Joining a baseline instead of an update is also faster.

After joining a model, only incremental update packets are read in from the sharing service (page 10).

**TIP** You can also create a baseline using the **Sharing automation tool** (page 26) from the **Applications & components** catalog.

---

**See also**

Share a model in Tekla Model Sharing (page 17)

---

### Tekla Model Sharing settings

To modify the basic Tekla Model Sharing settings, use the options in the **Sharing settings** dialog box in **File --> Sharing --> Sharing settings**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model folder file sharing</td>
<td>Click the <strong>Exclude</strong> button to define files or folders in the model folder that you do not want to share.</td>
</tr>
<tr>
<td>• Tekla Model Sharing cache</td>
<td>You can set up a separate Tekla Model Sharing Cache service to be used with the Tekla Model Sharing service. With the Tekla Model Sharing Cache service, the model data is stored to the sharing service and then cached inside a LAN. This set-up is useful especially if there are several Tekla Model Sharing users in the same location, or a narrow bandwidth to the Internet. Using a cache reduces the download effort. The first user who reads in a packet from the sharing service loads it to the cache, and the next user gets the data faster from the cache inside the LAN than from the sharing service through the Internet. The cache is not used for packets that are written out.</td>
</tr>
<tr>
<td>• Name and Port</td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| **Name** is the name of the computer on which the cache is installed.  
To check the computer name, click Windows Control Panel --> System and Security --> System.  
**Port** is the cache service port number that you have set when you installed the cache service. The default value is 9998.  
Click the Set button to connect to the cache.  
Alternatively, you can set the advanced option XS_CLOUD_SHARING_PROXY to “name of the server”; “port” in a .ini file. This advanced option is user-specific.  
To reset the cache settings in the dialog box to the ones defined in the .ini file, click the Reset button. If any .ini file has the advanced option defined, the settings appear in the dialog box. |  |
| **Show available updates when joining the model** | Select the check box to enable a list that shows all the available baselines and updates (page 34) when you join the model.  
The Available updates list shows all the baselines and the updates after the latest baseline. You can select any of the available baselines or updates to join, not only the latest. By joining an earlier baseline or update you can go back in the model history, and, for example, check the model state on a certain date.  
Alternatively, you can set the advanced option XS_SHARING_JOIN_SHOW_AVAILABLE_UPDATES to TRUE in a .ini file to enable the showing of updates. This advanced option is user-specific. |
| **Show available updates when reading in the changes** | Select the check box to enable a list that shows all the available updates (page 23) when you read in the model changes.  
The Available updates list shows all the available updates. You can select any of the available updates to be read in, not only the latest. By reading in an earlier update you can go back in |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>the model history, and, for example, check</td>
<td>the model history, and, for example, check the model state on a certain date. Alternatively, you can set the advanced option XS_SHARING_READIN_SHOW_AVAILABLE_VERSIONS to TRUE in a .ini file to enable the showing of updates. This advanced option is user-specific.</td>
</tr>
<tr>
<td>the model state on a certain date.</td>
<td></td>
</tr>
<tr>
<td>Alternatively, you can set the advanced option XS_SHARING_READIN_SHOW_AVAILABLE_VERSIONS to TRUE in a .ini file to enable the showing of updates. This advanced option is user-specific.</td>
<td></td>
</tr>
<tr>
<td>Show changes after read in</td>
<td>Select the check box to enable a list that shows the model changes (page 23) after you have read in. If you select the Only when conflicts exist option, the list is shown only when there are conflicts in the model after read in.</td>
</tr>
<tr>
<td>Only when conflicts exist</td>
<td>Alternatively, you can set the advanced options XS_SHARING_READIN_SHOW_CHANGEMANAGER and XS_SHARING_READIN_SHOW_CHANGEMANAGER_CONFLICTSONLY to TRUE in a .ini file to enable the showing of model changes. These advanced options are user-specific.</td>
</tr>
<tr>
<td>Enable write out revision comment</td>
<td>Select the check box to enable the entering of revision comments.</td>
</tr>
<tr>
<td>When you write out, you can enter a revision</td>
<td>When you write out, you can enter a revision comment and code in the comment dialog box. If you enable the revision comments, the comment dialog box is displayed for all the model users.</td>
</tr>
<tr>
<td>comment and code in the comment dialog box.</td>
<td>Alternatively, you can set the advanced option XS_SAVE_WITH_COMMENT to TRUE in .ini files to enable the revision comment. This advanced option is model-specific.</td>
</tr>
<tr>
<td>Alternatively, you can set the advanced option XS_SAVE_WITH_COMMENT to TRUE in .ini files to enable the revision comment. This advanced option is model-specific.</td>
<td></td>
</tr>
<tr>
<td>Copy project folder files to model folder</td>
<td>Select whether the project or the firm folder files are copied to the model folder that you are going to share. Select the check boxes and click the Copy files button.</td>
</tr>
<tr>
<td>Copy firm folder files to model folder</td>
<td>We recommend you to copy the project and firm folder files.</td>
</tr>
<tr>
<td>Overwrite model folder files</td>
<td>You can also select whether the copied project or firm folder files replace the existing files of the same name in the model folder.</td>
</tr>
<tr>
<td>Individual files can be copied to a model</td>
<td>Individual files can be copied to a model folder at any time. The next time you write out, they are shared to all model users.</td>
</tr>
<tr>
<td>folder at any time. The next time you write</td>
<td></td>
</tr>
<tr>
<td>out, they are shared to all model users.</td>
<td></td>
</tr>
</tbody>
</table>
Exclude a model from the sharing service in Tekla Model Sharing

If needed, you can exclude yourself and your local version of the model from the sharing service.

When you exclude a model, your local version of the model is no longer connected to the sharing service and you cannot share your changes anymore. However, the model instance still exists in the sharing service and other users can continue working with the model normally.

**NOTE** After you have excluded your local version of the model from the sharing service, you cannot merge the excluded model back to the original shared model. The excluded model is completely new and it has no connection to the model in the sharing service.

All users, regardless of their user role (page 17) (Owner, Editor, Project viewer, Viewer), can exclude their local version of the model from the sharing service.

1. On the **File** menu, click **Sharing --> Exclude from sharing**.
   A confirmation message is displayed.
2. Click **Continue**.
   Your local version of the model is disconnected from the sharing service, and you cannot write out or read in (page 23) changes anymore.
   The model automatically becomes a single-user model.

After you have excluded your local version of the model from the sharing service you can

- continue working with the model in single-user mode.
- start working with the model in multi-user mode (page 39).
- start working with the model again in Tekla Model Sharing.

If you would like to start working again with the excluded model in Tekla Model Sharing, you can either

- start sharing (page 17) the model and invite other users to join the model.
  If you start to share the model, the model is completely new and it has no connection to the previous model in the sharing service, even though the model retains its old name.
• join (page 20) the same model again in the Shared models dialog box in File --> Sharing --> Browse shared models.

When you join the model, you can select a baseline or an update (page 34) to join.

If you join the model again, you need to save a new local version of the model on your computer. If you do not change the name of the model, you may have several models that have the same name in the Shared models dialog box. All these local versions of the model need to be saved in different locations on your computer, because you cannot have two or more models of the same name in the same folder.

Convert a shared model to a multi-user model in Tekla Model Sharing

If needed, you can stop working with a shared model in Tekla Model Sharing and convert your local version of the model to a multi-user model.

A model cannot be simultaneously shared and used in multi-user mode (page 61). If you want to start using multi-user mode as a means to share your model instead of Tekla Model Sharing, you need to first exclude your local version of the model from the sharing service and then convert it to a multi-user model.

**NOTE** The excluded model has no connection to the original shared model in the sharing service. This means that if you exclude your local version of the model from the sharing service and start to use the model in multi-user mode, you cannot later merge the original shared model and the multi-user model.

1. Exclude your local version of the shared model from the sharing service to make it a single-user model:
   a. Open the shared model that you want to convert to a multi-user model.
   b. On the **File** menu, click **Sharing --> Exclude from sharing**.
      A confirmation message is displayed.
   c. Click **Continue**.
      The model automatically becomes a single-user model.
      Your local version of the model is disconnected from the sharing service, and you cannot write out or read in changes anymore. However, the model instance still exists in the sharing service and other users can continue working with the model normally.

2. Convert the current single-user model to a multi-user model:
   a. On the **File** menu, click **Sharing --> Convert to a multi-user model**.
b. Enter the multi-user server name or select the name from the list in the Convert to multi-user model dialog box.

c. Click Convert.

The current model is converted to a multi-user model and you can start using the model in multi-user mode.

**See also**

Share a model in Tekla Model Sharing (page 17)

### 1.3 What is shared in Tekla Model Sharing

By default, all the model data is shared when you share a model in Tekla Model Sharing.

How data is shared in Tekla Model Sharing depends on the type of the shared data.

- Some data is shared incrementally.

  This means that only the new and changed data is shared. When you read in, the data that is fetched from the sharing service is merged to the data on your computer.

  **NOTE** You cannot remove or replace incrementally shared databases. The compatibility of incrementally shared databases is checked when the model is opened.

- Some data is shared, but it cannot be updated incrementally.

  When you read in, the data that is fetched from the sharing service overwrites the data on your computer.

- Some data is not shared.

  Empty folders under the model folder are not shared.

  By default, Organizer data is not shared.

  However, you can use the Organizer import and export with Tekla Model Sharing to share Organizer changes.

  **NOTE** Some of the catalog files that are located in the environment folders (rebar_database.inp, assdb.db, screwdb.db, matdb.bin, profdb.bin) are copied to the model folder when the sharing is started.
How data is shared

If you want to check the files that have been overwritten when you read in, click File --> Sharing --> Open file backup folder to open the \ModelSharing\BackUpEnv folder under the model folder. The folder contains overwritten files from the three latest read ins. You can then, for example, copy the files back to your model or check the files for change detection.

**NOTE** We recommend that you do not remove or replace any databases. If you remove or replace a database, you must create a new baseline of the model. All other users must then join this new baseline, and then continue reading in packets.

### Databases

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Model database</strong></td>
<td>Model database .db1 is shared incrementally.</td>
</tr>
<tr>
<td><strong>Numbering database</strong></td>
<td>Numbering database .db2 is shared, but it cannot be updated incrementally.</td>
</tr>
<tr>
<td></td>
<td>If you have modified the family numbering settings and you read in, you lose the changes if another user has changed the family numbering settings and has written out.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> We recommend that one user updates and shares the numbering settings with other users by writing them out. In case the user needs to read in before writing out the numbering updates, it is important to check that the settings are as they were before starting to share them.</td>
</tr>
<tr>
<td></td>
<td>We recommend you to use the <strong>Number series of selected objects</strong> command on the <strong>Drawings &amp; reports</strong> tab when numbering.</td>
</tr>
<tr>
<td></td>
<td>Create your model output, such as drawings, reports, NC files and IFC files, after a successful write out.</td>
</tr>
<tr>
<td><strong>Model history database</strong></td>
<td>Model history database history.db is shared incrementally.</td>
</tr>
<tr>
<td><strong>Plan database</strong></td>
<td>Plan databases .db3 are shared, but they cannot be updated incrementally.</td>
</tr>
<tr>
<td></td>
<td>If you have imported a CIS/2 or a SDNF model and you read in, you lose the plan database changes if another user has imported the same CIS/2 or SDNF model and has written out.</td>
</tr>
</tbody>
</table>
### Analysis model database

Analysis model database `.db6` and analysis results model database `.db5` are shared, but they cannot be updated incrementally.

If you have modified an analysis model and you read in, you lose the analysis model changes if another user has changed the same analysis model and has written out.

### Custom components and sketched profiles

Custom components and sketched profiles database `xslib.db1` is shared incrementally.

### Standard-part model database

Standard-part model `.db1` is shared when you save the standard-part model in a separate folder under the model folder.

Ensure that `XS_STD_PART_MODEL` is set relative to the model folder and that it points to the correct standard-part model, for example, `XS_STD_PART_MODEL=..\StandardParts\`.

---

### Catalogs

<table>
<thead>
<tr>
<th>Description</th>
<th>Profile catalog</th>
<th>Reinforcing bar catalog</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profile catalog</strong></td>
<td>Shared model contains the profile catalog (page 46) file <code>profdb.bin</code>. When you <strong>add</strong> and <strong>use</strong> a new profile definition in the shared model, the definition is shared the next time you write out. When another user reads in this new definition, the <code>profdb.bin</code> file in the user's model folder is updated to include the added definition. You can also update the profile catalog with new profile definitions without creating any new objects or change the existing profile definitions of a profile that is already used in the model.</td>
<td><strong>Reinforcing bar catalog</strong></td>
</tr>
</tbody>
</table>
### Bolt catalog

**Bolt assembly catalog**

Shared model contains the bolt catalog file `screwdb.db` and the bolt assembly catalog file `assdb.db`.

When you **add** and **use** a new bolt or bolt assembly definition in the shared model, the definition is shared the next time you write out. When another user reads in this new definition, the `screwdb.db` and `assdb.db` files in the user's model folder are updated to include the added definition.

You can also update the bolt catalog and bolt assembly catalog with new bolt or bolt assembly definitions without creating any new objects.

### Material catalog

Shared model contains the material catalog file `matdb.bin`.

When you **add** and **use** a new material definition in the shared model, the definition is shared the next time you write out. When another user reads in this new definition, the `matdb.bin` file in the user's model folder is updated to include the added definition.

You can also update the material catalog with new material definitions without creating any new objects.

### UDAs, options, views, pour units

<table>
<thead>
<tr>
<th><strong>User-defined attribute (UDA) definitions</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>When a model is created, the user-defined attribute definitions are read from the <code>objects.inp</code> files and the definitions are stored to the <code>environment.db</code> database. Modified and added new attribute definitions are shared incrementally. New attribute definitions are added to the database automatically when the model is opened. If the current <code>objects.inp</code> file has a different definition than the <code>environment.db</code>, it is possible to take changes to use by clicking <strong>File --&gt; Diagnose &amp; repair --&gt; Diagnose and change attribute definitions</strong>. If the <code>objects.inp</code> file is in the model folder, it is shared as a file and it overrides the local <code>objects.inp</code> file when you read in.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Options</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>When a model is created, the options are read from the <code>options.ini</code> files and the model-specific options are</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
</tbody>
</table>
| Stored to `options_model.db` and `options_drawings.db` databases.  
Model-specific options can be modified using the **Options** and **Advanced Options** dialog boxes. Modifications to model-specific options are shared incrementally.  
- Some of the options are of the type **SYSTEM(ROLE)**. These options are read from the `.ini` files and are not shared. It is possible to change **SYSTEM(ROLE)** model option to **MODEL(ROLE)** option and the drawing option to **DRAWINGS(ROLE)** option. The options are then stored to the `options_model.db` or `options_drawings.db` databases in the model folder, and the value is shared incrementally.  
- Some of the options are of the type **USER**. These options are user-specific and they are not shared.  
- Some of the options are of the type **SYSTEM**. These options are user-specific and they are not shared. It is possible to change a **SYSTEM** option to a **MODEL(SYSTEM)** option. If you change a **SYSTEM** option to **MODEL(SYSTEM)**, the changed value only works for the current model. These options are not shared. |  
| Other important files in the model folder | The database ID range mapper file `db.idrm` and the library database ID range mapper file `xslib.idrm` are related to the handling of IDs. These files are needed, for example, to open drawings that have been created in single-user or multi-user modes.  
The `plotdev.bin` file contains the print device definitions that you create in **Printer Catalog** (old printing). The file is shared when located in the model folder. |  
| View sharing | By default, views are not shared. Views are shared if they have a name, and the **Share** option in the **View Properties** dialog box is set to **Shared**.  
Note that when you join a model, you get all the model views but changes to the views are not shared if the **Share** option is set to **Not shared**. |  
| Pour unit information | Automatic assignments of objects to pour units are not shared. The **Calculate pour units** command has to be |
run in the local versions of the shared model to update the pour units.

If XS_CALCULATE_POUR_UNITS_ON_SHARING is set to TRUE (which is the default value), Tekla Structures automatically calculates and updates the pour units during writing out and reading in.

If XS_CALCULATE_POUR_UNITS_ON_SHARING is set to FALSE, each user has to run the Calculate pour units command in their local version of the shared model to update the pour units.

Manual assignments created by using the Add to pour unit and Remove from pour unit commands are shared.

Exclude files and folders from Tekla Model Sharing
By default, files and folders in the model folder are shared when you share a model in Tekla Model Sharing. If you do not want to share all of the model folder files or folders, you can select to exclude some of them from sharing.

NOTE  Tekla Model Sharing works only if the model is the same for all users. Tekla Structures takes care of model-specific data sharing. You can only exclude files that do not have an effect on the model. You cannot exclude any of the databases that are in the model folder, xslib.db1, for example.

Empty folders under the model folder and some files are excluded automatically.

   The Sharing settings dialog box opens.
2. Click the Exclude button to see which files and folders in the model folder are excluded from sharing, and to exclude more files or folders.
   Some of the files and folders are excluded automatically from sharing. These files and folders appear on the Excluded model folder files and directories list, and they cannot be removed from the list.
   a. If you want to exclude more folders or files, click the Directory or the File button.
   b. Select the folder or the file to be excluded.
The excluded folders and files are added to the **Excluded model folder files and directories** list.

If you exclude a folder, all its sub-folders and sub-files are also excluded from Tekla Model Sharing.

You can exclude files in several ways. For example, if you have a file called `TeklaStructures.bbb`, and you use the following settings to exclude the files:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(x.x)</td>
<td><code>TeklaStructures.bbb</code> is excluded from sharing.</td>
</tr>
<tr>
<td>(x.*)</td>
<td>All the files with <code>TeklaStructures. </code> are excluded from sharing.</td>
</tr>
<tr>
<td>(*.x)</td>
<td>All the files with <code>.bbb</code> are excluded from sharing.</td>
</tr>
<tr>
<td>(<em>.</em>)</td>
<td>All the files from that folder, but not from its sub-folders, are excluded from sharing.</td>
</tr>
</tbody>
</table>

c. If you want to remove the added folders or files from the list of excluded files, click **Remove**. You cannot remove a folder or a file that has been excluded automatically.

3. Click **OK** when you have finished selecting the excluded files.

### How to share catalog updates

Sometimes you may need to update catalogs with new definitions, such as new profiles, and share the changes without creating any objects with the new definitions.

1. Ensure that all users on the shared model write out (page 23) their changes.
2. **Read in (page 23)** all the model changes.
3. Update the needed catalogs.
4. Create a new **baseline (page 34)**.
5. Ensure that all users join (page 20) the created baseline.

After users have joined the baseline:

a. Ensure that users check that their settings for excluded files and folders are up-to-date in **File --> Sharing --> Sharing settings --> Exclude**, or that they copy the `FileSharing.ini` file from the previous local version of the model in `..\TeklaStructuresModels \<model>\ModelSharing\Settings`.

b. Ensure that users remove their previous local versions of the model.
How to share Organizer data

How to share Organizer data

By default, Organizer data is not shared. However, you can use the Organizer import and export with Tekla Model Sharing to share Organizer changes.

1. Select a user who is responsible for the Organizer data. This is User A.
2. User A creates the Organizer data and exports the data to a model subfolder.
   
   Note that the selected folder cannot be the default ProjectOrganizer folder.
4. User B reads in (page 23) and notices that there is new data available.
5. User B opens Organizer and imports the data that User A has exported.
6. User B removes the old Organizer data and saves the model.
7. User A updates the Organizer data, exports the update and writes out.
8. User B reads in and imports the updated data to Organizer.
   
   The data appears as new in Organizer. User B removes the old data.

How different object types work in shared models

When several users modify the model at the same time in Tekla Model Sharing, conflicts may occur.

In general, all object types work similarly in Tekla Model Sharing. When you read in, the changes in the incoming packet override your local changes to the same object. In other words, if several users modify the same object, the user who first writes out the changes to the sharing service wins in conflicts.

Before you start to share models, agree on common ways of working. For example, you can agree that users work on different areas of the model.

<table>
<thead>
<tr>
<th>Object / Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model objects</td>
<td>A shared modification to an object property overrides any other object property modification. For example, one user modifies a beam profile and writes out. Another user has modified the material of the same beam and reads in. The user who modified the beam material loses the changes, because the shared changes override the local changes to the same object.</td>
</tr>
<tr>
<td>Family numbering</td>
<td>Check the family numbering settings. Family numbering settings are shared but cannot be incrementally updated. We recommend that one</td>
</tr>
<tr>
<td>Object / Property</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>user first reads in all the packets, makes the updates and then shares the settings by writing them out. If the user needs to read in before writing out, it is important to check that the settings are as they were before starting to share them. Give start numbers in wide ranges so that you do not run out of numbers within a numbering series, and that any numbering series does not overlap with another. We recommend you to use the Number series of selected objects command on the Drawings &amp; reports tab when numbering.</td>
<td></td>
</tr>
<tr>
<td>Grids</td>
<td>If there is a conflict in sharing grids, grids are recreated using the original values that have been set in the grid properties. Any manually added grid lines are lost. For example, when two users modify a grid by adding extra grid lines and write out, the added grid lines disappear from the model when they read in.</td>
</tr>
<tr>
<td>Catalogs</td>
<td>Check the catalogs so that they include all the needed definitions. Starting from Tekla Structures 2018, the shape geometry files that are in .xml format are automatically converted to .tez format in shared models.</td>
</tr>
<tr>
<td>User-defined attributes (UDAs)</td>
<td>A shared change to a user-defined attribute (UDA) overrides changes to the same UDA only. For example, a change in the Comment UDA overrides a change to the Comment UDA but not to the Shorten UDA. A shared change to a part does not override UDA changes and vice versa.</td>
</tr>
<tr>
<td>Part and the related component</td>
<td>A shared change to a part does not override component changes and vice versa.</td>
</tr>
<tr>
<td>Custom components</td>
<td>If a user deletes a custom component from the Applications &amp; components catalog in the local version of the shared model, reading in causes an instance of the custom component to appear in the model even if the component was not used in the model. You cannot edit the component instance in the model. If you need to edit the component, explode it first.</td>
</tr>
<tr>
<td>Object / Property</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Drawings</td>
<td>There can be duplicate drawings from the same part. For example, two users create drawings from the same part when they are working on their local versions of the shared model. When both users write out their changes, two drawings appear in Document manager. Tekla Structures does not delete either of the drawings, and it does not merge the changes from the drawings. You need to visually check the drawings and decide which drawing to delete, or to use drawing locks (page 31) to prevent other users modifying the drawings.</td>
</tr>
<tr>
<td>Pours</td>
<td>Agree whether pour management will be used in the model and set XS_ENABLE_POUR_MANAGEMENT accordingly. In some situations, pour management has caused conflicts when reading in, even if the pour units have not been modified. These conflicts may result in objects being removed from pour units. If pour management is enabled in the model, do not disable it using XS_ENABLE_POUR_MANAGEMENT, especially in the middle of the project. This may cause problems if you have drawings containing pour objects, and if you are sharing your model. The pour objects and pour breaks in the model and in the drawings may get invalid, and you may lose all pour-related modeling work. Automatic assignments of objects to pour units are not shared. The Calculate pour units command has to be run to update the pour units.</td>
</tr>
<tr>
<td></td>
<td>• If XS_CALCULATE_POUR_UNITS_ON_SHARING is set to TRUE (which is the default value), Tekla Structures automatically calculates and updates the pour units during writing out and reading in.</td>
</tr>
<tr>
<td></td>
<td>• If XS_CALCULATE_POUR_UNITS_ON_SHARING is set to FALSE, each user has to run the Calculate pour units command in their local version of the shared model when they need up-to-date pour unit information. For example, user 1 moves a reinforcing bar so that it touches a pour object, runs the Calculate pour units command to add the bar to the pour unit, and writes out. When user 2 reads in, user 2 sees that the reinforcing bar has been moved, but the bar has not been added to the pour unit.</td>
</tr>
</tbody>
</table>
Manual assignments, and other modifications to pour objects and to the objects attached to the pour objects (such as changes to geometry or location), are shared. A shared manual change in pour unit assignment overrides a local change.

For example, user 1 adds an embed to a pour unit by using the Add to pour unit command, and writes out. User 2 has added the same embed to another pour unit by using the Add to pour unit command. When user 2 reads in, user 2 sees that the embed has been added to the pour unit user 1 added it to.

Standard files for numbering setup

Standard files for numbering setup are not loaded automatically when you read in. If you want to take them in to use, you need to reload them after reading in.

**WARNING** If an object deletion has been written out to the sharing service, the object will be deleted in your model when you read in. This happens regardless of whether you have modified the object before reading in. Deleted objects remain deleted if the deletion has been shared.

Deleted objects are not visualized when you read in.

### 1.4 Best practices in Tekla Model Sharing

To keep your shared models in good shape and to share your changes successfully, follow the Tekla Model Sharing best practices.

**NOTE** The users of the same shared model need to have the same Tekla Structures version, and use the same latest service pack.

Note that in some situations, pour management (page 47) has caused conflicts when reading in, even if the pour units have not been modified. These conflicts may result in objects being removed from pour units.

For general Tekla Model Sharing troubleshooting instructions, see Troubleshooting Tekla Model Sharing.

**Collect model history in Tekla Model Sharing**

Tekla Model Sharing collects model history on the actions in the shared model. Model history shows when the model has been changed, how the model has changed, and who has made the changes.
1. On the **File** menu, click **Settings --> Advanced options --> Speed and Accuracy**.
2. Ensure that **XS_COLLECT_MODEL_HISTORY** is set to **TRUE**. Tekla Structures automatically sets **XS_COLLECT_MODEL_HISTORY** to **TRUE** when a model is shared.
3. Set **XS_CLEAR_MODEL_HISTORY** to **FALSE**.
4. Click **OK**.
5. To view model history, do one of the following:
   - On the ribbon, click ![Image] and select an object in the model. The model history is shown in the **Inquire object** dialog box. If the **Enable write out revision comment** option has been selected in the **Sharing settings** dialog box, the revision comments are displayed as well.
   - Create a model history report.
     a. On the **Drawings & reports** tab, click **Reports**.
     b. Select a report template that shows the model history. The name of the report template may vary in different environments. In the Default environment, the report template is called **Q_Model_History_Report**.
     c. Click **Create from all** to create a report on all the objects in a model, or select one or more objects in the model and click **Create from selected** to create a report from the selected objects.

Offline usage history is stored according to the Windows domain user account. Note that in Tekla Model Sharing models, when you write out your changes to the sharing service, the changes are stored using your Trimble Identity.

### How object IDs work in shared models

Tekla Structures objects have an identifier that is shown as an object GUID, Globally Unique Identifier, that is also used in Tekla Model Sharing. This means that features that do not use GUIDs need to be changed to use GUIDs:

- Interoperability import/export actions:
  - FabTrol XML
  - ASCII
- All other applications, macros and report processes that rely on static IDs.
Backing up shared models

We recommend you to back up the models used in Tekla Model Sharing. In case there are problems with a shared model, it is possible to select any user's local version of the model, or a model that has been backed up, and continue working using that model. Make sure that you have the complete backed up model in use and that the model folder includes, for example, drawings and different databases. This ensures that the model functions properly and you do not lose any data. If the backed up version of the model is old, reading in all the changes may take some time.

Back up your models according to your company conventions, for example, by using Windows Backup. You can also use the File --> Save as --> Save and create backup copy command to create a backup copy of the model. The backup copy will have the same GUIDs as the original model.

Note that the Save as command cannot be used for backing up the model. If you use Save as, the model gets new IDs and it has no relation to the original model.

If you use the Save as command, the model history is not copied with the saved model.

Restoring shared models

If a shared model has problems that may cause loss of working time, a company administrator can delete the model versions that have problems using Management Console for Tekla Model Sharing. It is also possible that a user of a shared model restores a previous version of the model in Tekla Structures, and that model is used in Tekla Model Sharing.

Management Console for Tekla Model Sharing provides a web-based access for administrators to manage all shared models of an organization. An administrator can lock a model and name one user as the lock owner who can investigate the model in Tekla Structures. Once the lock owner finds the problem, the administrator can delete the model versions that are causing the problem, and then unlock the model so that it can be used normally again.

While the model is locked, the sharing commands in Tekla Structures are available as follows:

- The Read in and Write out icons have yellow arrows . Only the lock owner can use these commands.
- On the File menu, the Read in, Write out, Create baseline and Users commands are available for the lock owner.
In the Shared models dialog box, the Edit model, Manage users, and Remove model from cloud commands, and joining a particular model are available for the lock owner. For other users the sharing commands are not available.

If a user of the shared model has already read in or written out any of the model versions that the administrator has deleted, Tekla Structures shows the Write out and Read in icons with red arrows for this user. The sharing commands on the File menu are not available. The user needs to rejoin the model.

If a user is not using any of the deleted versions, the user does not need to rejoin.

Note that it is also possible to revert to an earlier version of the model without further investigating it. The administrator can lock the model in Management Console for Tekla Model Sharing, delete the versions that are not needed or that contain errors, and then unlock the model. After this, the users need to rejoin the valid version of the model.

Note that when model versions are deleted, the changes that have been made in those versions are lost from the model. The changes that should be included in the model need to be made again and read in.

Another option to take a previous version of the model into use is that a user of the shared model performs the following steps:

1. Join (page 20) the model again.
2. Read in (page 23) the packets until you have reached the preferred level in the model history.
3. Exclude (page 38) the model from sharing.
4. Start sharing (page 17) and invite other users again to the model.

Ensure that all the users within the model start to use the restored version of the model.

Cache service for Tekla Model Sharing

Tekla Model Sharing Cache service downloads model data from the Tekla Model Sharing service and caches the data in the file system inside a LAN. Using the cache service reduces the use of the Internet, resulting in faster download times when the same data is requested more than once. Note that the cache is not used for packets that are written out.

The cache service needs an Internet connection to download model data from the sharing service. The first time a user fetches a packet it will be loaded to
the cache service. Any following requests to the same packet will then be served fast from the cache service inside the LAN.

The cache service is useful even if there is only one Tekla Model Sharing user in the same office. For example, rejoining a model is faster as the model data is available in the cache service. In addition, the model data is always loaded as small data blocks. This is useful if the downloading is interrupted for some reason, because the cache service can just later download the missing blocks.

If there are several Tekla Model Sharing users in the same office, we highly recommend you to install the Tekla Model Sharing Cache service. The cache service is recommended especially in regions where the download speed may be limited.

The image below shows how the model data is stored to the sharing service and used with the Tekla Model Sharing Cache service.

Software and system requirements for a cache installation:

- Windows Server 2008 R2, or later
- .NET Framework 4.5.1

Install a cache service in the following way:

1. Ensure that you have an active Windows computer or a server with enough disk space to store the cached model data.
2. Download the Tekla Model Sharing Cache service installation file from Tekla Downloads.

3. Run the installation file and follow the steps in the installation wizard to complete the installation.
   • The default cache folder is C:\TeklaModelSharingCache. If needed, you can change the folder destination.
     Ensure that the destination folder has enough disk space for the estimated usage of the service. The required disk space can vary from a few gigabytes to terabytes, depending on the amount of Tekla Model Sharing users and the size of the models.
   • The default TCP/IP port number for the cache service is 9998.
     Use this port number when you configure Tekla Structures client workstations to use the cache. This port is the main communication and control channel to the cache service.
   • The default TCP/IP port number for internal communication is 9001.
     This port is automatically fetched from the cache service, and it is used for the actual data transfer.

**Network access**

You need to allow inbound traffic for TCP/IP ports (defaults 9001 and 9998) for the cache service host.

If the ports cause conflicts or other problems because of other services or a firewall, you can change the ports to some other ports.

The cache service needs an Internet connection to download model changes from the sharing service.

**NOTE** If you later need to modify the installation, re-run the TeklaModelSharingCacheService.exe installation file and select Repair. You can then change the previously set cache folder or port numbers. To use content from the previous cache folder, copy or move the needed content to the new folder.

4. Check that the Tekla Model Sharing Cache service has started.
   • Locate **Tekla Model Sharing Cache** from the Windows services by using, for example, the Computer Management console compmgmt.msc or the Services management console services.msc.
   • Use Windows Event Viewer to verify that there are no errors from the service and that there are Information messages showing that the service has started.

5. Configure Tekla Structures client workstations to use the cache.
In Tekla Structures, on the **File** menu, click **Sharing --> Sharing settings**.

In the **Sharing settings** dialog box:

- **Name** is the name of the computer on which the cache is installed. To check the computer name, click **Windows Control Panel --> System and Security --> System**.

- **Port** is the cache service port number that you have set when you installed the cache service. The default value is 9998.

**Troubleshoot the cache service installation**

If you cannot connect to the service from Tekla Structures:

- Ensure that the Tekla Model Sharing Windows Service is running.
- Ensure sure that the firewalls do not block TCP/IP ports configured to Tekla Structures, for example 9001 or 9998 when you use the default ports.

If the service does not start:

- Check the Windows Event Viewer’s Application Log for possible errors.

**Rejoin the model if the model is not saved after write out**

If there are errors in writing out changes to the sharing service, you may need to rejoin the model. Tekla Structures will show you an error message if the errors in the write out could cause database inconsistencies and corrupt model data.

When you write out, Tekla Model Sharing does the following:

1. Saves the model.
2. Prepares the incremental packet. The data in the model folder is not changed yet.
3. Uploads the incremental packet to the sharing service.
4. Saves the model again if the incremental packet is uploaded successfully. Local model data is updated with the needed information.

Tekla Structures will not show you an error message if there are errors at any step before step 4. The sharing service has not received the model update yet. You can try to write out again as the model folder does not contain any data that would prevent the write out. If there are new updates available for the model, first read in the updates and then try to write out again.

If there are errors at step 4, Tekla Structures shows you an error message advising you to rejoin the model. After joining, you can check from the sharing history (page 27) that your write out was uploaded to the sharing service.

Errors at step 4 mean that the model may not have been saved correctly, and model data may be corrupted or lost. The model has several different Tekla Structures databases each of them with their own baseline. If there are errors,
the Tekla Structures model does not have all the needed information of what has been shared.

**How to get support for sharing issues**
You can contact Tekla Structures support to solve Tekla Model Sharing issues. When you deliver your model to your local support for investigation, ensure that you include the following:

- The model. Zip the model but do not save it anymore before delivering it.
- Give Viewer permissions to Tekla Structures support by inviting tms-support-no-reply@tekla.com to the model.
  
  Remember to remove Tekla Structures support from the users after the model has been investigated.
- Detailed description of the problem.
  
  Include steps to reproduce the problem if possible.
- Images and screenshots.
- Which Tekla Structures version you are using.
- Which environment and role you are using.

### 1.5 Multi-user mode

You can work on Tekla Structures models in either single-user or multi-user mode. Multi-user mode allows several users to access the same model at the same time. Several users can work on the same project and be aware of the others’ progress. This eliminates the need for copying and merging models.

**Advantages**

- No duplicate models to control, track or store
- Using only one model reduces on site errors
- Erection plans based on a single master model
- Bolt and material lists generated from a single master model
- Ability to share the workload of large projects among many users
- Ability to collect model history (see XS_COLLECT_MODEL_HISTORY)

**Other issues to consider**

As with all projects, you need to plan your multi-user project carefully. Some issues to consider are:

- Only one user can save to the master model at a time
• Use a numbering plan. When working with multi-user models, always use the option **Synchronize with master model (save-numbering-save)** in the **Numbering setup** dialog box to prevent saving conflicts.

• Schedule numbering sessions appropriately (it can take some time to number larger models)

• If possible, assign distinct areas of the model to each user to avoid conflicts that may happen when several users are working in the same area.

• You should never use a mix of single-user and multi-user setups on one project. Saving a multi-user model in single-user mode deletes changes by other users working on the model, and can also corrupt the model. See **Saving in multi-user mode (page 63)** to find out how saving works in multi-user mode.

**NOTE** Tekla Structures multi-user mode only runs on TCP/IP-based networks.

See also
- Multi-user system (page 58)
- How multi-user works (page 61)
- Saving in multi-user mode (page 63)
- Autosaving in multi-user mode (page 64)
- Shutting down the model in multi-user mode (page 66)
- Copy multi-user models (page 66)
- Error messages in multi-user mode (page 67)
- Recommendations for multi-user setup (page 68)

**Multi-user system**

A Tekla Structures multi-user system runs on a TCP/IP network and consists of:

• A server computer running the multi-user server

• A file server computer containing the master model

• Client computers running Tekla Structures

**Tekla Structures multi-user server as a service**

Tekla Structures multi-user server runs as a service that is started automatically when you start the computer. You do not need to log in to the service.

Tekla Structures multi-user server performs the following main tasks:

• Locks the model when somebody saves or numbers the model
• Identifies client computers
• Keeps track of active multi-users
• Gives numbers for general arrangement drawings and multidrawings
• Displays warnings if another user has already edited or is currently editing drawings or the same model object

To optimize the performance of a multi-user system, run as few other programs as possible on the Tekla Structures multi-user server.

**Server shutdown**

Users should save their working models to the master model before the Tekla Structures multi-user server is stopped. If the service is stopped before saving the working models, for example because the server computer needs a restart, simply restart the service and have users save their working models to the master model.

**Install Tekla Structures multi-user server as a service**

The Tekla Structures multi-user server installer installs the multi-user server as a service. When you have installed the server, the service is always available and it is automatically started when the server computer is started. There is no need to log in and no need to start the server manually every time you start your computer. Tekla Structures multi-user server allows many users to work on the same model simultaneously.

We recommend that you use the latest multi-user server version available regardless of the Tekla Structures version that you use.

1. Download the multi-user server software installation file from Tekla Downloads.
2. Double-click the installation file to run the installation.
3. Follow the steps in the installation wizard to complete the installation.
   
   The server is by default installed to:
   c:\Program Files (x86)\Tekla Structures Multiuser Server
   
   You cannot change the installation path during the installation.
   
   If you install the multi-user server on your own computer, the server name is the name of your computer.
   
   The multi-user server uses TCP/IP port 1238.

   The installation log is written to the xs_server.log file that is available in c:\ProgramData\TeklaStructuresServer.

**Change the server of a multi-user model**

You can change the Tekla Structures server of a multi-user model.
1. On the **File** menu, click **Sharing --> Change multi-user server**.
2. Enter the new server name or select it from the list.
3. Click **Change**.
   
   If the connection to the new server cannot be established, the old connection is restored.

**NOTE** The file `.This_is_multiuser_model` located in the model folder defines whether the model is a multi-user or a single-user model. The file includes also the name of the server. You can open the file using any standard text editor.

**See also**

Convert a multi-user model to a single-user model (page 60)

Convert a single-user model to a multi-user model (page 60)

---

**Convert a multi-user model to a single-user model**

You can convert a multi-user model to a single-user model and open it in the single-user mode.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert a current, open model</td>
<td>On the <strong>File</strong> menu, click <strong>Sharing --&gt; Convert to a single-user model</strong>. The current model is converted to a single-user model.</td>
</tr>
</tbody>
</table>
| Convert some other than the current model | 1. On the **File** menu, click **Open --> All models**.  
2. Select the multi-user model to be converted from the list of models and click **Convert to single-user model**.  
3. Click **Convert** in the **Convert to single-user model** dialog box. |

**See also**

Convert a single-user model to a multi-user model (page 60)

---

**Convert a single-user model to a multi-user model**

You can convert a single-user model to a multi-user model and open it in the multi-user mode.
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert a current, open model</td>
<td>1. On the <strong>File</strong> menu, click <strong>Sharing -- Convert to a multi-user model</strong>.</td>
</tr>
<tr>
<td></td>
<td>2. Enter the multi-user server name or select the name from the list in the <strong>Convert to multi-user model</strong> dialog box.</td>
</tr>
<tr>
<td></td>
<td>3. Click <strong>Convert</strong>.</td>
</tr>
<tr>
<td></td>
<td>The current model is converted to a multi-user model.</td>
</tr>
<tr>
<td>Convert some other than the current</td>
<td>1. On the <strong>File</strong> menu, click <strong>Open --&gt; All models</strong>.</td>
</tr>
<tr>
<td>model</td>
<td>2. Select the single-user model to be converted from the list of models, and click <strong>Convert to multi-user model</strong>.</td>
</tr>
<tr>
<td></td>
<td>3. Enter the multi-user server name or select the name from the list in the <strong>Convert to multi-user model</strong> dialog box.</td>
</tr>
<tr>
<td></td>
<td>4. Click <strong>Convert</strong>.</td>
</tr>
</tbody>
</table>

**See also**

*Convert a multi-user model to a single-user model (page 60)*
How multi-user works

The multi-user model consists of a single *master model*. Each user can access this model and open their own local view of the model. This local view is called a *working model*. The above image shows one possible configuration of the multi-user system.

Any changes a user makes to his working model are local and are not visible to other users until he saves the working model to the master model.

The multi-user system can contain several *client computers*, where users work on their working models. The master model can be located anywhere on the network, including any of the client computers.

When you open a multi-user model on a client computer, Tekla Structures makes a copy of the master model to the memory of the client computer (a working model).

When you click **Save** to save your working model back to the master model, Tekla Structures:

1. Takes a new copy of the master model and compares your working model with it.
2. Saves the changes in your working model to the copy of the master model (locally).
3. Saves this copy back to the master model. (When other users save their working models, they can now see your changes.)

4. Takes a new copy of the master model and saves it locally as your working model. (You can see your own changes and those uploaded by other users.)

The multi-user model is locked during opening, saving and numbering. When one of the users performs any of these operations, other users cannot perform them during that time.

**Locks for models in multi-user mode**

To preserve the integrity of the multi-user model, Tekla Structures locks the master model when a user:

- Opens the multi-user model
- Saves a working model to the master model
- Runs numbering

When you try to save the model that is locked, Tekla Structures gives you an option to queue for saving until the model is unlocked. Tekla Structures keeps on retrying saving every 15 seconds until the operation is completed or until you cancel the operation.

**See also**

Saving in multi-user mode (page 63)

**Saving in multi-user mode**

Tekla Structures preserves the integrity of the model, even if more than one user modifies the same model objects. If two users modify the same object, then save to the master model, the master model will only contain the changes of the user who most recently saved their working model to the master model.

**TIP** To avoid potential save conflicts, have users work on different areas of the model.

Tekla Structures creates connections to the right parts, even if the part is moved by another user.

Note that if you use the **Save as** command to save the model, the model history is not copied with the saved model.

**Speeding up the saving process**

The following advice may help in speeding up the saving process:
• Check your network connection speed, because it can slow down the saving process significantly.
• Close down all the views of the model before saving.
• Set the advanced options XS_PROJECT and XS_FIRM so that they point to a local drive and move most of the system files there. If there are many system files in the network drive, saving may become slower than when using system files located on your own hard drive. Each user should use the same files to ensure similar outcome.
• Delete any hidden reference models which you do not need anymore.

See also
How multi-user works (page 61)

Autosaving in multi-user mode
Autosave only saves the working model, not the master model. Other users do not see the modifications you make after an Autosave. In multi-user mode, this makes Autosave much faster than the Save command. Save updates the master model.

By default, Tekla Structures saves the Autosave files in the master model folder with the filename <model>.db1_<user>. If several people are using the same username, conflicts will occur.

To avoid conflicts and problems caused by the network traffic, store the Autosave files locally, not in the model folder that is located on a network drive. Set the advanced option XS_AUTOSAVE_DIRECTORY, for example, to XS_AUTOSAVE_DIRECTORY=C:\TeklaStructuresModels\autosave. By saving autosave files locally you make sure that if there are problems in the network traffic, you are still able to save your own work.

1. On the File menu, click Settings --> Options, and in the General settings define the Autosave intervals for operations performed in the drawing and the model.
2. Periodically autosave the model manually.

To do so, create a shortcut for the Autosave command. Click File menu --> Settings and in the Customize area select Keyboard shortcuts.

NOTE Remember to save regularly to the master model by clicking Save.

See also
Error messages in multi-user mode (page 67)
Copy multi-user models (page 66)
How multi-user works (page 61)
Model history in multi-user mode

Tekla Structures collects model history on the actions that have taken place in the multi-user model by different users.

Model history shows when the model has been changed, how the model has changed, who has made the changes, and the model revision comments.

Collect model history in multi-user mode

1. On the File menu, click Settings --> Advanced options.
2. Go to the Speed and Accuracy tab.
3. Set XS_COLLECT_MODEL_HISTORY to TRUE.
4. Set XS_CLEAR_MODEL_HISTORY to FALSE.
5. Optional: Go to the Multi-user tab.
   Set XS_SAVE_WITH_COMMENT to TRUE.
   This enables the saving of model revision comments.

View model history in multi-user mode

To view model history, do one of the following:

- On the ribbon, click 🔄 and select an object in the model.
  The model history is shown in the Inquire object dialog box.
- Create a model history report.
  1. On the Drawings & reports tab, click Reports.
  2. Select a report template that shows model history from the list. The name of the report template may vary in different environments.
     In the Default environment, the report template is called Q_Model_History_Report.
  3. Click Create from all to create a report on all the objects in a model, or select one or more objects in the model and click Create from selected to create a report from the selected objects.

Save model revision comments in multi-user mode

You can save model revision comments when working with multi-user models. This means that all objects which have been changed during the last save interval include the revision information in them. You can use this information in filtering and reports. You can also use it to examine which users have modified the objects.

- The Owner is the user, who has added the object into the model.
• **History** shows when the model has been changed, how the model has changed, who has made the changes, and the model revision comments.

Before you can save model revision comments, check the following:

• Set the advanced option XS_SAVE_WITH_COMMENT to **TRUE** in **File --> Settings --> Advanced options --> Multi-user**.

• Set the advanced option XS_COLLECT_MODEL_HISTORY to **TRUE** in **File --> Settings --> Advanced options --> Speed and Accuracy**.

1. When you have set the advanced options mentioned above to **TRUE**, Tekla Structures displays the **Model revision comments** dialog box when you are saving the model. Enter the desired revision comment and code in the **Model revision comment** and **Model revision code** boxes.

2. Click **OK**.

Tekla Structures applies the values of this dialog box to parts that were changed after the last save. When you inquire objects, you can see the model revision information in the **Inquire object** dialog box. You can use this information also for selection and view filtering.

---

**Shutting down the model in multi-user mode**

Do not shut down the computer containing the master model while other users are working on their working models. They will not be able to save their changes to the master model.

If this does happen, to avoid losing any changes, follow the steps below:

1. Keep the working model(s) open on the client computer(s).
2. Restart the computer containing the master model.
3. Open the master model on the computer containing it and autosave the model.
4. Click **Save** on the client computers to save the working models to the master model.

---

**See also**

Saving in multi-user mode (page 63)

Autosaving in multi-user mode (page 64)

---

**Copy multi-user models**

1. Have all users save and close their working models.
2. On the **File** menu, click **Open --> All models**.
3. From the list of models, select the multi-user model and click **Convert to single-user model --> Convert**.
4. Use **Save as** to make a copy of the model.

5. Exit Tekla Structures and re-open the model in multi-user mode to continue working on it.

**Display active multi-users**

You can display information on users working on the same server.

To display active multi-users, click **File menu --> Sharing --> Active multi-users**.

The **Active Multi-Users** dialog box displays the following information:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locked</td>
<td>The time when the model was locked.</td>
</tr>
<tr>
<td>Model name</td>
<td>The name of the model.</td>
</tr>
<tr>
<td>User</td>
<td>Users that are currently working on models on the server.</td>
</tr>
<tr>
<td>Latest login</td>
<td>The time when the users have logged in.</td>
</tr>
<tr>
<td>Latest access to server</td>
<td>The time when the users have last accessed the server.</td>
</tr>
<tr>
<td>Editing drawings</td>
<td>The drawings that are currently being edited.</td>
</tr>
<tr>
<td>Edited drawings</td>
<td>The drawings that have been edited and saved to the server.</td>
</tr>
</tbody>
</table>

**TIP** The **Active Multi-Users** dialog box is refreshed every 30 seconds. You can refresh it immediately by clicking **Refresh**.

**Error messages in multi-user mode**

<table>
<thead>
<tr>
<th>Error message</th>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database write conflicts detected</td>
<td>More than one user has changed an object.</td>
<td>Check the conflict.log. It lists the GUID numbers of the objects that more than one user has changed. This is not usually a critical problem. No need to use the Check database tool. See also Saving in</td>
</tr>
<tr>
<td>Error message</td>
<td>Problem</td>
<td>Solution</td>
</tr>
<tr>
<td>---------------</td>
<td>---------</td>
<td>---------</td>
</tr>
<tr>
<td>Could not save model. Possible reasons are: - disk is full or write protected - locked .tmp -file(s) exists in the model directory</td>
<td>You tried to save a multi-user model to a computer or folder that you could not access.</td>
<td>• Check that you have permission to write to the model folder. • Check that there is enough disk space to save the model. • Restart the computer where you want to save the model. Try to save the model again. • Delete the .tmp files from the model directory.</td>
</tr>
<tr>
<td>Database locked cannot open model</td>
<td>Computer stopped responding while saving the model, which locks the model.</td>
<td>To unlock the model, the user whose operating system stopped responding should open the model in multi-user mode and save it.</td>
</tr>
<tr>
<td>Cannot read autosaved model as a normal model in the multi-use mode</td>
<td>The opening of a multi-user Autosave file has been prevented in single-user mode to prevent the reading of wrong file types.</td>
<td>Do not rename or move Autosave files. Do not open the Autosave file of a single-user model in multi-user mode or vice versa.</td>
</tr>
</tbody>
</table>

**Recommendations for multi-user setup**

Here are some recommendations on how to optimize your multi-user setup. For more information, see Hardware recommendations.

**Server computer**

The Tekla Structures server does not have a high workload and can be run on a relatively low specification computer. You do not need a commercial network file server. Its main task is to process network requests for object ID numbers. See Multi-user system (page 58) for more information.
**Client computer**

Have as much RAM as possible (4 Gb or more). This speeds up saving in multi-user mode. See Saving in multi-user mode (page 63) to find out more about the multi-user save process.

We also recommend using a fast multi-core processor, particularly for computers where you run numbering.

LVD (Low Voltage Differential) drives speed up the saving and opening of models.

**Network**

Ensure that the TCP/IP protocols are set correctly:

- Each PC on the same network has a unique ID number
- Each PC on the same network has an identical Subnet mask

| TIP | To find the IP address of a computer, enter `ipconfig` at the DOS prompt. |

| NOTE | Some network operating systems may block user history data, which means that for example the Inquire object dialog box does not show user names. |

---

**Remove inconsistencies from a multi-user database**

To preserve the integrity of your multi-user model, you need to remove any inconsistencies from the multi-user database at regular intervals, for example once a day. This may also fix assemblies with no main part and drawings of unknown (U) type.

We recommend you to check the multi-user database in single-user mode.

1. Have all other users exit the multi-user model.
2. Save your model to receive the modifications of other users.
3. Exit the model.
4. Open the model in single-user mode.
5. On the File menu, click Diagnose & Repair and in the Model area, click Repair model.
6. Save the model.
7. Exit the model.
Modeling in multi-user mode

Before you start a project, assign each user an area of the model. To prevent potential save conflicts, you need to avoid having more than one user working on the same, or adjacent model objects. See also Saving in multi-user mode (page 63).

Example

If three users are to model a project, User #1 could model columns, User #2 the 1st floor beams, and User #3 the 2nd floor beams.

In the following example, three users are working on the same model. You can see how modeling and saving works in practice.

The master model contains columns and grids, as you can see here.

Each user opens the model in multi-user mode. All users are now working on working models, locally.

On the working models:

User #1 adds base plates to the columns:
User #2 adds and connects the 1st floor steel beams:

User #3 adds and connects the 2nd floor steel beams:
User #1 clicks **Save** to save to the master model. His working model now shows the base plates he added and looks like this:

User #2 clicks **Save** to save to the master model. His working model now shows his 1st floor framing and User #1’s base plates:

**Working collaboratively within a Tekla Structures model**

Multi-user mode
User #3 clicks **Save** to save to the master model. His working model now shows all three users's work:

To see the updated master model, Users #1 and #2 need to save to the master model again to update their working models.
Numbering setup in multi-user mode

Define the numbering settings as follows:

1. On the **Drawings & reports** tab, click **Numbering settings**.

2. In the **Numbering setup** dialog box, select the **Synchronize with master model (save-numbering-save)** check box.

   When you select this check box, you can cancel the numbering before the last save is made. This is useful, for example, if you want to check the numbering results and you find something that you still want to change.

   **NOTE** When working with multi-user models, use this option always to prevent saving conflicts.

3. Modify the other properties as required.

4. Click **OK**.

   Tekla Structures will now save the model before and after you number all parts or modified parts.

When you click **Perform numbering** on the **Drawings & reports** tab to run numbering, Tekla Structures displays a list that shows the numbering progress. When the numbering is finished, the changed numbering results are highlighted in the list. When you select an item on the list, Tekla Structures highlights the corresponding object(s) in the model. If you keep the F key pressed when you select the item, Tekla Structures fits the work area of the current view around the objects.

If the numbering results are correct, click **Save numbers** to make the second save. To cancel the numbering before the second save, click **Cancel**. If you cancel the numbering, the model is returned to the state before numbering and standard files are read to all dialogs.

To review the numbering results further, click **Stop timer**.

To change the time frame in which Tekla Structures makes the second save, use the advanced option XS_NUMBERING_RESULTS_DIALOG_DISPLAY_TIME.

**NOTE** We recommend that you run the **Diagnose & Repair Numbering: All** command in File menu **Diagnose & Repair** to remove any numbering inconsistencies from the multi-user database at regular intervals, for example once a day.
**See also**

*Access rights in multi-user mode (page 77)*

**Synchronize numbering with the master model**

If you need to include numbering information from areas in the model that have been modeled by other users:

1. Ask all users to save their working models. This updates the master model.
2. Number the model. Make sure that the **Synchronize with master model (save-numbering-save)** check box is selected in the **Numbering setup** dialog box (see *Numbering setup in multi-user mode (page 74)*). This updates your working model to the master model, numbers the master model, and then saves the numbered master model for all users to access.

**NOTE** If you create drawings and/or reports after numbering, you need to save the master model again to make them visible to other users.

---

**Drawings in multi-user mode**

The multi-user environment is very useful when several users are simultaneously editing drawings.

Tekla Structures saves each drawing in a unique file. These drawing files are located in the drawing folder in the master model folder.

```plaintext
- TeklaStructuresModels
  - 1flant
    - attributes
    - drawings
```

The file is in the format `D0000123456.dg`. The `.dg` files are part of the model, so you can only open them using Tekla Structures.

`.dg` files contain the locations of views, details of any editing done to the drawing, and the positions of dimensions, part marks, and text. The `.dg` filename does not contain any reference to assembly, part, or multidrawing numbers.

If two users open and save the same drawing in their working models, then save their changes to the master model, one set of changes will be lost. The master model will only contain the changes of the user who most recently saved their working model to the master model. See *Saving in multi-user mode (page 63)*.

The Tekla Structures multi-user server assigns the general arrangement drawing numbers automatically. This means that each drawing gets the first
free number available. If users A and B both create a general arrangement drawing at the same time, they are automatically assigned different numbers. The same applies to multidrawing numbers.

**See also**

Guidelines for multi-user drawings (page 76)
Locks for drawings in multi-user mode (page 77)

**Guidelines for multi-user drawings**

You may find the following guidelines useful when you edit or check drawings:

<table>
<thead>
<tr>
<th>Action</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saving drawings</td>
<td>Periodically save your working model to the master model (every 5–10 drawings).</td>
</tr>
<tr>
<td>Editing drawings</td>
<td>• Assign each user a different range of drawings to edit.</td>
</tr>
<tr>
<td></td>
<td>• Lock finalized drawings.</td>
</tr>
<tr>
<td></td>
<td>• If Tekla Structures displays the message <strong>Database write conflicts detected</strong> and a drawing ID number, two or more users have opened and saved the same drawing. See Drawings in multi-user mode (page 75).</td>
</tr>
<tr>
<td>Checking drawings</td>
<td>Only check locked drawings.</td>
</tr>
<tr>
<td>Printing drawings</td>
<td>Make sure that no-one else is working with the same drawing. If you print a drawing while someone else is editing it and then save the model, the other user’s changes will be lost, even though you have not opened, modified, or saved the drawing. You can disable the print date by using the advanced option <strong>XS_DISABLE_DRAWING_PLOT_DATE</strong>.</td>
</tr>
<tr>
<td>Creating general arrangement drawings</td>
<td>Create a set of empty general arrangement drawings in the beginning of the project, and assign a certain range of these ready-created empty drawings to each user (for example, GA1 to GA10 to User A, GA11-GA20 to User B and so on). This prevents overlapping general</td>
</tr>
</tbody>
</table>

Working collaboratively within a Tekla Structures model 76 Multi-user mode
<table>
<thead>
<tr>
<th>Action</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>arrangement drawing numbers in the project.</td>
</tr>
</tbody>
</table>

**See also**

Delete unnecessary drawing files in multi-user mode (page 77)

**Locks for drawings in multi-user mode**

When you are about to open a drawing, Tekla Structures displays a notification on the status of the drawing. The options are:

- Someone is already editing it.
- Someone has already edited it (drawing has been saved to their computer, but not yet to the server).
- The drawing has already been saved and there is a newer version available on the server.

**NOTE**  
Locks for drawings are only used when a drawing is edited manually, not for example when drawings are automatically edited through cloning.

Note that to lock edited drawings, the XS_COLLECT_MODEL_HISTORY advanced option must be set to TRUE.

**Delete unnecessary drawing files in multi-user mode**

Every time you update a drawing, Tekla Structures creates a new drawing (*.dg) file in the drawings sub-folder of the model. After that, the previous drawing file is not used.

You can delete the unnecessary drawing files in multi-user mode. Use the advanced option XS_DELETE_UNNECESSARY DG FILES to have the unnecessary drawing files deleted automatically when the last user exits the model and saves the model.

By default all unnecessary drawing files are deleted automatically after seven days. Use the advanced option XS_DELETE_UNNECESSARY DG FILES SAFETY_PERIOD to define the time frame after which unnecessary drawing files are deleted.
Access rights in multi-user mode
You can use privileges to control access rights. The person who has created the model, or anyone from the same organization, can control access rights to the model using privileges. In practice the privileges of the model are controlled via the privileges.inp file.

By modifying the privileges.inp file you can control
• access to modify user-defined attributes.
• access to modify object properties. This is done by locking and unlocking objects.
• access to modify numbering settings.
• access to remove users on multi-user server.
• access to save standard files.

You can prevent your model and drawings being accidentally modified by using the Locked user-defined attribute (UDA) or drawing locks, or locks in Phase manager. Using the Locked UDA and privileges together you can even restrict some users or organizations from modifying your model.

For example, you can limit access to the model so that a checker can only change status attributes. Or you could prevent certain users from changing the user-defined attributes used for approval or manufacturing and erection status.

Change access rights in the privileges.inp file
How the privileges work:
• The privileges.inp file serves as a user interface for updating the privileges in a model.
• The privileges are loaded from the privileges.inp file and stored in the model.
• The privileges are loaded from the privileges.inp file only if the current user is allowed to do so.
• If there is no privileges.inp file or if it cannot be loaded, then the privileges that are already stored in the model (if any) are used.
• If you do not set any privileges, all users have full rights.
• Tekla Structures checks the privilege defaults in the privileges.inp file when you create a model, and each time you open a model.
• Tekla Structures searches for the file first in the current model folder, then in the folder defined for the advanced option XS_INP.
NOTE Only the person who created the model, or anyone from the same organization, can modify the privileges of the model via the privileges.inp file.

To change the access rights:
1. Close the model.
2. Open the privileges.inp file, located in ..\ProgramData\Trimble\Tekla Structures\<version>\environments\common\inp folder, in any text editor.
3. Change the desired settings and save the file.
4. Re-open the model.

Example
Below is an example of the privileges.inp file. The slash (/) or backslash (\) separates the user name from the organization (<organization>/<user>). If no user name is entered, it means anyone in the company. Each row contains three columns, separated by tabs.

If you want to give the privileges only to one user or only to some users, you first have to exclude everyone and then include the users who you want to give the privileges.

Note that the organization and the user names are case sensitive. For example, COMPANYA is not the same as companyA.

```
privileges.inp
attribute:APPROVED_BY COMPANYA/ full
attribute:APPROVED_BY COMPANYB/james full
attribute:APPROVED_BY everyone none
attribute:STATUS COMPANYB/ full
attribute:STATUS COMPANYA/ view
attribute:STATUS everyone none
```

Options in the privileges.inp file
The following commands are available in the privileges.inp file:

- access to modify any user-defined attribute (UDA) - attribute:UDA_NAME
- access to modify object properties - attribute:OBJECT_LOCKED
- access to modify numbering settings - action:PartnumbersOptions
- access to perform numbering - action:PerformNumbering
- access to remove users in multi-user model - action:AllowMultiuserKick
- access to save standard files - action:SaveStandard
• access to add watermarks to printed drawings -
  action: DrawingWatermark

When you want to give the right only to one user or some users, you have to first exclude everyone and then include the users.

<table>
<thead>
<tr>
<th>Column</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>protected user-defined attribute</td>
<td>attribute: name</td>
<td>Affects the protected user-defined attribute &quot;name&quot;. Check the exact spelling of the name in the objects.inp.</td>
</tr>
<tr>
<td>OR</td>
<td>action</td>
<td>action: name</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>user</td>
<td>everyone</td>
<td>All users</td>
</tr>
<tr>
<td></td>
<td>domain/</td>
<td>Affects all users within the network domain &quot;domain&quot;.</td>
</tr>
<tr>
<td></td>
<td>domain/nn</td>
<td>Affects the user &quot;nn&quot; in the network domain &quot;domain&quot;.</td>
</tr>
<tr>
<td></td>
<td>nn</td>
<td>Affects the user &quot;nn&quot;.</td>
</tr>
<tr>
<td>rights</td>
<td>full</td>
<td>User can change the user-defined attribute.</td>
</tr>
<tr>
<td></td>
<td>view</td>
<td>User can view the user-defined attribute, but not change it. This option appears dimmed to the user.</td>
</tr>
<tr>
<td></td>
<td>none</td>
<td>The user-defined attribute is hidden from the user.</td>
</tr>
</tbody>
</table>
**User-defined attribute Locked**
To protect objects from being accidentally modified, you can use the **Locked** user-defined attribute (UDA).

You can use it for
- parts (separately for beams, columns, etc.)
- bolts
- welds
- specific drawing types
- project properties
- phase properties

The **Locked** user-defined attribute (UDA) has three values, **Yes**, **No** and **Organization**. When set to **Yes**, the object is locked and you cannot modify its properties. You can only change the object's user-defined attributes that do not affect numbering. If you try to modify a locked object, Tekla Structures displays the following warning message:

"There are locked objects, see report. The operation could not be performed."

The **OBJECT_LOCKED** attribute in the objects.inp file defines whether the **Locked** user-defined attribute (UDA) is visible in the Tekla Structures user interface.

**NOTE** Make sure that numbering is up-to-date before you lock objects.

**Control access to lock and unlock objects in a multi-user model**
Use the **OBJECT_LOCKED** attribute in the privileges.inp file to set users' access to the user-defined attribute (UDA) **Locked** and thus prevent users from locking and unlocking objects.

**Example**
Only users **man** and **man2** have full rights to lock and unlock objects. The attribute is hidden from everybody else:

```
privileges.inp
attribute:OBJECT_LOCKED everyone none
attribute:OBJECT_LOCKED man full
attribute:OBJECT_LOCKED man2 full
```

**NOTE** To protect other user-defined attributes, you need to list them in the privileges.inp file.
Control access to numbering in a multi-user model

Use the `PartnumbersOptions` in the `privileges.inp` file to restrict users' access to the numbering properties and thus prevent unauthorized users from modifying the numbering settings.

**NOTE** Users can still run numbering even if they have no privilege to modify the numbering settings.

If a user who has no privilege to modify properties in the **Numbering Setup** dialog box tries to access the dialog box, Tekla Structures displays a warning message which states that the user does not have the required privilege.

**Example**

Only `admin` can modify the properties in the **Numbering Setup** dialog box:

```
privileges.inp
action:PartnumbersOptions everyone none
action:PartnumbersOptions ORGANIZATION\admin full
```

Control access to save standard files in a multi-user model

Use the `SaveStandard` action in the `privileges.inp` file to control users' access to save standard files.

**Example**

Only `admin` has rights to save standard files in network domain `ORGANIZATION`:

```
privileges.inp
action:SaveStandard everyone none
action:SaveStandard ORGANIZATION\admin full
```

Control access to remove users from a multi-user model

Use the `AllowMultiuserKick` action in the `privileges.inp` to restrict permissions to remove users from a multi-user model.

You can define that undesired active multi-users can be removed from the user list in the **Active multi-users** dialog box. This is useful, for example, if an application error has occurred on the user’s computer, and the locks on locked objects need to be cleared by removing the user.

Define the `AllowMultiuserKick` action in the `privileges.inp` file and give full permissions to the user who you want to be able to remove other users from the model.
Example
Only user jsmith has full permissions to remove users:

```
privileges.inp
  action:AllowMultiuserKick everyone none
  action:AllowMultiuserKick jsmith full
```

To remove a user:
1. On the File menu, click Sharing --> Active multi-users.
2. Right-click a user who you want to remove and select Clear locks.
3. Click Refresh to remove the user.
   All the locks that the user has on objects and the user are removed.

1.6 Trimble Connector
Trimble Connector enables the connection between Tekla Structures and Trimble Connect for Desktop or Trimble Connect for Web for sharing reference models.

With Trimble Connector, you can
- attach a Tekla Structures model to a Trimble Connect project and project folders
- create a new Trimble Connect project
- download a reference model from a Trimble Connect project to a Tekla Structures model
- upload a Tekla Structures reference model to a Trimble Connect project
- export Trimble Connect model objects as an .ifc reference model to a Trimble Connect project

**NOTE** You need to have a Trimble Identity before you can start using Trimble Connector.

**NOTE** Trimble Connect related metadata and all reference models are located in the ..\TeklaStructuresModels\<model>\TConnect folder. Exported reference model settings are stored to the ..\TeklaStructuresModels\<model>\Links folder. Trimble Connector does not work correctly if you manually modify the files in these folders.
Download a reference model from and upload a reference model to Trimble Connect

- To download a reference model from a Trimble Connect project to a Tekla Structures model, click **File --> Import > Trimble Connect**.
- To upload a Tekla Structures reference model to a Trimble Connect project, click **File --> Export > Trimble Connect**.

The Trimble Connect dialog box opens. Log in using your Trimble Identity, and you can start working with Trimble Connector.

Launch Trimble Connect and Trimble Connector from ribbon or Quick Launch

Instead of opening Trimble Connector through the **File** menu, you can start it from the ribbon or **Quick Launch**. You can also start Trimble Connect for Desktop and Trimble Connect for Web from these two locations.

- You can use Trimble Connect ribbon tab commands to launch Trimble Connect for Desktop, Trimble Connect for Web and Trimble Connector:

- You can also launch these applications using **Quick Launch**:

- You need to log in to Trimble Connector using your Trimble Identity.
- When you launch Trimble Connect for Web:
  - Trimble Connect for Web opens the Trimble Connect project attached to the Tekla Structures model.
  - If you have attached a project, the project activity page will be opened: https://web.connect.trimble.com/#/project/ProjectId/activity.
  - If you have not attached a project, http://connect.trimble.com/ is displayed.
- When you launch Trimble Connect for Desktop:
• Trimble Connect for Desktop opens the desktop project attached to the current Tekla Structures model.
• If you have not attached a project, Trimble Connect projects page is opened.
• If you have not installed Trimble Connect for Desktop, web page to download Trimble Connect for Desktop https://app.connect.trimble.com/tc/app#/store will be opened.

When you launch Trimble Connector:
• Trimble Connector opens, and you can attach a project if you have not done that earlier. You can also create a new project.

Link a Tekla Structures model to a Trimble Connect project

1. In Trimble Connector, click +. The Select project dialog box opens.
2. Select the project geographical location in the Trimble Connect service. A list of available projects is shown.
3. Select a project and click OK. You can also create a new project by entering the name for the project and clicking Create.
   The name of the selected project is shown on top of the dialog box. Now you can attach folders to the project.
4. Click +. The Select folders dialog box opens. The previously selected project is shown.
5. Double-click the project to see the folders inside the project.
6. Double-click the root folder to see the sub folders. A list of available folders is shown. You can select multiple folders, create new folders and delete existing folders from the list.
   If you create a new folder, enter the folder name in the box and click Create.
7. Select a folder where you want to link the model and click OK. The selected folders are shown in the Trimble Connect dialog box.
8. Double-click the folder to open it.
9. Click Export new model to Trimble Connect and specify the export details:
   - Enter a name for the model. The model name is unique for a project.
   - Select what you want to link: Filter, All, or Selected.
   - If you selected Filter, select an appropriate filter.
   - If you selected Selected, select the objects in the Tekla Structures model.
   - Specify an IFC export settings file if necessary.
     Note that if you do not define a settings file that specifies which object types you want to export, such as reinforcement, surface geometry is only exported.
   - Click OK.

Download a reference model from a Trimble Connect project to a Tekla Structures model

1. Double-click a selected folder. A list of reference models in that folder is shown.
2. A reference model that has not yet been downloaded to a Tekla Structures model has the icon. Select a reference model and click . The reference model is downloaded to a Tekla Structures model sub folder and inserted to the Tekla Structures model.
   If you want to see a list of reference model versions, click the arrow in front of the reference model name. You can select any of the previous versions of the model and insert it to the Tekla Structures model by clicking .
   When a reference model version has been inserted to the Tekla Structures model, the version gets the icon.
   If there is a reference model version that exists in the Tekla Structures model sub folder but has not been inserted to the Tekla Structures model, the version gets the icon.
   When the reference model version is the same in Tekla Structures and in Trimble Connect, the model gets the icon.
Download a reference model update from a Trimble Connect project to a Tekla Structures model

If a Trimble Connect project folder contains an update to a reference model that already has been downloaded to Tekla Structures, the reference model gets the 🔄 icon. Click the icon to download the latest version of the model.

Upload a Tekla Structures reference model to a Trimble Connect project

If a Tekla Structures model has a reference model inserted that has not been uploaded to a Trimble Connect project, the model gets the 🔄 icon. The models are listed at the bottom of the Trimble Connect dialog box. You can upload the reference model to a Trimble Connect project by clicking 🔄.

Upload a Tekla Structures reference model update to a Trimble Connect project

If a Tekla Structures model has an update to an inserted reference model, and the model has been published to a Trimble Connect project, the reference model gets the New version label. You can upload the reference model update to a Trimble Connect project by clicking 🔄.

Export Tekla Structures model objects as an .ifc reference model to a Trimble Connect project

You can create an .ifc coordination view 2.0 file from Tekla Structures model objects and export it to a Trimble Connect project. You can create the file from selected model objects, or from all model objects.

1. Click 🔄 to start the export.
   The Configure IFC export dialog box opens.
2. Enter a name for the exported model.
   The model name is unique for a project.
3. Select to export **All** or **Selected**, or select **Filter**.
   - If you selected **Selected**, select the objects.
   - If you selected **Filter**, select the filter from the list below.
4. Select the IFC export settings file.
   You can create and save IFC export settings in the Export to IFC dialog box.
   The settings file needs to be located in the model attributes folder. If you do not select a settings file, the IFC model is created of parts only, not assemblies.
   Note that if you do not define a settings file that specifies which object types you want to export, such as reinforcement, surface geometry is only exported.
5. Click **OK**.
   You can download the reference model to the Tekla Structures model. Select the reference model in Trimble Connector, and click 🌓.
   After a successful export, the model is marked with ✅.
   If the Tekla Structures model has an updated version of the exported reference model, click 🌓 to export the updated version of the reference model.
   If you do not specify a settings file, the .ifc file only includes parts and grids. The .ifc file does not include assembly information, which means that you can export only main parts. You can add additional property sets by saving a property set through File --> Export --> IFC, use the file name `ifc.xml`.

**Use base point instead of alignment offset**

If the Trimble Connect project folder name is equal than an existing base point name, or if the project folder name ends with *(existing base point name)*, then the base point is used instead of the alignment offset. If a base point is used, offsets are ignored. An example of a project folder name ending with *(existing base point name)* would be the folder name **Architectural (EK840)** where base point with the name EK840 representing the coordinate system name exists.

**ToDos**

The ☐️ **ToDo** list in Trimble Connector displays the ToDo notes added to the project. You can add ToDo notes and reply to notes of other project members. The ToDo notes are shared to all project members by default, but you can
select a user or a user group who to assign the ToDo with a due date when it needs to be resolved.

Open and view the ToDo list
1. In Trimble Connector, open a project.
   You cannot view or create ToDo notes if you do not have a project open.
2. Click the ToDo button.
3. You can:
   • Sort the list according to Author, Assignee, Due date, Status, and Priority.
   • You can use Search to search for specific ToDos.
   • You can group by Author, Status, Priority, Type, Tag, Creation date, and Last modified date.
4. To close the ToDo list, click the Close button.

Create ToDo notes
1. In Trimble Connector, click the ToDo button.
2. To create a ToDo with a view and a snapshot, select the native Tekla Structures objects.
   Select only one view. When you create a view, an IFC file of the selected native objects is created and uploaded to the project root \TeklaStructures-ToDos folder.
   The coordinate system follows what has been set in workplane handler.
   Do not create views of a lot of objects at a time, because then creating a ToDo may take a long time.
   To create a ToDo without a view and a snapshot, do not select any objects.
3. Click the Create ToDo button, and a new pane opens where you can fill in the ToDo details.
   • Fill in the Title and the Description.
     The Description information is obligatory. You cannot save a ToDo without a description.
   • To define an assignee, click Select next to Assignee and select a project member or user group from the list, or start typing the name of the user or user group to filter the user list.
     ToDos can be assigned to other users once the project has been shared.
• Select the due date from the calendar, and set the priority, type, status and completion percentage, if needed.

• To add an attachment, click **Add attachment**, and do one or both of the following:
  
  • Click **Open** and **+** to browse for a file on your computer and add the file to the selected folder, and click **OK**.

  • Click **+** to browse for a file on your computer, click **Add from my computer** and attach the file to the current **ToDo** note and click **OK**.

  • Double-clicking the attachment opens the file if Windows has association to the file name extension. Model files are not opened.

4. Click the **Save** button to save the **ToDo**.

   The saved **ToDo** is immediately synchronized to Trimble Connect. After the **ToDo** has been pushed to Trimble Connect, it receives a unique name consisting of the abbreviated project name plus a running number.

   The created **ToDo** can be seen in Trimble Connect on the **ToDo** and **Activity** tabs.

View **ToDo** notes

1. In Trimble Connector, click the **ToDo** button.

   The **ToDo** list opens.

2. Double-click the **ToDo** you want to view.

   The **ToDo** property pane opens.

   You can close the **ToDo** property pane by clicking the **Close** button.

Add comments to **ToDo** notes

Any user in the project can comment any **ToDo**.

1. In Trimble Connector, click the **ToDo** button.

   The **ToDo** list opens.

2. Double-click the **ToDo** note you want to comment.

3. In the opened property pane, add your comments to the **Comments** box.

4. Save your comments by clicking **Add comment**.

Project administrators and **ToDo** creators can also delete comments by clicking the **Delete** button next to the comment box.
Create markups in ToDo notes

You can create ToDo markups in Trimble Connector and show the markups in Tekla Structures and in Trimble Connect.

1. In Trimble Connector, select an existing project or create a new project.
2. Use the markup tools to add markups in the current model:
   - Removes all clip planes from all model views.
   - Removes all markups from the model.
   - Creates a measurement markup. In the model, pick two points and then a point to place the measurement. You can pick points, edges or faces.
   - Creates a cloud markup. In the model, pick the cloud center and a position on the cloud edge. Tekla Structures creates the cloud perpendicular to the view plane defined by the center location you picked.
   - Creates a line markup. In the model, pick the start point and the end point. The arrow is created at the start point.
   - Creates a text markup consisting of text or UDA/Report attribute and a leader line. Type the text or a prefix in the markup text box, select a UDA or Report attribute from the list, pick the leader line start point, and then pick a location for the text.

In the example below, Approved by has been entered as text and UDA: Approved by has been selected from the list of available attributes.

To add more UDA or Report attributes in the list of available attributes, or add new attributes to the Text markup attribute options list so that they would be available for selection, click the...
Maintain text markup attribute options button in the bottom-right corner. The Text markup attribute options dialog box is displayed:

Here you can:

- select the **UDA** or **Report** attributes that you want to add in the list of available attributes

- add new attributes using the options at the top. You need to select if the attribute is **UDA** or **Report**, select the attribute type (Integer, **Double** or **String**, and enter the name of the attribute. To add an assembly attribute, remember to select the **Assembly** check box. The plus (+) button adds the defined attribute in the list.

- creates a pencil or freehand markup. In the model, pick a start point, move the mouse pointer to create the shape that you want (do not hold down the left mouse button), and pick the end point. Tekla Structures creates the markup perpendicular to the view plane defined by the start point you picked.
3. In Trimble Connector, click the **ToDo** button.
4. Select the needed model objects from the Tekla Structures model.

5. Click the **Create ToDo** button, and a new pane opens where you can fill in the ToDo information. Fill in at least the title and the description, see Create ToDo notes above.

6. Ensure that the ToDo is synchronized with Trimble Connect.

### Assign existing ToDo notes

Once a project has been shared, ToDos can be assigned to other users. You can assign the ToDo only if you are the administrator of the project, or if you have created the ToDo. You can only assign ToDos created in **Trimble Connector**.

1. In Trimble Connector, click the **ToDo** button. The **ToDo** list opens.
2. Double-click the ToDo note you want to assign.
3. Click the **Edit** button.
4. In the **Assignee** box, click **Select** and select a project member or user group from the list, or start typing the name of the user or user group to filter the user list.
5. Select the due date from the calendar.
6. Set the priority, type and the status of the ToDo, if needed.
7. Click the **Save** button to save changes.

### Synchronize ToDo notes

If another project member has created or commented ToDo notes in Trimble Connector, the ToDos are automatically synchronized immediately.

Alternatively, you can click the synchronize button 🔄 to synchronize the ToDos to Trimble Connect.

### Adjust ToDo settings

1. In Trimble Connector, click the **Settings** button.
2. Select the **Double-click the ToDo view** settings to use:
   - These settings affect the snapshot view in ToDo notes.
   - **Adjusts camera and view projection**: This option is needed if you do not want the snapshot view to change because of coordinate system difference, for example, to keep the current view untouched. If you select this option, the view projection will also change if the Tekla
Structures view projection differs from the ToDo note snapshot view projection.

- **Removes and adds clip planes:** Clip planes in the Tekla Structures view are removed, and clip planes in the ToDo view are added to the Tekla Structures view. This option can only be used available if the Adjusts camera and view projection option is selected.

- **Selects objects:** This option selects the Tekla Structures native object if the corresponding object has been selected in the ToDo view. If the coordinate systems differ, it is possible to select objects and zoom to the selected objects.

3. To close the settings pane, click the Close button.

**Collaborate with Trimble Connect Desktop**

The Tekla Structures - Trimble Connect for Desktop interoperability tool allows the collaboration between Trimble Connect for Desktop and Tekla Structures in Trimble Connector. The tool allows collaboration with Trimble Connect for Desktop by sharing object selection and camera location. Prerequisite is to have Trimble Connect for Desktop installed, a valid license and Trimble Identity. For more information, see Tekla Structures - Trimble Connect Desktop interoperability.
Get started with import and export formats

Tekla Structures is highly interoperable. If you need to exchange model information with users of other software or systems, you can import and export information in many standard file formats or even establish a direct link with several other products.

- In most cases, the format used for the exchange is a general industry standard format (page 95) supported by many different tools.
- Formats may be supported for import, export or both. See Compatible formats (page 96) for a listing.
- The table of supported software (page 98) lists options you have for sharing data with many commonly used tools.
- When you are ready to exchange data, see Import to and export from Tekla Structures (page 114)
- You can install new capabilities such as new import and export formats or direct links to other software from the (page 402).
- If your organization has a capable programmer, you can even add your own customized import and export formats or direct links to other software and systems using Tekla Open API.

2.1 Industry standards

There are many industry standard file transfer formats. The principle ones supported by Tekla Structures are IFC, CIS/2, DSTV, SDNF, DGN, DXF, DWG, IGES, and STEP. Older formats are also included. For a tighter integration, you can link to Tekla Structures using the Tekla Open API technology.

The file name extension normally informs the user which format it is based upon. If you do not know what format it is, or the file does not import, then you will need to open the file in a text editor to look at the header information,
where the file type and the authoring application is usually noted. With CIS/2 files the authoring application and version number is sometimes written at the end of the file.

See also
Compatible formats (page 96)

2.2 Compatible formats
You can import and export several formats in Tekla Structures.

The following table lists many of the different formats you can use in Tekla Structures to import and export data (page 114).

For information about software connected to the formats, see Compatible software (page 98).

To find out more about the various import and export tools, see Import to and export from Tekla Structures (page 114).

To use some of the formats, you need to download an extension from Tekla Warehouse.

<table>
<thead>
<tr>
<th>Format</th>
<th>Import</th>
<th>Export</th>
</tr>
</thead>
<tbody>
<tr>
<td>aSa (.TEK)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Autodesk (.dwg)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Autodesk (.dxf)</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Bentley ISM</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>BIM Collaboration format (.bcf)</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>BTL Export (.btl)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>BVBS (.abs)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CIS/2 LPM5/LPM6 analytical (.stp,.p21,.step)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CIS/2 LPM5/LPM6 design (.stp,.p21,.step)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CIS/2 LPM6 manufacturing (.stp,.p21,.step)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>CPIxml</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DSTV (.nc,.stp,.mis)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>EJE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Elematic ELiPLAN, ELiPOS (.eli)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>EPC</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Fabsuite (.xml)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>FabTrol Kiss File (.kss)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>FabTrol MIS Xml (.xml)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Format</td>
<td>Import</td>
<td>Export</td>
</tr>
<tr>
<td>-------------------------------------------------------------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>High Level Interface File (.hli)</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>HMS (.sot)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>IBB Betsy (.fa, .f, .ev)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>IFC2x2 (.ifc)**</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IFC2x3 (.ifc)**</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IFC4 (.ifc)**</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IFCXML 2X3 (.ifcXML)**</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IFCZIP 2x3 (.ifcZIP)**</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Initial Graphics Exchange Specification (IGES) (.iges, .igs)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LandXML (.xml)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Project (.xml)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microstation (.dgn)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Oracle Primavera P6 (.xml)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plant Design Management System (.pdms)</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>SAP, Oracle, ODBC, etc.</td>
<td>X *</td>
<td>X **</td>
</tr>
<tr>
<td>SketchUp (.skp)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Staad ASCII file (.std)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Steel Detailing Neutral Format (.sdf,.sdnf,.dat)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Steel12000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>STEP AP203 (.stp,.step)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>STEP AP214 (.stp,.step)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>StruM.I.S</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tekla Collaboration file (.tczip)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tekla-FabTrol Report (.xsr)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tekla Structural Designer neutral file (.cxl)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tekla Structures shape (.tsc)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trimble Field Link .tfl</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trimble LM80 (.txt,.cnx)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TubeNC (.xml)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unitechnik (.uni,.cam)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Tekla OpenAPI used

**For a list of IFC applications certified by buildingSMART international, see Certified Software.
## 2.3 Compatible software

The following table lists Tekla Structures compatible software and the formats that you can import to and export from (page 114) Tekla Structures.

Many of the compatible interoperability applications, application links, or direct links are available on Tekla Warehouse.

For information about formats connected to the software, see Compatible formats (page 96).

For a list of IFC applications certified by buildingSMART international, see Certified Software.

To find out more about the various import and export tools, see Import to and export from Tekla Structures (page 114).

<table>
<thead>
<tr>
<th>Product</th>
<th>Company</th>
<th>Import to Tekla Structures</th>
<th>Export from Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>3D+</td>
<td>Trimble</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td></td>
</tr>
<tr>
<td>3ds Max</td>
<td>Autodesk</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td></td>
</tr>
<tr>
<td>3ds Max Design/VIZ</td>
<td>Autodesk</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td></td>
</tr>
<tr>
<td>A+ Software</td>
<td>ArmaPlus</td>
<td>BVBS (.abs), Soulé (.xml), aSa (.TEK)</td>
<td></td>
</tr>
<tr>
<td>Adapt</td>
<td>Adapt Corporation</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td>ADConX</td>
<td>ADConX</td>
<td>Direct Link</td>
<td></td>
</tr>
<tr>
<td>Advanced Steel,</td>
<td>Autodesk</td>
<td>CIS/2 LPM5 analytical (.stp, .p21, .step)</td>
<td>CIS/2 LPM5 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td>Advanced Design/</td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>Engineering</td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
</tr>
<tr>
<td>Allplan/Planbar</td>
<td>Nemetschek</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>---------</td>
<td>---------</td>
<td>----------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td>ANSYS</td>
<td>ANSYS</td>
<td>IGES (.iges, .igs)</td>
<td>IGES (.iges, .igs)</td>
</tr>
<tr>
<td>ArchiCAD</td>
<td>Graphisoft / Nemetschek</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFCXML 2X3 (.xml)</td>
<td>IFCXML 2X3 (.xml)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFCZIP (.ifczip)</td>
<td>IFCZIP (.ifczip)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Coordinated view v1</td>
<td>Coordinated view v1</td>
</tr>
<tr>
<td>ArchonCAD</td>
<td>ArchonCAD Ltd.</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>IGES (.iges, .igs)</td>
</tr>
<tr>
<td>Armaor</td>
<td>Ariadis</td>
<td></td>
<td>BVBS (.abs)</td>
</tr>
<tr>
<td>Artube</td>
<td>Adige</td>
<td></td>
<td>STEP (.stp, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>IFC (.ifc)</td>
</tr>
<tr>
<td>aSa Rebar</td>
<td>Applied Systems Associates Inc</td>
<td>aSa Rebar file (.TEK)</td>
<td>aSa Rebar file (.TEK)</td>
</tr>
<tr>
<td>ASI</td>
<td>Applied Science International LLC</td>
<td></td>
<td>Staad ASCII file (.std)</td>
</tr>
<tr>
<td>AutoCAD</td>
<td>Autodesk</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td>AutoCAD Architecture</td>
<td>Autodesk</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFCXML 2X3 (.xml)</td>
<td>IFCXML 2X3 (.xml)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFCZIP (.ifczip)</td>
<td>IFCZIP (.ifczip)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td>AutoCAD Civil 3D</td>
<td>Autodesk</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>LandXML files (.xml)</td>
<td>LandXML files (.xml)</td>
</tr>
</tbody>
</table>

Get started with import and export formats 99 Compatible software
<table>
<thead>
<tr>
<th>Product</th>
<th>Company</th>
<th>Import to Tekla Structures</th>
<th>Export from Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>AutoCAD MEP</td>
<td>Autodesk</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td></td>
</tr>
<tr>
<td>AutoPLANT</td>
<td>Bentley</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td>AutoVue</td>
<td>Oracle</td>
<td></td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td>Aveva E3D</td>
<td>AVEVA</td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf, .dat)</td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf, .dat)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>.ifc based Tekla Collaboration files (.tczip)</td>
<td>.ifc based Tekla Collaboration files (.tczip)</td>
</tr>
<tr>
<td>AviCAD</td>
<td>Progress/EBAW</td>
<td></td>
<td>Unitechnik (.cam), BVBS (.abs)</td>
</tr>
<tr>
<td>AxisVM</td>
<td>Inter-CAD Kft.</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td>BeamMaster</td>
<td>AGT</td>
<td></td>
<td>Direct Link</td>
</tr>
<tr>
<td>BeamMaster</td>
<td>AGT</td>
<td></td>
<td>Direct Link</td>
</tr>
<tr>
<td>Bentel Architecture</td>
<td>Bentley</td>
<td>Direct Link (ISM)</td>
<td>Direct Link (ISM)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td>Bentley Building</td>
<td>Bentley</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td>Electrical Systems</td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
</tbody>
</table>

Get started with import and export formats
<table>
<thead>
<tr>
<th>Product</th>
<th>Company</th>
<th>Import to Tekla Structures</th>
<th>Export from Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microstation (.dgn)</td>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td></td>
<td></td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td>Bentley Building Mechanical Systems</td>
<td>Bentley</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxr)</td>
<td>Autodesk (.dxr)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.tep, .step)</td>
<td>STEP AP214 (.tep, .step)</td>
</tr>
<tr>
<td>Bentley Inroads</td>
<td>Bentley</td>
<td>LandXML files (.xml)</td>
<td></td>
</tr>
<tr>
<td>Bentley Structural</td>
<td>Bentley</td>
<td>Direct Link (ISM)</td>
<td>Direct Link (ISM)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxr)</td>
<td>Autodesk (.dxr)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 design (.tep, .p21, .step)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td>STEP AP214 (.tep, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.tep, .step)</td>
<td>STEP AP214 (.tep, .step)</td>
</tr>
<tr>
<td>Betsy</td>
<td>IBB – Consultants &amp; Engineers</td>
<td>Betsy .fa, Betsy .f, Betsy .ev</td>
<td></td>
</tr>
<tr>
<td>BIM Collaboration Format</td>
<td>BuildingSMART</td>
<td>BCF 1.0 (.bcf)</td>
<td>BCF 1.0 (.bcf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>BCF 2.0 (.bcf)</td>
<td>BCF 2.0 (.bcf)</td>
</tr>
<tr>
<td>Cadmatic</td>
<td>Cadmatic</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxr)</td>
<td>Autodesk (.dxr)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>CADmep+</td>
<td>MAP Software / Autodesk</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxr)</td>
<td>Autodesk (.dxr)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------</td>
<td>----------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFCXML 2X3 (.xml)</td>
<td>IFCXML 2X3 (.xml)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFCZip (.ifczip)</td>
<td>IFCZip (.ifczip)</td>
</tr>
<tr>
<td>CADPipe</td>
<td>AEC Design Group</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CADWorx Plant</td>
<td>CADWorx Plant</td>
</tr>
<tr>
<td></td>
<td>Intergraph / Hexagon</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 design (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 design (.stp, .p21, .step)</td>
</tr>
<tr>
<td>CAESAR II</td>
<td>Intergraph / Hexagon</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td>CATIA</td>
<td>Dassault</td>
<td>Autodesk (.dwg)</td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td>Concrete Pro</td>
<td>LAP Laser GmbH</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Unitechnik (.cam)</td>
<td>ASCII</td>
</tr>
<tr>
<td>Corobs</td>
<td>Müller Opladen</td>
<td></td>
<td>TubeNC (.xml)</td>
</tr>
<tr>
<td>CYPECAD</td>
<td>Cype</td>
<td>Direct Link</td>
<td></td>
</tr>
<tr>
<td>Daystar Software</td>
<td>Daystar Software Inc.</td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
</tr>
<tr>
<td>DDS-CAD</td>
<td>DDS</td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>Diamonds</td>
<td>Buildsoft</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td>Digital Project</td>
<td>Gehry Technologies</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
</tbody>
</table>

Get started with import and export formats
<table>
<thead>
<tr>
<th>Product</th>
<th>Company</th>
<th>Import to Tekla Structures</th>
<th>Export from Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>DuctDesigner 3D</td>
<td>QuickPen / Trimble</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>ebos</td>
<td>Progress/EBAWE</td>
<td></td>
<td>Unitechnik (.cam)</td>
</tr>
<tr>
<td>elcoCAD</td>
<td>Hannappel SOFTWARE GmbH</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td>ELiPLAN</td>
<td>Elematic</td>
<td>ELiPLAN (.eli)</td>
<td>ELiPLAN (.eli)</td>
</tr>
<tr>
<td>ELiPOS</td>
<td>Elematic</td>
<td></td>
<td>ELiPLAN (.eli)</td>
</tr>
<tr>
<td>EliteCAD</td>
<td>Messerli Informatik</td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td>ETABS</td>
<td>Computers &amp; Structures, Inc.</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP214 (.stp, .step)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td>FabPro Pipe</td>
<td>UHP Process Piping Inc.</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td>Fabsuite</td>
<td>Fabsuite</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td></td>
<td></td>
<td>KISS (.kss)</td>
<td>KISS (.kss)</td>
</tr>
<tr>
<td>FabTrol MRP</td>
<td>FabTrol</td>
<td>FabTrol MIS XML (.xml)</td>
<td>FabTrol MIS XML (.xml)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FabTrol KISS File (.kss)</td>
<td>FabTrol KISS File (.kss)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tekla-FabTrol Report (.xsr)</td>
<td>Tekla-FabTrol Report (.xsr)</td>
</tr>
<tr>
<td>FactoryCAD</td>
<td>Siemens</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
</tbody>
</table>

Get started with import and export formats

Compatible software
<table>
<thead>
<tr>
<th>Product</th>
<th>Company</th>
<th>Import to Tekla Structures</th>
<th>Export from Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>FelixCAD</td>
<td>SofTec</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dwf)</td>
</tr>
<tr>
<td>FEM Design</td>
<td>StruSoft</td>
<td><strong>Direct Link</strong></td>
<td><strong>Direct Link</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>Floor Pro</td>
<td>Adapt Corpo</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td>ration</td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dwf)</td>
</tr>
<tr>
<td>FormZ</td>
<td>AutoDesSys, Inc.</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp)</td>
<td></td>
</tr>
<tr>
<td>FXTube</td>
<td>Mazak</td>
<td></td>
<td>STEP (.stp, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>IFC (.ifc)</td>
</tr>
<tr>
<td>GSA</td>
<td>Oasys</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td>GT Strudl</td>
<td>GT Strudl</td>
<td><strong>Direct Link</strong></td>
<td><strong>Direct Link</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td></td>
</tr>
<tr>
<td>HMS</td>
<td>HMS</td>
<td></td>
<td>HMS (.sot)</td>
</tr>
<tr>
<td>HOOPS</td>
<td>Tech Soft 3D</td>
<td></td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td>Inventor</td>
<td>Autodesk</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>STEP AP203/AP214 (.stp, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp)</td>
<td></td>
</tr>
<tr>
<td>IronCAD</td>
<td>IronCAD</td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
</tbody>
</table>

Get started with import and export formats
<table>
<thead>
<tr>
<th>Product</th>
<th>Company</th>
<th>Import to Tekla Structures</th>
<th>Export from Tekla Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>iTWO</td>
<td>RIB Software AG</td>
<td></td>
<td>CPIxml (.xml)</td>
</tr>
<tr>
<td>Joints For Tekla</td>
<td>Progetto Archimede</td>
<td></td>
<td>Direct Link</td>
</tr>
<tr>
<td>KeyCreator</td>
<td>Kubotek</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td>Lantek</td>
<td>Lantek</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td>LEIT2000</td>
<td>SAA</td>
<td></td>
<td>Unitechnik (.cam)</td>
</tr>
<tr>
<td>LP-System</td>
<td>Lennerts &amp; Partner</td>
<td></td>
<td>BVBS (.abs)</td>
</tr>
<tr>
<td>MagiCAD</td>
<td>Progman</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>MasterFrame</td>
<td>MasterSeri es</td>
<td>DSTV96 (.nc, .stp, .mis)</td>
<td>DSTV96 (.nc, .stp, .mis)</td>
</tr>
<tr>
<td>Maxon Cinema 4D</td>
<td>Nemetschek</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td>Maya</td>
<td>Autodesk</td>
<td>Autodesk (.dx)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>Autodesk Maya</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Autodesk (.dx)</td>
</tr>
<tr>
<td>Meridian Prolog</td>
<td>Trimble</td>
<td>Direct Link</td>
<td></td>
</tr>
<tr>
<td>Mesh Welding</td>
<td>EVG (Filzmoser)</td>
<td></td>
<td>Unitechnik (.cam), BVBS (.abs)</td>
</tr>
<tr>
<td>Mesh Welding</td>
<td>A.W.M.</td>
<td></td>
<td>Unitechnik (.cam)</td>
</tr>
<tr>
<td>Mesh Welding</td>
<td>Progress / EBAWE</td>
<td></td>
<td>Unitechnik (.cam)</td>
</tr>
<tr>
<td>Microsoft Office Project</td>
<td>Microsoft</td>
<td>Project (.xml)</td>
<td>Project (.xml)</td>
</tr>
<tr>
<td>Microstran</td>
<td>Engineering Systems Pty Limited</td>
<td>Autodesk (.dx)</td>
<td>Autodesk (.dx)</td>
</tr>
<tr>
<td>Microstation</td>
<td>Bentley</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dx)</td>
<td>Autodesk (.dx)</td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------</td>
<td>----------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>IGES (.iges, .igs)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td>Midas Gen</td>
<td>MIDAS</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td>ModeSt</td>
<td>Tecnisoft</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td>Multiframe</td>
<td>Daystar Software Inc.</td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
</tr>
<tr>
<td>Nastran</td>
<td>MSC Software Corporation</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>IGES (.iges, .igs)</td>
</tr>
<tr>
<td>NavisWorks</td>
<td>Autodesk</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td>NiSA</td>
<td>Cranes Software International Ltd. / CSC</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td>NX (Unigraph)</td>
<td>Siemens</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>IGES (.iges, .igs)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td>PDMS</td>
<td>AVEVA</td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf, .dat)</td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf, .dat)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tekla Collaboration files (.tczip)</td>
<td>Tekla Collaboration files (.tczip)</td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------</td>
<td>----------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>PDS</td>
<td>Intergraph / Hexagon</td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.dat)</td>
<td>Steel Detailing Neutral Format (.dat)</td>
</tr>
<tr>
<td>PEMA WeldControl</td>
<td>Pemamek</td>
<td></td>
<td>Direct Link</td>
</tr>
<tr>
<td>PipeCAD</td>
<td>Mc4 Software</td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td>PipeDesigner 3D</td>
<td>QuickPen / Trimble</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>Pipelabo</td>
<td>Maruhide</td>
<td></td>
<td>Direct Link</td>
</tr>
<tr>
<td>Plancal</td>
<td>Plancal Ag / Trimble</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td>Plant-4D</td>
<td>CEA Technology</td>
<td></td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td>PowerConnect</td>
<td>Buildsoft</td>
<td>Work in progress</td>
<td>Work in progress</td>
</tr>
<tr>
<td>PowerFrame</td>
<td>Buildsoft</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td>PRIAMOS</td>
<td>GTSdata</td>
<td></td>
<td>CPIxml (.xml), Unitechnik (.cam)</td>
</tr>
<tr>
<td>Primavera</td>
<td>Oracle</td>
<td>P6 (.xml)</td>
<td>P6 (.xml)</td>
</tr>
<tr>
<td>ProCAM</td>
<td>HGG</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td>ProStructures</td>
<td>Bentley</td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf) ISO</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf) ISO</td>
</tr>
<tr>
<td>Pro/Engineer</td>
<td>PTC</td>
<td>IGES (.iges, .igs)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td></td>
</tr>
<tr>
<td>ProFit</td>
<td>Progress/EBAWE</td>
<td></td>
<td>BVBS (.abs)</td>
</tr>
<tr>
<td>Pro-Fit</td>
<td>Zeman</td>
<td></td>
<td>Direct Link</td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------</td>
<td>----------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>Prokon</td>
<td>Prokon</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td>PythonX</td>
<td>Lincoln Electric</td>
<td></td>
<td>DSTV</td>
</tr>
<tr>
<td>Qnect</td>
<td>Qnect</td>
<td></td>
<td>Direct Link</td>
</tr>
<tr>
<td>RAM (CAD Studio)</td>
<td>Bentley</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 design (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 design (.stp, .p21, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ISM</td>
<td>ISM</td>
</tr>
<tr>
<td>Raptor</td>
<td>Peddinghaus</td>
<td></td>
<td>Direct Link</td>
</tr>
<tr>
<td>Revit Architecture/M EP</td>
<td>Autodesk</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td>Revit Structure</td>
<td>Autodesk</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 design (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 design (.stp, .p21, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tekla Collaboration files (.tczip)</td>
<td>Tekla Collaboration files (.tczip)</td>
</tr>
<tr>
<td>RFEM</td>
<td>Dlubal</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>Rhinoceros</td>
<td>McNeel North America</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------</td>
<td>----------------------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td>Geometry Gym link</td>
</tr>
<tr>
<td>RinasWeld</td>
<td>Kranendonk</td>
<td>Direct Link (US market)</td>
<td>Direct Link (US market)</td>
</tr>
<tr>
<td>RISA 3D (Suite)</td>
<td>Risa Technology</td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 design (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 design (.stp, .p21, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdf, .sdnf)</td>
<td></td>
</tr>
<tr>
<td>RisaConnecti on</td>
<td>Risa Technology</td>
<td>Direct Link (US, UK, Germany, Sweden, Norway, China, India, Australasia)</td>
<td>Direct Link (US, UK, Germany, Sweden, Norway, China, India, Australasia)</td>
</tr>
<tr>
<td>Robot Millenium</td>
<td>Autodesk</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 design (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 design (.stp, .p21, .step)</td>
</tr>
<tr>
<td>RSTAB</td>
<td>Dlubal</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>SACS</td>
<td>Engineering Dynamics Inc.</td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steel Detailing Neutral Format (.sdnf)</td>
<td>Steel Detailing Neutral Format (.sdnf)</td>
</tr>
<tr>
<td>SAFE</td>
<td>Computers &amp; Structures, Inc.</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td></td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>----------</td>
<td>----------------------------------</td>
<td>-----------------------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>SAM</td>
<td>Bestech Limited</td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td>SAP2000</td>
<td>Computers &amp; Structures, Inc.</td>
<td><strong>Direct Link</strong></td>
<td><strong>Direct Link</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td>Schnell Software</td>
<td>Schnell Software</td>
<td></td>
<td>BVBS (.abs), Unitechnik (rebar/ mesh)</td>
</tr>
<tr>
<td>SCIA</td>
<td>Nemetschek</td>
<td><strong>Direct Link</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>.ifc</td>
<td>.ifc</td>
</tr>
<tr>
<td>SDS/2</td>
<td>Design Data</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 design (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 design (.stp, .p21, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td>S-FRAME</td>
<td>S-FRAME Software Inc.</td>
<td><strong>Direct Link</strong></td>
<td><strong>Direct Link</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td>Sicam</td>
<td>Controlled Automation</td>
<td></td>
<td><strong>Direct Link</strong></td>
</tr>
<tr>
<td>SketchUp Make</td>
<td>Trimble</td>
<td>SketchUp (.skp)</td>
<td>SketchUp (.skp)</td>
</tr>
<tr>
<td>SketchUp Pro</td>
<td>Trimble</td>
<td>SketchUp (.skp)</td>
<td>SketchUp (.skp)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td>Import to Tekla Structures</td>
<td>Export from Tekla Structures</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------</td>
<td>--------------------------------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>Smart 3D (SmartPlant / SmartMarine)</td>
<td>Intergraph / Hexagon</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 design (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 design (.stp, .p21, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc), with SmartPlant 3D</td>
<td></td>
</tr>
<tr>
<td>Solibri Model Checker/Model Viewer</td>
<td>Solibri</td>
<td></td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>SolidEdge</td>
<td>Siemens</td>
<td>Autodesk (.dx)</td>
<td>Autodesk (.dx)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td></td>
</tr>
<tr>
<td>SolidWorks</td>
<td>Dassault</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dx)</td>
<td>Autodesk (.dx)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>IGES (.iges, .igs)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td>Soulé</td>
<td>Soulé Software Inc.</td>
<td>.xml, BVBS (.abs)</td>
<td></td>
</tr>
<tr>
<td>SPACE GASS</td>
<td>SPACE GASS</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td>SpaceClaim</td>
<td>SpaceClaim Co.</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dx)</td>
<td>Autodesk (.dx)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td></td>
</tr>
<tr>
<td>STAAD.Pro</td>
<td>Bentley</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dx)</td>
<td>Autodesk (.dx)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
<td>CIS/2 LPM6 analytical (.stp, .p21, .step)</td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td><strong>Import to Tekla Structures</strong></td>
<td><strong>Export from Tekla Structures</strong></td>
</tr>
<tr>
<td>----------------</td>
<td>--------------------------------</td>
<td>--------------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>Steel Projects PLM</td>
<td>Steel Projects</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td>Steel Smart System</td>
<td>Applied Science International, LLC</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td>StructureWorks</td>
<td>Structure Works LLC.</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td>STRUDS</td>
<td>SoftTech</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td>StruM.I.S</td>
<td>StruM.I.S</td>
<td>Direct Link (.bswx)</td>
<td>Direct Link (.bswx)</td>
</tr>
<tr>
<td>Tekla Field3D</td>
<td>Trimble</td>
<td>Direct Link (.ifc)</td>
<td>Direct Link (.ifc)</td>
</tr>
<tr>
<td>Tekla Civil</td>
<td>Trimble</td>
<td>Direct Link (.xml)</td>
<td>Direct Link (.xml)</td>
</tr>
<tr>
<td>Tekla Collaboration</td>
<td>Trimble</td>
<td>Direct Link (.tczip)</td>
<td>Direct Link (.tczip)</td>
</tr>
<tr>
<td>Tekla Structural Designer</td>
<td>Trimble</td>
<td>Neutral XML file (.cxl)</td>
<td>Neutral XML file (.cxl)</td>
</tr>
<tr>
<td>Trimble Business Centre</td>
<td>Trimble</td>
<td>LandXML files (.xml)</td>
<td>LandXML files (.xml)</td>
</tr>
<tr>
<td>Trimble Connect</td>
<td>Trimble</td>
<td>Direct Link (.ifc)</td>
<td>Direct Link (.ifc)</td>
</tr>
<tr>
<td>Trimble Field Link</td>
<td>Trimble</td>
<td>.tfl</td>
<td>.tfl</td>
</tr>
<tr>
<td>Trimble LM80 Desktop</td>
<td>Trimble</td>
<td>Autodesk (.dwg) (.dxf)</td>
<td>Autodesk (.dwg) (.dxf)</td>
</tr>
<tr>
<td>TurboCAD</td>
<td>IMSI Design</td>
<td>Autodesk (.dwg) (.dxf)</td>
<td>Autodesk (.dwg) (.dxf)</td>
</tr>
<tr>
<td>Product</td>
<td>Company</td>
<td><strong>Import to Tekla Structures</strong></td>
<td><strong>Export from Tekla Structures</strong></td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------</td>
<td>-------------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>UniCAM</td>
<td>Unitechnik</td>
<td>Microstation (.dgn)</td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STEP AP203/AP214 (.stp, .step)</td>
<td>STEP AP214 (.stp, .step)</td>
</tr>
<tr>
<td>UniCAM</td>
<td>Unitechnik</td>
<td>Unitechnik (.cam, .uni)</td>
<td></td>
</tr>
<tr>
<td>Unigraphics</td>
<td>Siemens PLM Software</td>
<td>IGES (.iges, .igs)</td>
<td></td>
</tr>
<tr>
<td>Vacam</td>
<td>Voortman</td>
<td>Direct Link</td>
<td></td>
</tr>
<tr>
<td>Vernon</td>
<td>Lincoln Electric</td>
<td>TubeNC (.xml)</td>
<td></td>
</tr>
<tr>
<td>VectorWorks</td>
<td>Nemetschek</td>
<td>IFC2X3 (.ifc)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IGES (.iges, .igs)</td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td>Vico Office</td>
<td>Trimble</td>
<td>Direct Link</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>IFC2X3 (.ifc)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>IfcXML 2X3 (.xml)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>IfcXML 2X3 (.xml)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Microstation (.dgn)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>.xls</td>
</tr>
<tr>
<td>Vico Schedule Planner</td>
<td>Trimble</td>
<td>Direct Link</td>
<td>Direct Link</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>.xml</td>
</tr>
<tr>
<td>Volo View</td>
<td>Autodesk</td>
<td>Autodesk (.dwg)</td>
<td>Autodesk (.dwg)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Autodesk (.dxf)</td>
<td>Autodesk (.dxf)</td>
</tr>
</tbody>
</table>

Get started with import and export formats 113 Compatible software
Tekla Structures has several tools you can use to import and export physical and reference models and the information they contain.

For details about compatible software in import and export, see Compatible software (page 98).

**NOTE** The import and export functionality is not available in all Tekla Structures configurations. For more information, see Tekla Structures configurations.

You can use import and export in Tekla Structures for several purposes:

- You can import reference models to Tekla Structures. For example, you can import an architectural model, a plant design model, or a heating, ventilating and air-conditioning (HVAC) model as a reference model. Reference models can also be simple 2D drawings that are imported and then used as a layout to directly build the model on.

- You can import 2D or 3D models created by other software, then detail or manipulate the structural objects using Tekla Structures. Once the model is complete, you can export it, and return it to the architect or engineer for review.

- You can create reports from the imported models from most of the formats.

- You can export Tekla Structures models for use in Analysis & Design (several formats). Then you can import the Analysis & Design results back to the Tekla Structures model.

- Various model transfers can be completed for the engineering and contractor phase of the project.

- You can import shapes from many formats. Shapes are used in defining items.
You can export data for use in manufacturing information systems and in the fabrication phase:

- You can export CNC data (Computer Numerical Control) for use by automated cutting, drilling and welding CNC machinery.
- You can export to MIS (Manufacturing Information Systems) so that fabricators can track project progress, for example.

Click the links below to find out more about the various types of import and export:

- Reference models and compatible formats (page 119)
- IFC (page 149)
- DWG and DXF (page 186)
- DGN (page 218)
- LandXML (page 222)
- PDF (page 223)
- SketchUp (page 224)
- Point clouds (page 225)
- NC files (page 272)
- FEM (page 265)
- ASCII files (page 315)
- CIS and CIMSteel models (page 307)
- MIS lists (page 306)
- FabTrol XML files (page 314)
- PDMS/E3D (page 315)
- HMS (page 395)
- ELiPLAN (page 384)
- BVBS (page 376)
- Unitechnik (page 319)
- Analysis and design systems (page 254)
- CAD (page 400)
- Layout manager (page 235)
- Trimble Connector (page 83)

In addition to these built-in import and export tools, you have a variety of links to other applications available in Tekla Warehouse that you can download.
3.1 Conversion files

Conversion files (.cnv) map Tekla Structures profile, twin profile, and material names with names used in other software.

Conversion files are simple text files, containing the Tekla Structures name in the first column, and the name used in the other software package in the second column. Columns are separated by a space. All parametric profiles must be entered in the profile conversion file.

You can use the same conversion file both when importing and exporting models, and you can specify the location of conversion files in most of the import and export tools.

If you enter a conversion file name without a path, Tekla Structures searches for the file in the current model folder. If you leave the box empty, Tekla Structures searches for the file indicated by the advanced option XS_PROFDB in File menu --> Settings --> Advanced options --> File Locations. This is also the case, if the tool does not allow you to define the path and conversion file.

Tekla Structures has several conversion files in the standard installation, and you can also create your own. Standard conversion files are located in the profil folder under the environment folder ..\ProgramData\Trimble\Tekla Structures\<version>\environments\ folder. The exact location may vary depending on your environment. All conversion files have the .cnv extension.

Create conversion files

You can create your own conversion files if the ones that come with Tekla Structures installation do not suit your needs.
1. Open an existing conversion file using any standard text editor. By default, conversion files are located in the \profil folder under the environment folder...\ProgramData\Trimble\Tekla Structures <version>\environments\. The exact location may vary depending on your environment.

2. Save the file with another name. If the export/import tool allows you to define the path to the conversion file, you can save the file where you like. If this is not the case, save the file in a location defined by the advanced option XS_PROFDB in File menu --> Settings --> Advanced options --> File Locations.

3. Modify the file: enter profile names recognized by Tekla Structures in the first column, and the corresponding name recognized by the other software in the second column. While modifying, ensure that:
   • You do not have blank material definitions (" ", empty quotation marks).
   • You do not have spaces in the profile position strings. For example, enter "Hand_Rail" not Hand Rail".

4. Save your changes.

**NOTE** • All the three files (profile, twin profile and material) are not needed if the differences in the profile name is just concerning * X or x formats, because these are normally handled automatically. For example, if you wanted to import UC254x254x73 to be UC254*254*73, the lower case "x" is automatically changed to "X" so the format of the conversion file would be UC254*254*73 254X254X73.
   • If you have problems importing the model, check any error messages in the Tekla Structures log file, and check the conversion files.

**Example**
Below are some examples of conversion files:

**SDNF**

! Profile name conversion Tekla Structures --> SDNF

! If Converted-name does not exist, it will be the same
! as Tekla Structures-name.

! Tekla Structures-name Converted-name
C10X15.3  C10X15.3
C10X20  C10X20
C10X25  C10X25
C10X30  C10X30
C12X20.7  C12X20.7
C12X25  C12X25
C12X30  C12X30
C15X33.9  C15X33.9
C15X40  C15X40
C15X50  C15X50
C3X4.1  3X4.1

**DSTV**

! Profile name conversion Tekla Structures -> DSTV

! If Converted-name does not exist, it will be the same
! as Tekla Structures-name.

! Tekla Structures-name Converted-name

C10X15.3  C10X15.3
C10X20  C10X20
C10X25  C10X25
C10X30  C10X30
C12X20.7  C12X20.7
C12X25  C12X25

Below there is first an example of an incorrect conversion file and then of a correct one, errors are highlighted:

```
00100782 4 0 2 "brace" "Tread 4" 1 "TREAD4.5" "" 0.000000 0 0
0.000000 1.000000 0.000000 16.250000 13.154267 3.857143
15.500000 13.154267 3.857143 0.000000 0.000000 0.000000
0.000000 0.000000 0.000000 0.000000 0.000000 0.000000
0.000000 0 0 0 0 0 0 0 0 0
```

```
00100782 4 0 2 "brace" "Tread_4" 1 "TREAD4.5" "A36" 0.000000
0 0 0.000000 1.000000 0.000000 16.250000 13.154267 3.857143
15.500000 13.154267 3.857143 0.000000 0.000000 0.000000
```

Import to and export from Tekla Structures  Conversion files
Twin profile conversion files

Tekla Structures contains separate conversion files for twin profiles, and it reads the twin profile conversion file before the profile conversion file, so you must include the profiles from the original model in the import.

The twin profile conversion file is a text file containing the profile prefix (characters only) and the distance between the profiles in mm, separated by a space. Tekla Structures converts all profiles with the specified prefix to twin profiles.

The twin profile conversion file could be named twin_profiles.cnv and it could contain lines such as the one below:

DL 20

The distance between the profiles is the same for all profiles with the same profile prefix. For example, profiles with the prefix DL will always have the same spacing. If you want different spacing values, then you need to use a different profile prefix.

You also need to add the twin profile to the profile conversion file to get the DL profile converted to L-profile:

L200*20 DL200/20-20

Limitations

- Twin profile conversion cannot be used for profiles that start with a number. This means that you cannot define double angles as 2L. Instead, you need to use DL as the prefix for a twin profile, for example: DL200/20-20.

- Twin profile conversion does not work for FEM import. We recommend that each angle is modeled separately rather than as twin profiles, as SP3D does not control the gaps between members in the same way as Tekla Structures and there are, for example, various conversion and mapping difficulties. It is easier to convert members that are modeled as two members.

3.2 Reference models and compatible formats

A reference model is a file that helps you to build a Tekla Structures model. A reference model may be created in Tekla Structures or another software or modeling tool and then inserted to Tekla Structures.
For example, an architectural model, a plant design model, or a heating, ventilating and air-conditioning (HVAC) model can be used as a reference model. Reference models can also be simple 2D drawings that are inserted and then used as a layout to directly build the model on. You can snap to reference model geometry.

Reference models of different formats, such as IFC, IFC4, IFCzip, IFCxml, tcZIP, 3DD, DXF, DWG, DGN, XML, LandXML, STP, IGS, SKP and PDF, are converted by the TrimBimConverter to TrimBIM (.trb) at reference model insert. The .trb file is saved in the current model folder. The reference cache is created in the cache folder based on the advanced option XS_REFERENCE_CACHE when the reference model is set visible, which happens automatically at insert and update.

The following file types are supported:

- AutoCAD files .dxf
- AutoCAD files .dwg (supported version ACAD2018 and earlier)
- IFC files .ifc, .ifczip, .ifcxml
- IGES files .igs, .iges
- LandXML files .xml
- MicroStation files .dgn, .prp
- PDF files .pdf
- Tekla Collaboration files .tczip
- SketchUp files .skp (supported version SketchUp 2018 and earlier)
- STEP files .stp, .STEP

Some reference models are automatically subdivided or split into reference model objects.

**TIP** You can disable the roll-over highlight, which can speed up zooming.

**Reference model plug-ins in Tekla Warehouse**

Reference model plug-ins are available as .tsep plug-ins in Tekla Warehouse. Tekla Structures installation contains the plug-ins, but you can get newer ones from Tekla Warehouse, and then import it to the Applications & components catalog.

For more information about .tsep packages, see Import a .tsep extension to the Applications & components catalog.

**Reference models in drawings**

You can show reference models in drawings and adjust their visibility settings: Reference models in drawings.
See also
Insert a reference model (page 121)
Modify reference model details (page 127)
Lock reference models (page 128)
View reference models (page 123)
Detect changes between reference model versions (page 129)
Define a comparison set for reference model change detection (page 134)
Export change detection results to Excel (page 139)
Reference model objects (page 143)
Inquire reference model contents (page 142)
Examine reference model hierarchy and modify reference model objects (page 144)

Insert a reference model
You can insert reference models in a Tekla Structures model. You can use the reference models to overlay different discipline models with your own model. These disciplines can be architect, plant engineer, services engineer or other structural disciplines.

1. Open a Tekla Structures model where you want to insert the reference model.

2. Open the Reference Models list by clicking the Reference Models button in the side pane.

3. In the Reference Models list, click the Add model button.

4. In the Add model dialog box, if you have any previously created reference model properties files, load the desired file by selecting the file from the properties file list at the top.

5. In the Add model dialog box, browse for the reference model file by clicking Browse....

You can also drag reference models from Windows Explorer, and insert several models at a time.

For a list of compatible formats, see Reference models and compatible formats (page 119).

6. Select a group for the model or enter the name of a new group.

If you do not enter a name for the group, the reference model is inserted in the Default group.

You can also drag models to an existing group or create a new group later on.
7. In **Location by**, select one of the following options:

   **Model origin** inserts the model relative to 0,0,0.

   **Work plane** inserts the model relative to the current work plane coordinate system.

   **Base point**:<name of base point> inserts the model relative to the base point by using coordinate system values **East coordinate**, **North coordinate**, **Elevation**, and **Angle to North** from the base point definition in **Project properties**.

8. Select where you want to place the reference model. You can enter coordinates in the **Offset** boxes or pick a position for the reference model origin.

   The maximum number of decimals for coordinates is 13.

9. Set the **Scale** of the reference model if it is different from the one in the Tekla Structures model.

   Note that you need to set the scale for a DWG or a DXF file already in AutoCAD. When you define the measurement unit for a DWG or a DXF file and save the file in AutoCAD, the unit is recognized in Tekla Structures, and the reference model is scaled correctly.

   The maximum number of decimals for scale is 13.

10. You can rotate the model around model Z axis by picking a location in the model or entering the desired value in the **Rotation** box.

    The maximum number of decimals for the rotation value is 7.

11. Click **More** to show more details and add the **Code**, **Title**, **Phase** and **Description** of the reference model.

    By default, the title is the same as the name of the inserted reference model. You may want to use the name of the discipline or the company instead, for example. The code could be a site number, project number, or accounting number. Write the description according to the company conventions. The phase is the design phase of the reference model (not the phase in the Tekla Structures model).

    Below is an example of these details when you inquire the reference model.

    ```
    Group : Basement
    Code : 123456
    ref_description : Basement
    Title : First phase
    RevisionPhase : 1a
    ```

    You can also modify all the details after you have inserted the model.

12. Click **Add model**.

13. If the inserted reference model lies outside the work area and is not fully or at all visible in the model view, Tekla Structures displays a warning
message. Click **Expand** to extend the work area to see the reference model in the model view.

The reference model is inserted in the current phase of the Tekla Structures model.

Note that for IFC reference models the elevation offset value is not read from the inserted reference model.

When a reference model is inserted or updated, reference model data is copied to Tekla Structures model internal data storage located in the `<current model>/datastorage/ref` folder. The reference model is visible even if the original file is removed from its original location. The reference model data in this folder should not be touched.

**NOTE** Do not insert the same reference model to the Tekla Structures model several times. If there are duplicate reference models, there are also duplicate GUIDs.

When you want to update the reference model, do not delete the old reference model from an open Tekla Structures model and replace it with a new one, because then you would lose the work done on reference objects in the old model. Use the change detection functionality instead.

**TIP** To only clip reference models and point clouds with the clip plane tool, set the advanced option `XS_DO_NOT_CLIP_NATIVE_OBJECTS_WITH_CLIP_PLANE` to `TRUE`. If you do this, the native objects are not clipped.

See also

*Modify reference model details (page 127)*

**View reference models**

There are many ways you can select what you want to show about the reference models and how.

For details about inserting reference models, see *Insert a reference model (page 121)*.

<table>
<thead>
<tr>
<th>To:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open the <strong>Reference Models</strong> list</td>
<td>• Click the <strong>Reference Models</strong> button in the side pane on the right side of the Tekla Structures main window.</td>
</tr>
<tr>
<td>Hide and show reference models</td>
<td>• Click the eye button next to the model you want to hide.</td>
</tr>
</tbody>
</table>

Import to and export from Tekla Structures 123 Reference models and compatible formats
<table>
<thead>
<tr>
<th>To:</th>
<th>Do this:</th>
</tr>
</thead>
</table>
| The button changes to [ ] and the reference model is hidden in the 3D view.  
  • Click the eye button again to show the model. |  
| Hide and show a group of reference models |  
  • Click the eye button [ ] next to the group you want to hide. The group eye button and the reference model eye buttons all change to [ ], and all the reference models included in the group are hidden in the Tekla Structures model.  
  • Click the eye button again to show all the models in the group.  
  • If a group contains both hidden and visible models, the eye button for the group looks like this [ ].  
  • If there are no reference models in a group, the eye button looks like this [ ]. |
| Highlight the reference model in the 3D view |  
  • Click the reference model in the Reference Models list. |
| Show reference model details |  
  • Double-click the reference model in the Reference Models list. |
| Show reference model object details |  
  1. Double-click the reference model in the Reference Models list.  
  2. Ensure that the Select assemblies selection switch (for assemblies) or Select objects in assemblies selection switch (for parts) is active.  
  3. Point the reference model in the model view, hold down Shift and scroll to the hierarchy level where the desired reference model object is located.  
  4. Point the object and double-click it to open the reference model object details. |
| Rotate the reference model around model Z axis. |  
  • In the reference model details, enter the desired value in the Rotation box. You can also pick the rotation. |
<table>
<thead>
<tr>
<th><strong>To:</strong></th>
<th><strong>Do this:</strong></th>
</tr>
</thead>
</table>
| Hide and show reference model layers | 1. Double-click the reference model in the Reference Models list to open the details.  
2. Click the small arrow on the Layers row to show the list of layers.  
3. You can show and hide individual layers or all layers:  
   • To hide all layers, click the eye button on the Layers row.  
   • To hide individual layers, click the eye buttons of the individual layers.  
   • To hide several layers, holding down Ctrl, click the desired layers and then click the eye button of one of the selected layers.  
   • If the Layers list contains both hidden and visible layers, the eye button for the Layers row looks like this.  
   • If you hide all layers, the eye button for the Layers row changes to .  
   • If you hide individual layers, the eye button for the hidden layers changes to . |
| Detect changes between different versions of reference models | For details about change detection, see Detect changes between reference model versions (page 129).  
For details about comparison sets, see Define a comparison set for reference model change detection (page 134). |
| Refresh all reference models | • If the file name or path has not changed, open the Reference Models list and click the Refresh button.  
All models that are not up to date are reloaded. If a reference model is not found, a warning sign is displayed. |
### To:  
### Do this:

- If the file name or path has not changed, open reference model details, browse for the new file and click **Modify**.

  You can also refresh locked reference models, if you have set the advanced option `XS_REFRESH_ALSO_LOCKED_REFERENCE_MODELS` to `TRUE` in **File --> Settings --> Advanced options --> Import**.

#### Refresh a single reference model

1. Double-click the reference model in the **Reference Models** list to open the details.

2. Click the **Refresh** button.  
   The model is reloaded. If the reference model is not found, a warning sign 🔄 is displayed.

#### View user-defined attributes

1. Double-click the reference model in the **Reference Models** list to open the details.

2. Click the small arrow on the **User-defined attributes** row to show the list of user-defined attributes.

3. The user-defined attributes that are specified for reference models in the `objects.inp` file are listed in the **User-defined attributes** list. Enter or select a value from the list. By default, the `objects.inp` is located in `ProgramData\Trimble\Tekla Structures\<version>\environments\common\inp`. You may also have some `objects.inp` files that you modify and keep in firm or project folders. These files are read in certain order.

#### Clip reference models only with clip plane tool

Set the advanced option `XS_DO_NOT_CLIP_NATIVE_OBJECTS_WITH_CLIP_PLANE` to `TRUE` to only clip reference models and point clouds with the clip plane.
To: | Do this:  
---|---
| tool. If you do this, the native objects are not clipped.  
Redraw the model views after changing the value.  
This advanced option is located in the Model View category in the Advanced Options dialog box.

See also
Modify reference model details (page 127)  
Reference model objects (page 143)  
Examine reference model hierarchy and modify reference model objects (page 144)  
Lock reference models (page 128)

Modify reference model details
After you have inserted a reference model, you can modify its details.

Limitation: Coordinates given in the Details section are always relative to model coordinates. You can modify the coordinate system only if model coordinate system is used in the reference model.

1. Click the Reference Models button in the side pane on the right of the Tekla Structures main window.
2. In the Reference Models list, double-click the reference model that you want to modify.
3. Click the arrow on the Details row, and change the desired details:
   • Change Code, Title, Phase and Description of the reference model.  
     The code could be a site number, project number, or accounting number. By default, the title is the same as the name of the inserted reference model. You may want to use the name of the discipline or the company instead, for example. Write the description according to the company conventions. The phase is the design phase of the reference model (not the phase in the Tekla Structures model).
   • You can insert another version of the reference model using the File box. For more information about version handling, see Detect changes between reference model versions (page 129).
   • In the Group box, you can select a new group for the reference model.
• You can also change the **Location by** selection.

If the reference model is inserted by using a base point, and you change the **Location by**, the offset values are relative to the base point. When you click **Modify**, the model position changes according to **East coordinate**, **North coordinate** and **Elevation** setting differences.

• You can change the **Offset** by entering new coordinates or by picking a new offset.

• You can change the **Rotation** by entering a new value or picking a new location.

• Click the arrow on the **User-defined attributes** row, and enter values for the user-defined attributes.

You may enter strings (texts), select dates or enter numeric information depending on the type of the user-defined attribute. The reference model user-defined attributes are defined in their own section in the `objects.inp` file. If you have several `objects.inp` files, they are read in a specific reading order, for more information, see Customizing user-defined attributes.

4. Click **Modify**. The changes that you made are implemented in the reference model.

**See also**

Insert a reference model (page 121)

---

**Lock reference models**

You can prevent reference models from moving and from detail updates by locking the reference models.

1. Click the **Reference Models** button in the side pane on the right of the Tekla Structures main window.

2. Move your mouse over the desired reference model in the **Reference Models** list.

   The **Lock** button is displayed.

3. Click the **Lock** button.
Now the reference model is locked. You can only add values for user-defined attributes and work with layers, but you cannot modify the details in any other way or move the model.

To lock multiple reference models, select the models from the list and click the Lock button of one of the reference models.

To unlock the reference model, click the Lock button again.

See also
Reference models and compatible formats (page 119)
Modify reference model details (page 127)

Detect changes between reference model versions
You can check the changes between different IFC reference model versions in Tekla Structures using change detection. You can use change detection to detect changes between reference models from different disciplines, such as engineer or detailer. Changes are detected on object level. You can also compare Tekla Structures models if you have exported a Tekla Structures model into IFC format at least twice.

Tekla Structures stores versions of the reference models for change detection. Versioning is also needed for visualizing sharing changes and object conversion change management.

Limitations
- Property comparison works only for IFC or IFC-based reference models. The following formats are supported:
  - .ifc
  - .ifcxml
  - .ifczip
  - .tczip
- Deleted objects are not highlighted and cannot be selected.
**Change detection**

You can show changes between two stored reference model versions or between stored version and browsed reference model file version. In both of these cases you need to activate change detection:

1. Open the Reference Models list by clicking the Reference Models button in the side pane.
2. Open a reference model by double-clicking the model in the Reference Models list.
3. Open the Change detection list by clicking the arrow on the Change detection row.

**Change detection between stored version and browsed model file version**

The file path box has automatically the full file path to the current reference model original file. If a reference model file with the same name has changed, you can run the change detection and skip steps 1 and 3 below.

1. Click ... and browse for an earlier version of the reference model.
2. Select the This model is newer check box next to the file path if you want to define that the file shown in the box is newer.
3. Ensure that you have both the original reference model and the browsed reference model version visible by setting the eye buttons active in the Change detection section.
4. To change the comparison set if needed, click the ... button and define the set you want to use. Then click Update view. The comparison set contains the properties that you want to use in version comparison.
5. To change property set comparison tolerances, click the Property set comparison tolerances button.

![Change detection interface](image.png)
You can do any of the following in the changes list and in the property details list:

- Export change detection results to Excel by clicking \(\text{Export to Excel}\). The exported Excel file contains all or changed properties that are visible in the changes list. The information is exported in the current language.
- Click a row in the changes list to open the related property details list in the side pane. The content of the property details list depends on the comparison rules that you are using. The details list also indicates how the individual properties have changed in the **Old value** and **New value** columns.
- To show the object in the model, select the **Select objects in the model** check box, and then click a row in the changes list. Note that you cannot select deleted objects.
- The older state of an object is drawn to the model view when you select the corresponding object in the changes list.
- To highlight the object in the changes list, select the **Get selected objects from model** check box, and then click an object in the model.
- To zoom to the selected object in the model, select the **Zoom to selected** check box, and then click a row in the changes list. You can also zoom to deleted objects.
- The older state of a reference model object is drawn to the 3D view in orange color when you select the corresponding object.
- To show only changes in the property details list, select the **Show only changes** check box, and then click a row in the changes list.
- You can search for specific items using the search box at the bottom.
- If the changes list disappears, you can bring it back by clicking the \(\text{Changes list}\) button in the side pane. If the details list disappears, you can bring it back by clicking the \(\text{Property details}\) button in the side pane. These two buttons are only visible when **Change detection** is active.
Update reference model and detect changes between versions

You can update a reference model with another version of the model, and detect the changes between these two reference model versions.

1. Open another version of the reference model by browsing to it in the File box in reference model details and clicking Modify.
   
   This updates the original reference model with the changed information in the other reference model version.
   
   You can open several versions, but you can only compare two versions at a time.
   
   You do not need to copy the reference models to the model folder.

2. On the Change detection row, click the arrow on the row to open the Change detection list.
   
   In the Change detection list, the current version is bolded. The newest version is at the top and the oldest at the bottom.

3. Ensure that both models are visible by setting the eye buttons active in the Change detection list.
   
   Comparison is active only when two eye buttons are active. You cannot have more than two eye buttons active at the same time. If you activate a third reference model in the list, the older version from previously visible model is automatically set inactive, and the comparison is done between the two models that have the active eye.

4. Set another version as the current version in the Change detection list by right-clicking the version in the list and selecting Set as current.

5. To change the comparison set, click the ... button and define the set you want to use. Then click Update view. The comparison set contains the properties that you want to use in version comparison.

6. To delete a version, right-click the version in the Change detection list, and select Remove.
   
   The current model version is modified, and this modification is shared in multiuser mode or Tekla Model Sharing.
   
   When you remove a version, you are asked if you want to set the model as current and save changes.
   
   You need to pay special attention to versioning and updating in a project. For example, if you remove a version, the current model is updated and you may end up with conflicts.

7. Select any or all of the check boxes for the following options: Changed, Unchanged, Inserted and/or Deleted, and then click the Update view button, which is displayed when you select an option.
For example, select **Inserted** to show with green color the objects that were inserted between the two versions.

The changes list and the property details list are displayed. The changes list content is based on the IFC content and has all physical object types. The colors are the same as the ones in **Change detection**.

8. You can do any of the following in the changes list and in the details list:

- Click a row in the changes list to open the related property details list in the side pane. The property details list contains at least the name, location as origin and property set properties, basically the content is the same as in the reference object inquiry report. The details list also indicates how the individual properties have changed in the **Old value** and **New value** columns.

- To highlight the object in the model, select the **Select objects in the model** check box, and then click a row in the changes list. Note that you cannot select deleted objects.

- To highlight the model object in the changes list, select the **Get selected objects from model** check box, and then click an object in the model.

- To zoom to the selected object in the model, select the **Zoom to selected** check box, and then click a row in the changes list. You can also zoom to deleted objects.

- To show only changes in the property details list, select the **Show only changes** check box, and then click a row in the changes list.

- The older state of a reference model object is drawn to the 3D view in orange color when you select the corresponding object.

- You can search for specific items using the search box at the bottom.

- If the changes list disappears, you can bring it back by clicking the **Changes list** button in the side pane. If the details list disappears, you can bring it back by clicking the **Property details** button in the side pane. These two buttons are only visible when **Change detection** is active.
**Change comparison order**

- Select the **This model is newer** check box to define that the file shown in the file path box is newer than the other compared file. If the file has been updated, it appears in the box automatically and the check box is selected.

- It is possible to compare as newer (default) or older.

Select the **This model is newer** check box next to the file path box if you want to define that the file shown in the box is newer.

**Macro for selecting Tekla Structures native objects**

The **SelectCorrespondingObjectsBasedOnIfcObjectsSelection** macro is useful for cases where you exported native objects to IFC, inserted the IFC model back to the same native model, and then you want to select the corresponding Tekla Structures objects. You may need to select the corresponding objects when you want to add your own UDAs to all updated and selected native objects, for example.

**Remove old reference model versions automatically**

You can remove old reference model versions automatically with the advanced option **XS_REFERENCE_MODEL_KEEP_VERSIONS_COUNT**.

**See also**

- Insert a reference model (page 121)
- Convert IFC objects into native Tekla Structures objects (page 153)

**Define a comparison set for reference model change detection**

Change detection in Tekla Structures compares different versions of the reference model based on a comparison set, which tells you whether Tekla
Structures considers a change in a property a change or not. You can use the standard property comparison set, or define a comparison set of your own.

In the reference model, when change detection is active, the changes list shows all deleted, changed, new and not changed objects. The property details list only contains those properties that are defined by the current comparison set rules to be compared.

When you save a comparison file, both the standard file and a customized comparison set file are saved to the attributes folder under model folder. The standard file can only be removed from model folder if it exists in another location. If saving or removing the standard file is not successful, you will get an error message.

**Create a new comparison set**

1. Open two versions of the same reference model.
2. In Change detection, click the Comparison sets button ... to open the Comparison sets dialog box.
3. Enter a name for the comparison set.

![MyComparisonSet](image)

4. Add a new comparison rule by clicking the Add row button and typing or copying and pasting the property name.
   - You can copy and paste property names directly from the property details list in change detection.
   - To include more properties within one rule, use asterisk (*), for example:
     X* (all that starts with X)
     *X (all that ends with X)
   - If you want to compare only one property set property, clear the Property sets check box and create a separate rule for that property.
   - If you want to compare all property sets but not one property, select the Property sets check box and create rule for that property and leave its check box empty.
   - Note that comparison rules are case insensitive.
   - All rules in comparison set affect the comparison if the reference model version has a corresponding property.
5. Add more rules in the same way as in step 2 and 3.
6. To delete a rule, select the rule and click the Delete rule button. You cannot delete fixed comparison rules, like Geometry, Location, Rotation,
Materials, Profiles, Products, Common attributes or Property sets, but you can exclude those from comparison by leaving the check boxes next to them empty.

7. Ensure that you have the check box selected next to all the comparison rules you want to include in the comparison set. If you do not want to include a rule, clear the check box.

TIP You can also exclude attributes already included in a property set by adding a separate row for that specific attribute and then ensuring that you do not add a check mark in the check box next to that specific attribute.

8. Click the Save button.

9. Close the comparison set dialog box by clicking the Close button. If you have not saved your changes, you will be asked if you want to keep the changes when you close the dialog box.

10. Click the Update view button.

Properties in comparison property set

A comparison set may contain the following types of properties:

- Free property set properties, such as BaseQuantities.NetVolume
- Fixed properties that always exist in the comparison set file, but can be excluded from the comparison

The fixed properties are listed below:

<table>
<thead>
<tr>
<th>Property type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Geometry</td>
<td>Object dimensions</td>
</tr>
<tr>
<td><strong>Property type</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>-------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Location</td>
<td>The coordinates of the object in the model</td>
</tr>
<tr>
<td>Rotation</td>
<td>The rotation coordinates of the object</td>
</tr>
<tr>
<td>Material</td>
<td>Material name and grade</td>
</tr>
<tr>
<td>Profile</td>
<td>Profile name</td>
</tr>
<tr>
<td>Product</td>
<td>IfcProduct parameters that vary object type by type. Some properties are optional. Below examples of product properties for IfcColumn: Application full name, Application identifier, Change action, Creation date, Description, Family name, Given name, Is set last modified date, Last modified date, Middle names, Name, Object type, Organization description, Organization names, Organization roles, Roles, State, Version</td>
</tr>
<tr>
<td>Common attributes</td>
<td>Below examples of common attributes for IfcColumn: External Use, Fire Rating, Load bearing, Reference</td>
</tr>
<tr>
<td>Property type</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>COLUMNTYPE-&gt;GUID</td>
<td>GUID</td>
</tr>
</tbody>
</table>
| Property sets | Whatever has been added to IFC properties. Below examples of property set properties for IfcColumn:
| BaseQuantities.Length [mm] |
| BaseQuantities.NetWeight [kg] |
| BaseQuantities.NetVolume [mm³] |
| BaseQuantities OUTERSurfaceArea [m²] |
| Tekla Common.B bottom elevation |
| Tekla Common.Class |
| Tekla Common.Phase |
| Tekla Common.Preliminary mark |
| Tekla Common.Top elevation |
| Tekla Quantity.Area per tons [m²] |
| Tekla Quantity.Gross footprint area [m²] |
| Tekla Quantity.Height [mm] |
| Tekla Quantity.Length [mm] |
| Tekla Quantity.Net surface area [m²] |
| Tekla Quantity.Weight [kg] |
| Tekla Quantity.Width [mm] |
| Tekla Quantity.Volume [mm³] |

**Define property comparison tolerances**

In reference model version comparison, you can modify the property comparison tolerance settings to get relevant changes more easily. You need two versions from the same IFC model.

The changed row appears as light yellow if the tolerance is bigger than the difference.

1. Open two versions of the same reference model.
2. In the **Reference Models** pane, open the **Change detection** section and activate the change detection.
3. Click the **Property set comparison tolerances** button.

4. Change the tolerances by modifying the values.

![Property set comparison tolerances dialog box]

5. Apply the changes by closing the dialog box and clicking **Update view**.

   The changed row appears as light yellow.

![Exported properties in Excel]

You can also save the tolerances in the **Property set comparison tolerances** dialog box.

---

**Export change detection results to Excel**

The exported Excel file contains all or changed properties that are visible in the changes list. The information is exported in the current language.

Objects that are filtered out using **comparison set (page 134)** filtering are not exported.

Columns in export:

- **Status**
- **Name**
- **Profile**
- **Material**
- **Type**
- **GUID**

1. When the **reference model change management (page 129)** is active and the changes list is displayed, click **Export to Excel.**
2. Filter which properties are shown in the property changes list and exported to the Excel file by using the comparison set (page 134) filtering.

3. In the Export to Excel dialog box, define the needed settings:

   - **Template**: Select a new Excel template for the export.
   - **Export without column headers**: If you do not want to show the column headers in the Excel sheet, select this option.
   - **Export details**: Exports all property details. Property details are shown collapsed by default. When you open the collapsed details by clicking the plus (+) button, all details are listed under titles Name, Old value and New value.
   - **Changed details only**: Only exports those property details that have changed between reference model versions.

4. If you want to save the settings in a properties file to be loaded and used in other exports, enter a name and click Save.

5. When you are ready, click Export.
   The changes list is exported to an Excel spreadsheet.
   If you want, you can save the Excel where ever you want.

Example of the exported Excel when the Export details option has not been selected.
Example of the exported Excel when the **Export details** option has been selected. If you include details in the export, all property details are listed, and the detail rows are by default collapsed. You can open the details by clicking the plus (+) button.

Example of the exported Excel when the **Export details** and **Changed details only** options have been selected.
Inquire reference model contents

You can inquire the contents of a reference model. This is something you might want to do after importing a reference model into Tekla Structures.

1. On the ribbon, click **Inquire object**.
2. In your Tekla Structures model, click the reference model you want to examine.

   The contents of the reference model are listed in the **Inquire Object** dialog box.
See also
Insert a reference model (page 121)

Reference model objects

Some types of reference models are automatically subdivided into reference model objects, which is an individual part of an imported reference model. You can define user-defined attributes separately for each reference model object and use them for reports and the view and selection filters. They can also be moved to a Tekla Structures model that is currently being worked on.
Information included in a reference model object can be saved in the model database.

The reference model objects are read-only.

Whether the reference model supports splitting depends on the file format and file structure. .ifc models are always automatically subdivided, and .dwg files that include any of the following objects, are also automatically subdivided:

- block table
- polyface mesh
- polygon mesh
- proxy object (for example, ADT)
- ACIS objects (3DSolid, Body, Region)

The file formats .dgn, .prp, .skp, .step, and .iges are not subdivided.

**TIP** To report a needed reference object attribute you can inquire a reference object in the model to see the property name and then in Template Editor, add that property name to be reported in a Reference* row.

**See also**

Reference models and compatible formats (page 119)

### Examine reference model hierarchy and modify reference model objects

You can view the reference model hierarchy and check the hierarchy level of different objects. You can also add user-defined attributes to the reference model objects. The added attributes can be used for filtering, for example. Additionally, you can view the native reference object attributes and properties.

1. Ensure that the Select assemblies selection switch (for assemblies) or Select objects in assemblies selection switch (for parts) is active.
2. Point the reference model, hold down Shift and scroll using the middle mouse button to the hierarchy level were the reference object is. Notice that if the cursor is too close to a grid, the hierarchy is not scrolled.
3. Do any of the following:
   - To inquire the native reference object properties and attributes, right-click the object and select Inquire.
   - To view or modify the user-defined attributes of a reference object, double-click the object to open the reference model object details.
TIP  There are many more commands available for the selected reference model objects. Check rest of the commands on the pop-up menu.

Below is an example of a reference model representing a sanitary system. When you want to scroll the hierarchy, the selection switch Select assemblies or Select objects in assemblies must be on. The 0 level IfcProject in the example is the upmost level.

Below you can see one of the reference objects on the 3 level, IfcBuildingStorey, of the same reference model.
The last level, level 4, shows the individual parts.
In the example below, one of the reference objects on the lowest level has been inquired.
Reference model assemblies

Imported IFC reference models can contain assemblies. You can select reference model assemblies in the model view and view assembly level information in Tekla Structures.

- You can add user-defined attributes to reference model assemblies.
- You can use the **Inquire** command to view information on reference model assemblies. For example, you can view GUIDs of child objects.
• You can create reports to view information on reference model assemblies.

3.3 IFC

IFC stands for Industry Foundation Classes, the set of internationally standardized object definitions for use in the construction industry. IFC is developed as an open standard by buildingSMART.

IFC offers a high-level common language for the sharing of intelligent objects, such as building elements, between disciplines across the building life cycle. The principal benefit of IFC is the object description – not only does the IFC protocol preserve the full geometric description in 3D, but it also knows its location and relationships, as well as all the properties (or parameters) of each object.

For a list of IFC applications certified by buildingSMART international, see Certified software.

See also

IFC interoperability concepts (page 149)
IFC insert (page 152)
Insert a reference model (page 121)
Convert IFC objects into native Tekla Structures objects (page 153)
IFC export (page 168)

IFC interoperability concepts

Some common terms and concepts used in IFC import, export, and conversion are explained below.

B-rep

B-rep or boundary representation is a method for representing shapes using the limits. A solid is represented as a collection of connected surface elements, showing the boundary between solid and non-solid.

CSG

CSG or Constructive Solid Geometry is a technique used in solid modeling. CSG allows a modeler to create a complex surface or object by using Boolean operations to combine simpler objects.
Boolean operations on sets

Union:

Intersection:
Difference:

**Extrusion**
Sweeping is allowing a two-dimensional planar cross section to sweep through space.

**Revolved extrusion**
A revolved extrusion or a solid of revolution is a solid object that is obtained by rotating a plane cross section around a straight line (the axis) that lies on the same plane.

**Arbitrary profiles**
In addition to parameterized profiles, there is a free profile shape type called *arbitrary profiles*. These profiles are defined by an ifcCurve, which may have linear and curved segments. Thin wall profiles can be defined by a centerline and a thickness. Other profiles are defined by a closed shape. Closed profile shape may or may not have inner voids.
Parameterized profiles
There are several parameterized profiles available in the IFC specification. Those include standard hot-rolled steel I, L, T, U, and Z profiles, cold formed C profiles, and generic rectangle and circle profiles with or without a hollow. These profiles are defined with their parameters, such as width, height, web thickness and flange thickness.

IFC insert
You can insert IFC models as reference models to Tekla Structures, and optionally convert the inserted IFC objects into native Tekla Structures objects directly by using the direct conversion, or selected IFC reference objects using conversion change management. You can use inserted IFC reference models, for example, in clash checking, reporting and scheduling.

Insert a reference model
1. Open a Tekla Structures model where you want to insert the IFC reference model.
2. Open the Reference Models list by clicking the Reference Models button in the side pane.
3. Click the following link and follow the instructions for inserting the reference model: Insert a reference model (page 121).

Supported IFC schemas and IFC applications
• Tekla Structures supports the following IFC schemas:
  • IFC2X3 (recommended)
  • IFC4
• For a list of applications/utilities that are purported, by their developers, to provide IFC insert and/or export functionality, see List of all IFC applications.

Certification
• The IFC insert IFC2X3 functionality has the IFC certification granted by buildingSMART international. For a list of IFC-certified applications, see Certified Software.

Supported entities
The IFC reference model insert in Tekla Structures supports all the sub-objects of the IfcBuildingElement class and sub-objects of the IfcProduct class including:
• Architectural entities
• Structural entities

Import to and export from Tekla Structures
• Building services entities

**Supported formats**

• IFC (.ifc) and ifcXML (.ifcXML) formats are supported.
• You can use compressed (.ifcZIP) or uncompressed insert files.
• IFC4 does not support ifcXML.

See also

Convert IFC objects into native Tekla Structures objects (page 153)

**Convert IFC objects into native Tekla Structures objects**

You can convert most linear IFC reference objects such as beams, columns, braces, plates, slabs, footings and walls into native Tekla Structures objects. Conversion also supports polybeams that have curved sections, and have originally been exported from Tekla Structures, and string, int and double type UDAs. The purpose of converting IFC objects in Tekla Structures is to help in the creation of the structural model and to avoid rework in an early modeling phase.

In IFC object conversion, IFC objects are converted either as items or as extrusions. Conversion as *item* means that an IFC object is converted as a Tekla Structures item, where the 3D shape defines the geometry of the item. Conversion as *extrusion (page 149)* means that an IFC object is converted as a part (column, beam, plate, etc.) that has a profile extruded to create the length of the part.

**Limitation:** The IFC4 and IFC4.1 formats are not supported in IFC object conversion.

In IFC object conversion you need to do the following:

1. Before converting, check that the profiles and units in the IFC reference model are compatible with your environment.
2. Check the object conversion settings in the IFC object conversion settings dialog box and change them, if needed.
3. Convert the IFC objects to native Tekla Structures objects. There are two alternative ways available in object conversion:
   • Converting all selected reference model objects at one go using the Convert IFC objects command on the Manage tab.
   • Converting using the IFC object conversion change management. You can also perform an update conversion with a new reference model revision using the change management.

Is object conversion always necessary?
In Tekla Structures, reference model objects can be used in a way similar to the native objects, for example, in clash detection, reporting and scheduling. There is no need to have everything as native, because the reference model objects can also be used in many ways. For example, reference model objects can be shown in drawings and they can be listed in reports.

The reference files have the benefit compared to the copied files that the content of the files is automatically updated by the designer of that design discipline.

**Check and change the IFC object conversion settings**

Before you start converting, check the conversion settings and change them if necessary.

1. On the File menu, click Settings --> IFC object conversion settings.
2. In the IFC object conversion settings dialog box, check and change the conversion settings:

| Create report after conversion | Not used any longer. The changes list replaces the report. |
| Set handles to top flange      | Set the reference lines of beams to top flange. |
|                                | If Set handles to top flange is not selected, the reference lines of beams are located in the middle of the beams. |
|                                | This setting is not used for polybeams for better conversion results. |
| Convert Brep object            | Convert B-rep objects into Tekla Structures objects. |
|                                | You can select conversion to item and conversion to extrusion separately for concrete material and other material, for example, steel. The selected options are applied to direct conversion and in conversion change management. |
|                                | B-rep objects are converted to items, and the items are added to the shape catalog. The items belong to class 996. |
| Primary profile mapping        | Profile name Map profiles primarily by comparing the profile names between the IFC model and Tekla Structures profile catalog. |
|                                | Dimensions: Map profiles primarily by comparing the object dimensions. |
|                                | If the IFC object converter cannot map profiles with the method you select as primary, it applies the secondary (unselected) method. |
3. Copy properties from the IFC object property sets to be used as user-defined attributes of converted Tekla Structures objects:
   a. Click **Add** to add a row and enter the name of the IFC property in the **Property** box.
      Write the IFC property as it is shown in the **Inquire** dialog box (without the prefix EXTERNAL.).
   b. Enter the name of the user-defined attribute in the **UDA** box.
      The maximum length of the user-defined attribute name is 20 characters. The user-defined attribute that you add here must also be included in the **objects.inp** file. Ensure that the attribute name is unique. Enter the original name of the user-defined attribute, not the translation.
   c. Click **Type** to select the format of the attribute.
      The possible formats are string, integer or double. The type specifies the IFC property datatype, not the UDA datatype.

4. Before you convert IFC objects into native Tekla Structures objects, check the profiles and materials to ensure that the conversion will be successful, and map the profiles or material manually in the following way:
a. Click the **Check** button.

Tekla Structures displays any missing profiles or materials on the **Missing Profiles** and **Missing Materials** tabs in the **Missing Mapping** dialog box.

b. Select an appropriate option in the Tekla Structures profile and Tekla Structures material lists to define a mapping for the missing profiles or materials.

The mapping of profiles works for IFC data that has a profile name but does not include enough information for conversion. You can change your mappings later if needed. The maps are used in conversion only if the profiles are not found from Tekla Structures catalogs. Profile conversion follows a certain logic (page 162).

c. Click **Update Mapping Catalogs and Close**.

You can also open and modify the catalog files in a text editor. To do this, click the **Catalog** button. When you are done, reopen the IFC object conversion settings to take the new settings in use. The files are located in the \attributes folder under the model folder:

- `TeklaStructuresCatalogMaterials.txt` contains all materials
- `TeklaStructuresCatalogProfiles.txt` contains all profiles
- `MappedMaterials-default.txt` maps the materials
- `MappedProfiles-default.txt` maps the profiles

5. Click **OK** in the **IFC object conversion settings** dialog box. Now you can convert the IFC objects using one of the two available ways.

### Convert selected IFC objects at one go

You can convert all imported IFC objects at one go using the current object conversion settings. You need to have at least two or more revisions of the same model.

1. Open the **Reference Models** list by clicking the **Reference Models** button in the side pane.

2. Click the **Add model** button, browse for the model in the **Add model** dialog box, and click **Add model** again.

3. In the model, select the objects that you want to convert.

4. Go to the ribbon, and on the **Manage** tab, click **Convert IFC objects**. The selected objects are converted on the basis of IFC conversion settings. Conversion is done automatically for objects that have not been converted earlier. Converted IFC object are listed in the changes list at the bottom. Each object is on a row of its own, and cuts are listed hierarchically under the related object.
• To select objects in model, activate the Select objects in model check box, and then click an object row. This also selects the related native object.

• To highlight the object in the changes list and show its details, select the Get selected objects from model check boxes, and then click an object in the model.

• To zoom to the selected object in the model, select the Zoom to selected check box, and then click a row in the changes list. The Zoom to selected check box is disabled if the Select objects in the model is not selected.

• To show only changes in the property details list, select the Show only changes check box, and then click a row in the changes list.

• The status of an object may be New (green) Changed (yellow), Deleted (red), or Up-to-date (blue or gray, when the conversion change management is reopened), or Error (lila).

• The Conversion status column shows the resulting conversion status.

• The properties of a converted object are listed in the property details list that appears in the side pane when you click an object in the changes list.

5. You can update an object in the list by changing its conversion status to Conversion and clicking Apply changes.
6. If the lists disappear, click the following buttons that are only visible when the conversion changes list is active:

- The Changes list button brings back the changes list.
- The Property details button brings back the property details list.

**Convert IFC objects using conversion change management - first conversion**

Object conversion change management provides change detection and change management on object level. Conversion change management is needed in the initial data change management to reduce the challenges in construction projects. Objects are not converted automatically but you need to convert the objects using the conversion changes list.

1. Open the Reference Models list by clicking the Reference Models button.
2. Click Add model, browse for the model in the Add model dialog box, and click Add model again.
3. Double-click the model in the Reference Models list to open it, and then click the Start IFC conversion change management button.

   The current conversion status is displayed in the changes list and conversion management is activated. The status is based on reference model object physical changes and IFC conversion settings. The properties of a reference object are listed in the property details list that appears separately for each object when you click an object in the changes list.

   Use the Select objects in model view, Get selected objects from model, and Zoom to selected check boxes to review the model and the changes and details lists.
The reference object status and conversion status logic and colors:

<table>
<thead>
<tr>
<th>Reference object status</th>
<th>Conversion status</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>No conversion</td>
<td>Green</td>
</tr>
<tr>
<td>Changed</td>
<td>Conversion as item or Conversion as extrusion</td>
<td>Yellow</td>
</tr>
<tr>
<td>Deleted</td>
<td>Conversion as item or Conversion as extrusion</td>
<td>Red</td>
</tr>
<tr>
<td>Up-to-date</td>
<td>Conversion as item or Conversion as extrusion</td>
<td>Blue (gray when the conversion change management is reopened)</td>
</tr>
<tr>
<td>Error</td>
<td>No conversion</td>
<td>Lila</td>
</tr>
</tbody>
</table>

4. Convert objects by selecting the desired object rows, selecting **Conversion** in the **Conversion status** column and clicking **Apply changes**. The conversion is based on conversion settings. You can select multiple objects.
• After conversion, the conversion status is either **Conversion as item** or **Conversion as extrusion** depending on the result of the conversion.

• **B-reps (page 149)** are shown as **Surface geometry**, **parametric (page 149)** profiles as **Parametric** and **arbitrary (page 149)** shapes as **Arbitrary**. Assembly is also **Arbitrary**, and so are the reference objects that are selected with the **Select objects in assemblies** or **Select objects in components** selection switches.

• If B-rep (**Surface geometry** in the **Type** column) conversion is selected, conversion is done as item, if not error.

• If object is **extrusion (page 149)** (**Arbitrary** or **Parametric** in the **Type** column), it is converted as extrusion.

• You can force conversion to be item by selecting **Conversion as item**. In this case, an extrusion object is also converted as item. The conversion does not check if same shape is already available, meaning new shape will always be created.

• You can force conversion to be extrusion by selecting **Conversion as extrusion**. In this case, B-rep is also converted as extrusion, profile is by mapping, or by bounding box if there is no mapping. This conversion result is not always as preferred.

• If the conversion fails, the result is written to the **Conversion status** column, and the row color is purple.

5. If the lists disappear, click the following buttons that are only visible when the conversion management is active:

• The **Changes list** button brings back the changes list.

• The **Property details** button brings back the property details list.

**Convert IFC objects using conversion change management - update conversion**

If a previously converted reference object has changed in a newer reference model revision, you can compare the older and newer revisions of the reference model and update the conversion.

1. Open the **Reference Models** list by clicking the **Reference Models** button in the side pane.

2. Open the older reference model revision by double-clicking it in the **Reference Models** list.

3. Update the reference model with a new revision of the reference model by selecting a new revision file in the **File** list in the **Details** section and clicking **Modify**.
4. Click the **Start IFC conversion change management** button.

5. Go through the changes:
   - Select the **Select objects in model view** and **Zoom to selection** check boxes to see the changed objects clearly in the model.
   - Click the changed row to see detailed changes in property details in the side pane.

6. You can update previously converted objects partially by selecting the **Update** check box next to a certain property in the property details pane. For example, if you only want to update the profile information, only select the **Update** check box next to the **Profile** row in the property details pane.

7. To convert all objects with changed conversion status, select all rows, change the **Conversion status** to **Conversion** and click **Apply changes**.
   - The objects that have a changed conversion status are converted on the basis of the current IFC object conversion settings.
   - You can update previously converted native model objects based on previous conversion type and settings by selecting **Conversion** in the **Conversion status** column. You cannot change the type from extrusion to item, in this case you need to delete the native objects and force conversion.
   - If the reference object status is **Deleted**, select **Conversion** and click **Apply changes**. This removes the native object and the link to the removed reference objects.

**Macro for selecting converted IFC objects**

The **SelectConvertedObjectsBasedOnIfcObjectsSelection** macro selects the objects that have been converted to native Tekla Structures objects. You may need to select the converted objects to check the properties of the native Tekla Structures objects, for example. This macro is located in the **Applications** section of the **Applications & components** catalog.

**Class values**

The status of the converted object is reported in the changes list in the **Class** column. Sometimes the input data in the IFC model is not adequate to
successfully create the converted object. The following table explains what the class values mean.

<table>
<thead>
<tr>
<th>Class value</th>
<th>IFC object data</th>
<th>Converted object description</th>
</tr>
</thead>
<tbody>
<tr>
<td>990</td>
<td>Parametric profile with a name</td>
<td>There is enough information in the IFC model to convert the object successfully.</td>
</tr>
<tr>
<td>991</td>
<td>Parametric profile without a name</td>
<td>Tekla Structures determines the name of the object based on the objects profile.</td>
</tr>
<tr>
<td>992</td>
<td>Arbitrary profile with a name</td>
<td>The profile of the converted object may be incorrectly rotated because there is no parametrized profile data in the IFC model.</td>
</tr>
<tr>
<td>993</td>
<td>Arbitrary profile without a name</td>
<td>The profile of the converted object may be incorrectly rotated because there is no parametrized profile data in the IFC model. The profile name is set to UNKNOWN.</td>
</tr>
<tr>
<td>994</td>
<td>B-rep piece with a name</td>
<td>The profile may be an extrema box due to the lack of profile data in the IFC model.</td>
</tr>
<tr>
<td>995</td>
<td>B-rep piece without a name</td>
<td>The profile may be an extrema box due to the lack of profile data in the IFC model.</td>
</tr>
<tr>
<td>996</td>
<td>B-rep piece</td>
<td>The object is converted using the Convert B-rep object option in converter settings.</td>
</tr>
</tbody>
</table>

Profile conversion logic in IFC object conversion

Tekla Structures uses a certain logic in converting profiles in IFC object conversion.
Parametric profile used in IFC model, I-, L-, U-, C-, T-, Z-, Rectangle- and Circular type profiles can be defined parametrically:

1. If IFC file has been created with Tekla Structures, original profile name is used.
2. If profile with same name is found from Tekla Structures Profile Catalog, it will be used.
3. Otherwise, Tekla Structures checks parameter values to find a corresponding profile. If found, that will be used.
4. Otherwise, a default parametric profile is used.

Arbitrary profile used in IFC model, profile shape is defined with polygon:

1. If IFC file has been created with Tekla Structures, original profile name is used.
2. If the shape is detected and found from Tekla Structures catalog, that profile will be used. The shape detection supports the standard types of hot rolled profiles.
3. Otherwise, a new profile is created based on the description of the arbitrary profile.

B-rep geometry used in IFC model, object is defined with surfaces and profile geometry information is not available:

1. If corresponding item exists in Tekla Structures model, it is used.
2. Otherwise, a new item will be created and used.

If Conversion as item is used for extrusion type of part, new item is always created.

See also

Convert IFC objects into native Tekla Structures objects (page 153)
**Example: Convert IFC objects into Tekla Structures objects in one go**

In this example, you use an IFC model as a basis for your structural model. You will convert the beams and columns into native Tekla Structures objects.

1. Hide irrelevant IFC layers:
   a. Click the **Reference Models** button.
   b. In the **Reference Models** list, double-click the reference model to open the details.
   c. Open the **Layers** list by clicking the down arrow on the right.
   d. Hide the unnecessary layers by clicking the eye button next to the layer.
2. Select all visible IFC objects.

3. On the Manage tab, click Convert IFC objects.
   Tekla Structures converts the reference objects.

4. Check the profiles and materials of the IFC objects and map missing material:
   a. On the File menu, click Settings --> IFC object conversion settings.
   b. Click Check.
      Tekla Structures lists the missing profiles and materials.
   c. View the Missing Profiles and Missing Materials tabs.
      Tekla Structures lists a missing reference part material Concrete Block.
   d. Select CONCRETE_UNDEFINED from the list.

   ![Concrete Block](image)

   e. Click Update Mapping Catalogs and Close.
   f. Select the Create report after conversion check box.
   g. Click OK in the IFC object conversion dialog box.

5. On the Manage tab, click Convert IFC objects again.
Tekla Structures converts the objects.

The Class for all the converted objects is 992. That means that the profile of the converted object may be incorrectly rotated because there is no parametrized profile data in the IFC model.

6. Check the conversion changes list:

- Select objects in the changes list to highlight them in the model: Use the buttons Select objects in model view and Zoom to selected.
- Compare the converted objects with the IFC objects.
- Use the Inquire objects button on the ribbon to view detailed information on objects.
Below is an image of converted beams and columns.

See also

Convert IFC objects into native Tekla Structures objects (page 153)

Limitations in IFC object conversion

Tekla Structures is dependent on the quality of the IFC model, because it uses information available in the model when converting objects.

Tekla Structures converts most linear IFC objects to native Tekla Structures objects.

The following limitations exist in IFC object conversion:

• If the IFC model does not comply with standard, it might not be converted as expected.

• Bolts, reinforcement and welds cannot be converted to native Tekla Structures objects.

• The currently supported physical elements: IfcBeam, ifcColumn, ifcMember, ifcPile, ifcFooting, ifcPlate, ifcDiscreteAccessory, ifcSlab, ifcWall, ifcWallStandardCase, ifcRailing and ifcBuildingElementPart.

• Only SweptSolid, Brep, CSG and Clipping representations are supported.

• Multiple representations for one object are not supported.

• Profile offset is not supported.
Sometimes, chamfers may be converted incorrectly.

See also
Convert IFC objects into native Tekla Structures objects (page 153)

IFC export
You can export Tekla Structures models as IFC models.

You can export all basic parts in the Tekla Structures model such as beams, columns, braces, slabs, panels, plates, reinforcing bars, and bolts with nuts and washers.

Tekla Structures exports the model objects on the basis of the export settings you define, including the property sets.

The IFC export functionality in Tekla Structures supports the IFC2X3 schema. The IFC export functionality has the IFC certification granted by buildingSMART international Certified Software.

IFC (.ifc) and ifcXML (.ifcXML) formats are supported. You can use compressed (.ifcZIP) or uncompressed import files.

<table>
<thead>
<tr>
<th>To</th>
<th>Click the links below to find out more</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define the resulting IFC entities for the exported model Tekla Structures model objects and the IFC export settings, and then export Tekla Structures model or a part of it into a IFC file</td>
<td>Export a Tekla Structures model or selected model objects to an IFC file (page 172)</td>
</tr>
<tr>
<td>Test the reference model after creating it</td>
<td>Check the exported IFC model (page 182)</td>
</tr>
</tbody>
</table>
To | Click the links below to find out more
---|---
Check what kind of base quantity information is included in the **Quantity takeoff add-on view** | IFC base quantities in exported IFC model (page 182)
Take a look at the property set configuration files | Property set configuration files used in IFC export (page 183)
Create additional property sets out of template attributes and user-defined attributes, define property definitions for the attributes, and bind the property sets to IFC entities to be used in IFC export | Define additional property sets for IFC export (page 169)

**Define additional property sets for IFC export**
You can create additional property sets out of template attributes and user-defined attributes, define properties for the attributes, and bind the Tekla Structures property sets to IFC entities for IFC export. Tekla Structures saves additional property sets in configuration files. You can keep several configuration files in several locations. When Tekla Structures exports an IFC file, it reads the predefined property sets and the additional property sets.

**Add a new IFC property set configuration file**
1. On the **File** menu, click **Export --> IFC**.
2. Select `<new>` in the **Additional property sets** list and click **Edit**. If you have copied one of the predefined configuration files in the model folder, open that one.
3. For a new configuration file, in the **Property Set Definitions** dialog box, enter a name for the configuration file in the **Name** box.
4. Enter a name for the property set next to the **New** button and click **New**.
   You can also select one of the property sets in the **Property sets** list.
   You can create several property sets in one configuration file. For example, you can add COGs, and start and end points on the part level, and scheduling information on the assembly level.
5. For a new property set, enter a description for the property set in the empty box.
6. Select an entity type from the **Select entity types** list by selecting its check box.

When you do this, the **Select attributes** list shows the attributes that are available for the selected entity type.

7. Add the desired attributes from the **Select attributes** list by selecting the check boxes next to the attribute names.

The attribute is added to the **List of all selected properties** list on the right. This list shows which attributes are exported and in which format:

- You can add new attributes by entering an attribute name in the **Attribute** box in the **Create/Modify property** area and clicking the **Add** button.

- You can modify and remove attributes on the list by selecting the attributes on the list and clicking **Modify** or **Remove**.

8. Under **Create/Modify property**, define the attribute properties:

- Select **Property type** for the selected attribute.

  Here, always select **Template attribute** for those user-defined attributes whose name contains more than 19 characters. For example, select **Template attribute** for ASSEMBLY.USERDEFINED.PLANS_STATUS.

- Enter or modify the name of the selected attribute in the name box **Name**.

- Select the **Type** of the attribute. The **Type** can be one of the following: **String** (sequence of characters), **Boolean** (false or true), **Integer** (number without a fractional part), **Measurement**, **Real** (numbers that have decimal representations), or **Time stamp**.

- If the type of the user-defined attribute is **Measurement**:
  - You can select the **Measurement type**: **Length**, **Area**, **Volume**, **Mass**, **Positive length** or **Count**.
  - You can select the **Conversion factor** and **Accuracy**. User-definable accuracy allows better IFC file size optimization.

9. Click **Save** to save your modifications.
1) The entity groups where Tekla Structures attributes are written in the exported IFC file

2) The template attributes or user-defined attributes that you want to export for the selected entity

3) List showing the selected attributes

4) The properties that you can define for the attributes

**Tekla Structures model objects and corresponding IFC entities**

<table>
<thead>
<tr>
<th>Tekla Structures object</th>
<th>IFC entity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beam</td>
<td>IfcBeam (IfcMember)</td>
</tr>
<tr>
<td>Column</td>
<td>IfcColumn, (IfcPile), (IfcMember)</td>
</tr>
<tr>
<td>Polybeam</td>
<td>IfcBeam, (IfcMember)</td>
</tr>
</tbody>
</table>
### Tekla Structures object | IFC entity
---|---
Curved beam | IfcBeam, (IfcMember)
Pad footing, Strip footing | IfcFooting
Slab | IfcSlab
Panel | IfcWall or IfcWallStandardCase
Contour plate | IfcPlate or IfcDiscreteAccessory
Bolts, nuts and washers | IfcMechanicalFastener
Bolt hole | IfcOpeningElement
Vertical braces | IfcMember
Railing: Beam, Column | IfcBeam, IfcColumn, (IfcRailing)
Assembly, cast unit | IfcElementAssembly, (IfcRailing), (IfcRamp), (IfcRoof), (IfcStair), (IfcWall)
Tekla Structures project | IfcProject
Assembly sub-part | IfcDiscreteAccessory
Bar, wire, strand, mesh, tendon, and other component embedded in concrete | (IfcReinforcingElement)
Reinforcement | IfcReinforcingBar
Pour object, pour break | IfcBuildingElementProxy
Surface treatment | IfcCovering
Weld | IfcFastener

**NOTE**
- If the entity is not in parenthesis in the table above, the object is automatically exported to this entity type. If an entity is in parenthesis, the object is not exported to this entity type automatically, but you can select the entity for the object on the **IFC export** tab.
- The **IfcBuildingElementPart** and **IfcBuildingElement** entities can also be used. **IfcBuildingElement** matches beams, columns, etc, but not assemblies.
- Polybeams are always exported as B-rep (page 149).

**Export a Tekla Structures model or selected model objects to an IFC file**

You can export Tekla Structures model or a part of the model into an IFC file. Before you start the export:

- Define the IFC entities for Tekla Structures model objects.
- **Define the needed property sets** (page 169).
- If you export the IFC file using the base point, define the base point.
• Note that to successfully export concrete parts, ensure that the advanced option `XS_ENABLE_POUR_MANAGEMENT` is set to `FALSE`. To export pour objects instead of the concrete parts, set the advanced option `XS_ENABLE_POUR_MANAGEMENT` to `TRUE` and select the **Pour objects** check box on the **Advanced** tab of the Export to IFC dialog box (IFC2x3) or the **Pours** check box (IFC4).

• During the IFC export you can add classification information to assemblies by entering the name of the classification system in the user-defined attributes in **Project properties**. The classification system is written to the IFCCLASSIFICATION field in the export file. You can define the classification values for the assemblies in Organizer or in the UDA dialog box of the assemblies. Note that classification information is written to the assembly level only.

For more information about how to add classification information to assemblies in Organizer, see **How to add classification code to objects in Organizer**.

For more information about adding UDAs to the UDA dialog box, see **Define and update user-defined attributes (UDAs)**.

**Define IFC entities for Tekla Structures model objects**
Before you export Tekla Structures model objects to IFC, you can define the resulting IFC entities for the exported model objects in the user-defined attributes of the objects.
1. Double-click an object, for example a column, to open part properties, and click the More button.

2. On the Parameters tab, set Load bearing to Yes, if you want to define the user-defined attribute LOAD_BEARING for the exported object.

   Set this option to No for all non-load bearing objects. Yes is the default value.

3. On the IFC export tab, select an option in the IFC entity list to define the IFC entity for the exported model object.

   Below is a list of entities available for a different types of Tekla Structures objects:

<table>
<thead>
<tr>
<th>Tekla Structures object</th>
<th>IFC entity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beam</td>
<td>IfcBeam (IfcMember)</td>
</tr>
<tr>
<td>Column</td>
<td>IfcColumn, (IfcPile), (IfcMember)</td>
</tr>
<tr>
<td>Polybeam</td>
<td>IfcBeam, (IfcMember)</td>
</tr>
<tr>
<td>Curved beam</td>
<td>IfcBeam, (IfcMember)</td>
</tr>
<tr>
<td>Pad footing, Strip footing</td>
<td>IfcFooting</td>
</tr>
<tr>
<td>Slab</td>
<td>IfcSlab</td>
</tr>
<tr>
<td>Panel</td>
<td>IfcWall or IfcWallStandardCase</td>
</tr>
<tr>
<td>Contour plate</td>
<td>IfcPlate or IfcDiscreteAccessory</td>
</tr>
<tr>
<td>Bolts, nuts and washers</td>
<td>IfcMechanicalFastener</td>
</tr>
<tr>
<td>Bolt hole</td>
<td>IfcOpeningElement</td>
</tr>
<tr>
<td>Vertical braces</td>
<td>IfcMember</td>
</tr>
<tr>
<td>Railing: Beam, Column</td>
<td>IfcBeam, IfcColumn, (IfcRailing)</td>
</tr>
<tr>
<td>Assembly, cast unit</td>
<td>IfcElementAssembly, (IfcRailing), (IfcRamp), (IfcRoof), (IfcStair), (IfcWall)</td>
</tr>
<tr>
<td>Tekla Structures project</td>
<td>IfcProject</td>
</tr>
<tr>
<td>Assembly sub-part</td>
<td>IfcDiscreteAccessory</td>
</tr>
<tr>
<td>Bar, wire, strand, mesh, tendon, and other component embedded in concrete</td>
<td>(IfcReinforcingElement)</td>
</tr>
<tr>
<td>Reinforcement</td>
<td>IfcReinforcingBar</td>
</tr>
<tr>
<td>Pour object, pour break</td>
<td>IfcBuildingElementProxy</td>
</tr>
<tr>
<td>Surface treatment</td>
<td>IfcCovering</td>
</tr>
<tr>
<td>Weld</td>
<td>IfcFastener</td>
</tr>
</tbody>
</table>

**NOTE** • If the entity is not in parenthesis in the table above, the object is automatically exported to this entity type. If an entity is in parenthesis, the object is not exported to this entity type.
automatically, but you can select the entity for the object on the IFC export tab.

- The IfcBuildingElementPart and IfcBuildingElement entities can also be used. IfcBuildingElement matches beams, columns, etc, but not assemblies.
- Polybeams are always exported as B-rep (page 149).

4. In the IFC export type list, select Auto or Brep:
   - The Auto option will automatically select what kind of Swept Solid IFC object a Tekla object becomes in the IFC.
   - If Auto fails for some reason (such as with a deformation), the export reverts to Brep automatically, and creates a mesh-based IFC object with less intelligence. These objects are data heavy but still geometrically correct.
   - Brep will force the IFC object to be always mesh based.

5. Click Modify in the user-defined attributes dialog box.

Export to IFC2x3

1. Select the model objects to export.
   - If you want to export all model objects, you do not have to select anything.
2. On the File menu, click Export --> IFC.
3. Browse for the Output file location and replace the name out with the desired file name.
   - IFC files are by default exported to the \IFC folder under the model folder. The length of the file path is limited to 80 characters. You do not need to enter the file name extension, it will be automatically added according to the selected File format.

4. Define the export settings:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameters tab</td>
<td></td>
</tr>
<tr>
<td>File format</td>
<td>The options are IFC, IFC XML, zipped IFC, and zipped IFC XML.</td>
</tr>
<tr>
<td>Export type</td>
<td>Which export type to select?</td>
</tr>
<tr>
<td></td>
<td>• The certified Coordination view 2.0 should be your default.</td>
</tr>
<tr>
<td></td>
<td>• If the model is used only for viewing purposes, or as a reference model, Surface geometry is your choice.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Coordination view 1.0</td>
<td>• Coordination view 1.0 is for those who need to export openings as separate objects.</td>
</tr>
<tr>
<td></td>
<td>• Steel fabrication view is for the fabrication workflow, and to be provided for manufacturing.</td>
</tr>
<tr>
<td>Surface geometry</td>
<td>Surface geometry is ideal when the need is to view the model without any need for re-using or editing:</td>
</tr>
<tr>
<td></td>
<td>• Reinforcing bars are exported as B-rep (page 149).</td>
</tr>
<tr>
<td></td>
<td>• Export does not support CSG (page 149) (Constructive Solid Geometry).</td>
</tr>
<tr>
<td></td>
<td>• Curved elements are exported as B-rep.</td>
</tr>
<tr>
<td></td>
<td>• Bolts are exported as B-rep.</td>
</tr>
<tr>
<td>Steel fabrication view</td>
<td>Steel fabrication view is recommended for exporting detailed information on steel objects for steel fabrication:</td>
</tr>
<tr>
<td></td>
<td>• Exports assembly presentation and dedicated property sets.</td>
</tr>
<tr>
<td></td>
<td>• Bolt holes are exported as voids.</td>
</tr>
<tr>
<td></td>
<td>• Steel fabrication model view configuration file for property sets and properties (IfcPropertySetConfigurations_AISC.xml) is included in the installation by default.</td>
</tr>
<tr>
<td>Coordination view 1.0</td>
<td>Coordination view 1.0 is recommended to be used instead of Coordination view 2.0 when you need to have voids and openings presented by using opening elements:</td>
</tr>
<tr>
<td></td>
<td>• Reinforcing bars are exported as extrusions.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Voids and openings are exported as opening elements (ifcOpeningElements).</td>
<td>• Voids and openings are exported as opening elements (ifcOpeningElements).</td>
</tr>
<tr>
<td>Curved elements are exported as extrusions.</td>
<td>• Curved elements are exported as extrusions.</td>
</tr>
<tr>
<td>Bolts are exported as B-rep.</td>
<td>• Bolts are exported as B-rep.</td>
</tr>
<tr>
<td>Additional property sets</td>
<td>• To define a new property set (page 169), select &lt;new&gt; and click Edit.</td>
</tr>
<tr>
<td></td>
<td>• To use an additional property set created earlier, select the property set from the Additional property sets list.</td>
</tr>
<tr>
<td>Location by</td>
<td>Model origin exports the model relative to 0,0,0.</td>
</tr>
<tr>
<td>Work plane</td>
<td>Work plane exports the model Elevation relative to the current work plane coordinate system.</td>
</tr>
<tr>
<td>Base point</td>
<td>Base point: &lt;name of base point&gt; exports the model relative to the base point using coordinate system values East coordinate, North coordinate, Elevation, Angle to North, Latitude and Longitude from the base point definition.</td>
</tr>
<tr>
<td>Advanced tab</td>
<td>Select the object types to export.</td>
</tr>
<tr>
<td>Object types</td>
<td>If you select Pour objects, cast in place concrete parts are exported as pour objects.</td>
</tr>
<tr>
<td></td>
<td>If you select Assemblies, you can exclude single part assemblies by selecting Exclude single part assemblies in the Other area.</td>
</tr>
<tr>
<td>Property sets</td>
<td>Selecting the option Base quantities adds in the exported IFC file a Quantity takeoff add-on view containing additional information on the entities in the exported IFC model.</td>
</tr>
<tr>
<td></td>
<td>For more information about the base quantities, see IFC base quantities in exported IFC model (page 182).</td>
</tr>
<tr>
<td></td>
<td>Default exports the default set of properties.</td>
</tr>
<tr>
<td></td>
<td>Minimum exports the minimum set of properties required by the buildingSMART IFC standard. To view the property sets, click View.</td>
</tr>
<tr>
<td>Other</td>
<td>Layer names as part names uses part names, such as COLUMN and BEAM, as layer names for exported objects.</td>
</tr>
</tbody>
</table>
|                              | Export flat wide beams as plates exports flat and wide beams as plates. Select this option if you have modeled plates as beams or columns with flat
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>profiles. For example, some system components use beams or columns instead of plates.</td>
<td></td>
</tr>
<tr>
<td><strong>Use current view colors</strong> exports the objects using the colors defined in object representation, not the class colors. Note that exporting object transparency settings is not supported.</td>
<td></td>
</tr>
<tr>
<td>Select <strong>Exclude single part assemblies</strong> when you export assemblies.</td>
<td></td>
</tr>
<tr>
<td><strong>Spatial hierarchy from Organizer</strong> uses the spatial hierarchy (Building-Site-Section-Floors) created in Organizer in export.</td>
<td></td>
</tr>
<tr>
<td>Do the following: a. Select <strong>Spatial hierarchy from Organizer</strong>. b. Create a project hierarchy in Organizer. c. In Organizer, right-click the project, and select <strong>Use for reporting</strong>. d. Before the IFC export, synchronize or write the Organizer data in the Tekla Structures model by right-clicking the project in Organizer, and selecting <strong>Write to the model for reporting</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

5. Select either **Selected objects** or **All objects** to define the object selection for the export.

6. Click **Export**.

**Export to IFC4**
You can export a Tekla Structures model or a part of the model into an IFC4 file.

Before you can start the IFC4 export in Tekla Structures, you need to set the advanced option `XS_IFC4_EXPORT_PLEASE` to `TRUE` in `teklastructures.ini`.

1. Select the model objects to export.
   - If you want to export all model objects, you do not have to select any objects.

2. On the **File** menu, click **Export --> IFC**.
3. In the **File name** box, enter the file name without a file name extension. The extension will be automatically added according to the selected **Format**. The length is not limited.

4. Browse for the **Folder** location.
   IFC files are by default exported to the `\IFC` folder under the current model folder.
   Both absolute and relative paths can be defined.

5. In **Selection**, select whether you want to export **All objects** or **Selected objects**.

6. Define other export settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location by</td>
<td><strong>Model origin</strong> exports the model relative to 0,0,0. <strong>Work plane</strong> exports the model relative to the current work plane coordinate system. <strong>Base point</strong>: <code>&lt;name of base point&gt;</code> exports the model relative to the base point using coordinate system values <strong>East coordinate, North</strong></td>
</tr>
</tbody>
</table>
Setting | Description
--- | ---
**coordinate, Elevation, Angle to North, Latitude and Longitude** from the base point definition.

**Format** | The options are **IFC** and **zipped IFC**.

**Export type** | The options are **Reference view** and **Design transfer view**.

The **Reference view** is intended to support the referencing workflow, and exported files can be used as reference files, and viewed in a viewer. The **Reference view** is not meant to be used for conversion to native objects.

**Reference view** also exports cuts and openings. They are considered reference information, and that is why they are not shown in IFC file viewers.

The overall goal of the **Reference view** is to provide workflows for various software applications that do not require modifying geometry. Such applications enable viewing, estimating, building, operating, and other downstream analysis.

**Design transfer view** is intended for the handover workflow, meaning import for further editing. This requires the conversion of the IFC entities into native objects. One example is the takeover of the structural engineering model (or part of it) into the basis of the structural detail modeling. The IFC object conversion will be used to convert the IFC entities to Tekla Structures native objects. Typically import and conversion are only needed a couple of times, or even once only. The result may require some rework to accomplish a proper model.

**Additional property sets** | • To define a new property set (page 169), select `<new>` and click Edit.

• To use an additional property set created earlier, select the property set from the Additional property sets list.

• The additional property sets are stored in the AdditionalPSet folder under the model folder.

**Layer names as** | You can use phases, part names, or template attributes as layer names for exported objects.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Name or Phase from the list, or type the attribute name in the box. Note that you cannot use user-defined attributes as the layer name.</td>
<td></td>
</tr>
<tr>
<td>Object color</td>
<td>Select whether you want to export objects using object class colors or object group colors. If you select object group colors, the defined transparency settings are also exported.</td>
</tr>
<tr>
<td>Export flat wide beams as plates</td>
<td>Select this option if you want to export flat and wide beams as plates. Select this option if you have modeled plates as beams or columns with flat profiles. For example, some system components use beams or columns instead of plates.</td>
</tr>
</tbody>
</table>
| Spatial hierarchy from Organizer    | **Spatial hierarchy from Organizer** uses the spatial hierarchy (Building-Site-Section-Floors) created in **Organizer** in export. Do the following:  
  a. Select **Spatial hierarchy from Organizer**.  
  b. Create a project hierarchy in **Organizer**.  
  c. In **Organizer**, right-click the project, and select **Use for reporting**.  
  d. Before the IFC export, synchronize or write the **Organizer** data in the Tekla Structures model by right-clicking the project in **Organizer**, and selecting **Write to the model for reporting**. |
| Pours                               | When you select the option **Pours**, concrete parts are exported as pours. If you do not select this option, concrete parts are exported without pours. |

7. Click **Export**.

After the export a message box is displayed. In this message box you can open the folder where the exported IFC model is stored, or view the log file in a browser. The log file gives detailed information of the export process, exported entities and the errors occurred during the export.
Limitations in IFC4 export

- The export is not certified by buildingSMART and may therefore have syntax and content issues.
- The user interface does not provide all the features included in the IFC2x3 export user interface.
- The Reference view is intended to be used for design coordination and for referencing workflow. Due to the API change, all the needed pieces of data may not be available and therefore the resulting IFC model may be incomplete.
- We do not recommend using IFC4 in production projects yet.

**Check the exported IFC model**
We recommend that you test the reference model after creating it.

To check the exported IFC model (page 172), insert the model as reference model to the original Tekla Structures model.

Check the following things:

- Check the IFC model visually. Use different colors for the IFC model and the original model. Use clip planes to check the model thoroughly.
- Compare the number of objects. If there are differences, check the export log.
- Check the modeling of unsuccessfully exported objects. For example, unnecessary cuts may result in unsuccessful export. Consider remodeling the incorrect objects or set IFC export type to Brep for the objects.

**TIP** You can also use Trimble Connector (page 83) for viewing and checking the IFC model.

**IFC base quantities in exported IFC model**
Base quantities are quantity definitions that are independent of a particular method of measurement and therefore internationally applicable. Base quantities are defined as gross and net values and provided by measurement of the correct geometric shape representation of the element. Additional Quantity takeoff add-on view is included to the exported IFC model if you set Base quantities to Yes in the Tekla Structures IFC Export dialog box.

The Quantity takeoff add-on view contains the following base quantity information on the entities in the exported IFC model:

<table>
<thead>
<tr>
<th></th>
<th>Beam</th>
<th>Column</th>
<th>Slab</th>
<th>Wall</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Height</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Beam</td>
<td>Column</td>
<td>Slab</td>
<td>Wall</td>
</tr>
<tr>
<td>--------------------------</td>
<td>------</td>
<td>--------</td>
<td>------</td>
<td>------</td>
</tr>
<tr>
<td>Length</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Net area</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Outer surface area</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gross footprint area</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Net volume</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Net weight</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

**Property set configuration files used in IFC export**

Tekla Structures uses configuration files for defining which user-defined attributes and template attributes are exported as property sets into IFC models.

**Predefined property set configuration files**

The predefined configuration files are read-only and they are read from .. \ProgramData\Trimble\Tekla Structures\<version>\Environments \Common\inp. The location may vary depending on your environment.

**IFC2x3:**

- IfcPropertySetConfigurations_CV2.xml *(Default property sets)/
  IfcPropertySetConfigurations_CV2_1.xml *(Minimum property sets) contains the property sets for **Export type Coordination view 2.0**.

- IfcPropertySetConfigurations_SG.xml *(Default property sets)/
  IfcPropertySetConfigurations_CV2_1.xml *(Minimum property sets) contains the property sets for **Export type Surface geometry**.

- IfcPropertySetConfigurations_AISC.xml *(Default property sets)/
  IfcPropertySetConfigurations_AISC_1.xml *(Minimum property sets) contains the property sets for **Export type Steel fabrication view**.

The IfcPropertySetConfigurations_CV1.xsd file in the same folder is a schema file that describes the structure of the XML file and is used for validation of the XML file. This file is read when the software is started.

**Additional property set configuration files**

When you configure property sets for IFC export in XML format, you need two files:

- IfcPropertySetConfigurations.xsd is a schema file that describes the structure of the XML file and is used for validation of the XML file. This file is read when the software is started.

- IfcPropertySetConfigurations.xml is the actual property set configuration file.
We recommend you define the additional property sets (page 169) in the Property Set Definition dialog to ensure that the XML configuration files are valid. The additional property sets you create are saved to the AdditionalPSets folder under the model folder by default. You can also read additional property sets from the following folders:

- XS_SYSTEM
- XS_PROJECT
- XS_FIRM

If you use the above mentioned folders, save the files in a folder called AdditionalPSets under the system, project or firm folder.

Property set configuration file contents

- A configuration file includes the structure of property sets, and the data definitions for the properties inside the property sets:
  - Template attribute or UDA name. Template attributes are read from content_attributes_global.lst and the user-defined attributes from the environment database.
  - Data type, such as String, Integer, Float, Timestamp, Boolean, Logical, or planeanglemeasure.
  - Unit type, such as length, area, volume, or mass.
  - Unit value scaling of unitless UDA values. Conversion factor is added so that unitless values can be converted to correspond to the global units used in the IFC files. Area and volume units need these factors.
  - Possibility to use default values.
  - Possibility to ignore the set to export if template attribute or UDA does not have a value.

- A configuration file includes property set binding rules to IFC entities:
  - Binding to IFC entity type hierarchy including support for not only building elements but also for bolts, reinforcing bars, and assemblies.
  - Possibility to use limiting rules, such as Equal, NotEqual, LessThan, GreaterThan, LessThanOrEqual, and GreaterThanOrEqual for numbers, and Equal and NotEqual for texts.

You need to modify your additional property set configuration file using a suitable editor, if you want to add these limiting rules.

- There can be any number of binding rules for any property set, but only one property set definition for each ReferenceId.
- You can bind different property sets to different IFC entity types. For example, a plate may have a different property set than a beam.
- If no value is found for a property in export, the export does not write the property set at all. To avoid this, add optional=true for that property in the property set.
Below is an example of the contents of the IfcPropertySetConfigurations.xml file.

```xml
<PropertySet referenceId="assemblies">
  <Name> Tekla Assembly </Name>
  <Description> Assembly Properties </Description>
  <Properties>
    <Property xsi:type="PropertySingleValue" optional="true">
      <Name> Assembly/Part position code </Name>
      <PropertyValue xsi:type="StringValue" stringType="IfcLabel">
        <GetVal xsi:type="TemplateVariableType">
          <TemplateName> ASSEMBLY_POSITION_CODE </TemplateName>
        </GetVal>
      </PropertyValue>
    </Property>
    <Property xsi:type="PropertySingleValue" optional="true">
      <Name> Assembly/Part name </Name>
      <PropertyValue xsi:type="StringValue" stringType="IfcLabel">
        <GetVal xsi:type="TemplateVariableType">
          <TemplateName> ASSEMBLY_NAME </TemplateName>
        </GetVal>
      </PropertyValue>
    </Property>
  </Properties>
</PropertySet>
```

Below is an example of the contents of the IfcPropertySetConfigurations.xml file.
3.4 DWG and DXF

DWG is the native file format of AutoCAD and the standard file format for Autodesk products. DWG is used for 2D and 3D CAD data that is supported by Tekla Structures.

DXF (Drawing eXchange Format) was developed by Autodesk for enabling data interoperability between AutoCAD and other programs. As the file format does not contain any form of part ID it is not possible to track changes between different physical objects contained within different versions of a file. Clash checking is not possible with a DXF file in Tekla Structures.

The DWG/DXF files imported with the DWG/DXF tool do not show the surfaces of the imported objects, only the construction lines or lines converted to part
profiles that can be used to create a model. If you want to show surfaces of the objects, insert DWG and DXF files as reference models (page 121).

In DWG/DXF import, Tekla Structures supports ACAD2012 or earlier.

To determine the AutoCAD version of the DWG file, open the file in a text editor. You will find the version code in the first six bytes:

AC1027 = 2013
AC1014 = 14
AC1012 = 13
AC1009 = 12, 11
AC1006 = 10
AC1004 = 9
AC1002 = 2

Click the links below to find out more:

Import a 2D or 3D DWG or DXF file (page 187)
Export a model to a 3D DWG or DXF file (page 188)
Export a drawing to a 2D DWG or DXF file (page 190)
Export a drawing to 2D DWG or DXF (old export) (page 201)

Link DWG or DXF files in drawings
You can also add links to DWG or DXF files in drawings through the 2D Library or by using the drawing ribbon command DWG/DXF:

• 2D Library in drawings
• Add links to DWG and DXF files in drawings

Import a 2D or 3D DWG or DXF file
In DWG/DXF import, you can convert 2D and 3D objects as parts or reference lines (construction lines).

1. On the File menu, click Import --> DWG/DXF.
2. Enter the name of the import file.
   Click Browse... to browse for the file.
3. Enter the offset from X, Y and Z.
4. Enter the scale.
5. Select how to show the imported parts:
   • **Reference lines** displays parts in the model as construction lines.
   • **Parts** displays the full profile of parts in the original model, based on the profile sizes defined in the **Plate profile** and **Beam profile** boxes. You can only use metric profiles with this option.
6. Select **Use 2D import** to import a two-dimensional representation of the original object.
   This is useful when you have selected the **Reference lines** option. Do not select **Use 2D import** if you want to import the model in 3D.
7. Click **Import**.

Tekla Structures imports the file you specified. If you need to delete the imported parts or reference lines, select the parts or lines and press **Delete**.

**Limitations**
When importing DWG profiles, note the following:
• The profile must be the only object in the DWG file. The file should not include any titles, blocks or any other graphics.
• The profile must be a closed polyline.
• Generating the polylines from an ADSK 3D model requires a number of steps to clean the profile.
• The profile needs to be scaled up.
• The DWG/DXF files imported with the DWG/DXF tool do not show the surfaces of the imported objects, only the construction lines or lines converted to part profiles that can be used to create a model. If you want to show surfaces of the objects, insert DWG and DXF files as reference models (page 121).
• The import functionality is not available in all Tekla Structures configurations. For more information, see Tekla Structures configurations.

**Export a model to a 3D DWG or DXF file**
You can export the whole model or model parts to 3D DWG or 3D DXF file types. By default, Tekla Structures creates a model.dwg file in the current model folder. You can export parts, items and bolts to 3D DWG/DXF.

**Limitations**
The 3D DWG/DXF export has the following limitations:
• Bolt holes are not exported.
• Curved beams and polybeams are exported as single, continuous beams.
• The number of segments in the curved beams is as defined for the particular curved beam.
• Reinforcing bars are not exported.
• Grids are not exported.

**TIP** You can define color settings for parts and other model objects. This way you can affect the color that the objects have in the exported DWG/DXF files.

1. Open a Tekla Structures model.
2. On the **File** menu, click **Export --> 3D DWG/DXF**.
3. In the **Export 3D DWG/DXF** dialog box, accept the default export file name, or enter another one.
   To replace an already existing export file, click the ... button and browse for the file.
4. Select whether to export as DWG or DXF.
5. In **Export as**, select the representation for the exported objects:
   • **Faces** exports parts as faces.
     Exporting 3D DWG or DXF files as **Faces** uses more memory and may take longer, but the end result is better.
   • **Lines** exports parts as lines located in the center of the profile cross-sections. This option suits well for exporting to analysis software.
   • **Center lines** exports parts as part center lines.
   • **Reference lines** exports parts as reference lines, drawn between the creation points. This option suits well for exporting to analysis software.
     If the model is large, or you have less memory to use, the **Reference lines** option is faster, and the resulting file size is smaller.
6. Select **Part accuracy**:
   • The options are **High** and **Normal**. **High** also exports chamfers in profile cross-sections.
7. Select **Bolt accuracy**:
   • **High** exports entire bolt assemblies, including washers.
   • **Normal** only exports the bolt and nut.
   • **No bolts** exports no bolts.
8. Select whether to include **Cuts** in the export.
   **Yes** exports cuts.
9. Select whether to include **Inner contours**
   - Yes includes the inner contours.

10. In the **Export** list, select what to export:
   - **All objects** exports the whole model.
   - **Selected objects** exports the parts selected from the model.
   
   To only select parts that you want to include in the export, activate the **Select parts** and **Select objects in components** selection switches. You can also create a selection filter that exports all the parts and objects that you want. Components cannot be imported as such, but you need to select the objects in components to export the included parts.

11. Click **Create**.

Tekla Structures creates the export file in the current model folder. The ID of each part is exported as an attribute and written into the export file for each part.

**See also**

Export a drawing to a 2D DWG or DXF file (page 190)

---

**Export a drawing to a 2D DWG or DXF file**

You can export Tekla Structures drawings to 2D DWG and DXF format. You can export several drawings at a time.

The DWG/DXF export is object based. For example, if you export a rectangular part that is drawn using hidden line types, the result is a rectangular object drawn with a dashed line. In the old line-based DWG export, the result would be many separate short straight lines. Hatches are also exported as hatch objects in CAD and not separate lines.

In the DWG/DXF drawing export you can:

- easily set layers for different objects, and separate mark frames from mark text and leader lines, for example
- separate different parts from another by using filters
- use layers that have been predefined by standard CAD layer settings
- use base points and model coordinates
- embed images in the export file so that the images are no longer exported as links
**Start DWG/DXF export**

1. Start the export in any of the following ways:
   
   - On the **File** menu, click **Export --> Drawings**, and select the drawings from the displayed **Document manager**.
   
   - Click **Drawings & reports --> Document manager**, select the drawings that you want to export from **Document manager**, and then on the **File** menu, click **Export --> Drawings**.
   
   - Click **Drawings & reports --> Document manager**, select the drawings that you want to export from **Document manager**, right-click and select **Export**. Note that this command is not available when you open the **Document manager** in the drawing mode.
   
   - In an open a drawing, on the **File** menu, click **Export drawings**.
2. Click **Open preview** to show the preview window, where you can also change the drawing if you have selected many drawings for export. To get the preview visible for the first time, click **Refresh preview**. You can refresh the preview again by clicking **Refresh preview**. The preview does not get refreshed automatically, because this could take a long time.
**Define export settings and export to DWG/DXF**

1. In the **Save** list, load previously saved or predefined export settings. If you want to save modified settings for future use with another name, enter a name for a new settings file and click **Save**.

2. In **File location**, define the location for the exported DWG files. By default, the files are exported to the \PlotFiles folder under the current model folder. **Open folder when finished** opens the export folder after the export. You can use relative file location by using .\ in front of the output folder name. The specified output folder is saved in the settings.

3. In the **File type** list, select **DWG** or **DXF**.

4. Select the DWG version to be used in export. There are several versions of AutoCAD or DXF formats available. 2010 is the default.

5. Define other settings on the **Options** tab as necessary:

<table>
<thead>
<tr>
<th>Model space coordinates</th>
<th>Select one of the following options:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• <strong>Local</strong>: Exports the drawing to the 0 point in the CAD coordinate system. This option uses the</td>
</tr>
</tbody>
</table>
left bottom corner of the 1st view frame to set the local coordinates. If frame is expanded, the local will move.

- **Model**: Matches Tekla Structures 0 point with CAD 0 point and rotates the CAD coordinate system accordingly in X and Y coordinates. Note that Z coordinates are not supported.

- **Base point**: Matches the selected base point with CAD 0 point, and rotates the CAD coordinate system accordingly. The base points are defined in the Tekla Structures model through **File --> Project properties --> Base points**.

  Note that Z coordinates are not supported.

| File prefix | Enter a specific prefix or suffix to be used in the file name. The preview of the file name will change accordingly. The DWG export supports the following drawing-specific advanced options, which you can use to modify the name of the exported file:

  XS_DRAWING_PLOT_FILE_NAME_A
  XS_DRAWING_PLOT_FILE_NAME_C
  XS_DRAWING_PLOT_FILE_NAME_G
  XS_DRAWING_PLOT_FILE_NAME_M
  XS_DRAWING_PLOT_FILE_NAME_W

  For more information about the values that you can give to these options, see Customize print output file names. |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>File suffix</td>
<td>Embed all images inside the export file. No extra image files are created in the export.</td>
</tr>
<tr>
<td>Embed images inside the file</td>
<td>Export all included objects to the model space and paper space of a CAD file. Model and global coordinates and paper space switch in the layer settings will be ignored. Note that if the drawing has linked or copied views, and you have not selected <strong>Drawing as snapshot to CAD model space</strong>, the drawing views may be placed on top of each other, and the view limits may not be accurate in the resulting DWG file. This is because drawing views are not conceptually the same as paper space viewports in the DWG format. Also note that if you have shortened views in the drawing, and the objects are placed in 1:1 scale,</td>
</tr>
<tr>
<td>Drawing as snapshot to CAD model space</td>
<td>Import to and export from Tekla Structures 194 DWG and DXF</td>
</tr>
</tbody>
</table>
the ends will be stretched to match the actual size of the part. Select **Drawing as snapshot to CAD model space** to avoid stretching of the shortened view in a CAD model space. The drawing space in a CAD software will keep the view shortening.

| Scale | Define the scale for the exported DWG. This option is only available if you have selected the **Drawing as snapshot to CAD model space** check box. For example, if you have a drawing between the coordinates 0,0 and 800, and you define a scale value 5, the resulting DWG is 5 times bigger, and the DWG is located between the coordinates 0,0 and 4000. In another example, if you have set the drawing view scale in Tekla Structures to 1:50 and wish to export the drawing in 1:1 scale, using export option scale value 50 will produce the desired result. If you set the advanced option XS_EXPORT_DRAWING_TRY_TO_KEEP_LOCATION to **TRUE**, Tekla Structures tries to keep the DWG origin in the same position as the drawing view origin. This can only be done in plan views and elevation views. If the drawing has more than one plan view or elevation view, Tekla Structures places the DWG origin in the bottom-left corner of the drawing frame. |
| Ungroup objects in blocks | Exports graphical objects as individual objects, does not add the objects to blocks. For example, a line, hatch and rectangle will be a DWG object line, hatch and rectangle, rather than blocks. When this option is selected, the option **Update Tekla Structures linework only** is disabled. |
| Update Tekla Structures linework only | Updates the Tekla Structures drawing content and keeps other content that is created in a CAD software intact in the same file. Blocks (groups), created by Tekla Structures will be updated. This setting is only shown if you have set the advanced option XS_DWG_EXPORT_UPDATE_TS_LINWORK_OPTION to **TRUE** in the **Export** category in the **Advanced Options** dialog box. Note that you need to have the same drawing exported already, and the layer setup and the layer template must be the same as during the previous export. All CAD lines that were added previously will stay in the file and only Tekla Structures |
content will get updated, unless editing was done in CAD blocks editor.

Also note that if you edit the content of a block (CAD object), and then select the **Update Tekla Structures linework only** option, the whole block will be re-written, and the changes made in CAD will not be kept. To keep the changes in CAD, you need to explode a block before editing it.

For example, you may want to use this setting if you have added drawing title blocks in the CAD file after the first export of the drawing from Tekla Structures, and want to keep these title blocks as they are, and update only the objects that exported from Tekla Structures.

6. On the **Layer rules** tab, you can define explicitly the layers where different model and drawing objects, or parts of objects are exported to. For example, you can separate outline from fills and hatches.

You can also define here whether the line color, style and weight will be used from Tekla Structures settings or from the target layer settings specified in a DWG or DXF file. Note that Tekla Structures line weight, style and colors stay as you see them in the Tekla Structures drawing, and there is no functionality to modify them just for the DWG export.

7. To use a DWG template, use the **Target layers from DWG** list to browse for the template file. If specified, the template is used for layer definition. The DWG template should not contain any CAD objects, just layer settings, unless it contains objects that are intended to appear on drawings exported using this template. For example, here you could use your standard DWG file with all the predefined layers.
You can enter .\ and then the file name, in which case Tekla Structures searches for the file first in the model, project and firm folders, then in the folder indicated by the advanced option XS_DRIVER, then in the system folder, and finally in the user settings folder.

The **DWG file not found** text is displayed next to the **Browse...** button until a DWG or a DXF file is found and loaded.

The target layer boxes are briefly colored in yellow when a new DWG file is loaded from the **Target layers from DWG** list. When there are no layers available in the DWG file, the boxes are colored in red.

8. Add the rules:
   - You can create a new rule by clicking the **Add** button on the right, or by copying the selected rule by clicking the **Copy** button. You can select multiple rules.
   - You can move the rules upwards or downwards in the set by clicking the **Move up** and **Move down** buttons. You can select multiple rules.
   - If you wish to delete a rule, select it and click **Delete**. You can delete multiple rules at a time.

9. Define the rule contents:

| **Objects** | Select the objects that you want to export. Note that some objects, like neighbor part marks, are currently under marks and not listed separately. To have them separated in the export, you need to use **Object filtering**, and create several mark rules for parts and neighbor parts. To include everything else that is missing from the **Objects** list, add an **All** object rule at the end of the rules list, because rules are read in the order they are listed. To export pours, you need to have the pours enabled in the model, see XS_ENABLE_POUR_MANAGEMENT. |

Import to and export from Tekla Structures 197 DWG and DXF
### Presentation filtering

Define which part of the objects should follow the rule. You can also select **All**.

The **Presentation filtering** options are different for different object types.

You cannot add more than one filter per rule. For example, to have mark frames separated from mark text, you need to create two rules for marks, and in the first one, set the **Presentation filtering** to **Text**, and in the other one to **Frames**. See the section **Layer rule example** below for an example.

### Object filtering

Reads the selection filter attribute files that have been defined in the current model.

Note that these files are only read from the current model folder, not from firm or project folders.

### Target layer

If you have no DWG templates, or want to create layers of your own, type a new layer name in the **Target layer** box, or select a previously used layer from the list.

Note that after you have added a DWG template, its layers will appear in the **Target layer** list.

The target layer boxes are briefly colored in yellow when a new DWG file is loaded from the **Target layers from DWG** list. When there are no layers available in the DWG file, the boxes are colored in red.

### Color

Define whether the linework is taken from Tekla Structures settings or from the DWG template.

### Line style

### Line weight

### Paper space

To draw drawing objects correctly in the paper space in a DWG file (and...
not through the view portal), select the **Paper space** check box.

If the check box is not selected, there will only be a portal from the model space in the paper space.

Note that it is recommended to put drawing annotations, such as marks, dimensions, and texts to the paper space only. That way they will appear correctly, for example, when a part is cut in a Tekla Structures drawing view.

<table>
<thead>
<tr>
<th>Include</th>
<th>To include a rule in the final DWG, select the <strong>Include</strong> check box next to the rule. If you do not want to export some objects, just clear the <strong>Include</strong> check box.</th>
</tr>
</thead>
</table>

10. Open the preview and click **Refresh preview** to preview the result before exporting.

11. Click **Export**.

The drawings are exported on the basis of the defined settings and rules. The rules are read in the order that they are listed. If you have selected **Open folder when finished**, the export folder will open.

The error message **Drawing cannot be read** is displayed if the exported drawing is missing, not up to date or has similar problems.

When you click the **Export** button, Tekla Structures first checks if the files can be written to before the export starts, and asks you to close the necessary applications. It also checks if the files already exist and asks if you want to overwrite the existing files.

**Layer rule example**

In the example below, three separate mark rules have been created that will be exported on layers 1, 2, and 3. Lines are exported on the layer 1, texts on the layer 2, and frames on the layer 3.

![Layer rule example](image)

After exporting, you can show the marks in the CAD model in the following three ways depending on the layers displayed in the CAD viewer:

All layers are shown:
Layer 1 containing the lines is hidden:

Layer 2 containing the texts is hidden:

Layer 3 containing the frames is hidden:
**Tips**

- If you export a DWG file to the **Output file version** 2013, a wipeout frame will be visible on the layout side in the CAD model due to the limitations in CAD, see below:

  ![Image](image.png)

  To avoid this, either use a DWG file layer template created in AutoCAD, or export to version 2010 (default) or earlier.

- Another reason for the visible wipeout frame is that you are using a DWG template where wipeout frames have been set to visible. Hide the wipeout frames in the CAD template.

**To use old DWG/DXF export**

If you want to use the old DWG/DXF export, set the advanced option `XS_USE_OLD_DRAWING_EXPORT` to `TRUE` in an `.ini` file. This advanced option is by default set to `FALSE`. For instructions on using the old export, see Export a drawing to 2D DWG or DXF (old export) (page 201).

**Export a drawing to 2D DWG or DXF (old export)**

You can export drawings to the 2D DWG or DXF format using the old DWG/DXF drawing export.

If you want to use the old DWG/DXF drawing export, set the advanced option `XS_USE_OLD_DRAWING_EXPORT` to `TRUE` in an `.ini` file. This advanced option is by default set to `FALSE`. For instructions on using the newer DWG/DXF drawing export, see Export a drawing to a 2D DWG or DXF file (page 190).

1. On the **Drawings & reports** tab, click **Document manager**.
2. Select from the list the drawings that you want to export.
3. Right-click and select **Export**.

4. In the **Export Drawings** dialog box, on the **Export file** tab, enter the export file name.

   If you are exporting several drawings, leave the file name box empty.

   The drawings are exported by default to the \PlotFiles folder under the current model folder. If you want to use another folder, enter the full path.

   Tekla Structures uses one of the following advanced options to define the names for the export files. The advanced option that is used depends on the drawing type:

   - XS_DRAWING_PLOT_FILE_NAME_A
   - XS_DRAWING_PLOT_FILE_NAME_C
   - XS_DRAWING_PLOT_FILE_NAME_G
   - XS_DRAWING_PLOT_FILE_NAME_W
   - XS_DRAWING_PLOT_FILE_NAME_M

5. Select the file type: **DXF** or **DWG**.

6. If you want to include a revision mark in the file name, select **Include revision mark to file name**.

7. Set the layer options on the **Layer options** tab:
   
   • Select the layer rules file.

     To add or modify layers, and to assign object groups to different layers, click **Setup**.

   • If you want to use advanced conversion to convert the type, color and weight of lines and layers, select **Use advanced line type and layer conversion**.

     • In the **Conversion file** box, enter the name of the file to be used in the conversion.

       By default, Tekla Structures uses the LineTypeMapping.xml file in the ..\Tekla Structures\<version>\environments\common\inp folder.

       If you need to define your own line type mappings, you can use the file LineTypeMapping.xml as a template when you create a conversion file of your own.

       • Select **Include empty layers** if you want to include empty layers in the export.

       • Select **Object color by layer** to have different colors on different layers.

8. Set the other drawing export options on the **Options** tab:
• Set **Drawing scale** and **Line type scale**.

• If you want to export the drawings so that the DWG/DXF content is grouped by object, select **Export objects as groups**. When you do this, Tekla Structures makes a new group for each object (part, mark, dimension line, etc.).

• Select **Cut lines with text** if you do not want to display continuous lines in exported drawings, for example, to run the line through text or drawing marks.

• Select **Export custom lines as split lines** to ensure that custom line types have the same appearance in the software you are exporting to and when printed. If **Export custom lines as split lines** is selected, custom line types are exported as solid lines that are split to several short lines. If **Export custom lines as split lines** is not selected, custom line types are exported as defined in TeklaStructures.lin.

• Select **Use paper space** to export to both model space and paper space. The unscaled contents of the drawing views are exported into model space. The drawing layout is exported into paper space. The layout contains scaled viewports showing appropriate areas of the model space.

  When exporting to paper space, ensure that all objects in the view are inside the view frame. Objects that are partially outside the drawing view frame are not exported.

9. Click **Export**.

**See also**

- Default line types in drawings (old export) (page 211)
- Define customized line type mappings in drawing export (old export) (page 207)
- Example: Set up layers and export to DWG (old export) (page 212)
- Layers in exported DWG/DXF drawings (old export) (page 203)
- Create layers in DWG/DXF files for drawing export (old export) (page 204)
- Assign objects to layers in drawing export (old export) (page 205)
- Copying export layer settings to another project (old export) (page 207)

**Layers in exported DWG/DXF drawings (old export)**

In drawing DWG/DXF export, you can define the layers to which different drawing objects belong. The benefit of using layers in export is that if you do not want to show a certain layer in the drawing, you can turn it off.

You can define the different layers using Tekla Structures selection filters.
You can use the LineTypeMapping.xml file to define the line type, line weight and line color for objects on different layers. You can also add custom line types in the TeklaStructures.lin file and use these when mapping Tekla Structures line types to the line types in the exported DWG and DXF files.

You can export into layers of their own all object types that are listed in the Drawing Export Layers dialog box.

The following objects cannot have layers in export because they cannot be identified as separate objects that can have selection filters: clouds, hatches, neighbor parts, symbols in drawings, section view titles, grid label texts, dimension labels, weld labels, bolt mark leader lines, and part mark leader lines. For example, hatches are exported to the same layer with the part that the hatch belongs to.

See also

Example: Set up layers and export to DWG (old export) (page 212)

Create layers in DWG/DXF files for drawing export (old export)
You need to define the layers that are included in the exported DWG and DXF files.

NOTE To keep track on the layers that you have, create all the layers that you need for the final DWG/DXF drawings at the same time.

1. On the File menu, click Export --> Drawings.
2. In the Export Drawings dialog box, go to the Layer options tab and click Setup next to the Layer rules box.
3. In the Drawing Export Layers dialog box, click Modify layers.
4. To add a layer, click Add.
   You can add as many layers as you need.
5. Click the row of the new layer in the Name column and enter a name for the layer.
6. Click the row of the new layer in the Color column and select a color for the new layer.
7. Click **OK**.

Next you can assign objects to the new layer.

**See also**

Assign objects to layers in drawing export (old export) (page 205)

Example: Set up layers and export to DWG (old export) (page 212)

**Assign objects to layers in drawing export (old export)**

You need to define which objects to export to certain layers in the exported DWG/DXF file. You can do this by using a selection filter for identifying the desired objects among all objects, and by creating a rule to export these objects to a certain layer.

Before creating the rule, first create the selection filter.

1. Create a selection filter.
2. On the **File menu**, click **Export --> Drawings**.
3. In the **Export Drawings** dialog box, go to the **Layer options** tab, and click **Setup**.
4. Open an object group by clicking the plus sign next to the group name.
   For example, click the plus sign next to **Model Object**.
5. Right-click a rule in the list and select **Add Next Level Rule**.
   For example, right-click **Part**.

6. Enter a name for the rule and select the selection filter that you created.

7. Click **OK**.
8. Double-click the row under the rule you just created and select the desired layer for it in the **Select Layer** dialog box.

9. Click **OK**.

   Tekla Structures maps the selected layer to the rule.

10. Save the created layer rule settings for later use by entering a name next to the **Save as** button and clicking **Save as**.

    **NOTE** The order of rules is important. Organize the rules by right-clicking the rule, and selecting **Move up** or **Move down**. The objects are exported to the first matching layer. If there is no matching layer, the objects are exported as **Other object type**.

**Example: Create a rule for exporting beam marks to their own layer in drawing export (old export)**

You can export all kinds of drawing objects to layers of their own.

This example shows how you can do that for beam marks. All kinds of marks can be exported separately to their own layers: bolt marks, part marks, connection marks, neighbor part marks, reinforcement marks and component marks.

First you need to create a selection filter selecting the beams and then you can define the layer rule. Name the beam selection filter **Beams**.

1. On the **File** menu, click **Export --> Drawings**.
2. Go to the **Layer options** tab of the **Export Drawings** dialog box and click **Setup** next to the **Layer rules** box.
3. Under **Mark** in the **Drawing Export Layers** dialog box, select the layer rule of the mark you want to define to its own layer (part, bolt, connection, neighbor part, or reinforcement mark).

   Select **Part mark**.
4. Right-click **Part mark** and select **Add Next Level Rule** from the pop-up menu.

This opens the **Layer manager rules** dialog box.

5. Enter a rule name (for example, **BeamMark**) and select a filter that you have created (**Beam**).

![Layer manager rules dialog box](image)

6. Click **OK**.

Tekla Structures creates a new rule **BeamMark**. Now you can connect the new rule to a layer you have created for beam marks and use when exporting drawings.

**See also**

*Assign objects to layers in drawing export (old export) (page 205)*

**Copying export layer settings to another project (old export)**

If you want your layer settings to also be available in other projects, you can copy them to a firm or project folder.

1. On the **File** menu, click **Export --> Drawings**.
2. Go to the **Layer options** tab and click **Setup**.
3. Define the required rule and layer settings.
4. Enter a name for the layer rule settings file next to the **Save as** button and click **Save as**.
5. Copy the file `<your_layer_rule>.ldb` from the `\attributes` folder under the current model folder to the firm or project folder.

**See also**

*Assign objects to layers in drawing export (old export) (page 205)*

*Create layers in DWG/DXF files for drawing export (old export) (page 204)*

**Define customized line type mappings in drawing export (old export)**

You can use advanced conversion to convert the type, color and weight of lines and layers. This way you will get the line types that you want to use in the target software, for example, AutoCAD.
By default, Tekla Structures uses the file `LineTypeMapping.xml` in the folder `..\Tekla Structures\<version>\environments\common\inp` for the conversion.

If you need to define your own line type mappings, you can use the file `LineTypeMapping.xml` as a template.

**NOTE** When modifying the line type mappings file, use an editor that is capable of validating XML in order to maintain a valid document structure.

To define your own line type mappings, do one of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Map according to line types only | 1. Open the mapping file in an XML editor.  
2. Enter only the line type information.  
   For example, all lines in all layers with line type `XKITLINE01` will be exported to `DASHED`.  
3. Save the mapping file to the model folder. |
| Map according to line types and layers | 1. Open the mapping file in an XML editor.  
2. Enter the line type and layer name.  
   Define the layers that the mapping will apply to in the `LayerName` attribute.  
   If you leave out the attribute `LayerName`, Tekla Structures uses the line type mapping for any layer. If you include the attribute `LayerName`, Tekla Structures uses the line type mapping for that layer only.  
   For example, all lines on the layer `BEAM` with line type `XKITLINE01` will be exported to `DASHED`. Tekla Structures first searches for these kinds of mappings by default.  
3. Define the color of the line in the `Color` attribute. Enter the color values in AutoCAD Color Index |
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>(ACI) codes (numbers from 0 to 255).</td>
<td>4. Define the thickness of the line in the Weight attribute. Enter the values in hundredths of millimeters.</td>
</tr>
<tr>
<td></td>
<td>5. Save the mapping file to the model folder.</td>
</tr>
</tbody>
</table>
This is how the file LineTypeMapping.xml is composed:

```xml
<xml version="1.0" encoding="UTF-8" standalone="yes"/>
<!DOCTYPE Mapper []
<!ELEMENT Mapper (Mapping*)>
<!ATTLIST Mapper Version CDATA #REQUIRED>

<!ELEMENT Mapping (From, To)>
<!ATTLIST Mapping LayerName CDATA #IMPLIED>

<!ELEMENT From EMPTY>
<!ATTLIST From LineType CDATA #REQUIRED>

<!ELEMENT To EMPTY>
<!ATTLIST To LineType CDATA #REQUIRED>
<!ATTLIST To LayerName CDATA #IMPLIED>
<!ATTLIST To Color CDATA #IMPLIED>
<!ATTLIST To Weight CDATA #IMPLIED>

<Mapper Version="1.1">
  <Mapping LayerName="Part">
    <From LineType="XKITLEIN0"/>
    <To LineType="BYLAYER" Color="4" weight="100"/>
  </Mapping>
  <Mapping LayerName="Part">
    <From LineType="XKITLEIN0"/>
    <To LineType="HIDDEN2" LayerName="Part_Hidden" Color="8" weight="100"/>
  </Mapping>
  <Mapping LayerName="Part">
    <From LineType="XKITLEIN0"/>
    <To LineType="DASHED" LayerName="Part_DashLine" Color="12" weight="100"/>
  </Mapping>
  <Mapping>
    <From LineType="XKITLEIN0"/>
    <To LineType="continuous"/>
  </Mapping>
  <Mapping>
    <From LineType="XKITLEIN0"/>
    <To LineType="DASHED"/>
  </Mapping>
  <Mapping>
    <From LineType="XKITLEIN0"/>
    <To LineType="DASHEDX2"/>
  </Mapping>
  <Mapping>
    <From LineType="XKITLEIN0"/>
    <To LineType="DASHDOT"/>
  </Mapping>
  <Mapping>
    <From LineType="XKITLEIN0"/>
    <To LineType="DASHDOTX2"/>
  </Mapping>
  <Mapping>
    <From LineType="XKITLEIN0"/>
    <To LineType="CENTER"/>
  </Mapping>
</Mapper>
```

1. The first section consists of XML and document type definition. Do not change or remove this section.

2. The mappings that are available are defined here. You can use these mappings as a template for your own mappings.
Examples

In the first example, a new Mapping element is added, where XKITLINE00 lines in the Beam layer are converted to BORDER line type, color is converted to 10 and weight to 1.00 mm:

```xml
<Mapping LayerName="Beam">
  <From LineType="XKITLINE00"/>
  <To LineType="BORDER" Color="10" weight="100" />
</Mapping>
```

In the second example, a new Mapping element is added, where XKITLINE02 lines in the Part layer are converted to HIDDEN2 line type, the layer name is converted to Part_Hidden, the color is converted to 8 and weight to 1.00 mm.

You can use the LineTypeMapping.xml file for exporting hidden lines to separate layers. The hidden lines must then be defined to their own layers (here Part_Hidden).

```xml
<Mapping LayerName="Part">
  <From LineType="XKITLINE02"/>
  <To LineType="HIDDEN2" LayerName='Part_Hidden' Color='8' Weight='100'/>
</Mapping>
```

**NOTE** For the export to succeed, ensure that the layer (here Part_Hidden) exists on the list of available layers in the Modify Layers dialog box.

See also

Default line types in drawings (old export) (page 211)

**Default line types in drawings (old export)**

Default line types are available in Tekla Structures drawings. You can map default line types to customized line types, which are defined in TeklaStructures.lin and further exported to DWG/DXF files.

The table below lists the default line types and shows what they look like.

<table>
<thead>
<tr>
<th>Line type name</th>
<th>Line type appearance</th>
</tr>
</thead>
<tbody>
<tr>
<td>XKITLINE00</td>
<td>______</td>
</tr>
<tr>
<td>XKITLINE01</td>
<td>-----</td>
</tr>
<tr>
<td>XKITLINE02</td>
<td>---</td>
</tr>
<tr>
<td>XKITLINE03</td>
<td>----</td>
</tr>
<tr>
<td>XKITLINE04</td>
<td>..........</td>
</tr>
<tr>
<td>XKITLINE05</td>
<td>-------</td>
</tr>
<tr>
<td>XKITLINE06</td>
<td>-------</td>
</tr>
</tbody>
</table>
**Example: Set up layers and export to DWG (old export)**
This example shows how to define layers and export line types on a certain layer to their own sublayers in DWG export. The workflow consists of six tasks:

1. **Example: Create a selection filter for DWG export (old export)** (page 212)
2. **Example: Create layers for DWG export (old export)** (page 213)
3. **Example: Create a rule for drawing DWG export and assign a layer to the rule (old export)** (page 213)
4. **Example: Define a custom line type for DWG export (old export)** (page 214)
5. **Example: Define line types and weights for layers in DWG export (old export)** (page 215)
6. **Example: Export the drawing to DWG (old export)** (page 216)

**Example: Create a selection filter for DWG export (old export)**

Start by creating a selection filter. This task is phase 1 in the workflow **Example: Set up layers and export to DWG (old export)** (page 212).

To create a selection filter:

1. In the model, click the **Selection filter** switch.
2. In the **Object Group - Selection Filter** dialog box, click **New filter**.
3. Add new filter rules.
   a. Create a filter rule that select parts according to the name **Beam**.
   b. Create a filter rule that selects parts according to the material **S* (as in steel)**.
4. Save the filter as **steel-beam**.
Example: Create layers for DWG export (old export)

After creating a selection filter, you can continue by creating layers that you want to have in the exported DWG. This task is phase 2 in the workflow Example: Set up layers and export to DWG (old export) (page 212).

To create the layers you want to have in the exported DWG:

1. On the **File** menu, click **Export --> Drawings**.
2. Go to the **Layer options** tab.
3. Click **Setup** and then click **Modify layers**.
4. Click **Add** to add a new layer.
   
   Create separate layers for solid lines (**steel-beam-layer**) and hidden lines (**steel-beam-layer-H**) within steel beams.

5. Set the color for the layers.
   
   Set the solid lines to red and hidden lines to blue.

   - **steel-beam-layer-H**
   - **steel-beam-layer**

6. Click **OK** to accept the changes.
Example: Create a rule for drawing DWG export and assign a layer to the rule (old export)

After creating layers, you can continue by creating a rule to export an object group into a layer, and assign the layer to the created rule. This task is phase 3 in the workflow Example: Set up layers and export to DWG (old export) (page 212).

To create a rule to export an object group into a layer, and assign the layer to the created rule:

1. Right-click a model object part rule and select **Add Next Level Rule**.
2. Enter a name for the rule (**steel-beam-rule**) and select the selection filter you created for steel beams (**steel-beam**).
3. Click **OK**.
4. To assign a layer to a rule, double-click the row under the **steel-beam-rule** and select a layer, in this case **steel-beam-layer**.
5. Click **OK**.
6. Save the layer rule settings with the name **example1** using **Save as**.
7. Close the dialog box by clicking **OK**.
Example: Define a custom line type for DWG export (old export)

After creating a rule, you can continue by defining a custom line type for continuous lines in the exported DWG. In this example, you will add some line type definitions. This is phase 4 in the workflow Example: Set up layers and export to DWG (old export) (page 212).

To define a custom line type:

1. **Open the TeklaStructures.lin file in a text editor (..\ProgramData\Trimble\Tekla Structures\<version>\environments\common\inp).**

2. **Add the following line type definition in the file:**

   ```
   *HIDDEN, Hidden ______ ______ ______ ______ ______ ______ ______ ______
   A, 1.5875, -0.79375
   *HIDDEN2, Hidden (.5x) ______ ______ ______ ______ ______ ______ ______ ______
   A, 0.79375, -0.396875
   *HIDDENX2, Hidden (2x) ______ ______ ______ ______ ______ ______ ______ ______
   A, 3.175, -1.5875
   *PHANTOM, Phantom ______ ______ ______ ______ ______ ______ ______ ______
   A, 7.9375, -1.5875, 1.5875, -1.5875, 1.5875, -1.5875
   *PHANTOM2, Phantom (.5x) ______ ______ ______ ______ ______ ______ ______ ______
   A, 3.96875, -0.79375, 0.79375, -0.79375, 0.79375, -0.79375
   *PHANTOMX2, Phantom (2x) ______ ______ ______ ______ ______ ______ ______ ______
   A, 15.875, -3.175, 3.175, -3.175, 3.175, -3.175
   *CONTINUOUS, Continuous ______________________
   A, 3
   ```

3. **Save the file. Ensure that the file name extension does not change.**

Example: Define line types and weights for layers in DWG export (old export)

After defining a custom line type, you can continue by modifying the LineTypeMapping.xml file and defining the line types and weights. This task is phase 5 in the workflow Example: Set up layers and export to DWG (old export) (page 212).

To define the line types and weights:

1. **Open the LineTypeMapping.xml file (..\ProgramData\Trimble\Tekla Structures\<version>\environments\common\inp) in a text editor.**

2. **Add the line type mappings for the layers as shown inside the lower blue frame in the image below. Do not touch the lines inside the upper red frame.**

3. **Save the file. Ensure that the file name extension does not change.**
1. The lines are on the steel-beam-layer layer.

2. The lines are drawn with XKITLINE00 (solid lines).

3. The lines are exported to CONTINUOUS lines in DWG. The line color in DWG was already defined in the layer properties (red). The line weight in DWG is 35.

4. The lines are on the steel-beam-layer layer.

5. The lines are drawn with XKITLINE02 (hidden lines).

6. The lines are exported to DASHED lines into a separate layer called steel-beam-layer-H in DWG. The line color in DWG was already defined in the layer properties (blue). The line weight in DWG is 35.

Example: Export the drawing to DWG (old export)

After you have defined all the layer settings, you can continue by exporting the drawing. Before exporting the drawing to DWG, ensure that all the drawing
properties are as you wish. This task is phase 6 in the workflow Example: Set up layers and export to DWG (old export) (page 212).

To export the drawing:
1. Open the drawing that you want to export.
2. On the File menu, click Export drawings.
3. Enter a name for the export file.
4. Set the Type to DWG.
5. Go to the Layer options tab page and load the layer rule settings that you saved earlier with the name example1.
6. Select the following check boxes: Use advanced line type and layer conversion, Include empty layers and Object color by layer.
8. Go to the Options tab, set the scale for the export and select the Export objects as groups check box and, if you want to, Cut lines with text and Export custom lines as split lines.
9. Click Export.

Open the exported DWG with an applicable DWG viewer software. You can see that the solid lines of the steel beam are on one layer and the hidden lines are on another layer. You can also see that columns do not match with the layer rules you defined, so they are handled according to other rules.
See below for examples on how the selecting and not selecting **Cut lines with text** affects the result.

In the following example, **Cut lines with text** is selected.

![Cut lines with text selected](image)

In the following example, **Cut lines with text** is not selected.

![Cut lines with text not selected](image)

3.5 DGN

The DGN format has been used especially for data transfer between plant design programs. It was developed by MicroStation. It is similar to DWG in that it is only a graphical data format. It contains unique part IDs in the given model. It is possible to check for clashes between the Tekla Structures model and a DGN reference model.

This format has the following limitations:

- GUID is not supported.
- DGN reference model import does not support change management or UDAs.
- 3D DGN export supports parts only.

**See also**

Reference models and compatible formats (page 119)
Insert DGN files (page 219)
**Insert DGN files**

You can insert DGN files as reference models to Tekla Structures.

You can view DGN reference model objects on different reference model layers according to the level settings in the DGN file. You can use DGN models for clash checking. Tekla Structures reference model insert supports V7 and V8 DGN formats.

A DGN file may contain one or more DGN models. A DGN model can be one of the following three types: a design model, an extrusion model or a sheet model. Design models are most useful in Tekla Structures as they contain appropriate structural data.

If there are many model types available in a DGN file, Tekla Structures selects the inserted model type in the following order:

1. Active model is inserted if it is a design model.
2. Default model is inserted if it is a design model.
3. If DGN file contains design models, the first one is inserted.
4. If there are no design models in the DGN file, the first model regardless of the model type is inserted.

DGN reference model insert does not support UDAs or change management.

To insert a DGN file, open the Tekla Structures model where you want to insert the reference model, and click the **Reference Models** button in the side pane 🔄.

For details about the reference model import, see **Insert a reference model (page 121).**

**DGN objects supported in reference models**

Tekla Structures can display the following DGN objects in reference models:

<table>
<thead>
<tr>
<th>Object</th>
<th>Type no.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cell</td>
<td>2</td>
<td>A collection of grouped entities with a common insertion point/origin, scale and orientation in 2D/3D space.</td>
</tr>
<tr>
<td>Line</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>Line string</td>
<td>4</td>
<td>A series of interconnected lines.</td>
</tr>
<tr>
<td>Shape</td>
<td>6</td>
<td>Like a line string, but closed (first point = last point).</td>
</tr>
<tr>
<td>Object</td>
<td>Type no.</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Text node</td>
<td>7</td>
<td>A multi-line paragraph/block of text.</td>
</tr>
<tr>
<td>Curve</td>
<td>11</td>
<td>A parametric spline curve.</td>
</tr>
<tr>
<td>Complex chain</td>
<td>12</td>
<td>A chained collection of other entities (lines, line strings, arcs, curves or b-spline curves).</td>
</tr>
<tr>
<td>Complex shape</td>
<td>14</td>
<td>Like a complex chain, but closed (first point = last point).</td>
</tr>
<tr>
<td>Ellipse</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>Arc</td>
<td>16</td>
<td></td>
</tr>
<tr>
<td>Text</td>
<td>17</td>
<td>Supports TrueType fonts and text styles (bold, underline, italic, etc).</td>
</tr>
<tr>
<td>3D surface</td>
<td>18</td>
<td>Like a 3D solid, but not capped on the ends.</td>
</tr>
<tr>
<td>3D solid</td>
<td>19</td>
<td>The solid created by projecting or rotating from a boundary entity (line, line string, curve, arc or ellipse).</td>
</tr>
<tr>
<td>Cone</td>
<td>23</td>
<td>Actually a truncated cone described by two parallel circles; if the radius of both circles is the same, a cylinder is produced.</td>
</tr>
<tr>
<td>B-spline surface</td>
<td>24</td>
<td>See description of b-spline curves, which also applies here; additional data is provided by surface boundary entities (type 25).</td>
</tr>
<tr>
<td>B-spline curve</td>
<td>27</td>
<td>Can be rational/non-rational, uniform/non-uniform, open/closed; entity type 27 supplies header data and additional data is provided by pole entities (type 21), knot entities (type 26) and weight factor entities (type 28).</td>
</tr>
<tr>
<td>Shared cell definition</td>
<td>34</td>
<td>Similar to a DWG block definition; basically defines a set of grouped entities.</td>
</tr>
<tr>
<td>Shared cell instance</td>
<td>35</td>
<td>Similar to a DWG block instance; given a particular cell 'definition', numerous cell 'instances' can be created at differing locations, scales and orientations.</td>
</tr>
<tr>
<td>Object</td>
<td>Type no.</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Multiline</td>
<td>36</td>
<td>A set of parallel lines, which can be jointed (with or without visible seams at the joints), and have various types of end caps (rounded, square, etc.)</td>
</tr>
<tr>
<td>Mesh</td>
<td>105</td>
<td>Supports indexed face loops, quad list, quad grid, triangle grid and triangle list meshes.</td>
</tr>
<tr>
<td>Smart solid</td>
<td>-</td>
<td>Smart solids (solids created from embedded Parasolid/ACIS data) can be imported into Tekla Structures as wireframe outlines.</td>
</tr>
</tbody>
</table>

**Export to 3D DGN files**

You can export selected parts or the whole model to 3D DGN.

Note that 3D DGN export supports parts only.

1. Open a Tekla Structures model.
2. On the **File** menu, click **Export --> 3D DGN**.
   
   The **Export 3D DGN** dialog box opens.
3. In the **Output file** box, enter the name of the export file.
   
   If you want to replace an already existing file, click the ... button and browse for the file.
4. In the **Export** list, select **All objects**, or **Selected objects** and select the parts to export.
   
   It might be a good idea to filter out minor secondary parts, for example, curved parts from railings, if you do not need them in the exported DGN model. This decreases the export file size.
5. Click **Create**.

   Tekla Structures creates the <name>.dgn file in the current model folder.

In 3D DGN export, you can only export to the model origin. Changing the work plane has no effect to export.

If you have tubular parts in your model and you want to reduce the size of the DGN files or the complex display in the rendered views, you can use the following advanced options to control this:

- **XS_CHORD_TOLERANCE_FOR_SMALL_TUBE_SEGMENTS**
- **XS_CHORD_TOLERANCE_FOR_TUBE_SEGMENTS**

You can also use the following advanced options to control DGN exports:
3.6 LandXML

You can insert LandXML reference models to Tekla Structures. The supported contents of LandXML files are terrain models, line alignments of roads and railways, and rain water systems.

You can export files in .xml format from applications like Bentley InRoads, Autodesk Civil, and Trimble Business Center, and insert the .xml files in Tekla Structures as reference models. The LandXML format extends the capabilities of Tekla Structures to show merged models, including the infra models. Tekla Structures supports LandXML 1.2 schema and single-precision floating-point format.

A typical example of a building structure where LandXML can be used is the surface of the bedrock to be utilized when pile lengths are to be considered. LandXML can also be used when estimating the need of excavation. The LandXML format is important also for bridge and for civil structures design tasks.

An example of an imported LandXML reference model:

An example of layers in a LandXML reference model:
Limitations

The LandXML feature does not support all the possible data in the format. It supports the subset of the primitives defined in LandXML 1.2 schema, such as alignments, terrain models and pipe networks.

• Surfaces are not shown correctly in drawings.
• Triangle type of surfaces are only supported.
• There is no warning if the LandXML file contains unsupported data.

See also

Insert a reference model (page 121)
3.7 PDF
You can insert a PDF file as a reference model to your Tekla Structures model. During import, Tekla Structures converts the PDF into the DXF format.

Insert a PDF file to a model
1. On the File menu, click Import --> Insert PDF . 
The Insert PDF Reference Model dialog box opens.
2. Click Browse.
3. Browse for the PDF file and click Open.
4. Set the scale for the reference model.
5. Enter the number of the pages that you want to insert.
6. Click OK.
7. Pick a point to place the reference model.
   Tekla Structures converts the PDF into the DXF format. The conversion creates a DXF file for every inserted page. Tekla Structures saves the DXF files to the same folder where the PDF is.

Limitations
Only vector graphics are converted, not raster graphics.

3.8 SketchUp
You can export a Tekla Structures model to SketchUp in the .skp format.
Trimble SketchUp is a modeling software used in, for example, architecture, construction, engineering and landscape architecture. 3D Warehouse contains lots of SketchUp models that you can import as reference models to Tekla Structures.
You can insert Sketchup files as reference models to Tekla Structures. Tekla Structures supports Sketchup version 2019 and earlier in import. For more information about inserting reference models, see Insert a reference model (page 121).
You can export Tekla Structures models as .skp files to be used in SketchUp.
Export a model to SketchUp
1. Select the model objects to export.
   If you want to export all, you do not have to select anything. We recommend exporting large models in portions.
3. Browse for the Output file location and enter the file name.
4. On the **Advanced** tab, select the objects that you want to export.
5. Click **Create selected**.
   If you want to export everything, click **Create all**.

### 3.9 Point clouds

Point clouds are groups of measured points on the surfaces of objects created with 3D laser scanners, for example, Trimble 3D laser scanners. In construction, the point clouds are mainly used in renovation projects to define the building or structure that is to be renovated. They can also be used to get the exact position of existing machinery, pipework or landscape that need to be taken into consideration on the site. You can also use them to check execution by importing them as build points into a model to be compared to the design.

When you attach a point cloud to a Tekla Structures model, you can place it either by the model origin or a defined base point.

The original point cloud file is processed and cache files are created in the Potree format. The point cloud conversion occurs as a background process, and you can continue working with Tekla Structures meanwhile. Point cloud data is stored in the folder defined by the advanced option `XS_POINT_CLOUD_CACHE_FOLDER`. By default, the folder is `%LocalAppData%\Trimble\TeklaStructures\PointClouds`, for example, `C:\Users<user>\AppData\Local\Trimble\Tekla Structures\PointClouds`. It may be useful to use a network drive for the potree file in a project. The file will not be copied to the local computer. This advanced option is user-specific, and it is located in the **File Locations** category in the **Advanced Options** dialog box.

If the same point cloud is used in several models, it will not be converted again or duplicated when you attach it. If point clouds are identical, the existing converted file is used, otherwise the file is converted.

In Tekla Structures, point clouds have colors if the original file format supports colors.

Point clouds can be seen in both the OpenGL model view and in the DX model view. The DX model view with perspective projection may give better visual result. Performance with bigger amount of data and/or larger number of views may make DX usage impossible.

**Compatible file formats**

- **ASCII (.asc, .xyz)**
- **E57 (.e57)**
- **LAS (.las)**
- **LAZ (.laz)**
PTS (.pts)
PTX (.ptx)
Potree (.js)
Trimble scan format (.tzf)

Limitations

• Some basic Tekla Structures model handling functionalities are not available, such as select, undo, move, rotate, copy, and pop-up menu on right-click.
• Point clouds are not autosaved.
• You cannot delete a point cloud from the point clouds list using the keyboard button Delete.
• Point clouds are not visible in drawings.
• Point clouds are not shared in Tekla Model Sharing or in multi-user mode.
• For the file formats ASCII, PTS: On each text line, the first three fields must be: x y z. For colored point data, the last three fields must be: r g b

Attach a point cloud to the model

1. Click the Point clouds button in the side pane.

2. If you want to place the point cloud inside the work area, select the Show inside work area only check box.

3. Click Attach.


5. Change the point cloud scale, if needed.
6. In **Location by**, select **Model origin** to place the point cloud in the model origin, or select a base point to place the point cloud in the real world coordinates.

**NOTE** If you do not know the coordinate system of the point cloud, select **Auto-created base point** to get the point cloud near the model origin. Automatic base point with point cloud bounding box min x, min y, and min z coordinates will be created in Tekla Structures origin.

7. Click **Attach point cloud**.

8. To show the point cloud in the model, select the model view where you want to show it, and click the eye button next to the point cloud in the list.

   Note that when you select a model view, it has a yellow frame.

   When the point cloud is set visible in the model view, you can see the min x, min y, and min z coordinates of the point cloud bounding box on the status bar.

   To hide the point cloud, click .

When you are modeling, you can snap to points for modeling and measuring distances. You can use clip planes in point clouds to exactly show what you want, for example, clip off the roof and some of the floors so that you can see the bottom floor of the building, and everything there that needs your attention in the planning phase. You can also use the **Clipper tool** in Tekla Warehouse for handling several clip planes at a time, and split the model to smaller pieces for visualization and modeling.

**Detach a point cloud from a model**

- To detach a point cloud, click **Detach** next to the point cloud name in the **Point clouds** list. Then reopen the model or save the model.

  Note that you cannot detach the point cloud by pressing **Delete** on the keyboard.

  The point clouds are cached to the default location or to the location specified by the user. When a point cloud is no longer used in any Tekla Structures model, it is cleaned from cache.
Set the default maximum point count in a view

You can use the advanced option XS_SET_MAX_POINT_CLOUD_POINT_COUNT to set the default maximum value for the points in a view. The default value is 10 000 000 (10 million).

This advanced option is system specific, and it is located in the Model View category of the Advanced Options dialog box. Restart Tekla Structures if you change the value.

Clip point clouds and reference models only

Set the user-specific advanced option XS_DO_NOT_CLIP_NATIVE_OBJECTS_WITH_CLIP_PLANE to TRUE to only clip point clouds and reference models with the Clip plane command. Native Tekla Structures objects are not clipped. FALSE is the default value. This advanced option is located in the Model View category in the Advanced Options dialog box.

Redraw the model views after changing the value.

Point cloud example

In the first image below, a point cloud has been attached to a model in a plan view. Remember to select a model view and click the eye button , otherwise the point cloud will not be shown.
In the next image, the clip plane tool has been used to cut off floors and other structures:
In the next image, a section has been cut to be used in a section view:
The last image shows the section view:
Share point clouds with other users
Point clouds are normally so large in file size that it is not sensible to share the point cloud as a part of the model data. Point cloud is not structural domain data but project data that is not a part of the model, and therefore it is not dependent on the model save. However, there is need for multiple persons to use the same point cloud model efficiently. You can use the potree file for sharing the point cloud. The best practices in sharing the point cloud potree file among model users are explained below. You first need to create the potree file and copy the potree file to a shared location, and then other users can attach it to their Tekla Structures model.

Create a potree file

Option 1: With Tekla Structures
1. Create a potree file by attaching a point cloud model to a Tekla Structures model.

   The potree file is created to the folder defined by the advanced option XS_POINT_CLOUD_CACHE_FOLDER. The potree file is named as <potree_name>.db, and it has a folder with the same name. For example:
2. Copy both the `<potree_name>.db` file and the related folder to a shared location. You can rename the model if you want, in which case you also need to rename the folder.

**NOTE** Do not replace existing potree data, especially if it is used by other users.

**Option 2: With Point cloud manager**

You can download **Point cloud manager** from Tekla Warehouse.

For detailed instructions about using **Point cloud manager**, see the **Point cloud manager** help. You can open the help by clicking the help button.

To use the **Point cloud manager**:

1. Install the application, and start it from the start menu or start screen, depending on your Windows version.
2. Set the root folder for the project, for example `C:\Trimble\PTRS`.
3. Click the **Add new project** button to create a project with a given name. This name will be the name of the potree database and potree folder.
4. Import one or more point cloud models by clicking **Add file**, and browsing for the point cloud file.

5. When the point cloud has been imported, create the potree by clicking...

![Add new project window](image)

![Point Cloud Manager](image)
6. Copy the `<potree_name>.db` and the `<potree_name>` folder to a shared location. Attaching a potree requires both the `<potree_name>.db` and the `<potree_name>` folder.

![File system screenshot showing `mypotree` and `mypotree.db`]

**NOTE** Do not replace existing potree data, especially if it is used by other users.

**Attach a potree from a shared location**

1. Open Tekla Structures and the **Point clouds** pane from the side pane.
2. Browse to the point cloud folder (e.g., `mypotree` in the example above) and select the point cloud `.js` file. Then follow the instructions above for attaching the point cloud.

![Attach point cloud dialog box]

### 3.10 Layout manager

Use **Layout manager** to import and export layout data between Tekla Structures and a field layout device, such as Trimble® LM80. **Layout manager** enables you to use accurate model data on the construction site.

When you wish to import and export layout data, we recommend that you first set up groups in **Layout manager**, then model the layout points and layout...
lines, and organize them in the groups. The points and lines are used in a layout device on the construction site to position parts correctly.

Once you have defined and organized the layout data, you can export the data from **Layout manager** to a field layout device in three different export formats: point file (`.txt`), job file (`.cnx`), and Trimble Field Link file (`.tfl`).

You can check and measure the positions of the exported layout points (design points) on the site using a field layout device. The layout device helps you to position the parts correctly on the site, because then the points along the part boundaries can be placed to the correct locations. To place the part boundaries correctly, measure the as-built positions of the parts on the site and create measured points along the part boundaries.

When you have measured the as-built positions and created measured points, you can import the points to Tekla Structures. You can first preview the points in **Layout manager**. Finally, you can view the measured points in the model.

To import and export directly with a handheld mobile device, such as Trimble® LM80, you need to connect your computer to the device. Your computer needs to have software that enables it to communicate with a mobile device. For information on how to connect your computer to Trimble layout devices, see the Trimble website.

**See also**

- Set up groups in Layout manager (page 236)
- Create a layout point (page 241)
- Create a layout line (page 242)
- Export layout data from Layout manager (page 243)
- Import layout data to Layout manager (page 246)
- Example: Base point use in Layout manager (page 251)

**Set up groups in Layout manager**

You can create groups in **Layout manager** to organize layout points and layout lines suitably.

**Base points in Layout manager**

You can use base points in **Layout manager** when defining the location of layout points. You can use the base points that have already been defined in the model, and you can define new base points in **File --> Project properties --> Base points**. **Layout manager** uses the **Location in the model**
coordinates that you define for base points, and the **East coordinate**, **North coordinate**, and **Elevation** coordinates.

<table>
<thead>
<tr>
<th>Name</th>
<th>Trimble Building</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Trimble Building in Espoo, Finland</td>
</tr>
<tr>
<td>Coordinate system</td>
<td>ETRS-GK25</td>
</tr>
<tr>
<td>East coordinate (E)</td>
<td>25489283613.00</td>
</tr>
<tr>
<td>North coordinate (N)</td>
<td>6674830501.00</td>
</tr>
<tr>
<td>Elevation</td>
<td>3557.00</td>
</tr>
<tr>
<td>Latitude</td>
<td>60.186171</td>
</tr>
<tr>
<td>Longitude</td>
<td>24.806864</td>
</tr>
</tbody>
</table>

When you add, modify, or delete base points in **File --> Project properties --> Base points**, reopen or refresh **Layout manager** to ensure that the base point data is up to date in **Layout manager**.

- The base points that you add are shown in the **Group local coordinate system** list for the groups in **Layout manager**.
- If you delete a base point that is linked to a group in **Layout manager**, Tekla Structures recreates that base point so that it can still be used in **Layout manager**.
- If you modify a base point that is used in **Layout manager**, Tekla Structures shows a message about the base point use in **Layout manager**. You can either use the modified coordinates in **Layout manager**, or you can select not to use them. If you select not to use them, the coordinates of the base point will then be different in Tekla Structures and in **Layout manager**.

When you open an existing model in a Tekla Structures version where **Layout manager** uses the base point functionality, **Layout manager** creates base points based on the group local coordinate systems that are not in the model origin [(0,0,0) & no rotation]. The created base points are added to the groups
in **Layout manager** and shown in the **Group local coordinate system** list. The base points are also shown in the list of base points in **File --> Project properties --> Base points**. The description text in the **Base point** dialog box shows that the base point has been created by **Layout manager**.

**Define a default coordinate system for groups**

You can define a default base point to set the default coordinate system for all the new groups that you create in **Layout manager**. You can use the groups in **Layout manager** to organize layout points and layout lines.

1. On the **Manage** tab, click **Layout manager**.
2. In **Layout manager**, select **Layout Manager Object Group** to show the available **Group local coordinate system for new groups** list.
3. Select from the list the base point that you want to use, or the model origin.

![Layout Manager](image)

The base points that have been defined in the model are available in the list. If you have added new base points to the model since you opened **Layout manager**, reopen or refresh **Layout manager** to make the new base points available in the list.

You can change the group default coordinate system at any time by selecting another option from the list. Note that the default coordinate system only applies to new groups. The existing groups are not changed.

**Define numbering settings for groups**

You can define that all groups in **Layout manager** have the same numbering settings. When you change the settings, the changed settings are used in all the groups that you create after the change. The settings in the existing groups are not changed.

1. On the **Manage** tab, click **Layout manager**.
2. Click 📋 to open the settings and then click **Group**.
3. Define the numbering settings.
   a. Enter the prefix in the **Prefix** box.
   b. Enter the starting number in the **Starting number** box.
c. Enter the maximum length of the number in the **Number max length** box.

d. Enter a delimiter to separate the prefix and the number in the **Delimiter** box: a hyphen or an empty space.

e. Select from the **Fill leading space** list whether the leading space in front of the number is filled with zeroes or not, for example, PFX 00001 or PFX 1.

4. Click **OK**.

5. To apply the numbering settings to the points and lines in a group, right-click the group and select **Auto Naming**.

---

**NOTE** You can modify the numbering settings of an individual group if you do not want to use the default settings. Select the group and change the settings. To restore the default settings, click **Reset**.

---

**Create a group in Layout manager**

1. On the **Manage** tab, click **Layout manager**.

2. Right-click **Layout Manager Object Group** and select **Add Group**.
   
   You may want to set up several groups so that you can organize the points and lines into groups as they are modeled. You can have a maximum of 255 groups in **Layout manager**.

3. If needed, click the group to rename it.
   
   A group name can have 18 characters.

4. Define the numbering settings for the group.

5. Select the **Group local coordinate system**.
   
   The coordinates are immediately applied when selected.
   
   If you do not want to use the default base point, you can select some other suitable base point, or the model origin.
When you have selected a coordinate system for the group and added layout points to it, you can view the location coordinates of the points in Layout manager. Select the point in Layout manager to show the coordinates of the point in Layout manager.

• **Location in the model** shows the point location compared to the model origin.

• **Location in the group** shows the point location compared to the group local coordinate system.

• **East, North, Elevation** shows the coordinates that represent the corresponding X, Y and Z coordinates.

**NOTE** Layout manager may show an Unassigned group in the tree structure. The Unassigned group shows layout points and layout lines that have inadequate group information. Such points and lines have usually been created in an earlier Layout manager version.
Create a layout point

Use the Layout Point tool in the Applications & components catalog to create layout points. The layout points that you create in the model are design points that you can export to a layout device, such as Trimble® LM80.

Before you start, ensure that the Select components selection switch is activated.

1. In the Applications & components catalog, double-click the Layout Point tool.

2. Define the layout point properties on the Parameters tab:
   a. Enter a name and a description for the layout point.
      You can use the following special characters in layout point names: _ ~ % ! @ # & . = + - and space.
      Note that the maximum length of the name is 16 characters if you export layout data to .cnx and .tfl formats. When exporting to a text file, there is no limitation in the number of characters in the name. The maximum length of the description is 24 characters.
   b. Enter the diameter of the layout point in the Size box.
      Layout manager uses the XS.IMPERIAL advanced option to determine the units. Set XS.IMPERIAL to TRUE to show imperial units.
   c. Select whether the layout point is a reference point or not.
      A reference point is a mapping point to another coordinate system, such as a geo-spatial coordinate system or a municipal monument.
   d. Select a color for the layout point.
   e. Select a shape for the layout point.
   f. Select a group from the list or create a new group by entering a name.

   For imported points, Is Stakeout Point shows if the point is a measured point as staked in the Trimble® LM80 device if it deviates from the corresponding layout point created in the model. Is Field Point shows if a point is a field point that has been measured on the construction site and imported to Tekla Structures.

3. Select a location for the layout point in the model.
   The layout point is created when you select the location.

4. On the Manage tab, click Layout manager.

5. Click Refresh to show the added point.
TIP You can also add a layout point to a group in Layout manager. First select a group, then select the point in the model. Right-click the group and select Add Selected. Click Refresh to show the point.

TIP To zoom to a layout point in the model, right-click the point in Layout manager and select Zoom Selected.

To highlight a layout point in Layout manager, click in Layout manager and select Highlight selected model point. Select Redraw to remove the highlighting.

See also
Set up groups in Layout manager (page 236)

Create a layout line
Use the Layout Line tool in the Applications & components catalog to create layout lines. Layout lines are created between layout points.

Before you start, ensure that the Select components selection switch is activated. Create layout points in your model.

1. In the Applications & components catalog, double-click the Layout Line tool.
2. Define the properties of the layout line:
   a. Enter a name and a description for the layout line.
   b. Enter the diameter of the layout line in the Size box.
      Layout manager uses the XS_IMPERIAL advanced option to determine the units. Set XS_IMPERIAL to TRUE to show imperial units.
   c. Select a color for the layout line.
   d. Select a group from the list or create a new group by entering a name.
      Is Field Line shows if a line is a field line that has been measured on the construction site and imported to Tekla Structures.
3. Pick the first layout point.
4. Pick the second layout point.
   The start point and the end point cannot be in the same location.
   The layout line is created.
5. On the Manage tab, click Layout manager.
6. Click **Refresh** to show the added line.

**TIP** You can also add a layout line to a group in **Layout manager**. First select a group, then select the line in the model. Right-click the group and select **Add Selected**. Click **Refresh** to show the line.

**TIP** To zoom to a layout line in the model, right-click the line in **Layout manager** and select **Zoom Selected**.

To highlight a layout line in **Layout manager**, click **** in **Layout manager** and select **Highlight selected model point**. Select **Redraw** to remove the highlighting.

**See also**
- Set up groups in **Layout manager** (page 236)
- Create a layout point (page 241)

**Export layout data from **Layout manager**

You can use **Layout manager** to export layout data from your model to a layout device, such as Trimble® LM80.

**Export layout data**

You have two options when exporting:

- Export the layout data from **Layout manager** to a file and move the file later to a layout device.
- Export a file directly to a layout device. You can do this if you connect the layout device to your computer using a USB, or a Bluetooth connection.

Before you export, you can define the default export settings in **Layout manager** settings.

1. On the **Manage** tab, click **Layout manager**.
2. Check from the settings that the default export settings are as intended.
3. Select the **group** that you want to export.

   The points in the group are exported according to the group local coordinate system. The local coordinates of the points are shown in the export dialog box. The temporary work plane location will not affect the coordinates of the exported points.
4. Click and select the appropriate file type for the export.
   - **Export point file (.txt)** to export layout points (page 241).
   - **Export job file (.cnx)** to export all layout data in the model to Trimble® LM80.
   - **Export Field Link file (.tfl)** to export all layout data in the model to a Trimble Field Link device.

Note that in addition to Trimble devices, other layout devices can also read in the .txt and .cnx file types.

**NOTE** The layout points that you create in the model are design points that you can export to a layout device.

The maximum length of the layout point name is 16 characters if you export layout data to .cnx and .tfl formats. When exporting to a text file, there is no limitation in the number of characters in the name. The maximum length of the description is 24 characters.

5. Select the destination folder and enter a name for the export file.

6. Select the coordinate system for the export from the **Export local coordinate system** list.
   - If you are exporting one group, the Export local coordinate system list shows the base point of the group. You can change the coordinates by selecting another option from the list.
   - If you are exporting more than one group and the groups do not have the same local coordinate system, the Export local coordinate system list shows the text: **Local coordinate systems of groups**. If you use this option in the export, each group uses the base point that has been defined for it.

   You can also use one base point for all the groups in the export by selecting the coordinate system from the Export local coordinate system list.

7. If needed, select a drawing in **Map file (.dxf)**.

   You can attach a layout drawing when exporting a job file (.cnx) and a Trimble Field Link file (.tfl). You can use the layout drawing with the layout point data in the layout device. To ensure that the drawing is exported correctly, you need to define the drawing scale.

8. Click **Export** to export.
Define default export settings

You can define the default export settings for each export file type: point file (.txt), Trimble LM80 job file (.cnx), and Trimble Field Link (.tfl). The units depend on the settings in File menu --> Settings --> Options --> Units and decimals.

1. On the Manage tab, click Layout manager.
2. Click 🔄 to open the settings.
3. Click Point File to define the export settings for point files (.txt):
   a. Select the unit.
   b. Select the delimiter.
   c. Define the order of column headers in point files. Right-click a header in the list and select Move Up or Move Down.
4. Click Trimble LM80 to define the export settings for Trimble® LM80 job files (.cnx):
   a. Select the Default directory.
   b. Select the default Length unit.
      You can select to export as meters, feet-inches, or survey feet.
   c. Select the plane Angle unit.
      The default angle unit is Degree.
   d. Select the Version of the Trimble® LM80 device.
      The default version is V4. Ensure that the setting matches the version of your layout device.
5. Click Trimble Field Link to define the Trimble Field Link file default directory (.tfl).
6. Click OK.

Define the drawing scale

You can include a drawing when exporting all layout data in a job file or a field link file from Layout manager by adding the drawing to the Map file (.dxf) box in the export dialog box. The drawing is exported in the .dxf or .dwg format. To ensure that the drawing is exported correctly, you need to define the drawing scale.

1. Create a general arrangement (GA) drawing of your model.
   We recommend that you make the drawing as simple as possible, only include parts and grids to show the drawing correctly in a layout device. You might want to create a drawing layout especially intended to be used in Layout manager export.
2. Open the drawing that you are going to use as a drawing layout.
3. Double-click the drawing view frame to open View Properties.
4. Copy the drawing scale.
5. Close the drawing.
6. On the Manage tab in the model view, click Layout manager.
7. Click Drawing Scale Calculator.
8. Enter the drawing scale in the Scale Denominator (e.g. 48, 128) box.
9. Click Calculate.
   The drawing scale is shown in the Scale box.
10. Copy the drawing scale from the Scale box and close the Drawing Scale Calculator dialog box.
   Tekla Structures opens the Document manager dialog box and the Export drawings to DWG/DXF dialog box.
12. In the Document manager dialog box, select the drawing that you want to export.
13. In the Export drawings to DWG/DXF, do the following:
   a. In File location, select the export folder.
   b. Select the Drawing as snapshot to CAD model space check box.
   The Scale box is shown.
   c. Enter the drawing scale in the Scale box.
14. Click Export.

Import layout data to Layout manager
You can use Layout manager to import layout data to your model from a layout device, such as Trimble® LM80, to verify the as-built conditions.

Import layout data
You have two options when importing:
• Copy the file that contains the layout data from the layout device to your computer and import the file later to Layout manager.
• Import the file directly to Layout manager. You can do this if you connect the layout device to your computer using a USB, or a Bluetooth connection.

1. On the Manage tab, click Layout manager.

2. In Layout manager, click Import.
3. Select the appropriate import file option.

- **Import point file (.txt)** to import layout points (page 241).
  Point files (.txt) are always imported to the Design Points tab, regardless of whether they have been measured on the site or not.

- **Import job file (.cnx)** to import all layout data in a Trimble® LM80 job file.
  Job files (.cnx) are imported to the Measured Points tab.

- **Import Field Link file (.tfl)** to import all layout data in a Trimble Field Link file.
  Trimble Field Link files (.tfl) import both design points that have been exported from Tekla Structures originally and measured points that have been measured on the site. In the import dialog box, a design point is flagged 🟢 if the point name and therefore, the point already exists. We recommend that you do not import an existing design point. Clear the check box next to the flag to exclude an existing point from the import 🟢.

4. Select the file to import.
   When you select a file, a new group that is named with the file name is created. You can have a maximum of 255 groups in **Layout manager**.

5. Select the **group (page 236)** to which the layout data is imported, or click **New** to create a new group.
   Job files (.cnx) and Trimble Field Link files (.tfl) may contain layout point groups. If there are groups in these files, the groups are shown in the list of groups that you can select in the **Group** list.

6. Check the group local coordinates.
   The **Group local coordinate system** shows the group coordinate option that you have selected. You can change the coordinates by selecting another option from the list.
   If you select the group that has the import file name, the default coordinate system for groups defined in **Layout Manager Object Group** is used.

7. Click **Show** to show the contents of the import file.

8. If needed, define the point file columns in the **Text File Import - Column Headers Mapping** dialog box.

9. Click **Import**.

---

**NOTE**  Design points are layout points that have been created in the Tekla Structures model. Measured points are layout points that have been measured on the construction site.
**Define point file columns**

You can import layout points to your model in a point file that lists the layout point names and the point coordinates. If the point file does not have a header, or if **Layout manager** does not recognize the header, the **Text File Import - Column Headers Mapping** dialog box is displayed when you click **Show** to show the file contents in the import dialog box.

Example of a point file without a header:

```
Layout point 6, 0, 13.12336, , 0
Layout point 5, 0, 6.56168, , 0
Layout point 4, 4.92126, 0, , 0
Layout point 3, 9.84252, 6.56168, , 0
Layout point 2, 4.92126, 13.12336, , 0
Layout point 1, 9.84252, 13.12336, , 0
Layout point, 9.84252, 0, , 0
```

In the **Text File Import - Column Headers Mapping** dialog box, the content of the point file is shown at the bottom and the column headings are shown at the top.

1. Check that the point file content is shown under the correct column headings:
   - **Name Column** shows the layout point name.
   - **X Column** shows the x coordinates.
   - **Y Column** shows the y coordinates.
   - **Z Column** shows the z coordinates.
2. If needed, change the columns at the top of the dialog box by selecting the correct column from the list.

3. Select a measuring unit.

4. Select in the **Process first line** setting whether the first line in the point file is a header row or not.
   - **Yes** means that the first line has layout point data and that it is not a header line.
   - **No** means that the first line is a header line.

5. Click **OK**.

**Measured points in Layout manager**

Measured points are points that are measured on the construction site using a layout device and imported to Tekla Structures. You can view the properties of
measured points in **Layout manager** or in the **Layout Point** tool dialog box. In addition to the general point properties, such as name, diameter, and shape, the measured points have measured point properties that cannot be modified in Tekla Structures.

To view the measured point properties, select the point in **Layout manager** or double-click the point in the model.

The measured point properties are as follows:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Is Stakeout Point</strong></td>
<td>You can label a measured point as staked in the Trimble® LM80 device if it deviates from the corresponding layout point created in the model. The property is shown in the <strong>Layout Point</strong> tool dialog box.</td>
</tr>
<tr>
<td><strong>Is Field Point</strong></td>
<td>A field point has been measured on the construction site and imported to Tekla Structures. <strong>Is Field Line</strong> is the corresponding property for layout lines. The property is shown in the <strong>Layout Point</strong> tool dialog box.</td>
</tr>
<tr>
<td><strong>HR</strong></td>
<td>Height of rod is the height of the prism on the pole. It is used to determine instrument height, and therefore the actual elevation of the measured point.</td>
</tr>
<tr>
<td><strong>HA</strong></td>
<td>Horizontal angle is the angle that was measured from the back sight, or 0 angle.</td>
</tr>
<tr>
<td><strong>VA</strong></td>
<td>Vertical angle is the difference in angle measurement from the horizontal position of the instrument scope.</td>
</tr>
<tr>
<td><strong>SD</strong></td>
<td>Slope distance is the actual distance regardless of elevation change. Horizontal angle is the distance along a horizontal plane.</td>
</tr>
<tr>
<td><strong>PPM</strong></td>
<td>Parts per million is a factor used to determine measurements that take into account the air conditions and how they affect the ability of light to travel through the air. This property is</td>
</tr>
</tbody>
</table>
### Property Description

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Benchmark offset</td>
<td>Benchmark offset is a measurement that defines a benchmark that elevation measurements are calculated from.</td>
</tr>
</tbody>
</table>

**Example: Base point use in Layout manager**

This example shows different model views that contain a layout point, control point, and civil origin in the model. The civil origin is the datum point, or the fundamental benchmark point of the national land survey network.

1. Create a control point in **File --> Project properties --> Base points**.

2. Create a layout point (page 241) by using the **Layout Point** tool, and add the layout point to the model.
The image below shows the point locations in a 3D model view.

- The green point in the bottom-left corner is the civil origin. Note that the **East coordinate** and **North coordinate** are not in scale here.
- The blue point is the control point, that is, the base point that you created.
- The red cone is the layout point, in the image framed with a yellow square.
- The green box is the model origin at the grid intersection A-1.

3. In **Layout manager**, add the layout point to a **group** (page 236). Select the base point that you created, **Control point 1**, to be used as the **Group local coordinate system** of the group.

4. Check the coordinates of the layout point.
   - **Location in the model**: the distance to the model origin.
   - **Location in the group**: the distance to the base point selected for the layout point group.
   - **East, North, Elevation**: the distance to the civil origin.
The images below show different views and measurements of the points in the model.

**Elevation view**

**Plan view**
5. **Export the layout point (page 243).**

The X, Y and Z coordinates in the export dialog box are the **East, North, Elevation** (X, Y, Z) coordinates that you can view in **Layout manager** point properties. These coordinates are exported.
3.11 Analysis and design systems

Analysis and design systems are used to design and analyze the frame or components within a structure. These applications calculate the loading, stresses and strains on the elements. They also calculate the moments, shears and deflections on objects under various loading conditions.

These types of applications make use of various forms of analysis from the traditional first order static, second order p-delta, geometric non-linear or buckling analysis. They can also make use of various forms of dynamic analysis from modal extraction to time history and response spectrum analysis along with the sizing of steel, concrete and timber elements to the relevant national and international design codes.

Some examples of these systems are Tekla Structural Designer, ETABS, STAAD.Pro, SAP2000, Robot, ISM, S-Frame, MIDAS, Dlubal, SCIA, Powerframe, GTStrudl, Strusoft, and AxisVM.

See also

Analysis and design direct links (page 255)
Tekla Structural Designer (page 256)
STAAD.Pro (page 263)
SAP2000 (page 262)
Robot (page 262)
ISM (page 263)
S-Frame (page 264)
FEM (page 265)

Analysis and design direct links

When you have a direct link to an analysis and design application, and you export the analysis model from Tekla Structures using that particular analysis application, the model is opened in the application. Tekla Structures and the analysis and design application need to be installed on the same computer.

The analysis and design direct links are created either using the Tekla Open API or the older COM link (Common Object Model transfer technology). A number of direct links are available including AxisVM, Diamonds, Dlubal, ETABS, GTStrudl, ModeSt, MIDAS, NISA, Powerframe, ISM, Robot, SAP2000, SCIA, S-Frame, STAAD.Pro, STRUDS, and Strusoft.

Many of the direct links are available for downloading in Tekla Warehouse. For the applications that are not available in Tekla Warehouse, the links can be downloaded from the vendor web sites or by contacting the vendor.
Tekla Structural Designer

Tekla Structural Designer is a software that allows you to design reinforced concrete buildings and steel buildings. It works with real physical objects such as beams, columns and slabs. The information transferred is the physical information such as geometry, section sizes and grade as well as attributed data. In Tekla Structures, you can import from and export to Tekla Structural Designer.

Tekla Structural Designer is a code-based modeling tool, which enables structural engineers to establish a code compliance design of the structure, and perform calculations and schema design, for example. All the design/code data is held within Tekla Structural Designer at all times.

Tekla Structural Designer will analyze and design structures to a range of International codes of practice.

The initial model can be started in either Tekla Structures or Tekla Structural Designer, depending on the project needs. You can import and export many times, and make use of the effective change management functionality.

The integration process allows you to pass models between Tekla Structural Designer and Tekla Structures, allowing the updates in the model at both ends. As the model is integrated between software applications, the changes are updated, and modifications performed since the last integration operation are maintained within the model.

Tekla Structural Designer and Tekla Structures accept and produce files in the .cxl neutral file format. The .cxl file format is an XML based neutral file format that allows applications to link Tekla Structural Designer.

Tekla Structures supports files created in Tekla Structural Designer 2016 or later.

This section only contains instructions regarding import (page 258) and re-import (page 260) from Tekla Structural Designer, and export (page 260) to Tekla Structural Designer. For more information about Tekla Structural Designer and the integration between Tekla Structural Designer and Tekla Structures, see Guidance notes for Integration between Tekla Structural Designer and Tekla Structures. This page contains a link to "Integration with Tekla Structures" guide in .pdf format.

Also take a look at other related information in Tekla User Assistance for Tekla Structural Designer:

Getting started guides
Product guides
Knowledge base articles
Videos
**Example workflow of integration between Tekla Structures and Tekla Structural Designer**

Integration between Tekla Structures and Tekla Structural Designer has been developed to ensure that the initial model can be started in either tool without any detriment to the design process. This added flexibility enables companies to align their software solutions closely to their own workflows. (i.e. The initial model can be created in Tekla Structural Designer by the engineer or in Tekla Structures by the technician.)

It is recommended that Tekla Structures model is used as the "master model" for geometrical changes as this model also is linked to the BIM documentation. Alterations made to the model geometry are best handled by altering the Tekla Structures model and transferring the changes through to Tekla Structural Designer for redesign.

A typical workflow and the decision making process through the different stages of a project could be as follows:

**Initial scheme stage**
- The initial model may be started in Tekla Structures or Tekla Structural Designer without any detriment to the process.
- A number of factors may determine which software is used for starting the modeling process, such as availability of staff, or deliverable requirements.
- Unless there are external drivers, Tekla Structures may prove to be the best starting point for the model as it can provide most of the deliverable items at the initial stage.
- The model does not need to cover the complete building, it might be a typical bay or floor, for example.
- The generated structure can be designed in Tekla Structural Designer for initial section sizing at the initial stage and synchronized back to Tekla Structures for initial drawings or material list creation.
- Simple drawings can be created at this stage, this can be done in Tekla Structures or Tekla Structural Designer.
- Initial material lists for cost estimates can be generated at this stage.

**Detailed design stage**
- It is not always appropriate to carry models forward from the Initial scheme stage to the Detailed design stage as changes to the overall scheme may have been made, which will not be reflected in the initial scheme model. It is sometimes better to begin the model again.
- Models can be started in Tekla Structures or Tekla Structural Designer to suit the user. The models can then be transferred to the other modeling system.
- Importantly, the two models can be worked on at the same time, with synchronization of the two models taking place to suit the workflow.
• Tekla Structural Designer can be used for a full gravity and lateral design of the structure.
• Within Tekla Structures, drawings can be generated to a tender stage level and general arrangements submitted to building control for approval.

**Construction stage**
• Using the model from the *Detailed design stage*, much of the *Construction stage* process will take place in Tekla Structures so that the integration with other disciplines can be accounted for.
• The design is not revisited unless the client drives the requirement for change.
• If a re-design of the structure is required, the same synchronization of Tekla Structures or Tekla Structural Designer models can be carried out to suit the user.
• The model will be completed within Tekla Structures and fully detailed drawings for parts can be created along with construction level arrangement drawings of the structure.
• Detail integration checks with other disciplines (e.g. mechanical and electrical engineers) can be carried out at this stage.

**Import from Tekla Structural Designer**
Import from Tekla Structural Designer creates Tekla Structures parts, such as beams, columns, slabs, and shear walls based on the contents of the imported `.cxl` neutral file.

Before importing, open Tekla Structures and the model where you want to import.

1. On the **File** menu, click **Import --> Tekla Structural Designer**.
2. In the import dialog box, enter the path of the import `.cxl` file in the **Import file** box or click the ... button next to the box to browse for the file.
3. Once you have selected a valid file, the import buttons and the **Preview Conversion** button will be enabled. To read the import file and display all the proposed profile and material grade conversions to be used, click the **Preview Conversion** button.
   
   The import uses an internal conversion list containing the standard profiles and grades. Any member with profile or material that cannot be converted using the internal conversion will be flagged in red and the Tekla Structures name will be replaced with the text *** NO MATCH ***.

4. If the text *** NO MATCH *** is displayed, you can convert the profiles and materials manually in the following way:
a. Create a profile and/or material conversion file in a text editor using the file name extension .cnv. The conversion files can also be used to override the standard conversion.
b. In the text file, enter the .cxl profile or material name, the equal sign (=) and then the corresponding Tekla Structures name, for example:

STB 229x305x70=TEE229*305*70 for profile

S275JR=S275 for material

If the conversion files are not used, the members with profiles or materials that cannot be converted will still be created but they will use the import file profile or material, which may be invalid in Tekla Structures, and the members may be drawn as lines in the model, but can then be edited manually in Tekla Structures.

5. Select the grid options:

- **Delete Tekla Structures' grids**: Import will remove all grid lines/planes from the current Tekla Structures model.
- **Import grids from import file**: The grid lines from the import file will be imported into the Tekla Structures model. A grid line pattern will be created, and all the imported grid lines will be attached as individual grid planes to this pattern.

6. Import by pressing one of the following buttons:

- **Import at Origin**: Import the model using the global X, Y and Z coordinates with the global origin as the 0,0,0 point for the import model's coordinate system.
- **Import at Location**: Select a point in the model to use as 0,0,0 and select a second point to define the X axis to use.

When a Tekla Structural Designer .cxl file is imported into Tekla Structures, the model is checked for existing items. If none of the items in the import file have previously been imported into the current model, Tekla Structures imports the contents of the selected import file and creates all the required objects in the Tekla Structures model. If the Tekla Structures model is empty, the project properties from the .cxl file will be written into the model's project properties. If the model contains members, the .cxl model data will be ignored leaving existing project properties intact.

**NOTE** You can find more information on exporting models and objects from Tekla Structural Designer in the Tekla Structural Designer product guides.

**See also**

Re-import from Tekla Structural Designer (page 260)
**Re-import from Tekla Structural Designer**

When you import from Tekla Structural Designer, you can control which changes will be made in the Tekla Structures model. If none of the objects in the import file have been previously imported in Tekla Structures, the import will complete after Tekla Structures has created the required objects. If objects already exist, then the new members will be listed as new, but if no objects exist, then the import will just take place.

1. Follow the steps in Import from Tekla Structural Designer (page 258).
2. To display the properties of an object, select the object from the list on the left in the import verification dialog box.
   - If you select more than one object, only the properties for the first object on the list are displayed, but all the objects that you selected are highlighted in the model.
3. If any object in the import file has previously been imported into the Tekla Structures model, the Model Comparison Tool dialog box is displayed showing the changes and allowing you to control which changes will be made in the Tekla Structures model. You can do one of the following:
   - **Ignore deleted list**: The .cxl file may contain a list of objects deleted in Tekla Structural Designer. If objects in this list still exist in the Tekla Structures model, they will be deleted unless this check box is selected.
   - **Ignore new items**: Objects that did not previously exist in the Tekla Structures model that are in the import file are excluded from the import if you select this check box.
4. To append the Tekla Structures object ID to the object type string in the comparison tool list, select Display part IDs.
5. If updating the positions of objects is not required, selecting **Profile and material updates only** will only update the object profiles and materials, and ignore other changes.
6. To reduce the amount of information displayed about the objects that have been updated, select **Only display changed fields**.
   - Only the values that have been changed are displayed instead of all the object properties.
7. Click **Accept** to use the current settings and complete the import.

   Once the import is complete you can view the changes in the model using **Tekla Structural Designer Integration Status** object group color and transparency settings (**View tab** --> **Representation** --> **Object Representation**).
**Export to Tekla Structural Designer**

Export to Tekla Structural Designer allows you to export the entire Tekla Structures model or a selected subset of the model. The exported .cxl file can be uploaded to Tekla Structural Designer to update the model, or to create a new Tekla Structural Designer model based on the Tekla Structures model.

**NOTE** To export to Tekla Structural Designer using a Tekla Structures analysis model, see Export an analysis model to Tekla Structural Designer.

Before exporting, open Tekla Structures and the model from which you want to export.

1. On the **File** menu, click **Export --> Tekla Structural Designer**.

2. In the export dialog box, either enter the path of the export file in the **Export file** box or click the **...** button at the end to browse to a folder and enter a name for the file.

3. Once you have selected a valid file, the export buttons and the **Preview Conversion** button will be enabled. To process the model and display all the proposed profile and material grade conversions to be used, click the **Preview Conversion** button.

   The export uses an internal conversion list containing the standard profiles and grades. Any member with profile or material that cannot be converted using the internal conversion will be flagged in red and the export name will be replaced with the text *** NO MATCH ***.

4. If the text *** NO MATCH *** is displayed, you can convert the profiles and materials in the following way:

   a. Create a profile and/or material conversion file in a text editor using the file name extension .cnv.

      The conversion files can also be used to override the standard conversion.

   b. In the text file, enter the .cxl profile or material name, the equal sign (=) and then the corresponding Tekla Structures name, for example:

      STB 229x305x70=TEE229*305*70 for profile

      S275JR=S275 for material

      If the conversion files are not used, the objects with profiles or materials that cannot be converted will still be created but they will use the export file profile or material that may be invalid.

5. You can export the whole Tekla Structures model or only the objects that you select. Do one of the following to create the neutral file:

   - To export the whole model, click **Export Model**.
• To export only the selected parts, select the parts from the model and click **Export Selected**.

The use of select and view filters is recommended to ensure that only structural part of the model or elements requiring design are exported.

The **Quick report** window will show you the result of the export.

**Robot**

The Robot Millennium A&D application is owned by Autodesk Inc. Full product details can be found on the Robot Millennium web site.

• This application is suitable for basic interoperability, and it can export and import cis/2 files.

• If you install Tekla Structures and Robot Millennium on the same computer, then a direct link can be used.

• Currently only the EC3, LRFD, CM66, E32 and ANS design codes are available in Robot when using the direct link.

• If you are upgrading to Robot 2012, you will need to uninstall Robot 2011 along with the Autodesk Robot Structural Analysis link. Then install Robot 2012 and the link again. This way you make Tekla Structures point to the Robot 2012 application.

To get more information and to download, go to **Tekla Warehouse**

**See also**

[Linking Tekla Structures with Robot](#)

[Analysis and design direct links (page 255)](#)

**SAP2000**

The SAP2000 analysis & design application is written by Computers & Structures, Inc. Full product details can be found on their website.

• The SAP2000 analysis & design application can export and import cis/2 and ifc files, and export SDNF files.

• If Tekla Structures and SAP2000 are installed on the same computer, then a direct link can be used.

• It is important that you run SAP2000 for the first time as a standalone application before you load the link. Just start SAP2000 and create a new
model, save it and close SAP2000. This will then update your registry which is needed by the link.

To get more information and to download, go to Tekla Warehouse.

See also
Linking Tekla Structures with SAP2000
Analysis and design direct links (page 255)

STAAD.Pro

The STAAD.Pro analysis and design application is owned by Bentley Systems, Incorporated. Full product details can be found on their website.

- STAAD.Pro can export and import CIS/2 files, along with their std format. It has become a semi-industrial standard especially in the plant and heavy engineering segments.
- If Tekla Structures and STAAD.Pro are installed on the same computer, then a direct link can be used.
- Profile mapping for different installation environments is achieved by mapping the profiles used by Tekla Structures and Bentley in files called ProfileExportMapping.cnv and ProfileImportMapping.cnv located in the TeklaStructures\TS_STAAD folder. Currently these files are only used in import.

To get more information and to download, go to Tekla Warehouse.

See also
Linking Tekla Structures with STAAD.Pro
Analysis and design direct links (page 255)

ISM

Bentley's Integrated Structural Modeling (ISM) is a technology for sharing structural engineering project information among structural modeling, analysis, design, drafting and detailing applications.

ISM is similar to Building Information Modeling (BIM), but focuses on the information that is important in the design, construction and modification of the load bearing components of buildings, bridges and other structures. Full product details can be found on their website.

The ISM link is different form the other analysis and design links in that the physical model is also transferred at the same time as the analysis and design model and the ISM model can be imported into an empty Tekla Structures
model. The round-trip of model information is also controlled by a synchronizer.

If Tekla Structures and an ISM enabled Analysis & Design application or Bentley Viewer v8i are installed on the same computer then a direct link can be used.

In order to use the link, the ISM Structural Synchronizer version 3.0 needs to be loaded before the link.

For more information and to download, go to Tekla Warehouse.

See also
Linking Tekla Structures with an ISM enabled Analysis & Design application
Analysis and design direct links (page 255)

S-Frame

S-Frame Analysis is owned and developed by S-FRAME Software Inc. It is a complete 4D structural modeling, analysis and design solution for steel, concrete, linear and non-linear structural models.

- The Tekla API link allows you to write code to connect to an open model in Tekla and query or manipulate the model. The link was established by using both the S-Frame and Tekla APIs. It uses a library database to manage items between Tekla Structures and S-Frame.

- S-Frame can export and import .dxf files. If Tekla Structures and S-Frame are installed on the same computer, then a direct link can be used. A copy of the link and instructions on using the link can be requested from https://s-frame.com. Descriptions regarding the link can be found here: Building information modeling (BIM) links.

- In some areas S-Frame used to be distributed by CSC, in which case the installation points to different folders. The model name must not include spaces as this currently is an issue as the analysis and design frame is not created if spaces are included.

The whole process involves the following steps: importing to S-Frame, displaying imported items, and exporting from S-Frame. This process is described below.

**Importing objects to S-Frame and displaying the objects**

1. The S-Frame software checks to see if there is an open model in Tekla Structures using the Tekla API.

2. If a connection can be established, the Tekla Structures model is queried for a list of model objects, such as modeled members or panels.
3. The returned objects are iterated through, recognized types are processed, and equivalent S-Frame objects are added or updated to a library database.

4. The IDs from Tekla Structures are stored so that items can be mapped back and forth between Tekla Structures and S-Frame.

5. Once the objects have been iterated through, the library database is queried, and the updated or created objects referenced in the library are displayed in S-Frame display window.

**Exporting from S-Frame**

1. The S-Frame is queried for objects that are displayed in the S-Frame display window.

2. The library is iterated through for types of known objects (members and panels) that can be mapped back and forth between Tekla Structures and S-Frame.

3. Using the unique IDs stored in the import, the Tekla Structures model is queried to see if items exist. If they do not, they will need to be created, and the library will be updated.

4. Items can then be added or updated to Tekla Structures to match what is in S-Frame.

**FEM**

Tekla Structures FEM import and export tool support several formats and provide several options for importing and exporting models.

FEM (Finite Element Method) is an analysis and calculation method used in structural engineering. In this element method, the target is divided into appropriate finite elements interconnected at points called nodes.

You can import the following formats into Tekla Structures using the FEM import tool.

<table>
<thead>
<tr>
<th>Option</th>
<th>Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>DSTV</td>
<td>DSTV format data (Deutsche Stahlbau-Verband). Several different systems, for example, RSTAB static software and Masterseries Analysis &amp; Design system. DSTV manufacturing format is the standard format used for manufacturing steel components on numerically controlled (NC) machines. It also has an Analysis &amp; Design format that is used for transferring Analysis &amp; Design models to the physical 3D model. Different programs produce different DSTV files. For example, the DSTV file produced by RSTAB static software only contains a static model. Tekla Structures</td>
</tr>
<tr>
<td>Option</td>
<td>Software</td>
</tr>
<tr>
<td>------------</td>
<td>----------</td>
</tr>
<tr>
<td>SACS</td>
<td>SACS modeling and analysis software</td>
</tr>
<tr>
<td>S-Frame</td>
<td>Analysis software, for example, FASTSOLVE.</td>
</tr>
<tr>
<td>Monorail</td>
<td>Monorail system</td>
</tr>
<tr>
<td>STAAD</td>
<td>STAAD format data (Structural Analysis And Design). STAAD modeling and analysis system. FEM import is an old way to import STAAD data. We recommend that you use a direct link to ISM or STAAD.Pro, which are available in Tekla Warehouse. If Tekla Structures and STAAD.Pro or ISM are loaded onto the same machine then direct links can be used. To make a STAAD input file compatible with the Tekla Structures STAAD import, use the option Joint coordinate format (Single) to save the input file in STAAD. This creates a line for each coordinate in the input file.</td>
</tr>
<tr>
<td>Stan 3d</td>
<td>Stan 3d analysis software</td>
</tr>
<tr>
<td>Bus</td>
<td>BUS 2.5 analysis software</td>
</tr>
</tbody>
</table>

You can export to the following formats: DSTV, MicroSAS, and STAAD.

**Import FEM**

1. On the **File** menu, click **Import --> FEM**.
2. In the **New Import Model** dialog box, select **Import FEM**.
3. Select **import model** (default) from the list or enter a new name.
4. Click **OK**.
5. Click **Properties** to open a dialog box where you can define the settings for the import file:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Conversion tab</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Profile conversion file</strong></td>
<td>Define the conversion files you want to use.</td>
</tr>
<tr>
<td><strong>Material conversion file</strong></td>
<td>Conversion files map Tekla Structures profile and material names with names used in other software.</td>
</tr>
<tr>
<td><strong>Twin profile conversion file</strong></td>
<td>For more information about conversion files, see Conversion files (page 115).</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Part Pos_No</strong></td>
<td>Enter a prefix and a start position number.</td>
</tr>
<tr>
<td><strong>Assembly Pos_No</strong></td>
<td></td>
</tr>
</tbody>
</table>

**Parameters tab**

<table>
<thead>
<tr>
<th>Input file</th>
<th>The name of the file you want to import. You can also browse for the file.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>Select the input file type: DSTV, SACS, Monorail, Staad, Stan 3d, Bus</td>
</tr>
<tr>
<td><strong>Origin X, Y, Z</strong></td>
<td>Define the origin coordinates to place the file in a specific location.</td>
</tr>
<tr>
<td><strong>Default yield stress limit</strong></td>
<td>The <strong>Default material when yield stress &lt; limit</strong> setting is used for SACS import file. Define the material to use if yield stress is less than the limit. The setting <strong>Default material when yield stress &gt;= limit</strong> is used for SACS or DSTV import files. For SACS, this field defines the material to use if yield stress is greater than or equal to the limit. For DSTV you can enter the material grade here, if it is not included in the import file.</td>
</tr>
<tr>
<td><strong>Default material when yield stress &gt; = limit</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Default material when yield stress &lt; limit</strong></td>
<td></td>
</tr>
</tbody>
</table>

**Combine members**

| Max length for combining | To combine several elements in the FEM model into one part in Tekla Structures, set **Combine members** to **Yes**. For example, if a beam in a file consist of more than one element, and you select **Yes**, the elements are combined to form one beam in the Tekla Structures model. If you use the value **No**, Tekla Structures creates a beam for each element in the FEM model. **Max length for combining** is only applied if you set **Combine members** to **Yes**. Use this setting to define the maximum length for combining parts. Tekla Structures combines elements into one part only if their combined length is less than the value you enter here. |

**Staad tab**

| Material                           | Select the material grade.                                                                                                                   |

**Report tab**

<table>
<thead>
<tr>
<th>Create report</th>
<th>Set to <strong>Yes</strong> to create a report.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Display report</strong></td>
<td>Set to <strong>Yes</strong> to display the report.</td>
</tr>
<tr>
<td><strong>Report template</strong></td>
<td>Select the report template. Your can also browse for the template.</td>
</tr>
</tbody>
</table>
### Setting Description

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report file name</td>
<td>Enter the report file name or browse for a report file. If you do not give the report any other name, the report is saved with the name import_revision_report.rpt in the model folder.</td>
</tr>
<tr>
<td><strong>DSTV tab</strong></td>
<td></td>
</tr>
<tr>
<td>Version</td>
<td>Select the DSTV version.</td>
</tr>
<tr>
<td>Import static elements</td>
<td>If the DSTV file to be imported contains a static and a CAD model, you can choose which one to import. Answering <strong>Yes</strong> to <strong>Import static elements</strong> imports the static model. Answering <strong>Yes</strong> to <strong>Import other elements</strong> imports the CAD model.</td>
</tr>
<tr>
<td>Import other elements</td>
<td></td>
</tr>
<tr>
<td><strong>Stan 3d tab</strong></td>
<td></td>
</tr>
<tr>
<td>Scale</td>
<td>Specify the scale of the import model. You can import Stan 3d without specifying the scale as long as both the Tekla Structures model and the import model are in millimeters. If the Stan 3d file is in millimeters, use the scale 1. If the Stan 3d file is in meters, use the scale 1000.</td>
</tr>
<tr>
<td>Material</td>
<td>Enter the material for the parts to import.</td>
</tr>
<tr>
<td><strong>Bus tab</strong></td>
<td></td>
</tr>
<tr>
<td>Pos_No</td>
<td>Indicate the Pos_No of the girders, columns, braces and cantilevers you import.</td>
</tr>
<tr>
<td>Material</td>
<td>Enter the material for the parts to import.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter the name of the parts to import.</td>
</tr>
<tr>
<td>Class</td>
<td>Enter the class of the parts to import.</td>
</tr>
<tr>
<td>Beams behind plane</td>
<td>The value <strong>Yes</strong> aligns the tops of all beams at the floor level.</td>
</tr>
<tr>
<td><strong>Advanced tab</strong></td>
<td></td>
</tr>
<tr>
<td>Action when object status is (compared to)</td>
<td>Previous plan lists the objects in your model, compared with the objects in the file to be imported. They can be <strong>New</strong>, <strong>Modified</strong>, <strong>Deleted</strong>, or <strong>Same</strong>. Tekla Structures compares the state of imported objects with those in your model. They can be <strong>Not in model</strong>, <strong>Different</strong>, or <strong>Same</strong>. Use the options under <strong>Not in model</strong>, <strong>Different</strong>, and <strong>Same</strong> to specify the actions when importing</td>
</tr>
</tbody>
</table>
6. Click **OK** to go to the **Import Model** dialog box.
7. Select the model to import.
8. Click **Import**.
   Tekla Structures displays the **Import model info** dialog box.
9. Select which version of parts to import.
10. Click **Accept all**.
    If you have changed the model and want to re-import it, you can also reject all changes by clicking **Reject all**, or accept or reject individual changes by clicking **Select individual**.
11. Tekla Structures displays the message **Do you want to save the import model for subsequent imports? Click Yes.**
    Tekla Structures displays the import model in a model view.
12. Right-click the model view and select **Fit work area to entire model** to ensure that the imported model is completely visible.
13. If parts are missing, check the **View depth Up** and **Down** values in the **View Properties** dialog box and change them if necessary.

**Export FEM**
1. Open a Tekla Structures model.
2. On the **File** menu, click **Export --> FEM**.
   The **FEM export** dialog box opens.
3. Go to the **Conversion** tab and enter the names of the **conversion files** (page 115), or browse for the files.
4. Go to the **Parameters** tab, and enter the name of the output file, or browse for the file.
5. Select the output file type: **DSTV**, **MicroSAS** or **Staad**.
6. Set **Split members** to **Yes** to split a part in the Tekla Structures model into several elements in the exported model.
7. If you are exporting to MicroSAS, set **Combine segmented members (MicroSAS)** to **Yes** to combine multiple parts to form one part in the exported model.
   For example, if you have divided a beam into several elements and select the Yes option, Tekla Structures combines the elements so that they form...
one beam in the exported model. With the option No every element of the beam in the model forms individual beams.

8. If you are exporting to Staad, go to the **Staad** tab:
   - Select an option from **Profile table** list.
   - Use the setting **Parametric shapes when possible** to define how Tekla Structures exports the profiles PL, P, D, PD, SPD to Staad. **Yes** exports the profiles as parametric shapes so that STAAD can identify them correctly. **No** exports all profiles as standard STAAD shapes.

   Example of a plate PL10*200 when exported as parametric shape (**Yes**):
   
   13 PRI YD 200.000000 ZD 10.000000.

   Example of the same plate exported as a standard shape (**No**):
   
   13 TABLE ST PL10*200

9. If you are exporting to DSTV, go to the **DSTV** tab:
   - Select the DSTV version from the version list.
   - In **Element reference with**, select whether you want to export into a static model (**CROSS_SECTION**), or into a CAD model (**MEMBER_LOCATION**).

10. Select the parts in the model to export.

11. Click **Apply** and **Create**.

    Tekla Structures creates the export file in the current model folder.

**Supported DSTV entities**

The DSTV entities are listed below. Tekla Structures supports those marked with an asterisk (*). See the DSTV standard “Stahlbau - Teil 1. März 2000” for more information.

**Static data:**

- vertex (*)
- polyline
- substructure (*)
- node (*)
- element (*)
- element_eccentricity (*)
- raster
- boundary_condition
- elastic_support
nodal_reaction
element_reaction

**General data:**
material (*)
cross_section (*)

**CAD data:**
member (*)
member_location (*)
construction-data
cutout
hole

**STAAD table type specifications**
Tekla Structures supports the following STAAD table type specifications:

- ST (single section from the standard built-in tables)
- ST PIPE (parametric)
- ST TUBE (parametric)
- RA (single angle with reverse Y_Z axes)
- D (double channel)
- LD (long leg, double angle)
- SD (short leg, double angle)
- TC (beams with top cover plates)
- BC (beams with bottom cover plates)
- TB (beams with top and bottom cover plates)

You can import the types CM and T, user-provided steel table types (UPT), and other non-standard profiles, if you have defined them in the profile conversion file. You must use the underscore character in the STAAD name, for example, *UPT_1_W10X49*. Tekla Structures automatically converts twin profiles in this import routine.

### 3.12 Steel fabrication

Fabrication applies to the building of structures by cutting, shaping and assembling components made from steel. Steel fabrication shops generally
concentrate on the preparation, welding and assembly aspect with a much greater use of the multi functioning machines.

Fabrication (cutting and drilling features) of structural steel elements has always been performed using manually operated techniques, and these remain today as fabrication methods. The emergence of CNC (computer numerical control) technology brought automation and greater accuracy to these techniques, resulting in families of special purpose machines dedicated to performing individual fabrication tasks.

The following tools are included for steel fabrication purposes in Tekla Structures installation:

- NC/DSTV (page 272)
- CIS and CIMSteel (page 307)
- MIS (page 306)
- Fabtrol XML (page 314)
- ASCII (page 315)

There are also some steel tools that you can download from Tekla Warehouse.

**NC files**

Tekla Structures produces NC files in DSTV format. You can select the information to be included in NC files and NC file headers, and define the desired pop-mark and contour mark settings. You can also produce MIS (Manufacturing Information System) list files according to the DSTV standard.

NC (Numerical Control) refers to a method where machine tool operations are controlled with a computer. The NC data controls the motion of CNC (computer numerical control) machine tools. During the manufacturing process a machine tool or machining center drills, cuts, punches or shapes the piece of material.

After you have finished detailing a Tekla Structures model, you can export the NC data as NC files from Tekla Structures to be used by CNC machine tools. Tekla Structures transforms the part length, hole positions, bevels, notches, and cuts into sets of coordinates that the machine tools can use to create the part in a shop. In addition to the CNC machine tools, the NC files can also be used by MIS and ERP software solutions.

The data for the NC files comes from the Tekla Structures model. We recommend that you complete detailing and create drawings before producing the NC files.

Tekla Structures produces NC files in DSTV format (Deutscher Stahlbau-Verband) in the current model folder. In most cases each part has its own NC file. You can also produce NC files in DXF format by converting DSTV files to DXF files.
DSTV is a standard interface for geometrical description of steel structure pieces for the post-processors with numerical control. The essential aim of this interface is to be neutral, which means that with only one standard description you can manage several different NC machines. The interface standardizes the link between a CAD-program or a graphical system via a CAM file for the NC machines. The geometry of the piece is introduced completely neutrally, and after knowing the parameters of the NC machine, the post-processor is able to translate this neutral language to the NC machine language. For more information, visit http://www.deutscherstahlbau.de/dstv/der-verband.

Notes and limitations:

- Duplicate bolts on a part (bolts in the same location as another bolt) are by default ignored in NC DSTV export. The tolerated distance for bolts to be considered duplicates can be adjusted with the XS_BOLT_DUPLICATE_TOLERANCE advanced option.

- The DSTV standard does not support curved beams, and therefore Tekla Structures does not create NC files for curved beams. Use polybeams instead of curved beams.

Create NC files in DSTV format

1. On the File menu, click Export -> NC files.
2. If you have some predefined settings that you want to use, select the settings from the settings file list at the top and click Load.
3. In the NC Files dialog box, select the check box in the Create column next to DSTV for plates and/or DSTV for profiles.
4. To modify the NC file settings, select an NC file settings row, and click Edit.

In the NC File Settings dialog box, modify the settings on the Files and part selection, Holes and cuts, Hard stamp and Advanced Options tabs. Click OK to save your NC file settings and to close the NC File Settings dialog box.

Hard stamps can be created for both the main part and the secondary parts. By default, Tekla Structures creates hard stamps only for the main part. Set the advanced option XS_SECONDARY_PART_HARDSTAMP to TRUE to also create hard stamps for secondary parts.

You can select to create only DSTV files, MIS files, both, or DSTV files embedded in MIS files.

If you want to add new NC file settings, click Add. This will add a new row in the NC file settings list, and the NC File Settings dialog box is displayed, where you can give the settings a new name.
You can enter a unique name for the settings using **Save as**. Tekla Structures saves the settings in the ..\attributes folder under the current model folder.

For more information about the NC file settings, see the "NC file settings" section below.

5. You can customize the order in which information is displayed in an NC file, and add additional information on individual parts in the NC file header. To select the information to be included in the NC file header, click **Header**, modify the information, and click **OK**:

   - In the **NC File Header Information** dialog box, include in the **Selected elements** list the header information options that you want, and arrange the options in the desired order by selecting the option and using the **Move up** and **Move down** buttons.
   - If needed, add additional information on individual parts.

   You can enter text in the **Text info on piece 1 - 4** boxes, and enter desired template attributes in double angle brackets, for example `<<WEIGHT>>` to display the weight of the part.

   ![NC File Header Information dialog box](image)

   • If you want to restore the default file header information, click the **Default** button in the **NC File Header Information** dialog box.

6. To create pop-marks and modify the pop-mark settings, click **Pop-marks**.

   For more information about creating pop-marks and about the pop-mark settings, see the section "Create pop-marks in NC files" below.
7. To create contour marks, and modify contour mark settings, click **Contour marking**.
   For more information about creating contour marking and about the contour marking settings, see the section "Create contour marking in NC files" below.
   For more information on contour marking, see the support article **How to create contour marking for steel beams**.

8. To save the settings that you have modified with another name for later use, click enter a new name next to **Save as** and click **Save as**.

9. In the **NC Files** dialog box, use the **All parts** or **Selected parts** options to select whether to create the NC files for all parts or only for the selected parts.
   If you use the **Selected parts** option, you need to select the parts in the model.

10. Click **Create**.
    Tekla Structures creates .nc1 files for the parts using the defined NC file settings. By default, the NC files are created in the current model folder. The filename consists of a position number and the extension .nc1.

11. Click **Show NC log** to create and show the log file dstv_nc.log that lists the exported parts and the parts that were not exported.
    If all expected parts are not exported, check that the parts which were not exported pass all the profile type, size, hole and other limits set in the NC file settings.

### **NC file settings**

**Files and part selection tab**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File format</strong></td>
<td>DSTV is the only available value.</td>
</tr>
</tbody>
</table>
| **File location** | The default folder is \DSTV_Profiles or DSTV_Plates under the current model folder.  
  You can define another destination folder for NC files in one of the following ways:  
  • You can enter the folder path in the **File location** box. You can also browse for the path.  
    For example, enter C:\NC.  
  • If you leave the field empty, the NC files will be created in the current model folder. |
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File extension</td>
<td>.nc1 is the default value.</td>
</tr>
<tr>
<td>Include revision mark to file name</td>
<td>Add a revision mark to the NC file name. The file name then includes a number indicating the revision of the file, P176.nc1 becomes P176_1.nc1, for example.</td>
</tr>
<tr>
<td>Create what</td>
<td>Select the type of files to create:</td>
</tr>
<tr>
<td>NC files</td>
<td>creates only DSTV files.</td>
</tr>
<tr>
<td>Part list</td>
<td>creates only a MIS list file (.xsr).</td>
</tr>
<tr>
<td>Part list file name</td>
<td>If you create an MIS list file, enter a name for the list in the Part list file name box. Also, you need to click the Browse button next to the Part list file location box and browse for the location where you want to save the list.</td>
</tr>
<tr>
<td>NC files and part list</td>
<td>creates both the DSTV files and an MIS list file.</td>
</tr>
<tr>
<td>Combined NC files and part list</td>
<td>embeds DSTV files in an MIS list file (.xsr).</td>
</tr>
<tr>
<td>Maximum size</td>
<td>The options define the maximum length, width, and height of the parts the machine tool can handle. Larger parts are sent to other machines.</td>
</tr>
<tr>
<td>Profile type</td>
<td>All profiles that are set to Yes in the Profile type list can be handled by the machine tool. Profile types are named according to the DSTV standard. I: I profiles</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>U: U and C profiles</td>
<td></td>
</tr>
<tr>
<td>L: L profiles</td>
<td></td>
</tr>
<tr>
<td>M: Rectangular tubes</td>
<td></td>
</tr>
<tr>
<td>R: Round bars and tubes</td>
<td></td>
</tr>
<tr>
<td>B: Plate profiles</td>
<td></td>
</tr>
<tr>
<td>CC: CC profiles</td>
<td></td>
</tr>
<tr>
<td>T: T profiles</td>
<td></td>
</tr>
<tr>
<td>SO: Z profiles and all the other types of profiles</td>
<td></td>
</tr>
</tbody>
</table>

By default, Tekla Structures unwraps round tubes as plate profiles and uses the plate profile type B in the NC file header data. To change this, use the advanced option XS_TUBE_UNWRAP_USE_PLATE_PROFILE_TYPE_IN_NC.

### Maximum size of holes

The **Maximum size of holes** options define how large holes the machine tool is able to drill. The NC file is not created if a part contains larger holes or its material is thicker than the specified values. The hole size is connected to material thickness or plate thickness.

Each row contains the maximum hole diameter and the material thickness. Both conditions have to be met for the NC file to be created. For example, a row with the values 60 45 means that when the material thickness is 45 mm or smaller, and the hole diameter is 60 mm or smaller, the NC file is created. You can add as many rows as needed.

The following example shows how the **Maximum size of holes** can be defined. In this example, we have the following situation:

- Three plates of different thickness.
- Two bolt groups with equal sizes, and one bolt group with a larger size.

**Maximum size of holes** are defined as follows:
Setting | Description
---|---
Test1 creates a folder under the model folder for the plates that meet the following criteria:
• **Hole diameter**: 22
• **Plate thickness**: 10
Test2 creates a folder under the model folder for the plates that meet the following criteria:
• **Hole diameter**: 22
• **Plate thickness**: 20
When you create NC files for the plates, the folder Test1 includes the plate PL350*10 and the folder Test2 includes the plate PL350*20. The plate PL350*15 is not included in any folder, because the hole size criterion is not met.
The order in which you enter the criteria is important: enter the most exclusive criteria first. If you define the criteria in a different order, the results will also be different.

**Holes and cuts tab**

See also XS_DSTV_CREATE_NOTCH_ONLY_ON_BEAM_CORNERS.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inner corners shape</td>
<td>The <strong>Inner corners shape</strong> option defines the shape of, for example, web notches or flange cuts at the beam end.</td>
</tr>
</tbody>
</table>

The **Inner corner shape** option also affects cuts on the flange:
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td>The Inner corner shape option does not apply to rectangular openings that are located in the middle of a part:</td>
</tr>
<tr>
<td><img src="image2.png" alt="Image" /></td>
<td>The Inner corner shape option does not apply to those inner contours that are already rounded in the model. The model values remain intact.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Image" /></td>
<td>The examples in the below show how the different inner corner shape options affect the part in the NC file. The original part in the model has flanges cut entirely and the web is notched.</td>
</tr>
<tr>
<td><strong>Option 0: Radius</strong></td>
<td><img src="diagram.png" alt="Diagram" /></td>
</tr>
<tr>
<td></td>
<td>The inner corners are shaped like holes with a given radius. A separate BO block is not written to the NC file.</td>
</tr>
<tr>
<td><strong>Option 1: Tangential</strong></td>
<td><img src="diagram.png" alt="Diagram" /></td>
</tr>
</tbody>
</table>
The inner corner is rounded according to the value in the *Radius* box.

Option 2: **Square**

The corner is as it is in the model.

Option 3: **Drilled hole**

A drilled hole is added to the inner corner. The hole radius is the same as the value in the *Radius* box. Holes are written as a separate BO block to the NC file.

Option 4: **Tangential drilled hole**

A drilled hole is added tangentially to the inner corner. The hole radius is the same as the value in...
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Radius</strong></td>
<td>the <strong>Radius</strong> box. Holes are written as a separate BO block to the NC file.</td>
</tr>
</tbody>
</table>
| **Distance from flange within which web is not cut** | The **Distance from flange within which web is not cut** option defines the height of the flange clearance area. The clearance check only affects the **I**, **u**, **C**, and **L** DSTV profile types.  
If a cut in a part is located closer to the flange than the clearance in the model, the cut points inside that clearance are moved to the border of the clearance area when the NC file is written.  
The part how it is modeled. The cut goes closer to the top flange than the defined flange clearance in the NC file settings:  
The part how it is written in the NC files. The dimension shows the clearance. The top of the original cut is moved so that the clearance area is left free. The bottom of the cut is not moved. |
| **Machine slots as**                         | The **Machine slot as** option defines how slotted holes are created:  
**Ignore slots**: Slotted holes are not created in the NC file.  
**A single hole in the center of the slot**: Drills a single hole in the center of the slotted hole.  
**Four small holes, one at each corner**: Drills four smaller holes, one at each corner. |
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Internal contours:</strong></td>
<td>Flame-cuts the slots as internal contours.</td>
</tr>
<tr>
<td><strong>Slots:</strong></td>
<td>Leaves slots as they are.</td>
</tr>
<tr>
<td><strong>Maximum diameter for holes to be drilled</strong></td>
<td>The Maximum diameter for holes to be drilled option defines the maximum hole diameter. Holes and slotted holes that are larger than the maximum hole diameter are manufactured as internal contours.</td>
</tr>
<tr>
<td><strong>Maximum diameter for circular cuts to be drilled</strong></td>
<td>Maximum diameter for circular cuts to be drilled defines the maximum circular part cuts. They are written as holes if the diameter of the cut is less than the value defined for the setting. Smaller internal circular cuts are converted to holes.</td>
</tr>
</tbody>
</table>

**Hard stamp tab**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create hard stamp</td>
<td>When selected, creates hard stamps.</td>
</tr>
<tr>
<td><strong>Hard stamp content</strong></td>
<td>The <strong>Elements</strong> list defines which elements are included in hard stamps and the order in which the elements appear in the hard stamp. You can also define the <strong>Text height</strong> and <strong>Case</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Project number</strong>: Adds the project number to the hard stamp.</td>
</tr>
<tr>
<td></td>
<td><strong>Lot number</strong>: Adds the lot number to the hard stamp.</td>
</tr>
<tr>
<td></td>
<td><strong>Phase</strong>: Adds the phase number to the hard stamp.</td>
</tr>
<tr>
<td></td>
<td><strong>Part position</strong>: Prefix and position number of the part.</td>
</tr>
<tr>
<td></td>
<td><strong>Assembly position</strong>: Prefix and position number of the assembly.</td>
</tr>
<tr>
<td></td>
<td><strong>Material</strong>: The material of the part.</td>
</tr>
<tr>
<td></td>
<td><strong>Finish</strong>: The type of finish.</td>
</tr>
<tr>
<td></td>
<td><strong>User-defined attribute</strong>: Adds a user-defined attribute (user fields 1-4) to the mark.</td>
</tr>
<tr>
<td></td>
<td><strong>Text</strong>: Opens a dialog box where you can add user-defined text to the hard stamp.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Part position | Including part position and/or assembly position in the hard stamp affects the NC filename:  
- Part position: P1.nc1, P2.nc1  
- Assembly position: A1.nc1, A2.nc1  
- Assembly and part position: A1-P1.nc1, A2-P2.nc1  
The following example shows a hard stamp that contains the elements Phase, Part position, Material, and Text. |

### Hard stamp placing

If you set the option **By orientation mark** to **Yes**, the default face is changed from bottom (u) to top (o) for L profiles, rectangular tubes and round bars.

The **Side** option defines the side of the part on which the hard stamp is placed.

The **Position along the part** and **Position in depth of part** options define the position of hard stamps on parts.

These options move the hard stamp on the same face it is created, but they cannot move the stamp to a different face. If the face is, for example, the bottom flange, you can move the stamp to a different place on bottom flange, but not to the top flange.

Default faces for different profiles:  
- I profile: Bottom flange (u)  
- U and C profiles: Back side of web (h)  
- L profiles: Back (h) or Bottom (u)  
- Rectangular tubes: Bottom flange (u)  
- Round bars: Bottom flange (u)
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Circular tubes: Front (v)</td>
<td></td>
</tr>
<tr>
<td>T profiles: Back side of web (h)</td>
<td></td>
</tr>
<tr>
<td>Plate profiles: Front (v)</td>
<td></td>
</tr>
<tr>
<td>See also XS_SECONDARY_PART_HARDSTAMP.</td>
<td></td>
</tr>
</tbody>
</table>

### Advanced Options tab

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of decimals</td>
<td>Define the number of decimals shown in NC files.</td>
</tr>
<tr>
<td><strong>Change external contour (AK block) radius sign</strong></td>
<td>Change the AK block curve radius signs on top (o) and back (h) faces. This change only affects on top (o) and back (h) faces.</td>
</tr>
</tbody>
</table>

Below is an example, where the **Change external contour (AK block) radius sign on top (o) and back (h) faces** is not selected.

<table>
<thead>
<tr>
<th>AR</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.00</td>
<td>300.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>3000.00</td>
<td>300.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>3000.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>1356.75</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>1356.75</td>
<td>115.99</td>
<td>40.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>1356.75</td>
<td>155.99</td>
<td>40.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>1046.75</td>
<td>115.99</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>1046.75</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

Below is an example, where the **Change external contour (AK block) radius sign on top (o) and back (h) faces** is selected.

<table>
<thead>
<tr>
<th>AR</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
<th>0.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.00</td>
<td>300.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>3000.00</td>
<td>300.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>3000.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>1356.75</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>1356.75</td>
<td>115.99</td>
<td>40.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>1356.75</td>
<td>155.99</td>
<td>40.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>1046.75</td>
<td>115.99</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>1046.75</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Change internal contour (IK block) radius sign</strong></td>
<td>Change the IK block curve radius signs for top (o) and back (h) faces.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Setting</td>
<td>This change only affects top (o) and back (h) faces.</td>
</tr>
<tr>
<td>Curve detection</td>
<td><strong>Curve detection</strong> controls whether three points should be read as a curve instead of two straight lines. When <strong>Curve detection</strong> is set to <strong>Yes</strong>, Tekla Structures checks the edges of a solid against a virtual curve described by the edges to see if the edges are curved or straight based on the <strong>Chord tolerance</strong> value. Enter the <strong>Chord tolerance</strong> value in millimeters. <strong>Curve detection</strong> is on by default. The image below describes the chord tolerance.</td>
</tr>
<tr>
<td>Chord tolerance</td>
<td></td>
</tr>
<tr>
<td>Convert I profile to T profile when flange is missing</td>
<td>Select whether to convert I profiles to T profiles when a flange is missing. You can select either <strong>Yes</strong> or <strong>No</strong>.</td>
</tr>
<tr>
<td>Skip unnecessary points</td>
<td>Select whether to keep or skip the points that are almost collinear.</td>
</tr>
<tr>
<td></td>
<td>If the creation points of a contour plate differ less than 0.3 mm from a straight line, they are skipped in the NC file when this setting is selected. When the setting is not selected, every creation point of a plate is written to the NC file. <strong>Skip unnecessary points</strong> not selected:</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Skip unnecessary points</strong> selected:</td>
<td></td>
</tr>
</tbody>
</table>

**Create KA block for**
Select the following options to show bent line information for bent plates and polybeam plates in the NC file KA block: **Unfolded bent plates** and **Unfolded polybeam plates**.
See also **XS_DSTV_DO_NOT_UNFOLD_POLYBEAM_PLATES**.

---

**Create pop-marks in NC files**
Pop-marks are small holes that help the shop assemble individual parts to form an assembly. Tekla Structures is able to write the pop-mark information in NC files to help position parts that will be manually welded to the assembly main part. Pop-marks are usually made using a drilling machine that drills a small hole in the surface of the material.

**Limitation:** Tekla Structures pop-marking does not work with polybeams.
Tekla Structures only creates pop-marks for parts for which you have defined pop-mark settings. You can save the pop-mark settings in a **.ncp** file, which Tekla Structures saves by default in the **..\attributes** folder under the current model folder.

---

Import to and export from Tekla Structures 286 Steel fabrication
NOTE Pop-marking affects numbering. For example, if two parts have different pop-marks, or one part has pop-marks and the other one does not, Tekla Structures gives the parts different numbers.

1. In the **NC Files** dialog box, select the parts for which you want to create the pop-marks by selecting the corresponding check boxes in the **Pop-marks** column.
2. Click the **Pop-marks** button.
3. In the **Pop-Mark Settings**, click **Add** to add a new row.
4. To define which parts are pop-marked and where the pop-marks are created, enter or select information for each item on a row.

   The order of the rows in the **Pop-Mark Settings** dialog box is important. Enter the most limiting definition first, and the most generic one last.

   First define the pop-mark settings on the **Parts to pop-mark** tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main part profile type</td>
<td>Select the main part profile type that is pop-marked. The list contains profiles according to the DSTV standard.</td>
</tr>
<tr>
<td>Main part name</td>
<td>Enter the names of the main part profiles. You can enter several part names separated by commas, for example, COLUMN, BEAM. You can use wildcards (* ? [ ]). For example, HE* matches all parts with a profile name that begins with the characters &quot;HE&quot;. Part name can contain more names separated by comma.</td>
</tr>
<tr>
<td>Sec part profile type</td>
<td>Select the secondary part profile type.</td>
</tr>
<tr>
<td>Secondary part name</td>
<td>Enter the names of the secondary part profiles. You can enter several part names separated by commas. You can use wildcards (* ? [ ]). Part name can contain more names separated by comma.</td>
</tr>
<tr>
<td>Pop-mark location</td>
<td>Select how the secondary part is projected onto the main part.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Left side</strong>: The left side of the secondary part is marked on the main part. The left side is the side</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Option</td>
<td>of the secondary part that is closest to the start point of the main part.</td>
</tr>
<tr>
<td>• Right side</td>
<td>The right side of the secondary part is marked on the main part.</td>
</tr>
<tr>
<td>• Both sides</td>
<td>Combines <strong>Left side</strong> and <strong>Right side</strong>.</td>
</tr>
<tr>
<td>• Center</td>
<td>Center of the secondary part.</td>
</tr>
<tr>
<td>• Left side holes</td>
<td>Marks the main part with the position of holes in the secondary part, on the left side of the secondary part.</td>
</tr>
<tr>
<td>• Right side holes</td>
<td>Marks the main part with the position of holes in the secondary part, on the right side of the secondary part.</td>
</tr>
<tr>
<td>• Both side holes</td>
<td>Combines <strong>Left side holes</strong> and <strong>Right side holes</strong>.</td>
</tr>
<tr>
<td>• Middle line</td>
<td>Marks two points on the middle line of the secondary part x axis.</td>
</tr>
</tbody>
</table>

| Move to flange                  | Select to which part of the main part flange the pop-marks are moved. The options are **None**, **Both flanges**, **Top flange**, and **Bottom flange**. |
| Edge distance                   | Enter the minimum distance from a pop-mark to the edge of the main part. Tekla Structures does not create pop-marks inside this distance. |
|                                 | If a pop-mark is inside the defined edge distance, Tekla Structures moves it, unless you have set **Pop-mark location** to **Center**. |
| Secondary pop-marks             | Select whether pop-marks are created to the secondary parts.                                     |
| Add pop marks to parts welded on site | Select whether pop-marks are created for parts that are welded on site.                           |

Then define the pop-mark settings on the **Pop-marking options** tab:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rotate part if pop-marks or other items only on the back</td>
<td>First select the <strong>Pop-marks on the back</strong> check box and then one of the options.</td>
</tr>
<tr>
<td></td>
<td>Also set the <strong>Hole diameter</strong>.</td>
</tr>
<tr>
<td>Rotate part and drill through pop-marks on the back if items or more</td>
<td></td>
</tr>
<tr>
<td>pop-marks only on the back</td>
<td></td>
</tr>
<tr>
<td>Drill through pop-marks on the back if no other items on the back</td>
<td></td>
</tr>
<tr>
<td>No pop-marks on overlapping holes</td>
<td>Select if you do not want to have pop-marks on overlapping holes.</td>
</tr>
<tr>
<td>Add pop-marks to centers of studs</td>
<td>Select to have pop-marks in the stud centers.</td>
</tr>
<tr>
<td>Show pop-marks in the model</td>
<td>Select to show pop-marks in the model.</td>
</tr>
<tr>
<td>Consider zero diameter holes as pop-marks</td>
<td>Write zero diameter bolt holes as a pop-marks.</td>
</tr>
</tbody>
</table>

5. Click **OK**.

6. Select the parts in the model and create the NC files.

Pop-marks are written in the **BO** block in the DSTV file as 0 mm diameter holes.

If needed, pop-marks can also be displayed in drawings. In drawings, select the **on/off** check box in the part properties to display the pop-marks.

Tekla Structures displays thick red lines for each pop-mark pair in the model view which was last updated.

**Examples**
Tekla Structures marks the center point of all round secondary profiles on a main part, and does not create pop-marks closer than 10 mm to the main part edge.

<table>
<thead>
<tr>
<th>Parts to pop-mark</th>
<th>Pop-marking options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main part profile type</td>
<td>Main part name</td>
</tr>
<tr>
<td>All profiles</td>
<td>All profiles</td>
</tr>
</tbody>
</table>

Tekla Structures projects the hole location in the secondary plates onto a main part.

<table>
<thead>
<tr>
<th>Parts to pop-mark</th>
<th>Pop-marking options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main part profile type</td>
<td>Main part name</td>
</tr>
<tr>
<td>All profiles</td>
<td>All profiles</td>
</tr>
</tbody>
</table>

**Create contour marking in NC files**

Tekla Structures is able to generate contour marking in NC files. This means that information on the layout and the parts that are welded or bolted together can be added to the NC files and passed on to the machine tool.

**Limitation:** Tekla Structures contour marking on polybeams does not work in all cases. The visual placement of contour marking on polybeams has been improved.

Tekla Structures only creates contour markings for parts for which you have defined contour marking settings. You can save the contour marking settings in a `.ncs` file, which Tekla Structures saves by default in the `.\attributes` folder under the current model folder.

You can add contour marking to both the main and the secondary parts.

**NOTE**  Contour marking affects numbering. For example, if two parts have different contour markings, or one part has contour markings and the other one does not, Tekla Structures gives the parts different numbers.

1. In the **NC Files** dialog box, select the parts for which you want to create the contour marks by selecting the corresponding check boxes in the **Contour marking** column.
2. Click the **Contour marking** button in the **NC Files** dialog box.
3. In the **Contour marking settings** dialog box, click **Add** to add a new row.
4. To define which parts are contour marked and how they are contour marked, enter or select information for each item on a row:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main part profile type</td>
<td>Select the main part profile type that is contour marked. The list contains</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Main part name</td>
<td>Enter the name for the main part profiles. You can enter several part names separated by commas, for example, COLUMN, BEAM. You can use wildcards (* ? []). For example, HE* matches all parts with a profile name that begins with the characters &quot;HE&quot;. Part name can contain more names separated by comma.</td>
</tr>
<tr>
<td>Sec part profile type</td>
<td>Select the secondary part profile type. The list contains profiles according to the DSTV standard.</td>
</tr>
<tr>
<td>Sec part name</td>
<td>Enter the name for the secondary part profiles. You can enter several part names separated by commas. You can use wildcards (* ? []). Part name can contain more names separated by comma.</td>
</tr>
<tr>
<td>Secondary contour marking</td>
<td>Select whether the secondary parts are contour marked.</td>
</tr>
<tr>
<td>Punch or powder</td>
<td>In the list, select how the part is contour marked:</td>
</tr>
<tr>
<td>Hard stamp</td>
<td>Select whether hard stamps are created.</td>
</tr>
<tr>
<td>Mark parts welded on site</td>
<td>Select whether you want to mark parts that are welded on site.</td>
</tr>
<tr>
<td>Edge distance</td>
<td>Define the minimum distance from a contour mark to the edge of the main part. Tekla Structures not create contour marks inside this distance.</td>
</tr>
</tbody>
</table>

5. Click **OK** and create the NC files.
Contour marking is written in the PU and KO blocks in the DSTV file. Tekla Structures displays contour marking as thick magenta lines in the model view.

_Fittings and line cuts in NC files_
When creating NC files in DSTV format, the method you use to cut the end of the beam affects the beam length in the NC file.

- **Fittings** affect the length of the beam in the NC file.
- **Line cuts** do not affect the length of the beam in the NC file.

When you cut the beam end, use the fitting method to make sure that the beam length is correct in the NC file.

The overall length of a beam will be the fitted net length of the beam. This means that Tekla Structures always takes the fitting into account when calculating the beam length.

For lines, polygons, or part cuts, the cut does not affect beam length, but the overall length in the NC file will be the gross (initially modeled) length of the beam.
1. Fitting
2. Line cut
3. Polygon or line cut
4. Fitting

**Shortest length**
If you want to use the shortest possible length in an NC file, use the advanced option XS_DSTV_NET_LENGTH.

**Net and gross length**
If you want to include both net and gross length into NC file header data, use the advanced option XS_DSTV_PRINT_NET_AND_GROSS_LENGTH.

**DSTV file description**
Tekla Structures produces NC files in DSTV format. DSTV format is an industrial standard defined by the German Steel Construction Association (Deutsche Stahlbau-Verband). A DSTV file is a text file in ASCII format. In most cases each part has its own DSTV file.

To learn more about the DTSV syntax, see Standard Description for Steel Structure Pieces for the Numerical Controls.

**Blocks**
The DSTV file is divided into blocks that describe the content of the file.

<table>
<thead>
<tr>
<th>DSTV block</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ST</td>
<td>Start of the file</td>
</tr>
<tr>
<td>EN</td>
<td>End of the file</td>
</tr>
<tr>
<td>BO</td>
<td>Hole</td>
</tr>
<tr>
<td>SI</td>
<td>Hardstamp</td>
</tr>
</tbody>
</table>
### Profile types
Profile types are named according to the DSTV standard.

<table>
<thead>
<tr>
<th>DSTV block</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AK</td>
<td>External contour</td>
</tr>
<tr>
<td>IK</td>
<td>Internal contour</td>
</tr>
<tr>
<td>PU</td>
<td>Powder</td>
</tr>
<tr>
<td>KO</td>
<td>Mark</td>
</tr>
<tr>
<td>KA</td>
<td>Bending</td>
</tr>
</tbody>
</table>

### DSTV profile type
Profile types are named according to the DSTV standard.

<table>
<thead>
<tr>
<th>DSTV profile type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>I</td>
<td>I profiles</td>
</tr>
<tr>
<td>U</td>
<td>U and C profiles</td>
</tr>
<tr>
<td>L</td>
<td>L profiles</td>
</tr>
<tr>
<td>M</td>
<td>Rectangular tubes</td>
</tr>
<tr>
<td>RO</td>
<td>Round bars</td>
</tr>
<tr>
<td>RU</td>
<td>Round tubes</td>
</tr>
<tr>
<td>B</td>
<td>Plate profiles</td>
</tr>
<tr>
<td>CC</td>
<td>CC profiles</td>
</tr>
<tr>
<td>T</td>
<td>T profiles</td>
</tr>
<tr>
<td>SO</td>
<td>Z profiles and all the other types of profile</td>
</tr>
</tbody>
</table>

### Part faces
Single letters in the DSTV file describe the part faces.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Part face</th>
</tr>
</thead>
<tbody>
<tr>
<td>v</td>
<td>front</td>
</tr>
<tr>
<td>o</td>
<td>top</td>
</tr>
<tr>
<td>u</td>
<td>bottom</td>
</tr>
<tr>
<td>h</td>
<td>behind</td>
</tr>
</tbody>
</table>

---

**Create NC files in DXF format using Convert DSTV files to DXF macro**

You can convert the created NC files in DXF format by using the **Convert DSTV files to DXF macro**

**Limitation:** The macro has been designed for simple plates. Therefore it may not give correct conversion results for beams, columns and bent polybeams.

1. Create the NC files in the DSTV format.
2. Click the **Applications & components** button in the side pane to open the **Applications & components** catalog.

3. Click the arrow next to **Applications** to open the applications list.

4. If **Convert DSTV files to DXF** is not visible in the **Applications** list, select the **Show hidden items** check box at the bottom of the **Applications & components** catalog.

5. Double-click **Convert DSTV files to DXF** to open the **Convert DSTV files to DXF** dialog box.

6. Browse for the folder that contains the NC files you want to convert to DXF files.

7. Select the NC files and click **Open**.

   Tekla Structures automatically creates an **NC_dxf** folder in the model folder and the DXF files are created there.

### Create NC files in DXF format using tekla_dstv2dxf.exe

You can use a separate Tekla Structures program tekla_dstv2dxf.exe to convert the DSTV files to DXF format. Only one side of a part (front, top, back or bottom) is written to the file, and therefore this export format is most suited to plates.

The program is located in the `..\Tekla Structures\<version>\nt\ dstv2dxf` folder.

1. **Create a folder for the NC files, for example c:.dstv2dxf.**
   
   Do not use spaces in the folder path. You should not save the files, for example, in the Tekla Structures folder under the `\Program Files` folder, because the folder path contains spaces.

2. **Copy all files from C:\Program Files\Tekla Structures\<version>\nt\dstv2dxf to the folder you created (C: \dstv2dxf).**

3. **Create DSTV files and save the files in the in the folder you created (C: \dstv2dxf).**

4. **Double-click a suitable dstv2dxf_conversion.bat file.**

   The program converts the files to DXF format in the same folder.

   If you need to adjust the conversion settings, modify the settings in an appropriate `tekla_dstv2dxf_<env>.def` file and restart the conversion. For more information, see the `tekla_dstv2dxf_<env>.def` file description below.

   The conversion file description pdf files can be found in the same folder as the `tekla_dstv2dxf.exe` program.
**tekla_dstv2dxf_<env>.def file description**

The `tekla_dstv2dxf_<env>.def` file is used when converting from the DSTV to the DXF format using the `tekla_dstv2dxf.exe`. It contains all the necessary conversion settings. The `.def` file is located in the `..\Tekla Structures\<version>\nt\dstv2dxf` folder.

The DSTV to DXF conversion settings are described below.

**Environment settings [ENVIRONMENT]**

**INCLUDE_SHOP_DATA_SECTION=FALSE**

Specify whether to include a special data section in the DXF file to allow the DXF file to be better imported into CNC software written by Shop Data Systems. Including this special data section in the DXF file makes the DXF file unreadable by AutoCAD.

Options: TRUE, FALSE

**NO_INFILE_EXT_IN_OUTFILE=TRUE**

Use to add the input file extension to the output file.

Options:

- TRUE: p1001.dxf
- FALSE: p1001.nc1.dxf

**DRAW_CROSSHAIRS=HOLES**

Draw crosshair for holes and slotted holes.

Options: HOLES, LONG_HOLES, BOTH, NONE

HOLES:

LONG_HOLES:

BOTH:
NONE:

SIDE_TO_CONVERT=FRONT
Define which side of the member to convert.
Options: FRONT, TOP, BACK, BELOW
Defines which part face is shown in the DXF file. This setting is originally designed for plates.
FRONT is the most typical option. Sometimes you may need another rotation for a plate, and then you can try if changing this setting to BACK would help. In addition to the SIDE_TO_CONVERT setting, it requires that the NC files are created with the advanced option XS_DSTV_WRITE_BEHIND_FACE_FOR_PLATE set to TRUE, which will include the back side data of a plate in the NC file.

OUTPUT_CONTOURS_AS=POLYLINES
Convert contours as polylines or lines and arcs.
Options: POLYLINES, LINES_ARCS

NOTE  If you set OUTPUT_CONTOURS_AS=LINES_ARCS:
• Slotted holes may sometimes have a gap/offset between a straight line and an arc.
• Sometimes a 3D DXF is produced instead of a 2D DXF.

If you set OUTPUT_CONTOURS_AS=POLYLINES, the DXF file may not be correct if the NC is created with the Inner corner=0 setting.

CONTOUR_DIRECTION=REVERSE
Define the contour direction. This option changes the coordinates of the vertices, and the order they are written. You can see the difference if you open the DXF file in a text editor: "reverse" is clockwise and "forward" is counterclockwise.
Options: REVERSE, FORWARD
CONTOUR_DIRECTION only works if you have set OUTPUT_CONTOURS_AS=POLYLINES. If you have set it to use LINES_ARCS, the output is always FORWARD (counter-clockwise).

CONVERT_HOLES_TO_POLYLINES=TRUE
Convert holes to polylines.
Options: TRUE, FALSE

MAX_HOLE_DIAMETER_TO_POINTS=10.0
Convert small holes to points in the DXF file.
When you set MAX_HOLE_DIAMETER_TO_POINTS to a value, the holes with a diameter smaller than this value will follow the HOLE_POINT_SIZE and HOLE_POINT_STYLE settings. With this kind of point visualization, the hole symbols will no longer show if a hole is bigger or smaller than the other one, but they will all have the same size.

HOLE_POINT_STYLE=33 and HOLE_POINT_SIZE=5
Point style and size for holes.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>HOLE_POINT_STYLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>2</td>
</tr>
<tr>
<td>×</td>
<td>3</td>
</tr>
<tr>
<td>-</td>
<td>4</td>
</tr>
<tr>
<td>○</td>
<td>33</td>
</tr>
<tr>
<td>⊙</td>
<td>34</td>
</tr>
<tr>
<td>✗</td>
<td>35</td>
</tr>
<tr>
<td>✰</td>
<td>36</td>
</tr>
</tbody>
</table>

1 is a circle, but this setting is not in use
2 is +
3 is X
4 is short line
33 is circle
34 is a circle with +
35 is a circle with X
36 is a circle with short line

SCALE_DSTV_BY=0.03937
Use 0.03937 to scale to imperial units.
Use 1.0 to scale to metric units.

ADD_OUTER_CONTOUR_ROUNDINGS=FALSE
Add holes to roundings. This only affects the roundings that are created using the Inner corner shape = 1 setting in the NC File Settings dialog box on the Holes and Cuts tab. The hole size information is coming to the DSTV file from the Radius value in the NC File Settings dialog box, and you cannot adjust the hole size in the dstv2dxf converter.

Options: TRUE, FALSE

ADD_OUTER_CONTOUR_ROUNDINGS=FALSE:

ADD_OUTER_CONTOUR_ROUNDINGS=TRUE:

MIN_MATL_BETWEEN_HOLES=2.0
Define how close the holes can be to each other in slotted hole conversion.

INPUT_FILE_DIR= and OUTPUT_FILE_DIR=
Folders for input and output files.

**DEBUG=FALSE**

Show data processing in the DOS window.

Options: **TRUE** or **FALSE**

**Text specifications [TEXT_SPECS]**

**TEXT_OPTIONS=PQDG**

Define the text options that you want to use in the DXF file:

- S adds a side mark (Side: v)
- P adds a part mark (Part: P/1)
- B adds a part mark and side mark (Part: P/1 Side: v)
- Q adds the quantity (Quantity: 5)
- G adds the steel grade (Material: A36)
- T adds the thickness (Thickness: 3)
- D adds the profile description (Desc: FL5/8X7)

**TEXT_POSITION_X=30.0 and TEXT_POSITION_Y=30.0**

The X/Y location of lower-left corner of first line of text from the origin point <0,0> of the DXF file.

**TEXT_HEIGHT=0.0**

TEXT_HEIGHT is not used, the text height is always 10.0, also in text layers.

**Text item prefixes**

You can define several different prefixes for text items. The prefix is only written in the file if the option **CONCATENATE_TEXT** is set to 0.

You can use the following prefix definitions:

- **PART_MARK_PREFIX=Part:**
- **SIDE_MARK_PREFIX=Side:**
- **STEEL_QUALITY_PREFIX=Material:**
- **QUANTITY_PREFIX=Quantity:**
- **THICKNESS_PREFIX=Thickness:**
- **DESCRIPTION_PREFIX=Desc:**

**CONCATENATE_TEXT=1**

Combine text items (part mark, quantity, profile, grade) into one or two lines.

Options:

- 0: Text lines are not combined. Prefixes work only with this option.
- 1: Part mark text on one line, other texts combined on another line.
2: All text on one line.

**CONCATENATE_CHAR=+**

Define a separator of max 19 characters for the text items.

**Examples of different text specifications**

The following settings are used the example below:

```
TEXT_OPTIONS=PQDG
TEXT_POSITION_X=30.0
TEXT_POSITION_Y=30.0
TEXT_HEIGHT=0.0
PART_MARK_PREFIX=Part:
SIDE_MARK_PREFIX=Side:
STEEL_QUALITY_PREFIX=Material:
QUANTITY_PREFIX=Quantity:
THICKNESS_PREFIX=Thickness:
DESCRIPTION_PREFIX=Desc:
CONCATENATE_TEXT=1
CONCATENATE_CHAR=+
```

![Image]

The following settings are used for the example below: **TEXT_OPTIONS=B,**
**CONCATENATE_TEXT=0:**

![Image]
## Miscellaneous layers [MISC_LAYERS]

<table>
<thead>
<tr>
<th>Entity</th>
<th>Layer Name</th>
<th>Color</th>
<th>Text Height</th>
<th>Output as</th>
</tr>
</thead>
<tbody>
<tr>
<td>TEXT</td>
<td>TEXT</td>
<td>7</td>
<td>Not used, always the same as the general text height definition 10.0.</td>
<td></td>
</tr>
<tr>
<td>OUTER_CONTOUR</td>
<td>CUT</td>
<td>7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INNER_CONTOUR</td>
<td>CUTOUT</td>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PART_MARK</td>
<td>SCRIBE</td>
<td>3</td>
<td>Do not set a value for this option. If you set one, the DXF file will not be created.</td>
<td></td>
</tr>
<tr>
<td>PHANTOM</td>
<td>LAYOUT</td>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NS_POP_PMARK</td>
<td>NS_POP_MARK</td>
<td>5</td>
<td>POP_CIRCLE 2.0</td>
<td>(POP_CIRCLE or POP_POINT followed by size)</td>
</tr>
<tr>
<td>FS_POP_PMARK</td>
<td>FS_POP_MARK</td>
<td>6</td>
<td>1.0</td>
<td>POP_CIRCLE 2.0</td>
</tr>
</tbody>
</table>

### Color table

1 = red
2 = yellow
3 = green
4 = cyan
5 = blue
6 = magenta
7 = white
8 = dark grey
9 = light grey

**Hole layers [HOLE_LAYERS]**

<table>
<thead>
<tr>
<th>Layer Name</th>
<th>Min Diam</th>
<th>Max Diam</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>P1</td>
<td>8.0</td>
<td>10.31</td>
<td>7</td>
</tr>
<tr>
<td>P2</td>
<td>10.32</td>
<td>11.90</td>
<td>7</td>
</tr>
<tr>
<td>P3</td>
<td>11.91</td>
<td>14.0</td>
<td>7</td>
</tr>
</tbody>
</table>

**Slot layers [SLOT_LAYERS]**

The type and color affect the symbol, but the color of the slot outline or arrow (phantom) is defined by the PHANTOM layer definition in the MISC_LAYERS definition.

<table>
<thead>
<tr>
<th>Layer Name</th>
<th>Min Dia m</th>
<th>Max Dia m</th>
<th>Min ‘b’</th>
<th>Max ‘b’</th>
<th>Min ‘h’</th>
<th>Max ‘h’</th>
<th>Typ e</th>
<th>Colo r</th>
<th>Phantom</th>
</tr>
</thead>
<tbody>
<tr>
<td>13_16x1</td>
<td>20.6</td>
<td>20.6</td>
<td>4.75</td>
<td>4.78</td>
<td>0.0</td>
<td>0.02</td>
<td>3</td>
<td>3</td>
<td>PHANTOM_OUTLINE</td>
</tr>
<tr>
<td>13_16x1-7_8</td>
<td>20.6</td>
<td>20.6</td>
<td>26.9</td>
<td>26.9</td>
<td>0.0</td>
<td>0.02</td>
<td>3</td>
<td>3</td>
<td>PHANTOM_OUTLINE</td>
</tr>
</tbody>
</table>

Below there are three examples with different phantom types. The other settings used are Slot type=1, HOLE_POINT_STYLE=33 and HOLE_POINT_SIZE=1

PHANTOM_ARROW:

![PHANTOM_ARROW]

PHANTOM_BOTH:

![PHANTOM_BOTH]

PHANTOM_OUTLINE:
For an explanation of the “b” and “h” dimensions, see the image below:

Examples of slot types
These example use different slot types, but the other setting are the same:

- Slot layer color is 3 (green).
- Hole layer color is 6 (magenta).
- Phantom layer color is 1 (red).
- Slot layer phantom type: PHANTOM_OUTLINE
- Hole point settings: HOLE_POINT_STYLE=35, HOLE_POINT_SIZE=10

<table>
<thead>
<tr>
<th>Slot type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLOT_TYPE_1</td>
<td>One hole symbol to the center of slot. The hole symbol follows the HOLE_POINT_STYLE and HOLE_POINT_SIZE settings. The slot symbol is created according to the selected phantom setting (PHANTOM_OUTLINE in this</td>
</tr>
<tr>
<td>Slot type</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SLOT_TYPE_2</td>
<td>Two hole symbols to the slot. The hole symbol follows the <code>HOLE_POINT_STYLE</code> and <code>HOLE_POINT_SIZE</code> settings. The slot symbol is created according to the selected phantom setting (PHANTOM_OUTLINE in this example). The hole symbol color follows the hole layer color, and the slot color follows the phantom layer color.</td>
</tr>
<tr>
<td>SLOT_TYPE_3</td>
<td>One circle to the center of slot. The size of the circle corresponds to the real hole size. The circle color follows the slot layer color, and the slot color follows the phantom layer color. The slot symbol is created according to the selected phantom setting (PHANTOM_OUTLINE in this example).</td>
</tr>
<tr>
<td>SLOT_TYPE_4</td>
<td>Two circles to the slot. The size of the circle corresponds to the real hole size. If the circles would be touching each other, only one circle in the middle of slot is created. The slot symbol is created according to the selected phantom setting (PHANTOM_OUTLINE in this example). The circle color follows the hole layer color, and the slot color follows the phantom layer color.</td>
</tr>
<tr>
<td>SLOT_TYPE_5</td>
<td>Hole symbol to the first slot center point. The hole symbol follows the <code>HOLE_POINT_STYLE</code> and <code>HOLE_POINT_SIZE</code> settings. The slot symbol is created according to the selected phantom setting (PHANTOM_OUTLINE in this example). The hole symbol color follows the hole layer color, and the slot symbol color follows the phantom layer.</td>
</tr>
<tr>
<td>SLOT_TYPE_6</td>
<td>One circle to the first slot center point. The slot symbol is created according to the selected phantom setting (PHANTOM_OUTLINE in this example). The circle color follows the hole layer color, and the slot symbol color follows the phantom layer color.</td>
</tr>
<tr>
<td>SLOT_TYPE_7</td>
<td>No hole symbol is created. The slot symbol is created according to the selected phantom setting (PHANTOM_OUTLINE in this example). The slot color follows the slot layer color.</td>
</tr>
</tbody>
</table>
**Create tube NC files**
You can create NC files for tubular hollow sections. You first need to use specific tube components to create the connections.

Create the following tube-to-tube and tube-to-plate connections:

- Tube-Chamfer
- Tube-CrossingSaddle
- Tube-MitreSaddle+Hole
- Tube-Saddle+Hole
- Tube-SlottedHole

After using the components, you can create an NC file for data export. The tube NC file creation results into an XML file which includes the model data.

**Limitations:**
To get the correct tube NC export results, note the following limitations:

- Line cuts and fittings created manually or by other components will be exported as simple chamfers.
- Holes created by bolts are not supported, and they will not be exported.
- Curved beams are not supported.

1. On the **File** menu, click **Export --> Tube NC files**.
2. In the **Tube NC Files** dialog box, enter a name for the export file, and browse for the location where you want to save the file. By default, the file is saved in the model folder.
3. Select whether you want to create the file for selected parts or for all parts.
4. Click **Create**.

Tekla Structures creates an XML file and a log file in the location you defined.

**MIS lists**
You can export an MIS list to a file.

You can export model data to Manufacturing Information Systems (MIS). The **MIS** export supports the following formats:

- **DSTV** - The exported file contains the MIS information written in the DSTV format.
- **FabTrol / KISS** - We recommend using the FabTrol reports instead of the **MIS** export for exporting FabTrol data. The FabTrol reports are available for the Steel Detailing role in the US environment. If you do not use a suitable environment you may also contact your local support for the FabTrol files.
• EJE - US environment, Imperial role only. Structural Material Manager internally stores all dimensions in sixteenths. Its External Data Interface writes all dimensions, such as widths and lengths, except for Beam and Channel descriptions, in sixteenths of an inch. As an example the length 12'-8 7/8 is equivalent to 2446 sixteenths, which is calculated as (feet * 192) + (inches * 16) + (eighths * 2) = (12 * 192 + 8 * 16 + 7 *2).

• EPC - The EPC (Estimating and Production Control) module of SDS/2 requires multinational numbering to be active.

• Steel 2000

Export a MIS list
1. On the File menu, click Export --> MIS .
   The Export MIS dialog box opens.
2. Select the file type from the MIS type list.
3. If you selected Fabtrol/KISS or Steel 2000, define the additional options:
   • Fabtrol/KISS
     Enter the customer name in the Customer name box.
     Select the Full material list check box to add labor-related information to the list (for example, holes, welds, cambers, preliminary marks).
   • Steel 2000
     Select the Export only shop bolts check box to include only workshop bolts in the list file.

4. Enter a name for the list file in the MIS list file box.
   By default, the list file is saved in the model folder.
   You can select the folder where you want to save the list file by clicking Browse.

5. Ensure that you have the selection switch Select objects in components selected. If you have the switch Select assemblies selected, Tekla Structures will create empty files.

6. Click Create all or Create selected to export the MIS list file.

CIS and CIMSteel models
The CIS (CIMsteel Integration Standards) is one of the results of the Eureka CIMsteel project. The current version CIS/2 is an extended and enhanced second generation release of the CIS. It was developed to facilitate a more integrated method of working through the sharing and management of
information within, and between, companies involved in the planning, design, analysis, and construction of steel framed buildings and structures.

There is one limitation: multi-material objects cannot be defined, because the standard concentrates on steel objects.

**Import a CIMSteel model**

1. On the **File** menu, click **Import --> CIMSteel**.
   The **Import Model** dialog box opens.
2. Select **Import CIS model** from the **Type** list.
3. Use the default name **import model** or enter a new name.
4. Click **OK**.
5. Select the model from the list.
6. Click **Properties** to open a dialog box where you can define the settings for the import file type you selected.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Parameters tab</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Model type</strong></td>
<td>Select the model type: <strong>Design, Analysis, SP3D</strong>.</td>
</tr>
<tr>
<td><strong>CIS version</strong></td>
<td>Select <strong>CIS/1</strong> or <strong>CIS/2</strong>:</td>
</tr>
<tr>
<td></td>
<td>• <strong>CIS/1</strong> imports files compatible with the CIMsteel LPM4DEP1 schema declaration.</td>
</tr>
<tr>
<td></td>
<td>• <strong>CIS/2</strong> imports files compatible with the CIMsteel CIS/2 (STRUCTURAL_FRAME_SCHEMA) schema declaration.</td>
</tr>
<tr>
<td><strong>Input file</strong></td>
<td>The name of the file you want to import. You can also browse for the file.</td>
</tr>
<tr>
<td><strong>Origin X, Y, Z</strong></td>
<td>Define the origin coordinates to place the file in a specific location.</td>
</tr>
<tr>
<td><strong>Combine members</strong></td>
<td>To combine several elements in the CIS model into one part in Tekla Structures, set <strong>Combine members</strong> to <strong>Yes</strong>.</td>
</tr>
<tr>
<td><strong>Max length for combining</strong></td>
<td>For example, if a beam in a file consist of more than one element, and you select <strong>Yes</strong>, the elements are combined to form one beam in the Tekla Structures model.</td>
</tr>
<tr>
<td></td>
<td>If you use the value <strong>No</strong>, Tekla Structures creates a beam for each element in the CIS model.</td>
</tr>
<tr>
<td></td>
<td><strong>Max length for combining</strong> is only applied if you set <strong>Combine members</strong> to <strong>Yes</strong>. Use this setting to define the maximum length for combining parts.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Setting</td>
<td>Tekla Structures combines elements into one part only if their combined length is less than the value you enter here.</td>
</tr>
<tr>
<td>Ignore offsets</td>
<td>CIS/1 and CIS/2 analysis models can include member offsets, which means that nodes are not exactly at the beam's end points. With the default Yes, Tekla Structures uses these offsets to locate the physical members. With No, Tekla Structures determines the location using the node locations.</td>
</tr>
<tr>
<td>Ignore forces</td>
<td>Use to define how forces are imported. With No, Tekla Structures imports absolute values of maximum forces to parts' user-defined attributes Shear, Tension and Moment. With Yes, Tekla Structures does not import forces.</td>
</tr>
<tr>
<td>Import GUID (design model)</td>
<td>Select Yes to include the part GUID in the import.</td>
</tr>
<tr>
<td>Conversion tab</td>
<td>Define the conversion files you want to use.</td>
</tr>
<tr>
<td>Profile conversion file</td>
<td>Conversion files map Tekla Structures profile and material names with names used in other software.</td>
</tr>
<tr>
<td>Material conversion file</td>
<td>For more information about conversion files, see Conversion files (page 115).</td>
</tr>
<tr>
<td>Twin profile conversion file</td>
<td></td>
</tr>
<tr>
<td>Advanced tab</td>
<td>Previous plan lists the objects in your model, compared with the objects in the file to be imported. They can be New, Modified, Deleted, or Same.</td>
</tr>
<tr>
<td>Action when object status is (compared to)</td>
<td>Tekla Structures compares the state of imported objects with those in your model. They can be Not in model, Different, or Same.</td>
</tr>
<tr>
<td></td>
<td>Use the options under Not in model, Different, and Same to specify the actions when importing changed objects. The options are No action, Copy, Modify, or Delete.</td>
</tr>
<tr>
<td></td>
<td>Usually there is no need to change the defaults.</td>
</tr>
</tbody>
</table>

7. Click OK to go to the Import Model dialog box.
8. Click Import.

Tekla Structures displays the Import model info dialog box.
9. Select which version of parts to import.
10. Click **Accept all**.

If you have changed the model and want to re-import it, you can also reject all changes by clicking **Reject all**, or accept or reject individual changes by clicking **Select individual**.

11. Tekla Structures displays the message **Do you want to save the import model for subsequent imports? Click Yes**.

Tekla Structures displays the import model in a model view.

12. Right-click the model view and select **Fit work area to entire model** to ensure that the imported model is completely visible.

13. If parts are missing, check the **View depth Up** and **Down** values in the **View Properties** dialog box and change them if necessary.

**Export to a CIMSteel analysis model**

1. Open a Tekla Structures model that you want to export.

2. Select the objects to export using the appropriate selection switches or filters.

3. On the **File** menu, click **Export --> CIMSteel: Analysis model**.

4. Select the CIS version from the **CIS version** list.
   - **CIS/1** generates a file that is compatible with the CIMsteel LPM4DEP1 schema declaration.
   - **CIS/2** generates a file compatible with the CIMSteel CIS/2 (STRUCTURAL_FRAME_SCHEMA) schema declaration.

5. Enter a name for the export file in the **Step file** box or accept the default. You can enter the path or browse for it. If you do not enter a path, Tekla Structures creates the export file in the current model folder.

6. If required, enter the a name and organization to identify who created the export file.

7. From the **Flavor** list, select one of the following standards to apply to the export: **UK**, **EUROPEAN**, or **US**.

8. Set units to **metric** or **imperial** in the **Linear units (CIS/2 only)** box. Imperial is only available for CIS/2. CIS/1 is always exported in metric units.

9. Enter coordinate values in **Origin X**, **Y**, and **Z** boxes if you want to export the model to a specific location. The origin comes from the origin in Tekla Structures.
10. To split a part in the Tekla Structures model into several elements in the CIMsteel model, set Split members to Yes.

For example, three columns may be connected to a beam in a model, so that one column is in the middle and the others are at each end of the beam. With the Yes option the beam is split into two equal elements in the CIMsteel model. With the No option there will be one beam, a single linear element, and two nodes (a node at each end) in the CIMsteel model.

11. Click Apply and Create.

Tekla Structures exports the CIMSteel analysis model to the current model folder, or to another folder you specified, using the name you specified.

Export to a CIMSteel design/manufacturing model
1. Open a Tekla Structures model that you want to export.
2. Select the parts that you want to export.
3. On the File menu, click Export --> CIMSteel: Design/Manufacturing Model.
4. Go to the Parameters tab and specify the required information:
   • Select the LPM version: LPM4 or LPM5.
   • Enter name for the export file in the Output file box or accept the default.
     You can enter the path or browse for it. If you do not enter a path, Tekla Structures creates the export file in the current model folder.
   • Select the model type from the CIS/2 model type list. The options are manufacturing, design, and SP3D.
   • Set units to metric or imperial in the Linear units (CIS/2 only) box.
     With Imperial units Tekla Structures writes all of the designations for nuts, bolts, and washers in fractional inches.
   • Enter a name for the structure in the Structure name field.
   • Enter the path to the profile and material conversion files or browse for them.
     If you leave the profile and material conversion file paths empty, Tekla Structures uses the conversion files in the current profile folder for the conversion.
   • To export globally unique IDs instead of internal ID numbers, set Export Globally unique ID to Yes.
   • If you want to export concrete parts, set Export concrete to Yes.
5. Go to the **Standards** tab, and enter the appropriate profile, material, and bolt standard organization, name and year.

Tekla Structures populates the export file with the information you enter here. If you do not enter the standard organization or the name, Tekla Structures places an empty entry ("") in the export file. If you do not give the year, Tekla Structures uses 1999 as the default value.

6. If you are exporting to a manufacturing model, go to the **Manufacturing** tab, and specify the required information:
   - Set **Include NC files** to **Yes** to include information on NC files in the export.
   - In **NC file directory**, specify the path (relative to the current model folder) to the folder where the NC files are located.

7. If you are exporting to a design model, go to the **Design model** tab, and set **Export design connections** to **Yes** to export design connections.

8. Click **Apply** and **Create**.

Tekla Structures exports the CIMSteel design or manufacturing model to the current model folder, or to another folder you specified, using the name you specified.

---

**CIMSteel conversion files**

Here are examples of the contents of the conversion files used in CIMSteel conversion.

**Example 1**

This example shows part of the profile conversion file `prfexp_cis.cnv`:

```
! US Imperial Flavor
! Profile name conversion Tekla Structures -> CIS
!
! If Converted-name does not exist, it will be
! the same as Tekla Structures-name.
! Tekla Structures-name Converted-name
!
!American Sections - Imperial
!W - Wide Flange Beams
W44X335 S\SECT\US\W44X335\ASTM_A6\1994
W44X290 S\SECT\US\W44X290\ASTM_A6\1994
W44X262 S\SECT\US\W44X262\ASTM_A6\1994
```
**Converted-name** contains the following information, and items are separated by a backslash (\):

- S (fixed value)
- SECT (fixed value)
- Name of the standardization organization
- Standard name of the profile shape
- Name of the standard
- Year of the standard

If the conversion file does not contain the relevant profile type, the Tekla Structures name of the profile is used. Tekla Structures also uses the standardization organization, standard name and year of standard defaults given on the **Standards** tab.

**Example 2**

This example shows part of the material conversion file `matexp_cis.cnv`:

```plaintext
! US Imperial Flavor
! Material name conversion Tekla Structures -> CIS
!
! If Converted-name does not exist, it will be
! the same as Tekla Structures-name.
! Tekla Structures-name Converted-name

# Carbon Structural Steel (ASTM_A36\1994)
GRADE32 S\MAT\US\GRADE32\ASTM_A36-94\1994
GRADE36 S\MAT\US\GRADE36\ASTM_A36-94\1994

# High Strength Carbon Manganese Steel (ASTM_A529\1994)
GRADE42 S\MAT\US\GRADE42\ASTM_A529-94A\1994
```

**Converted-name** contains the following information, and items are separated by a backslash (\):

- S (fixed value)
- MAT (fixed value)
- Name of the standardization organization
- Standard name of the material
- Name of the standard
- Year of the standard
**Converted-name** contains the following information about bolts, nuts, and washers, separated by two colon characters (::):

- Name of the standards organization
- Name of the standard
- Year of the standard
- Standard name of the bolt, washer, or nut

Tekla Structures names for bolts, washers, and nuts are constructed from their fastener standard, fastener type and size.

If the conversion file does not contain an equivalent profile name, Tekla Structures uses the name of the material.

**FabTrol XML files**

You can import fabrication status information for parts to a Tekla Structures model from an XML file written by FabTrol.

FabTrol is a Material Resource and Planning (MRP) system commonly used by steel fabricators to manage estimating, inventory and production. Data can be written to FabTrol via a KISS format export or directly via the text based reports from Tekla Structures for tracking of the assembly status through the project lifecycle. The tracking information entered in FabTrol can then be re-imported back to Tekla Structures via the FabTrol XML import for colorization of the model. This is performed by storing the data in a preset collection of user-defined attributes (UDAs). Import of the FabTrol XML is possible in all configurations of Tekla Structures (including Project Viewer) but data can only be saved into the UDAs in modeling or management configurations.

You need to have the XMLTrans.trn file in the system folder defined by the advanced option XS_SYSTEM. This file maps the FabTrol XML names to Tekla Structures UDA names.

**Import Fabtrik XML**

1. On the File menu, click Import --> FabTrol XML.
2. Click the ... button next to the Input file box to browse for the XML file.
3. Select an appropriate option from the Create log file list:
   - Select Create to write a new log file and delete the previous log file each time you import the XML file.
   - Select Append to add the log file information at the end of the existing log file.
   - If you do not need a log file, select No.
4. Select an appropriate option from the Display log file list:
   - If you do not want to display the log file, select No.
   - To display the log file, select On dialog.
5. Click **Create** to import the status information.

**PDMS/E3D**

You have the following tools available for download in Tekla Warehouse:
- PDMS/E3D and Tekla Structures Interoperability: Export to PDMS/E3D
- PDMS/E3D and Tekla Structures Interoperability: PDMS/E3D extension
- BIM Publisher

Tekla User Assistance contains the following articles about PDMS/E3D:
- PDMS/E3D and Tekla Structures Interoperability: Q&A, collected 7th March 2017
- AVEVA PDMS/E3D and Tekla Structures Interoperability: PDMS/E3D extension

**ASCII files**

ASCII stands for American Standard Code for Information Interchange. Some plant design systems export ASCII files, for example, ModelDraft, PDS and PDMS.

You can import and export profiles and plates created as beams using the ASCII format. Contour plates cannot be imported.

**Import a model in the ASCII format**

2. Create a new 3D view.
3. Copy the ASCII file to the model folder.
4. Name the file `import.asc`.
5. On the **File** menu, click **Import --> ASCII**.

   Tekla Structures displays the main parts created from the ASCII file in the model.

**Export a model to the ASCII format**

1. Open the Tekla Structures model you want to export.
2. Select the parts in the model you want to export.
3. On the **File** menu, click **Export → ASCII**.

Tekla Structures creates a `model.asc` file in the current model folder.

**ASCII file description**

In an import.asc file each part is described by 8 lines. These lines are repeated for each part to be transferred. Units are always in millimeters, blanks are used as separators.

Below is an example of a beam part description:

```
import.asc

4169 HEA300 1
290.000000 8.500000 300.000000 14.000000 300.000000 14.000000
A/6 BEAM
S235JR S235JR
0.000000
16.500000 24000.000000 4855.000000
6000.000000 24000.000000 4855.000000
16.500000 24000.000000 5855.000000
```

<table>
<thead>
<tr>
<th>Line</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line 1</td>
<td>4169 HEA300 1 = ID profile type</td>
</tr>
<tr>
<td></td>
<td>• ID 4169: Unique ID (integer).</td>
</tr>
<tr>
<td></td>
<td>• PROFILE HEA300: Profile name (string).</td>
</tr>
<tr>
<td></td>
<td>• TYPE 1: Profile type (integer)</td>
</tr>
</tbody>
</table>

The available profile types are:

0 = free cross section (can be used for special profiles which are not in the database)

1 = I profiles

2 = Welded hollow core profiles (HK, HQ)

3 = U profiles

4 = L profiles

5 = Round bars

6 = Round tubes

7 = Rectangular hollow core sections (RHS, P)

8 = T profiles

9 = Rectangular bars (FL, PL)

10 = Z profiles

11 = C profiles
<table>
<thead>
<tr>
<th>Line</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>Omega profiles</td>
</tr>
<tr>
<td>13</td>
<td>Sigma profiles</td>
</tr>
<tr>
<td>14</td>
<td>Rail profile</td>
</tr>
<tr>
<td>16</td>
<td>Reinforcement bars (DH)</td>
</tr>
<tr>
<td>Line 2</td>
<td>The contents of line 2 depend on the part profile.</td>
</tr>
<tr>
<td></td>
<td>• Polygon plates:</td>
</tr>
<tr>
<td></td>
<td>N_POINTS COORDINATES</td>
</tr>
<tr>
<td></td>
<td>N_POINTS: For profiles of type 0.</td>
</tr>
<tr>
<td></td>
<td>COORDINATES: Number of the corner points (integer).</td>
</tr>
<tr>
<td></td>
<td>The X and Y coordinates of the plate corners (floating). Rotation direction is clockwise. Coordinates follow the global coordinate system. Z coordinates are taken from the center line in the plate thickness direction.</td>
</tr>
<tr>
<td></td>
<td>Note that the line 2 can be divided into several rows in the file.</td>
</tr>
<tr>
<td></td>
<td>• Profiles:</td>
</tr>
<tr>
<td></td>
<td>For profile types 1-16, the line includes the physical dimensions of the cross section.</td>
</tr>
<tr>
<td></td>
<td>HEIGHT S W1 T1 W2 T2: 290.000000 8.500000 300.000000 14.000000 300.000000 14.000000</td>
</tr>
<tr>
<td></td>
<td>• HEIGHT 290.000000: Height of the cross section</td>
</tr>
<tr>
<td></td>
<td>• S 8.500000: Web thickness.</td>
</tr>
<tr>
<td></td>
<td>• W1 300.000000: Width of the upper flange.</td>
</tr>
<tr>
<td></td>
<td>• T1 14.000000: Thickness of the upper flange.</td>
</tr>
<tr>
<td></td>
<td>• W2 300.000000: Width of the lower flange.</td>
</tr>
<tr>
<td></td>
<td>• T2 14.000000: Thickness of the lower flange.</td>
</tr>
<tr>
<td>Line 3</td>
<td>A/6 BEAM = mark name</td>
</tr>
<tr>
<td></td>
<td>• MARK A/6: Position mark of the part (string).</td>
</tr>
<tr>
<td></td>
<td>• NAME BEAM: Part name (string).</td>
</tr>
<tr>
<td>Line 4</td>
<td>S235JR S235JR = material</td>
</tr>
<tr>
<td></td>
<td>Material of the part (string).</td>
</tr>
<tr>
<td>Line 5</td>
<td>0.000000 = rotation</td>
</tr>
<tr>
<td></td>
<td>Rotation angle (in degrees) around the local x-axis of the beam.</td>
</tr>
<tr>
<td>Line 6</td>
<td>16.500000 24000.000000 4855.000000 = X1 Y1 Z1</td>
</tr>
<tr>
<td></td>
<td>Coordinates of the beam start point. Z coordinates are center-line coordinates.</td>
</tr>
<tr>
<td>Line</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>Line 7</td>
<td>6000.000000 24000.000000 4855.000000 = X2 Y2 Z2</td>
</tr>
<tr>
<td></td>
<td>Coordinates of the beam end point. Z-coordinates are center-line coordinates.</td>
</tr>
<tr>
<td>Line 8</td>
<td>16.500000 24000.000000 5855.000000 = X3 Y3 Z3</td>
</tr>
<tr>
<td></td>
<td>Direction vector showing the direction of the local z-axis.</td>
</tr>
</tbody>
</table>

### 3.13 Concrete fabrication

With Tekla Structures you can efficiently deliver all types of precast concrete elements at the right time to the right place by integrating design and detailing with manufacturing, project management and efficient information sharing.

For the precast fabricators, the target is to offer functionalities to help to optimize the whole precast construction process from modeling to fabrication to site operations, minimize errors and waste in all stages and improve collaboration between project parties in design, production and site.

The offering consist of several product listed below.

**Unitechnik**

Unitechnik (from the company Unitechnik) is the most common format for exporting precast and mesh geometry as well as production data. Unitechnik is for precast panels and slabs and other products that are manufactured in a pallet circulation as well as for reinforcement meshes.

The Unitechnik format is not used only by UniCAM but also by other industry solutions such as Leit2000.

*Export to Unitechnik (page 319)* versions 5.0c - 6.1 are available in Tekla Structures core installation in the most extensive precast-related configurations.

**EliPLAN**

EliPLAN is an ERP software from machinery provider Elematic. The file format .eli also contains production data and geometry for CAM-operated hollow-core slab production.

Both export from and import to (page 384) Tekla Structures are available in the Tekla Structures installation in the most extensive precast-related configurations.

**HMS**

HMS is a CAM software for hollow-core production.

Tekla Structures has export to HMS (page 395) software included in the Tekla Structures installation in the most extensive precast-related configurations.

**BVBS**
Reinforcement geometry can be exported to German BVBS (Bundesvereinigung Bausoftware) format. The result is a text file in ASCII format.

You can export cut and bent reinforcing bars, reinforcing bar groups and reinforcement meshes, which can be rectangular, polygonal, non-bent or bent, and may include cuts. The export of hooks is also supported.

The supported version of the BVBS format is 2.0 from year 2000.

BVBS export (page 376) is available in Tekla Structures installation in the most extensive configurations.

UXML

UXML (from the company Unitechnik) is for precast panels and slabs and other products that are manufactured in a pallet circulation as well as for reinforcement meshes.

Tekla Structures supports exporting both to Unitechnik and UXML formats.

Precast Production Export for UXML can be found as an extension in Tekla Warehouse. For instruction on how to use the export, see Precast Production Export.

PXML

The data format of progressXML also known as PXML has been developed by Progress Software Development, which is part of precast solution provider Progress Group. Data format is based on hierarchically structured XML for the generation of data and production control and scheduling at precast or rebar prefabrication factories. PXML contains both the product geometry to be used in production and the attribute data for managing the related processes (ERP-data). In particular, there are two different areas of application:

- interface between systems of different manufacturers
- internal (proprietary) storage of data of CAD/CAM systems

PXML is the main data format to bring design geometry between detailer's Tekla Structures and factory's Progress software such as ebos, erpbos, ProFit and AviCAD.

Precast Production Export for PXML can be found as an extension in Tekla Warehouse. For instruction on how to use the export, see Precast Production Export.

Unitechnik

You can export the 3D geometry of the cast units to the Unitechnik format. The result is a text file in ASCII format.

Supported versions of the Unitechnik format are:

- 6.1.0 17.9.2009
Unitechnik format is intended for the production of the geometry of pallet- or table-produced precast elements such as solid, sandwich or double walls as well as panel slabs and half-slabs. You can export cast units consisting of concrete, steel and surface materials. Exporting of reinforcing bars (bent and not-bent), reinforcing bar groups and meshes with hooks is also supported.

**Example**

Exported cast unit:

1. Hole
2. Steel embed
3. Reinforcing bars, cages also supported (UT version 6.1.0)
4. Insulation plate (green)

For details about exporting to Unitechnik, see [Export to Unitechnik format](#) (page 321).

For details about exporting to UXML and PXML, see Precast Production Export. You can download Precast Production Export from Tekla Warehouse.

For details about Unitechnik export settings, click the following links:
Export to Unitechnik format
You can export the 3D geometry of the cast units to the Unitechnik format. The result is a text file in ASCII format with a file name extension .uni.

Limitation: Cast units with cast unit type cast-in-place are not exported.

1. Go to the part properties of the parts that you plan to export, and edit the user-defined attributes on the Unitechnik tab (or Unitechnik Mountpart tab for steel parts) as required. The user-defined attributes are environment specific, so you may not have all the settings below available:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product type</td>
<td>Product type is important for identifying the object type in CAM software. Undefined product type will result in error notification while importing the production data file. You can define the product type by selecting one of the options, or by defining a user-defined text.</td>
</tr>
<tr>
<td>User-defined product type</td>
<td>Optional field for product type.</td>
</tr>
<tr>
<td>Product group</td>
<td>Optional field for product group. The product group is used in the SLABDATE block.</td>
</tr>
<tr>
<td>Product addition</td>
<td>This attribute is exported with Unitechnik export (79) to object's SLABDATE block as a representative number 00-03. The available options are Standard element, Balcony, Roof, and Plastered element.</td>
</tr>
<tr>
<td><strong>Storey</strong></td>
<td>Optional field used for planning the transport and erection processes.</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td><strong>Transport unit number</strong>&lt;br&gt;<strong>Transport sequence number</strong></td>
<td>Optional fields used for planning the transport and erection processes. These can be defined in the export settings to be included as part of SLABDATE block.</td>
</tr>
<tr>
<td><strong>Transport pile level</strong></td>
<td>Optional field that specifies the transport pile level number. If there are elements in the stack that need to be layered on the same level, then the pile level is used if the transport sequence number is the same for the pile. This can be defined in the export settings to be included as part of SLABDATE block. For example, you may have a pile of 6 slabs, and they each have sequential pile level numbers 1, 2, 3.. 6.</td>
</tr>
<tr>
<td><strong>Concreting identification (LOT block)</strong></td>
<td>You can select <strong>No special treatment</strong> or <strong>Shovel concrete</strong>, or leave the field empty.</td>
</tr>
<tr>
<td><strong>Layer split thickness</strong></td>
<td>Manually define the layers with names and thicknesses.</td>
</tr>
<tr>
<td><strong>Layer not to export</strong></td>
<td>Specify the layer that you do not want to export.</td>
</tr>
<tr>
<td><strong>Mountpart data from UDA</strong></td>
<td>Select whether you want to export mountpart data from the user-defined attributes.</td>
</tr>
<tr>
<td><strong>Exlude from export</strong></td>
<td>Select whether you want to exclude mountparts from export.</td>
</tr>
<tr>
<td><strong>Identification of installation</strong></td>
<td>Select one of the following options:&lt;br&gt;<strong>Installed (0)</strong>&lt;br&gt;<strong>Only plotted (1)</strong>&lt;br&gt;<strong>Only installed (2)</strong>&lt;br&gt;<strong>Not installed, not plotted (3)</strong>&lt;br&gt;<strong>Installed in reinforcement (4)</strong>&lt;br&gt;<strong>Installed automatically (5)</strong></td>
</tr>
<tr>
<td><strong>Type of mounting part</strong></td>
<td>Define the type of mounting part by entering a user-defined attribute.</td>
</tr>
</tbody>
</table>
### Reference number
Define the reference number of a mounting part by entering a user-defined attribute.

<table>
<thead>
<tr>
<th>Mountpart name</th>
<th>Enter the mountpart name.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Info 1 text (UT 6.0)</td>
<td>Specify more information, if necessary.</td>
</tr>
<tr>
<td>Info 2 text (UT 6.0)</td>
<td>Specify more information, if necessary.</td>
</tr>
</tbody>
</table>

2. We recommend that you define the top-in-form face. Do this before creating any drawings.
   For more information, see Define the casting direction of a part.

3. Update numbering.
   **Export Unitechnik** reads and exports data from the numbering series of parts. It is important that all exported parts are numbered correctly. Incorrectly numbered parts are not exported.

4. On the **File** menu, click **Export --> Unitechnik**.
   The **Export Unitechnik** dialog box is displayed.

5. Define the Unitechnik export properties on the tabs:
   - Unitechnik export: Main tab (page 325)
   - Unitechnik export: TS configuration tab (page 330)
   - Unitechnik export: Embeds tab (page 341)
   - Unitechnik export: Reinforcement tab (page 349)
   - Unitechnik export: Validation tab (page 359)
   - Unitechnik export: Reinf. data specification tab (page 361)
   - Unitechnik export: HEADER block data specification tab (page 364)
   - Unitechnik export: SLABDATE block data specification (page 366)
   - Unitechnik export: Mounting part data specification tab (page 368)
   - Unitechnik export: Line attributes tab (page 369)
   - Unitechnik export: Pallet tab (page 373)
   - Unitechnik export: Log files tab (page 375)

6. Select objects using **Select assemblies** (recommended) or **Select objects in assemblies** depending on the option that you selected for **Create from** on the **Main** tab. You can also enter the cast unit positions to be exported manually.

7. Click **Create**.
   By default, .uni output files are created in the \UT Files folder under the current model folder. The number of output files depends on the

---

Import to and export from Tekla Structures 323 Concrete fabrication
options selected from the Create from list on the Main tab, and on the total number of selected parts, cast units, or assemblies.

The export log is displayed. See the Log files tab for additional log options.

The maximum number of exported elements or layers is limited to 99. If the limitation is exceeded, you will be notified by a console and log file message.

**Limitations in Unitechnik export**

The Unitechnik format is for flat panels and slabs for production in pallet circulation plants. It is an open format used by many different production system master computers, and therefore the specifications are quite strict, and field character lengths are limited, for example. The different master computers from different solution providers also have different interpretations of the Unitechnik data. The original format is from early 2000's, and it is a bit outdated in many aspects. As a result, the Unitechnik format has certain limitations:

- All Unitechnik fields have a maximum character length, both for geometry and attribute information.
- While Tekla Structures supports input of longer strings, the data has to be cut and simplified, or the export may be prevented completely. The log will notify if this happens.
- Negative values in certain geometry fields (negative pallet X, Y, and Z coordinates, for example) will cause errors in production systems, even though the geometry comes correctly from the model.
- Also the number of fields per hierarchy object is limited, although each has also unspecified reserve fields for customer-specific cases.
• 3D shapes are not supported.
• 3D concrete shapes are not supported (except for edge shapes in line attributes)
• 3D embed shapes are not supported
• 3D bent rebar shapes are not supported
• When using terminal hook deflection forms, the rebars and meshes can be bent only in one direction (hooks up or hooks down, for example).
• One Unitechnik file may only have one HEADER block, but it may have several SLABDATE blocks.
• Double wall elements are an exception. They should be exported in one file, with each shell having its own HEADER information.

**Unitechnik export: Main tab**

Use the **Main** tab to control the Unitechnik export properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unitechnik version</td>
<td>Select the Unitechnik version.</td>
</tr>
<tr>
<td>Create from</td>
<td>Select which parts or cast units are exported.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Selected cast units</strong></td>
</tr>
<tr>
<td></td>
<td>Only cast units that have one or more parts selected in the model are exported. Each cast unit has one output file. Select <strong>By cast unit Id</strong> or <strong>By cast unit position</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>All parts</strong></td>
</tr>
<tr>
<td></td>
<td>All cast units are exported. Each cast unit has one output file. Select <strong>By cast unit Id</strong> or <strong>By cast unit position</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Selected parts (separately)</strong></td>
</tr>
<tr>
<td></td>
<td>Only the selected concrete parts (also embeds and insulation parts belonging to the selected part) are exported. Each part has one output file.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Selected parts (cast united)</strong></td>
</tr>
<tr>
<td></td>
<td>Selected parts belonging to one cast unit are grouped and exported together in one output file. Select <strong>By cast unit Id</strong> or <strong>By cast unit position</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Selected assemblies</strong></td>
</tr>
<tr>
<td></td>
<td>This option is recommended in most cases. All selected assemblies are exported. One</td>
</tr>
</tbody>
</table>

Import to and export from Tekla Structures 325 Concrete fabrication
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option</td>
<td>assembly equals one cast unit and has one output file. Selection of subassemblies is also allowed.</td>
</tr>
</tbody>
</table>
|                                   | • **Cast units in list**  
|                                   | Select the cast units for export from the *Cast unit position list* you enter.  
|                                   | • **By cast unit Id**  
|                                   | Each cast unit has its own output file.  
|                                   | • **By cast unit position**  
|                                   | Identical cast units share an output file.  |
| Parts excluded from export (classes) | If you do not want to export some parts, enter the classes of the parts. You can also filter out rebars with this setting. Parts with classes in this list will not be exported. |
| Directory path                    | Define where the export files are saved. The default folder is .\UT_Files under the current model folder. |
| File name                          | Select the name of the output file from the lists and file name extension. |
| Extension                          | You can use up to 5 strings to generate the export file names. Select options from the lists, definition values or attributes, and an optional string length limiter. You can leave the box empty if you do not need all 5 strings. You can use the delimiter period ( .), dash (-), or underscore (_) between the strings. |

- **Proj. nr** is the number of the project.
- **Proj. name** is the name of the project.
- **CU nr** is the assembly position number of the main part of the cast unit.
- **Phase** is the current phase.
- **CU pos** is the assembly position of the main part of the cast unit.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>ACN</strong> is the assembly control number. To generate the assembly control numbers, go to the Drawings &amp; reports tab and click Numbering --&gt; Assign control numbers.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Part ID</strong> is the ID number, which is 10 characters long. If the ID number is not 10 characters long, zeros are added in front of the ID number to make it 10 characters long. For example, id number 45699 will be 000045699.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Counter</strong> adds a running number at the end of the file name, if the name already exists.</td>
<td></td>
</tr>
<tr>
<td>• Other options are <strong>Date, Time, Date-Time, UDA, Text, Template</strong>, and <strong>Project UDA</strong>. <strong>Date, Date-Time</strong> and <strong>Time</strong> use the format yyyy-mm-dd-hh-mm. <strong>Template</strong> means a template attribute. <strong>UDA</strong> and <strong>Template</strong> are always read from the main part. Also define the file name extension. By default it is <strong>Text</strong> and <strong>uni</strong>. You can select another option from the list.</td>
<td></td>
</tr>
</tbody>
</table>

<p>| File name mask | The format (length) of the output file name and file name extension. Numbers represent the length of the output string. If the name is longer than the selected option, it is cut. |
| Open folder after export | Select whether the folder where the output file is saved is opened after the export. |
| Output file structure | Structure of the exported file (slab date and layer part). |
| • <strong>Multiple layers</strong> | One <strong>SLABDATE</strong> block with N layers. Each cast unit has its own <strong>LAYER</strong> block. Embeds, reinforcement and insulations belong to one concrete part, and they are exported to the related <strong>LAYER</strong> block. If the layers are not defined correctly, it will result in error. |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Single layer, 1 slabdate, 1 part</td>
<td>Each cast unit has its own SLABDATE block, no LAYER blocks.</td>
</tr>
<tr>
<td>• Single layer, n slabdate, n parts</td>
<td>Cast units with equal geometry are collected in one SLABDATE block. No LAYER or LOT blocks are defined. Embeds, reinforcement and insulation belonging to a cast unit with the same geometry are collected and exported in one SLABDATE block.</td>
</tr>
<tr>
<td>• Single layer, 1 slabdate, n parts</td>
<td>All similar wall shells are defined within one SLABDATE block instead of being defined in a separate SLABDATE block per wall shell. The</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>option is useful when exporting special embeds.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Combined, n slabdate, 1 part</strong></td>
<td>Combined export that can contain more than one cast unit. The exported cast units are placed side by side according to the sequential logic defined on the <strong>Pallet</strong> tab.</td>
</tr>
<tr>
<td>1st exported layer</td>
<td>Select which part is exported in the first <em>layer</em>. This option allows to define which wall shell is positioned on the pallet first. The options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Main part</strong> <em>(of cast unit)</em></td>
</tr>
<tr>
<td></td>
<td>• <strong>Biggest part</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Heaviest part</strong></td>
</tr>
<tr>
<td><strong>Consider layer split thicknesses</strong></td>
<td>Select how the layers of the cast unit are exported. These options are available when you have set <strong>Output file structure</strong> to <strong>Multiple layers</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>No</strong>  The cast unit is exported as one volume.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Yes</strong>  The manual layers set on the <strong>Unitechnik</strong> tab in the user-defined attributes of a part are used, and the cast unit is exported in two or three layers.</td>
</tr>
<tr>
<td><strong>Blank symbol in exported file</strong></td>
<td>Select the blank symbol to be used in the export file. An example with &quot;_&quot; symbol:</td>
</tr>
<tr>
<td></td>
<td>An example with &quot;_&quot; symbol:</td>
</tr>
<tr>
<td></td>
<td>HEADER_*_</td>
</tr>
<tr>
<td></td>
<td>005</td>
</tr>
<tr>
<td></td>
<td>S7_____ W1___.__ W</td>
</tr>
<tr>
<td></td>
<td>S7_</td>
</tr>
<tr>
<td></td>
<td>Corporation__</td>
</tr>
<tr>
<td></td>
<td>______________</td>
</tr>
<tr>
<td></td>
<td>An example with &quot; &quot; symbol:</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Rotation</td>
<td>Select the scanning direction, which defines which main part face is towards the pallet base. Unitechnik export uses scanning layers to obtain the geometry of all parts in a cast unit. The scanning direction depends on the plane of the cast unit main part. A floor panel is scanned from bottom to top side. A wall panel and a column are scanned from one side to the other.</td>
</tr>
</tbody>
</table>

**See also**

Unitechnik (page 319)
Export to Unitechnik format (page 321)
Unitechnik export: TS configuration tab (page 330)
Unitechnik export: Embeds tab (page 341)
Unitechnik export: Reinforcement tab (page 349)
Unitechnik export: HEADER block data specification tab (page 364)
Unitechnik export: Reinforcement data specification tab (page 364)
Unitechnik export: SLABDATE block data specification (page 366)
Unitechnik export: Mounting part data specification tab (page 368)
Unitechnik export: Line attributes tab (page 369)
Unitechnik export: Pallet tab (page 373)
Unitechnik export: Log files tab (page 375)

**Unitechnik export: TS configuration tab**

Use the **TS configuration** tab to control the Unitechnik export properties.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>side. The position and direction of a basic shape of the exported cast unit depends on the rotation.</td>
</tr>
<tr>
<td></td>
<td>Note that you can use the surface object user-defined attribute <strong>Use surface as pallet base</strong> to orient the object without changing the top-in-form face or the rotation in export settings.</td>
</tr>
<tr>
<td>No</td>
<td>Floor: Bottom to top</td>
</tr>
<tr>
<td></td>
<td>Wall: Front to rear side (according to the modeling direction)</td>
</tr>
<tr>
<td></td>
<td>Column: Side to side</td>
</tr>
<tr>
<td>180</td>
<td>Floor: Top to bottom</td>
</tr>
<tr>
<td></td>
<td>Wall: Rear to front side</td>
</tr>
<tr>
<td></td>
<td>Column: From one side to the opposite side</td>
</tr>
<tr>
<td>+90 around X</td>
<td>Floor: Left to right side</td>
</tr>
<tr>
<td></td>
<td>Wall: Top to bottom</td>
</tr>
<tr>
<td></td>
<td>Column: Side to side</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------</td>
</tr>
<tr>
<td><strong>-90 around X</strong></td>
<td>- Floor: Right to left side</td>
</tr>
<tr>
<td></td>
<td>- Wall: Bottom to top</td>
</tr>
<tr>
<td></td>
<td>- Column: From one side to the opposite side</td>
</tr>
<tr>
<td><strong>-90 around Y</strong></td>
<td>- Floor: Rear to front side</td>
</tr>
<tr>
<td></td>
<td>- Wall: Right to left side</td>
</tr>
<tr>
<td></td>
<td>- Column: Top to bottom</td>
</tr>
</tbody>
</table>

With the **Top in form face** option, the scanning direction depends on the defined top-in-form-face, so that the opposite face will be towards the pallet.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Examples of rotation:</td>
</tr>
<tr>
<td></td>
<td>• Wrong scanning plane (from the right side to the left side):</td>
</tr>
</tbody>
</table>

[Diagram]
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extra rotation</td>
<td>Select the rotation around the z axis, and thereby the rotation of the pallet. The z axis has the same direction, but the x and y directions are changed. To show the actual coordinate system, set <strong>Draw pallet axis</strong> to <strong>Yes</strong> on the <strong>Pallet</strong> tab.</td>
</tr>
</tbody>
</table>
|                  | • **No**
|                  |   No extra rotation.                                                        |
|                  | • **Swap X/Y**
|                  |   Swap x and y axis.                                                        |
|                  | • **X=max(X_dim,Y_dim) main part**
|                  |   X axis goes through the longer side of the main part.                    |
|                  | • **X=min(X_dim,Y_dim) main part**
<p>|                  |   X axis goes through the shorter side of the main part.                   |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>X=max(X_dim,Y_dim) cast unit</strong>&lt;br&gt; X axis goes through the longer side of the cast unit.</td>
<td></td>
</tr>
<tr>
<td>• <strong>X=min(X_dim,Y_dim) cast unit</strong>&lt;br&gt; X axis goes through the shorter side of the cast unit.</td>
<td></td>
</tr>
<tr>
<td>• <strong>+90 around Z</strong>&lt;br&gt; Rotates x and y axis around the z axis by 90 degrees.</td>
<td></td>
</tr>
<tr>
<td>• <strong>-90 around Z</strong>&lt;br&gt; Rotates x and y axis around the z axis by -90 degrees.</td>
<td></td>
</tr>
<tr>
<td>• <strong>180 around Z</strong>&lt;br&gt; Rotates x and y axis around the z axis by 180 degrees.</td>
<td></td>
</tr>
</tbody>
</table>

The following example shows the coordinate system with no rotation and no extra rotation settings. Panel 1 has the z axis set parallel to the shorter side. It is incorrect in the Unitechnik format, so the coordinate system has to be rotated. Panel 2 shows a rotation by 90 degrees around the z axis.

<table>
<thead>
<tr>
<th>Auto-rotate on pallet</th>
<th>Select whether to auto-rotate the coordinate system for export +90° or -90° when the element width exceeds the pallet width, or when the element width exceeds the element length.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan position</td>
<td>The element contour, cutouts and line attributes are defined by scanning the cast unit in the scan direction defined by rotation settings above. A scanning plane works like a section with no view depth. The export application uses 1 or 2 scanning</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>planes for each part included in the exported cast unit (regardless of the output file structure setting). The offset is towards the middle of panel from the scanning plane, but can be negative or positive value. The number of the scanning layers depends on the selected scan position. Each object of the cast unit is scanned in one direction. Select the position in which all parts are scanned. Each part is scanned separately. Scanning plane is parallel to the basic shape plane.</td>
<td></td>
</tr>
<tr>
<td><strong>Bottom and top</strong></td>
<td>Two scanning planes at the start and at the end of the bounding box of the scanning part.</td>
</tr>
<tr>
<td><strong>Bottom only</strong></td>
<td>One scanning plane at the start of the bounding box of the scanning part.</td>
</tr>
<tr>
<td><strong>Top only</strong></td>
<td>One scanning plane at the end of the bounding box of the scanning part.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Middle only</strong></td>
<td>One scanning plane at the middle of bounding box of the scanning part.</td>
</tr>
<tr>
<td><strong>Top, bottom and middle</strong></td>
<td>Three scanning planes: one at the start, one at the end and one in the middle of the bounding box of the scanning part. To move the position of the exact scanning plane, use the <em>Scan position offset</em> boxes below to define start offset and end offset.</td>
</tr>
</tbody>
</table>

### Merge CONTOUR layers

You can export one scanned layer only. With two scanned layers, they have to be merged into one layer.

**Intersection**

Creates polygon intersection of two contour geometries.

1. First scanned layer
2. Second scanned layer
3. Layer

---

Import to and export from Tekla Structures 337 Concrete fabrication
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Option</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>• Union</td>
<td>Creates polygon union of two contour geometries.</td>
</tr>
<tr>
<td><img src="image1.png" alt="Diagram" /> + <img src="image2.png" alt="Diagram" /> = <img src="image3.png" alt="Diagram" /></td>
<td></td>
</tr>
<tr>
<td>Export CUTOUTs</td>
<td>To prevent cutout export, select No.</td>
</tr>
<tr>
<td></td>
<td><strong>Exclude selected</strong> excludes from the export the modeled cut parts that you define by class or name.</td>
</tr>
<tr>
<td></td>
<td><strong>Selected only</strong> includes in the export the cut parts that you define by class or name.</td>
</tr>
<tr>
<td>Merge CUTOUT layers</td>
<td>The same as Contour export, but for holes only.</td>
</tr>
<tr>
<td>Merge CUTOUTs</td>
<td>Select how to merge overlapping cutouts. You can select to export a big cutout which is created by smaller cuts as separate cutouts. The options are:</td>
</tr>
<tr>
<td></td>
<td>1. Merged as one cutout</td>
</tr>
<tr>
<td><img src="image4.png" alt="Diagram" /> → <img src="image5.png" alt="Diagram" /></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2. Unmerged, overlapping cutouts</td>
</tr>
<tr>
<td><img src="image6.png" alt="Diagram" /> → <img src="image7.png" alt="Diagram" /></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3. Unmerged cutouts with no overlapping</td>
</tr>
<tr>
<td><img src="image8.png" alt="Diagram" /> → <img src="image9.png" alt="Diagram" /></td>
<td></td>
</tr>
<tr>
<td>Extend contour and add formwork</td>
<td>Select whether to extend the contour by embeds which are outside the element.</td>
</tr>
<tr>
<td>Name for additional formwork (embed)</td>
<td>Define a name for the embed.</td>
</tr>
<tr>
<td>Geometry export</td>
<td>Select whether the geometry of the exported part (concrete contour, cutout, mountpart) is represented as polygons or lines.</td>
</tr>
<tr>
<td></td>
<td>Polygons exported:</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>SLABDATE</td>
<td>339</td>
</tr>
<tr>
<td>CONTOUR</td>
<td></td>
</tr>
<tr>
<td>CUTOUT</td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Export rounded holes as circle (K)</td>
<td>Select whether you want to export rounded holes as circles (K) or polygons/lines.</td>
</tr>
<tr>
<td>Double wall turned</td>
<td>Select whether the first shell of a double wall on the pallet is turned. This requirement depends on the receiving master computer system. The options are:</td>
</tr>
<tr>
<td>No: Exported as in model, shell1 is in front, shell2 in background.</td>
<td>Yes, turn shell1: The shell 1 is offset by the pallet width in y direction (defined on the Validation tab) and flipped around x axis</td>
</tr>
<tr>
<td>Yes, turn shell1 - fixed edge up: This is meant for special machines.</td>
<td></td>
</tr>
</tbody>
</table>

See also

- Unitechnik (page 319)
- Export to Unitechnik format (page 321)
Unitechnik export: Embeds tab

Use the **Embeds** tab to control the Export Unitechnik (79) export properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal embeds</td>
<td>Select which parts are considered as embeds. Embedded parts are exported in the <strong>MOUNPART</strong> block.</td>
</tr>
<tr>
<td></td>
<td>If the embed block consists of several parts, it is useful to combine all embed parts into one sub-assembly block and then add as sub-assembly to a cast unit or concrete shell sub-assembly. Single part embeds can be simply added to cast unit.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Selected + steel</strong></td>
</tr>
<tr>
<td></td>
<td>All classes listed in the <strong>Embeds classes</strong> box are considered as embeds. All steel parts are also considered as embeds, unless excluded from export.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Selected</strong></td>
</tr>
<tr>
<td></td>
<td>Classes listed in the <strong>Embeds classes</strong> box are only considered as embeds.</td>
</tr>
<tr>
<td></td>
<td>• <strong>No export</strong></td>
</tr>
<tr>
<td></td>
<td>Ignores the <strong>Embeds classes</strong> box and exports all steel parts as standard parts.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Selected (also reinforcement) + steel</strong></td>
</tr>
<tr>
<td></td>
<td>All parts and reinforcing bars listed in the <strong>Embed classes or names</strong> box are considered as embeds and plotted as lines. Also bounding</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Embed classes or names</td>
<td>Enter the classes or names of the embeds.</td>
</tr>
<tr>
<td>Export assemblies</td>
<td>Select how the 2D geometry of embeds and steel blocks are exported.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Diagram showing embed export options" /></td>
</tr>
<tr>
<td></td>
<td>Embeds are exported as parts. All embedded welds and assembly relations are ignored.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Diagram showing embed export options" /></td>
</tr>
<tr>
<td></td>
<td>Welded embeds and the assembly block are exported as one part with the bounding box geometry of the complete sub-assembly.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Diagram showing embed export options" /></td>
</tr>
<tr>
<td></td>
<td>Only the main part of the embedded block or embedded assembly is exported.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Diagram showing embed export options" /></td>
</tr>
<tr>
<td></td>
<td>The main part of the embedded block extended in the x direction to cover all the parts of the embedded block is exported.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td>Only the bounding box around the main part of the embedded block or embedded assembly is exported.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Image" /></td>
<td>Export the main part bounding box with corner symbols.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Image" /></td>
<td>Export all parts bounding box with corner symbols.</td>
</tr>
</tbody>
</table>

**Corner symbol width / height**
Enter the width and height of the corner symbol.

**Def export code**
Define how the insertion point and the direction for embeds is calculated. Possible values are 0, 1, 2, 3, 11, 12, 21, 22, 23, 31 and 32, 41, 42, 43.

In most cases, the insertion middle point refers to the center of gravity of the embed sub-assembly or main part depending on the **Export assemblies** setting.

0 = Ignores the symbol and uses the sub-assembly bounding box setting according to the insertion COG setting (1 - 5), for example, PLATE 0 0 4.

1 = The insertion point is the middle point of embed and the direction is parallel to the longest side of the exported mountpart geometry. 1 is the default.

2 = The insertion point is the middle point of embed and the direction is parallel to the shortest side of the exported mountpart geometry.

3 = The insertion point is the middle point of embed, and if the mainpart is symmetrical,
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>calculate the direction of the mountpart along the line from mainpart COG to sub-assembly COG.</td>
</tr>
<tr>
<td>11</td>
<td>The insertion point is the point of embed in the middle of shorted side and the direction is along the longest side.</td>
</tr>
<tr>
<td>12</td>
<td>The insertion point is the point of embed in the middle of longest side and the direction is along the shortest side.</td>
</tr>
<tr>
<td>21</td>
<td>The insertion point is in the contour's top edge point closest to the embed and the direction is parallel to the longest side of the exported mountpart geometry.</td>
</tr>
<tr>
<td>22</td>
<td>The insertion point is in the contour's top edge point closest to the embed and the direction is parallel to the shortest side of the exported mountpart geometry.</td>
</tr>
<tr>
<td>23</td>
<td>The insertion point is in the contour's top edge point closest to the embed and if the mainpart is symmetrical, calculate the direction of the mountpart along the line from mainpart COG to sub-assembly COG.</td>
</tr>
<tr>
<td>31</td>
<td>The insertion point is the point of the closest vertex on concrete part, between embeds and concrete part side and the direction is along the longest side.</td>
</tr>
<tr>
<td>32</td>
<td>The insertion point is the point of the closest vertex on concrete part, between embeds and concrete part side and the direction is along the shortest side.</td>
</tr>
<tr>
<td>41</td>
<td>Insertion point embed assembly COG and orients towards the start to end point axis.</td>
</tr>
<tr>
<td>42</td>
<td>Insertion point embed part start point and orients towards the end point.</td>
</tr>
<tr>
<td>43</td>
<td>Insertion point embed assembly COG and orients towards the axis of the longest edge.</td>
</tr>
</tbody>
</table>

**Cut outer assemblies**

Select how the embedded parts that are outside the concrete element are exported.

![Diagram](image)

All parts in the embed are exported.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Diagram" /></td>
<td>Only the embedded parts that are inside of the concrete element are exported. Embedded parts that are outside the concrete element are ignored. If an embedded part is partly inside a concrete element, the exported geometry of the embedded part is changed to cut.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Diagram" /></td>
<td>Same as the previous option, but only embedded parts with class defined in <strong>Cut outer only classes</strong> are taken into account.</td>
</tr>
<tr>
<td><strong>Cut outer only classes</strong></td>
<td>Enter the classes of parts whose geometry is changed to cut when you have selected the last option in the <strong>Cut outer assemblies</strong> list.</td>
</tr>
<tr>
<td><strong>Special assemblies export</strong></td>
<td>The options are <strong>No</strong>, <strong>Yes</strong>, <em>(spec_assemblies_def.txt)</em>, and <strong>Yes, no rotation on pallet</strong>.</td>
</tr>
<tr>
<td><strong>Special export assembly file name</strong></td>
<td>The options affect the exported geometry of the embeds. The real geometry is replaced by the geometry defined in text files. The default name of the text file is <em>spec_assemblies_def.txt</em> and is searched for in the model folder. Use <strong>Special export assembly file name</strong> to define the name and the location of the text file.</td>
</tr>
<tr>
<td><strong>Required structure of the text file is:</strong></td>
<td></td>
</tr>
<tr>
<td>• Name(text)</td>
<td>Number_of_lines_defined(number)</td>
</tr>
<tr>
<td>• S(representing single line)</td>
<td>Start_coors-X,Y (number number)</td>
</tr>
<tr>
<td>• S(representing single line)</td>
<td>End_coors-X,Y(number number)</td>
</tr>
<tr>
<td>• S(representing single line)</td>
<td>Start_coors-X,Y(number number)</td>
</tr>
<tr>
<td>• S(representing single line)</td>
<td>End_coors-X,Y(number number)</td>
</tr>
<tr>
<td><strong>Embeds in special assembly symbol definition file</strong> can also be designated by template property and its value in format <code>[TEMPLATE:VALUE]</code> instead of the embed name.</td>
<td></td>
</tr>
<tr>
<td><strong>Example of the file:</strong></td>
<td></td>
</tr>
</tbody>
</table>
The geometry of all embeds (from example with names Quicky, QuickyS, E-Doze) are replaced by geometry defined in the text file. In the following example, the part number 1 (the name is Beam) was not found in the text file so the geometry is exported according to default settings from export dialog. On the opposite side the part number 2 (the name is Quicky) was found, so the geometry is replaced.

You can also define the def export code, insertion point logic and embed z-positioning on the first definition row:

Name (text)
Number of lines defined (number)
Def export code (number, see above)
Insertion position (number 1-5) z-position (PALLE / BOTTOM / MIDDLE)

To specify the insertion point position of embeds in using the spec_assemblies_def.txt file:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Subassembly center of gravity</td>
</tr>
<tr>
<td>2</td>
<td>Subassembly bounding box center of gravity</td>
</tr>
<tr>
<td>3</td>
<td>Main part center of gravity</td>
</tr>
<tr>
<td>4</td>
<td>Extended main part center of gravity</td>
</tr>
<tr>
<td>5</td>
<td>Main part bounding box center of gravity</td>
</tr>
</tbody>
</table>

If you select **Yes, no rotation on pallet**, the embed symbols are placed according to the panel rotation, but the symbols themselves are not rotated.

**Embed Z position**
Select the embed z position. The options are **Minimum to pallet**, **Start point** and **Z=0**. When you select **Z=0**, all exported mountparts will be plotted on the level of the pallet.

You can use the `spec_assemblies_def.txt` file to set the position of the embeds, see above.

If unassigned, the setting chosen in the dialog box is used by default.

For example:

```
Quicky 4 1 1 middle
S -100 100 100 -100
S 100 100 -100 -100
S -100 -100 100 -100
S -100 100 100 100
```

On the first line of the example above you have additional options for positioning the embed symbol:

- **Quicky** is the name of the embed.
- **4** is the number of lines following.
- **1** is the embed installation type: 1 2 3 11 12 21 22 23 31 32 (see above).
- **1** defines the geometry for which the center-of-gravity is calculated, choices being 1 - 5, see above. **1** means that the symbol location is defined by the entire mountpart sub-assembly bounding box center of gravity.

The special assembly symbol plotting for **Z=0** is **pallet**, for **Minimum to pallet** **bottom** and for **Start point** **middle**.

**Insulation**
Define the insulation classes or names. The corresponding parts will be exported as insulation.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>parts. All parts considered insulation are exported in the MOUNPART block. Default mountpart type for insulation is 03 unless overwritten.</td>
<td></td>
</tr>
<tr>
<td>Electric tubes</td>
<td>Define the electric tubes classes or names. The corresponding parts will be exported as MOUNPART with lines geometry. Default mountpart type for electric installation is 07 unless overwritten.</td>
</tr>
<tr>
<td>Opening embed</td>
<td>Define the opening embed classes or names. The corresponding parts will be exported as normal embeds in the MOUNPART block. The geometry will not be considered in the CONTOUR and CUTOUT blocks of the concrete part.</td>
</tr>
<tr>
<td>Opening cutout</td>
<td>Define the opening cutout classes or names. The corresponding parts will be exported only in regard to their geometry in the CUTOUT block of the concrete part. They will not be exported in the MOUNPART block.</td>
</tr>
<tr>
<td>Cutpart former</td>
<td>Export cuts that have been specified with a class or name in the MOUNPART block. Default mountpart type for cutout box is 21 unless overwritten.</td>
</tr>
<tr>
<td>Opening with corner symbols</td>
<td>Specify classes or names of embeds for openings that will be exported with corner symbols instead of mountpart symbols.</td>
</tr>
<tr>
<td>All cutouts as corner symbols</td>
<td>Export rectangular cutouts as 4 corner symbol mount parts by defining the classes or names. You can define the size of the symbol in the dialog box.</td>
</tr>
<tr>
<td>Export insulation</td>
<td>Select whether insulation parts are exported in the MOUNPART block as embeds or in the SLABDATE block as concrete panels.</td>
</tr>
<tr>
<td>Export surface</td>
<td>Select whether surface treatment is exported in the MOUNPART block as embeds or in the SLABDATE block as concrete panels. You can also use the option No, which does not export surface treatment.</td>
</tr>
<tr>
<td>Install identification</td>
<td>Select the installation identification for the MOUNPART block. The options are Installed (0), Only plotted (1), Only installed (2), Not installed, not plotted (3), Installed in reinforcement (4), Installed automatically (5)</td>
</tr>
</tbody>
</table>

See also

Unitechnik (page 319)
Unitechnik export: Reinforcement tab

Use the Reinforcement tab to control the Unitechnik reinforcement export properties.

You can export single reinforcing bars, groups of straight and bent reinforcing bars, and rectangular or polygonal or bent meshes. The reinforcing bar group, or rectangular or polygonal mesh is divided into several single reinforcing bars. All reinforcing bars are exported in the **RODSTOCK** block.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Rebars export</strong></td>
<td>When set to <strong>Yes</strong>, straight reinforcing bars are exported. Hooks are supported. You can define the setting separately for straight or bent rebars. When set to <strong>Collected</strong>, uncollected reinforcement is excluded.</td>
</tr>
<tr>
<td><strong>Meses export</strong></td>
<td>When set to <strong>Yes</strong>, polygonal or rectangular meshes are exported. Hooks are supported. You can define the setting separately for straight or bent meshes. You can also select whether to unfold along longest line or parallel to pallet.</td>
</tr>
<tr>
<td><strong>Bent reinf. as unfolded</strong></td>
<td>When set to <strong>Yes</strong>, bent reinforcement is exported as unfolded. Hooks are also supported for unfolded reinforcement, and you can select <strong>Yes, with end hooks</strong>. Hooks form 0, 2 and 5 are detected.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Bent meshes with end hooks</strong></td>
<td>exports end hook shapes L, S and U (flection form 1, 4 and 5) as terminal hooks according to the Unitechnik specification. Other shapes are exported as free flection forms like before. Using the option <strong>Only meshes</strong>, you can export bent meshes as unfolded, while other bent reinforcement is exported as bent. You can select between two reinforcement starting points: <strong>Origin in unfolded rebar</strong> or <strong>Origin in start rebar point</strong>. Origin in unfolded rebar uses the first point of the main leg of rebar or mesh wire depending on the rebar orientation in export. The option also affects the z level of the reinforcement in the resulting Unitechnik file. The start points are unaffected by unfolding options.</td>
</tr>
<tr>
<td><strong>Export meshes as</strong></td>
<td>Set the rotation of the mesh plane in the export file. The options are: <strong>Standard</strong> - Embeds: Exported as mountparts. <strong>Turned to pallet</strong>: All meshes will be individually rotated in line with the pallet axes.</td>
</tr>
<tr>
<td><strong>Braced girder classes or names</strong></td>
<td>Enter the class or name of reinforcing bars, steel rods or profiles representing braced girders. For example, 15 17 5 means that parts with class 15, 17, or 5 are considered braced girders. If the <strong>Braced girder export</strong> and <strong>Braced girder classes or names</strong> boxes are not used, the braced girders will be exported incorrectly as reinforcement or embeds. Braced girders are represented as a single line, placed according to your selection: <strong>As braced girder top chord</strong> (default): The geometry of the main chord (top chord) with all information is included in the export. <strong>As braced girder bottom chords</strong>: The braced girder is exported as one object but with the quantity number 2 with the spacing included. <strong>As braced girder all chords</strong>: One object like above but with the quantity number 3. <strong>As top chord with end symbols</strong>: 2 Mountpart symbols are placed at the top chord end points.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>towards the braced girder direction, line 20 mm long. In addition, the above-mentioned BRGIRDER information.</td>
</tr>
<tr>
<td>• <strong>As bottom chords with end symbols:</strong> 4 Mountpart symbols are placed at the bottom chord end points towards the braced girder direction, line 20 mm long. In addition, the above-mentioned BRGIRDER information.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Only top chord end symbols:</strong> 2 Mountpart symbols are placed at the top chord end points towards the braced girder direction, line 20 mm long. No BRGIRDER.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Only bottom chord end symbols:</strong> 4 Mountpart symbols are placed at the bottom chord end points towards the braced girder direction, line 20 mm long. No BRGIRDER.</td>
<td></td>
</tr>
<tr>
<td>Reinforcement export type</td>
<td>Define the structure of the exported file for reinforcement.</td>
</tr>
<tr>
<td></td>
<td><strong>Plant with lying robot only</strong></td>
</tr>
<tr>
<td></td>
<td>All reinforcement including mesh objects will be exported as individual rodstocks within slabdate.</td>
</tr>
<tr>
<td><strong>HEADER</strong></td>
<td></td>
</tr>
<tr>
<td><strong>SLABDATE</strong></td>
<td></td>
</tr>
<tr>
<td><strong>CONTOUR</strong></td>
<td></td>
</tr>
<tr>
<td><strong>CUTOUT</strong></td>
<td></td>
</tr>
<tr>
<td><strong>MOUNPART</strong></td>
<td></td>
</tr>
<tr>
<td><strong>RODSTOCK</strong></td>
<td></td>
</tr>
<tr>
<td><strong>BRGIRDER</strong></td>
<td></td>
</tr>
<tr>
<td><strong>EXTIRON</strong></td>
<td></td>
</tr>
<tr>
<td><strong>END SLABDATE</strong></td>
<td></td>
</tr>
<tr>
<td><strong>END HEADER</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Fabrication of welded rebars</strong></td>
</tr>
<tr>
<td></td>
<td>If <strong>Export type</strong> is set to <strong>Fabrication of welded rebars</strong>, bar groups are exported as individual rodstocks, mesh objects are exported as rodstocks within <strong>STEELMAT</strong> blocks.</td>
</tr>
<tr>
<td></td>
<td>The structure of the output file (one <strong>SLABDATE</strong> is shown only):</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Collect reinforcement</strong></td>
<td>The structure of the output file is the same as for <strong>Fabrication of welded rebars</strong>. This option allows you to collect mesh, single reinforcing bars and reinforcing bar groups into groups exported in one <strong>STEELMAT</strong> block. The groups are collected based on the <strong>Collect based on</strong> field. You can also collect meshes which belong to different cast units.</td>
</tr>
</tbody>
</table>

```
HEADER__
SLABDATE
CONTOUR__
CUTOUT__
NOUNPART
RODSTOCK
BRGIRDER
REFORCEM
STEELMAT
RODSTOCK
BRGIRDER
END STEELMAT
STEELMAT
RODSTOCK
BRGIRDER
END STEELMAT
EXTIRON__
END REFORCEM
END SLABDATE
END HEADER__
```
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1 (orange color): | The mesh belongs to the bottom panel of the cast unit, mesh name is **MESH1**.  
| 2 (blue color): | Two single bars, the name is **MESH1**.  
| 3 (green color): | One reinforcing bar group belongs to the top panel, the name is **MESH1**.  

If **Reinforcement export type** is set to **Collect reinforcement** and **Collect based on** is set to **Name**, all three different reinforcement types are collected into one mesh, which is exported in one **STEELMAT** block.

Other non-designated rebar groups are exported as individual rodstocks. If the collected mesh has only one rebar, it is exported as an individual rodstock without a **STEELMAT**.

**Collect based on**  
Select how meshes are collected. Meshes with one bar are exported as a single reinforcing bar.

- **Name**  
  Meshes, single reinforcing bars and reinforcing bar groups with the same name are collected into meshes. Meshes, single reinforcing bars and reinforcing bar groups with the same name equals one mesh in the exported file.

- **Class**  
  Meshes, single reinforcing bars and reinforcing bar groups with the same class number are collected into meshes. Meshes, single reinforcing bars and reinforcing bar groups with one class number equal one mesh in the exported file.

- **Grade**  
  Meshes, single reinforcing bars and reinforcing bar groups with the same grade are collected into meshes.

- **UDA**  
  Meshes, single reinforcing bars and reinforcing bar groups with the same user-defined attribute are collected into meshes.  
  The value you enter in the box next to this option is the UDA value.

**Collect if distance is lower then**  
Define the maximum distance between the mesh rebars to be collected together into one **STEELMAT**.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Rebar grouping</strong></td>
<td>Group similar rebars with equal spacing. Similar rebars are exported using one RODSTOCK row with correct quantity and spacing. The options are Yes and No (default). The rebar grouping is primarily intended to be used in the production of simple mesh and reinforcement.</td>
</tr>
<tr>
<td><strong>Reinforcing bars length</strong></td>
<td>Select how the reinforcing bar length is calculated.</td>
</tr>
<tr>
<td></td>
<td>• Lines in the middle</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• <strong>Lines at the edge (total length only)</strong></td>
<td>Calculates the lengths of the reinforcing bar legs at the edge of the bars.</td>
</tr>
<tr>
<td>• <strong>Lines at the edge (all leg lengths)</strong></td>
<td>Calculates the lengths of the reinforcing bar legs at the edge of the bars.</td>
</tr>
</tbody>
</table>

**Import to and export from Tekla Structures**

Concrete fabrication
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Reinforcing bars diameter</strong></td>
<td>Select how the reinforcing bar diameter is exported. The options are:</td>
</tr>
<tr>
<td></td>
<td>• Actual or nominal (XS_USE_ONLY_NOMINAL_REBAR_DIAMETER)</td>
</tr>
<tr>
<td></td>
<td>For more information, see XS_USE_ONLY_NOMINAL_REBAR_DIAMETER.</td>
</tr>
<tr>
<td></td>
<td>• Size</td>
</tr>
<tr>
<td></td>
<td>• Actual</td>
</tr>
<tr>
<td></td>
<td>• Nominal</td>
</tr>
<tr>
<td></td>
<td>This selection affects the results of the Rebar length option.</td>
</tr>
<tr>
<td><strong>Rebar direction angle limit</strong></td>
<td>Select whether the reinforcing bars starting direction in XY plane is limited, as required in some production interfaces.</td>
</tr>
<tr>
<td></td>
<td>• No</td>
</tr>
<tr>
<td></td>
<td>The reinforcing bars exported as they're modeled in Tekla Structures.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>• <strong>From 0 to 180</strong></td>
<td>The reinforcing bars are exported so that they have a start angle limit to be under 180 degrees, and therefore always oriented to start in positive pallet y direction. In this case the rebar start point will be always be the rebar end with smallest Y-coordinate</td>
</tr>
<tr>
<td>• <strong>From 0 to 180 ordered</strong></td>
<td>Same as above but the reinforcing bars are sorted according to the direction angle of the reinforcing bar: the reinforcing bars with lower angles are first.</td>
</tr>
<tr>
<td>• <strong>From 180 to 0 ordered</strong></td>
<td>The reinforcing bars are sorted according to the direction angle of the reinforcing bar: the reinforcing bars with higher angles are first.</td>
</tr>
<tr>
<td><strong>First bending angle</strong></td>
<td>Allows setting the first bending angle of free-flection rodstock to be positive or negative (as required by certain interfaces). The options are:</td>
</tr>
<tr>
<td></td>
<td>• Always positive</td>
</tr>
<tr>
<td></td>
<td>• Allow positive or negative</td>
</tr>
<tr>
<td><strong>Reinforcement types</strong></td>
<td>Select the reinforcing bar type in a mesh to be exported.</td>
</tr>
<tr>
<td></td>
<td>1 and 2 are for the rods in the bottom face longitudinal and cross bars.</td>
</tr>
<tr>
<td></td>
<td>5 and 6 are for the rods in the top face longitudinal and cross bars.</td>
</tr>
<tr>
<td></td>
<td>4 is for other rebars placed in the element reinforcement.</td>
</tr>
<tr>
<td></td>
<td>8 is for loose bars welded into prefabricated meshes.</td>
</tr>
<tr>
<td><strong>Classes for loose rebars type 8</strong></td>
<td>Enter the classes of loose reinforcing bars to be collected. The bars are a part of a mesh and are exported as reinforcing bar type 8.</td>
</tr>
<tr>
<td><strong>Classes for non-automated rebars</strong></td>
<td>Enter the classes of reinforcing bars to be tagged for non-automated production.</td>
</tr>
<tr>
<td><strong>Spacer type</strong></td>
<td>You can add spacer type information to the first layer of the reinforcement (Unitechnik reinforcement type 1). The spacer type is added to</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>the respective spacer type block in the rodstock within the Unitechnik file. The options are:</td>
</tr>
<tr>
<td>Automatic</td>
<td>Calculates the spacer type automatically according to the cover thickness. The cover thickness is divided by 5 and rounded up to the nearest integer. For example, if the cover thickness is 21 - 25 mm, the spacer type is 5, and if it is 26 - 30 mm, the spacer type is 6. Enter the allowed types in the adjacent field, or leave blank to allow any.</td>
</tr>
<tr>
<td>User defined spacer type</td>
<td>Enter the spacer type to be input in all first layer rebars.</td>
</tr>
<tr>
<td>No</td>
<td>Leaves 0 as spacer type.</td>
</tr>
<tr>
<td>Spacing start position</td>
<td>Enter the first spacer start position from the start point of the rebar, for example, 500 (mm).</td>
</tr>
<tr>
<td>Spacing pitch</td>
<td>Enter the spacer pitch information from start point onwards, for example, 1000 (mm).</td>
</tr>
<tr>
<td>Add mesh stabilizing wires</td>
<td>Select whether to extend reinforcement mesh wires through openings to stabilize the mesh. Use for meshes with large openings.</td>
</tr>
<tr>
<td>Stabilization wire max spacing</td>
<td>Enter a value to define the maximum spacing of the wires that stabilize the reinforcement mesh. As a result, the minimum amount of extra wires will be extended within this spacing value from the closest full wire near opening.</td>
</tr>
<tr>
<td>Meshes sort</td>
<td>Select whether meshes are sorted.</td>
</tr>
<tr>
<td>Meshes offset</td>
<td>Select whether the mesh has an offset defined in the STEELMAT block. If the option is set to Yes, the value for X and Y direction is set to zero. If the option is set to No, the X and Y values are exported according to modeled situation.</td>
</tr>
</tbody>
</table>

See also

- Unitechnik (page 319)
- Export to Unitechnik format (page 321)
- Unitechnik export: Main tab (page 325)
- Unitechnik export: TS configuration tab (page 330)
- Unitechnik export: Embeds tab (page 341)
- Unitechnik export: Validation tab (page 359)
- Unitechnik export: Reinf. data specification tab (page 361)
Unitechnik export: Validation tab
Use the Validation tab to control the Unitechnik export properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draw scanned geometry</td>
<td>The exported geometry can be shown with <strong>Draw scanned geometry</strong>. This property shows the inside lines of the exported reinforcing bars.</td>
</tr>
<tr>
<td></td>
<td>Select whether you want to check if the geometry of the exported parts is correct. It shows the lines representing the exported rectangle of the basic shape, the exported geometry of parts, cuts, embeds, and reinforcement. Embeds are projected to the plane of the basic shape. The reinforcement lines are positioned inside each reinforcing bar.</td>
</tr>
</tbody>
</table>

![Diagram](image)

1. Basic shape
2. Geometry of the main element
3. Cut geometry
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4. Embed geometry</td>
<td>Note that this setting might have significant effect on export processing speed.</td>
</tr>
<tr>
<td>Draw pallet axis</td>
<td>Select whether to show the coordinate system. The axes are displayed with dotted lines.</td>
</tr>
<tr>
<td>Wall to pallet checking</td>
<td>Select whether the export checks the wall size against the pallet size. If you select the <strong>Yes, if exceeded, do not export</strong> option, the <strong>Pallet width</strong> <strong>Pallet length</strong>, and <strong>Max. cast unit thickness</strong> options cannot be empty.</td>
</tr>
<tr>
<td>Pallet width</td>
<td>Define the pallet width.</td>
</tr>
<tr>
<td></td>
<td>On the basis of the pallet width and length, the <strong>Wall to pallet checking</strong> option is able to check if a wall element is too big to fit to a pallet. If the wall element does not fit to a pallet, the wall element is turned.</td>
</tr>
<tr>
<td>Pallet length</td>
<td>Define the pallet length.</td>
</tr>
<tr>
<td>Max cast unit thickness</td>
<td>Define the maximum cast unit thickness.</td>
</tr>
<tr>
<td></td>
<td>To avoid collision with the drying chamber, the maximum thickness of a cast unit should be smaller than the maximum opening of the drying chamber.</td>
</tr>
<tr>
<td>Rebar diameter limitation</td>
<td>Minimum and maximum diameter for the reinforcing bars to be exported.</td>
</tr>
<tr>
<td>Rebar length limitation</td>
<td>Minimum and maximum length for the reinforcing bars to be exported.</td>
</tr>
<tr>
<td>Rebar leg length limitation</td>
<td>Minimum and maximum length for individual leg section within a bent rebar to be exported.</td>
</tr>
<tr>
<td>Mesh wire length limitation (Longitudinal)</td>
<td>Minimum and maximum diameter for longitudinal reinforcing bars to be exported.</td>
</tr>
<tr>
<td>Mesh wire length limitation (Cross)</td>
<td>Minimum and maximum length for cross reinforcing bars inside a mesh to be exported.</td>
</tr>
<tr>
<td>Mesh wire leg length limitation</td>
<td>Minimum and maximum length for individual leg section within a bent mesh wire to be exported.</td>
</tr>
<tr>
<td>Mesh wire overhang limitation</td>
<td>Minimum and maximum length for mesh wire overhang section before the first cross-wire welding point and after the last cross-wire welding point to be exported.</td>
</tr>
<tr>
<td>Mesh wire spacing limitation</td>
<td>Allowed spacing values for mesh wires separated by blank space to be exported. If no value added, there is no limitation for spacing.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Export others</td>
<td>Select whether the reinforcing bars that do not meet the above limitations are exported at all (No), as loose reinforcing bars of type 4 or 8, or whether the diameter and length limitations are ignored. You can also select to export non-valid rebars as non-automated or to prevent the export. When a rebar fails the validation for diameter of length limitation, you are now notified by a log message.</td>
</tr>
</tbody>
</table>

See also

Unitechnik (page 319)
Export to Unitechnik format (page 321)
Unitechnik export: Main tab (page 325)
Unitechnik export: TS configuration tab (page 330)
Unitechnik export: Embeds tab (page 341)
Unitechnik export: Reinforcement tab (page 349)
Unitechnik export: Reinf. data specification tab (page 361)
Unitechnik export: HEADER block data specification tab (page 364)
Unitechnik export: SLABDATE block data specification (page 366)
Unitechnik export: Mounting part data specification tab (page 368)
Unitechnik export: Line attributes tab (page 369)
Unitechnik export: Pallet tab (page 373)
Unitechnik export: Log files tab (page 375)

Unitechnik export: Reinf. data specification tab

Use the Reinf. data specification tab to control the Export Unitechnik (79) export properties. In the column on the right, enter the custom or UDA string when applicable.

On this tab, you can add data attributes only, no geometric attributes. The information you add controls the reinforcement unit data (single reinforcement, mesh, braced girder, or cage). The attributes are either optional or obligatory. The length of some of the fields may be limited in the UT format, so keep the strings short.

Depending on the setting, the following attributes can be added: **Name**, **Grade**, **Class**, **Rebar ID**, **Mesh ID**, **Mesh position**, **UDA**, **UDA (main part)**, **UDA (rebar)**, **Part UDA**, **Main part UDA**, **Phase**, **User-defined text**, **User-defined text + class**, **Template**, and **Text[Template]#Counter**.
Text[Template]#Counter:

- Text can be any text including punctuation marks.
- Write templates in brackets [].
- # adds a running number if the data content is the same in several entries.
- You can enter several templates and use text delimiters, for example, [ASSEMBLY_POS]-[REBAR_POS].
- If you start the Text[Template]#Counter with a template, add a space as the first character before the bracket.
- Template attributes are read from the single reinforcement, mesh, braced girder, or cage.
- You can also use attributes that refer to another hierarchy level, for example, the assembly UDA of the rebar.
- You can use <VALUE> to inquire a part UDA and {VALUE} to inquire an assembly UDA. This makes it possible to use a shorter string instead of having to use a template property to designate UDAs.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rebars: Article number rebar</td>
<td>Select which property you want to export as a reinforcing bar article number for rebars.</td>
</tr>
<tr>
<td>Rebars: Article number mesh</td>
<td>Select which property you want to export as a mesh article number for rebars.</td>
</tr>
<tr>
<td>Meshes: Article number rebar</td>
<td>Select which property you want to export as a reinforcing bar article number for meshes.</td>
</tr>
<tr>
<td>Meshes: Article number mesh</td>
<td>Select which property you want to export as a mesh article number for meshes.</td>
</tr>
<tr>
<td>Meshes: Meshes designation</td>
<td>Select the information that you want to export about the meshes.</td>
</tr>
<tr>
<td>Meshes: Info 1 text (UT 6.0)</td>
<td>Information field is filled with the selected data.</td>
</tr>
<tr>
<td>Meshes: Info 2 text (UT 6.0)</td>
<td>Information field is filled with the selected data.</td>
</tr>
<tr>
<td>Welded leg designation</td>
<td>Designate the welded leg in bent mesh bars if there is only one leg that is welded to cross-wires. When you select Yes, information about welded leg designation is exported.</td>
</tr>
<tr>
<td>Strands (UT 6.0): Pull force (KN)</td>
<td>You can now use main part UDA (UDA (main part)) or rebar UDA (UDA (rebar)) to include strand pull force information in the Unitechnik export. Selecting Empty does not export the strand pull force information. This setting only works for rebars that are set to type 9 in the Unitechnik reinforcement type box</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>BRGIRDER block: Braced girder type</td>
<td>Select the string value of girder type field in the BRGIRDER block in the exported file.</td>
</tr>
<tr>
<td>• Empty</td>
<td>No string is exported.</td>
</tr>
<tr>
<td>• Name</td>
<td>The name of the braced girder type is exported. If the name of the top part of a braced girder is empty, the names of the rods are checked.</td>
</tr>
<tr>
<td>• UDA</td>
<td>You can export the user-defined attribute values for a braced girder type (type), braced girder article number (art_number), or braced girder fabricator name (fabricator).</td>
</tr>
<tr>
<td></td>
<td>The UDAs can be added to the braced girder if the parts have been created using the system component Braced girder (88) or Braced girder (89) and you have entered the needed values on the dialog boxes of the components.</td>
</tr>
<tr>
<td>• User defined text</td>
<td>The value you enter in the box next to this option is exported.</td>
</tr>
<tr>
<td>CAGE BLOCK: Cage designation</td>
<td>Select the information that you want to export about the cage in the CAGE block (UT 6.1).</td>
</tr>
<tr>
<td>CAGE BLOCK: Base cage shape</td>
<td>Select the information that you want to show as base cage shape.</td>
</tr>
<tr>
<td>CAGE BLOCK: Info 1 text</td>
<td>Information field is filled with the selected data.</td>
</tr>
<tr>
<td>CAGE BLOCK: Info 2 text</td>
<td>Information field is filled with the selected data.</td>
</tr>
</tbody>
</table>

See also
- Unitechnik (page 319)
- Export to Unitechnik format (page 321)
- Unitechnik export: Main tab (page 325)
- Unitechnik export: TS configuration tab (page 330)
- Unitechnik export: Embeds tab (page 341)
Use the **HEADER block data specification** tab to control the Unitechnik export HEADER block data. In the column on the right, enter the custom or UDA string, when applicable.

On this tab, you can add data attributes only, no geometric attributes. The attributes are either optional or obligatory. The length of some of the fields may be limited in the UT format, so keep the strings short.

Depending on the setting, the following attributes can be added:
- **Project number**
- **Project name**
- **Cast unit position**
- **Cast unit position code**
- **Assembly control number (ACN)**
- **Cast unit ID**
- **Cast unit prefix (2 digits)**
- **Cast unit drawing revision mark**
- **Project properties - name**
- **Project properties - address**
- **File name with extension**
- **File name without extension**
- **Tekla Structures version**
- **Main part ID**
- **Project UDA**
- **Main part UDA (UT_product_code)**
- **Phase**
- **User-defined text**
- **User name**
- **Main part template**
- **Template and Text[Template]#Counter**

**Text[Template]#Counter:**
- Text can be any text including punctuation marks.
- Write templates in brackets [].
- # adds a running number if the data content is the same in several entries.
- You can enter several templates and use text delimiters.
- If you start the **Text[Template]#Counter** with a template, add a space as the first character before the bracket.
- Template attributes are read from the main part.
- You can also use attributes that refer to another hierarchy level.
- You can use `<VALUE>` to inquire a part UDA and `{VALUE}` to inquire an assembly UDA. This makes it possible to use a shorter string instead of having to use a template property to designate UDAs.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of order</td>
<td>Order fields in the HEADER block are filled with the selected data.</td>
</tr>
<tr>
<td>Name of component</td>
<td>Component fields in the HEADER block are filled with the selected data.</td>
</tr>
<tr>
<td>Drawing number</td>
<td>Drawing number fields in the HEADER block are filled with the selected data.</td>
</tr>
<tr>
<td>Drawing revision</td>
<td>Drawing revision fields in the HEADER block are filled with the selected data and drawing revision mark is exported.</td>
</tr>
<tr>
<td>Product code</td>
<td>Product code fields in the HEADER block are filled with the selected data.</td>
</tr>
<tr>
<td>Project line3 text</td>
<td>Project information fields (3rd line) in the HEADER block are filled with the selected data.</td>
</tr>
<tr>
<td>- Project line4 text</td>
<td></td>
</tr>
<tr>
<td>File creator (UT 6.0)</td>
<td>You can select to export the Tekla Structures version information, use name or user-defined text in the HEADER block.</td>
</tr>
<tr>
<td>Free field (UT 5.2)</td>
<td>Only for Unitechnik 5.2. You can select to export the following information to the HEADER block: user name, user-defined text, file name with extension, file name without extension, or model name.</td>
</tr>
<tr>
<td>Building site - name</td>
<td>Name of the building site.</td>
</tr>
<tr>
<td>Building site - street</td>
<td>Street address of the building site.</td>
</tr>
<tr>
<td>Building site - post code</td>
<td>Postal code of the building site.</td>
</tr>
<tr>
<td>Building site - place</td>
<td>City or town where the building site is located.</td>
</tr>
<tr>
<td>Building owner - name</td>
<td>Name of the building owner.</td>
</tr>
<tr>
<td>Building owner - street</td>
<td>Street address of the building owner.</td>
</tr>
<tr>
<td>Building owner - post code</td>
<td>Postal code of the building owner.</td>
</tr>
<tr>
<td>Building owner - place</td>
<td>City or town where the building owner street address is located.</td>
</tr>
<tr>
<td>Data field template units: No. of units after the decimal point</td>
<td>Specify the number of decimals after the decimal separator in data field template units.</td>
</tr>
</tbody>
</table>

**See also**

- Unitechnik (page 319)
- Export to Unitechnik format (page 321)
- Unitechnik export: Main tab (page 325)
- Unitechnik export: TS configuration tab (page 330)
Use the **SLABDATE block data specification** tab to control the Unitechnik export SLABDATE block data. In the column on the right, enter the custom or UDA string, when applicable.

On this tab, you can add data attributes only, no geometric attributes. The attributes are either optional or obligatory. The length of some of the fields may be limited in the UT format, so keep the strings short.

Depending on the setting, the following attributes can be added: **Counter**, **Cast unit number**, **Cast unit position**, **Part position**, **Part name**, **Cast unit position code**, **Cast unit name**, **Cast unit GUID**, **Assembly control number (ACN)**, **Cast unit ID**, **Cast unit prefix**, **Cast unit thickness**, **Concrete part thickness**, **Cast unit width**, **Concrete part width**, **Main part thickness**, **Main part ID**, **Main part GUID**, **Main part UDA**, **Material**, **Name**, **UDA**, **User-defined text**, **Phase**, **Total quantity of part**, **Main part template**, **Part weight**, **Unit weight**, **Cast unit weight**, **Yes, with swapped X axis and Y axis**, **Template** and **Text[Template]#Counter**.

**Text[Template]#Counter**:
- Text can be any text including punctuation marks.
- Write templates in brackets [{}].
- # adds a running number if the data content is the same in several entries.
- You can enter several templates and use text delimiters.
- If you start the **Text[Template]#Counter** with a template, add a space as the first character before the bracket.
- Template attributes are read from the main part.
- You can also use attributes that refer to another hierarchy level.
- You can use `<VALUE>` to inquire a part UDA and `{VALUE}` to inquire an assembly UDA. This makes it possible to use a shorter string instead of having to use a template property to designate UDAs.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Slab number</strong></td>
<td>Slab number field in the <strong>SLABDATE</strong> blocks is filled with the selected data.</td>
</tr>
<tr>
<td><strong>Transport type</strong></td>
<td>Export the means of transportation information.</td>
</tr>
<tr>
<td><strong>Transport unit number, Transport sequence number</strong></td>
<td>Define a value for the transport unit and sequence numbers in the <strong>SLABDATE</strong> blocks. This can be defined in the part UDAs.</td>
</tr>
<tr>
<td><strong>Transport pile level number</strong></td>
<td>Specify the transport pile level number in the <strong>SLABDATE</strong> blocks. If there are elements in the stack that need to be layered on the same level, then the pile level is used. For example, you may have a pile of 6 slabs, and they each have sequential pile level numbers 1, 2, 3.. 6. This can be defined in the part UDAs.</td>
</tr>
<tr>
<td><strong>Exposure class</strong></td>
<td>Export exposition class. You can select to read from part UDAs or use another option.</td>
</tr>
<tr>
<td><strong>Total thickness</strong></td>
<td>Select which value will be exported as total thickness. The options are <strong>Cast unit thickness</strong>, <strong>Concrete part thickness</strong>, <strong>Main part thickness</strong>, and <strong>Template</strong>.</td>
</tr>
<tr>
<td><strong>Production thickness</strong></td>
<td>Calculates the production thickness in <strong>SLABDATE</strong> block based on cast unit width or concrete part width. When you export double walls: With the option <strong>Cast unit width</strong> the cast unit thickness is exported for both shells.</td>
</tr>
<tr>
<td><strong>Production weight</strong></td>
<td>Set the type of the <strong>SLABDATE</strong> weight. The options are <strong>Part weight</strong>, <strong>Unit weight</strong>, <strong>Cast unit weight</strong>, and <strong>Template</strong>.</td>
</tr>
<tr>
<td><strong>Quality of layer</strong></td>
<td>Set the quality of the slabdate. The options are material and UDA.</td>
</tr>
<tr>
<td><strong>Item designation</strong></td>
<td>Designate data about the exported element.</td>
</tr>
<tr>
<td><strong>Info 1 text (60) - Info 4 text (60)</strong></td>
<td>Information fields (1-4) in the <strong>SLABDATE</strong> and <strong>MOUNPART</strong> blocks are filled with the selected data.</td>
</tr>
<tr>
<td><strong>Export project coordinates</strong></td>
<td>Select whether you want to swap X and Y axis of the exported project coordinates.</td>
</tr>
</tbody>
</table>

**See also**
- Unitechnik (page 319)
- Export to Unitechnik format (page 321)
Use the Mounting part data specification tab to control the Unitechnik export mounting part properties.

On this tab, you can add data attributes only, no geometric attributes. The attributes are either optional or obligatory. The length of some of the fields may be limited in the UT format, so keep the strings short.

How to use Text[Template]#Counter:

- Text can be any text including punctuation marks.
- Write templates in brackets [].
- # adds a running number if the data content is the same in several entries.
- You can enter several templates and use text delimiters.
- If you start the Text[Template]#Counter with a template, add a space as the first character before the bracket.
- Template attributes are read from the main part of the embed assembly.
- You can also use attributes that refer to another hierarchy level.

Note that steel parts have a tab Unitechnik Mountpart, where you can specify data which then overwrites the settings defined on the Mounting part data specification tab in the Export Unitechnik (79) dialog box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of mounting part</td>
<td>You can define the type of mounting part in the MOUNTPART block by UDA, class or name.</td>
</tr>
<tr>
<td>Reference number</td>
<td>You can define the reference number of a mounting part in the MOUNTPART block by UDA.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Mountpart name</td>
<td>Enter the MOUNTPART name.</td>
</tr>
<tr>
<td>Info 1 text (UT 6.0)</td>
<td>Information field is filled with the selected data.</td>
</tr>
<tr>
<td>Info 2 text (UT 6.0)</td>
<td>Information field is filled with the selected data.</td>
</tr>
</tbody>
</table>

**See also**

- Unitechnik (page 319)
- Export to Unitechnik format (page 321)
- Unitechnik export: Main tab (page 325)
- Unitechnik export: TS configuration tab (page 330)
- Unitechnik export: Embeds tab (page 341)
- Unitechnik export: Reinforcement tab (page 349)
- Unitechnik export: Validation tab (page 359)
- Unitechnik export: Reinf. data specification tab (page 361)
- Unitechnik export: HEADER block data specification tab (page 364)
- Unitechnik export: SLABDATE block data specification (page 366)
- Unitechnik export: Line attributes tab (page 369)
- Unitechnik export: Pallet tab (page 373)
- Unitechnik export: Log files tab (page 375)

**Unitechnik export: Line attributes tab**

Use the **Line attributes** tab to control the Unitechnik export properties. Line attributes are exported automatically according to the element and opening edge shape. If the factory does not use Unitechnik standard line attribute codes, you can override these exported codes. Sometimes line attribute values that are exported in the Unitechnik files are not suitable for the particular situation. For example, to preserve lightness in the model or extensive product standardization, you might have fewer chamfers in the model than there will be in the actual structure. For this reason, you might want to override some line attributes in the export so that the model remains light, but the exported Unitechnik files are correct. You can do this by using the options on the **Line attributes** tab.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export line attributes for contour</td>
<td>Select whether the line attribute values are used for contours (Export line attributes for contour)</td>
</tr>
</tbody>
</table>

Import to and export from Tekla Structures 369 Concrete fabrication
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>or for holes (<a href="#">Export line attributes for cutouts</a>) in the export.</td>
</tr>
<tr>
<td></td>
<td>• <strong>None</strong></td>
</tr>
<tr>
<td></td>
<td>Line attribute values are not used.</td>
</tr>
<tr>
<td></td>
<td>• <strong>All lines</strong></td>
</tr>
<tr>
<td></td>
<td>Line attribute values are used for all lines.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Outmost lines only</strong></td>
</tr>
<tr>
<td></td>
<td>Line attribute values are used only for the outermost lines in the part:</td>
</tr>
<tr>
<td></td>
<td><img src="#" alt="Diagram" /></td>
</tr>
<tr>
<td></td>
<td>This option is available only for contours.</td>
</tr>
<tr>
<td><strong>Border line overriding</strong></td>
<td>You can enter up to six border line modifications in the line attribute export.</td>
</tr>
<tr>
<td></td>
<td><img src="#" alt="Diagram" /></td>
</tr>
<tr>
<td></td>
<td>No border lines are overridden.</td>
</tr>
<tr>
<td></td>
<td><img src="#" alt="Diagram" /></td>
</tr>
<tr>
<td></td>
<td>Vertical outermost border lines at the start are overridden.</td>
</tr>
<tr>
<td></td>
<td><img src="#" alt="Diagram" /></td>
</tr>
<tr>
<td></td>
<td>Horizontal outermost border lines at the bottom are overridden.</td>
</tr>
<tr>
<td></td>
<td><img src="#" alt="Diagram" /></td>
</tr>
<tr>
<td></td>
<td>Vertical outermost border lines at the end are overridden.</td>
</tr>
</tbody>
</table>

Import to and export from Tekla Structures Concrete fabrication
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Diagram" /></td>
<td>Horizontal outermost border lines at the top are overridden.</td>
</tr>
<tr>
<td><img src="image2" alt="Diagram" /></td>
<td>Vertical outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="image3" alt="Diagram" /></td>
<td>Horizontal outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="image4" alt="Diagram" /></td>
<td>Horizontal and vertical outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="image5" alt="Diagram" /></td>
<td>All inclined outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="image6" alt="Diagram" /></td>
<td>All outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="image7" alt="Diagram" /></td>
<td>All vertical border lines, except the outermost border lines are overridden.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image1" alt="Diagram" /></td>
<td>All horizontal border lines, except the outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="image2" alt="Diagram" /></td>
<td>All vertical and horizontal border lines except the outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="image3" alt="Diagram" /></td>
<td>All border lines except outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="image4" alt="Diagram" /></td>
<td>All border lines except the horizontal and vertical outermost border lines are overridden.</td>
</tr>
<tr>
<td><img src="image5" alt="Diagram" /></td>
<td>All border lines are overridden.</td>
</tr>
</tbody>
</table>
| **Orig. attr, New attr.** | Define the original attribute (**Orig. attr**) and the attribute that will be used in the export (**New attr**).  
In the example below the horizontal outermost border line at the top would get a line attribute value 0033 originally, but the value will be overridden, and the line attribute value in the Unitechnik file will be 0040. |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export line attributes for cutouts</td>
<td>Select whether all line attributes are exported for openings.</td>
</tr>
<tr>
<td>Export angle of 1st and last vertical border</td>
<td>Select whether you want to export the angle of cut at the first and last vertical border.</td>
</tr>
<tr>
<td>Max, Min</td>
<td>The width of the chamfer is max 30 mm ja and the depth of the tongue and groove max 30 mm. If not within the tolerance, they are handled as special formwork 0002.</td>
</tr>
</tbody>
</table>

See also

- Unitechnik (page 319)
- Export to Unitechnik format (page 321)
- Unitechnik export: Main tab (page 325)
- Unitechnik export: TS configuration tab (page 330)
- Unitechnik export: Embeds tab (page 341)
- Unitechnik export: Reinforcement tab (page 349)
- Unitechnik export: Validation tab (page 359)
- Unitechnik export: Reinf. data specification tab (page 361)
- Unitechnik export: HEADER block data specification tab (page 364)
- Unitechnik export: SLABDATE block data specification (page 366)
- Unitechnik export: Mounting part data specification tab (page 368)
- Unitechnik export: Pallet tab (page 373)
- Unitechnik export: Log files tab (page 375)
**Unitechnik export: Pallet tab**

Use the **Pallet** tab to control the Unitechnik export properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Placing on pallet</td>
<td>Define if the placing is checked from the start or end of the pallet.</td>
</tr>
<tr>
<td>X offset at start or end</td>
<td>Define if the X offset at start or end of the pallet is checked.</td>
</tr>
<tr>
<td>Y offset from alignment</td>
<td>Specify the Y offset of elements on the pallet.</td>
</tr>
<tr>
<td>Align in Y axis</td>
<td>Align elements in Y direction. You can select whether to align • element upper edge to pallet upper edge • element upper edge to pallet center line • element center line to pallet center line • element lower edge to pallet center line • element lower edge to pallet lower edge</td>
</tr>
<tr>
<td>Clearance between cast units</td>
<td>Define if the clearance between the cast units is checked.</td>
</tr>
<tr>
<td>Same cast unit thickness needed</td>
<td>Define if the cast unit thickness is checked.</td>
</tr>
<tr>
<td>Sequence in pallet</td>
<td>When you have selected <strong>Combined, n slabdate, 1 part</strong> as the output file structure on the <strong>Main</strong> tab, you can select the logic of sequencing panels on pallet using main part or cast unit ACN or number, main part UDA or main part template, or Unitechnik transport UDAs. You can set the sequence as <strong>Ascending</strong> or <strong>Descending</strong>.</td>
</tr>
</tbody>
</table>

**See also**

- Unitechnik (page 319)
- Export to Unitechnik format (page 321)
- Unitechnik export: Main tab (page 325)
- Unitechnik export: TS configuration tab (page 330)
- Unitechnik export: Embeds tab (page 341)
- Unitechnik export: Reinforcement tab (page 349)
- Unitechnik export: Validation tab (page 359)
- Unitechnik export: Reinf. data specification tab (page 361)
- Unitechnik export: HEADER block data specification tab (page 364)
**Unitechnik export: Log files tab**

Use the Log files tab to control the Unitechnik export properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log file directory path</td>
<td>Define the path for a log file. If the path is empty, then the log file is saved in the same location as the export files.</td>
</tr>
<tr>
<td>Create main Log file</td>
<td>Select whether to create a one main log file.</td>
</tr>
<tr>
<td>Create Log file for each file</td>
<td>Select whether a log file is created separately for each export file.</td>
</tr>
<tr>
<td>Write history to log file and UDA</td>
<td>Create a log file containing the history of the exported parts. You can also select to write the information to the UDA UT_export_history of the main part. The following data is gathered: export time, part information, export path and file, and who has performed the export.</td>
</tr>
<tr>
<td>Show error dialog boxes</td>
<td>Select whether an error message is shown, for example, when exported parts are not numbered correctly or when the embedded parts have no parent part.</td>
</tr>
<tr>
<td>Write file name to UDA</td>
<td>Select to write the full export file name (<em>File name with extension</em>) or the export file name without the file name extension (<em>File name without extension</em>) to hidden main part UDA UT_FILE_NAME.</td>
</tr>
</tbody>
</table>

**See also**

Unitechnik (page 319)
Export to Unitechnik format (page 321)
Unitechnik export: Main tab (page 325)
Unitechnik export: TS configuration tab (page 330)
Unitechnik export: Embeds tab (page 341)
Unitechnik export: Reinforcement tab (page 349)
Unitechnik export: Validation tab (page 359)
Unitechnik export: Reinf. data specification tab (page 361)
You can export reinforcement geometry to BVBS (Bundesvereinigung Bausoftware) format. The result is a text file in ASCII format. The supported version of the BVBS format is 2.0 year 2000.

You can export bent reinforcing bars, reinforcing bar groups and reinforcement meshes, which can be rectangular, polygonal, non-bent or bent, and may include cuts. The export of hooks is also supported.

Reinforcing bars that have bendings with two or more variable radius values are exported fully conforming with the BVBS specification so that radius element and leg elements are written separately. If this causes compatibility issues within your own environment and other tools using the BVBS files, you can still go back to the older way of exporting by setting the advanced option XS_BVBS_EXPORT_ARC_COMPATIBLE_TO_OLDER_METHOD to TRUE in an .ini file, for example, in user.ini.

Click the links below to find out more:
- Export to the BVBS format (page 376)
- Reinforcing bar length calculation in BVBS export (page 383)

**Export to the BVBS format**
You can export reinforcement geometry to the BVBS format. The result is an ASCII file with a file name extension .abs.

1. Ensure that numbering is up to date.
2. Go to the properties of the cast units and reinforcement that you plan to export, and edit the user-defined attributes on the BVBS tab as required. The user-defined attributes are environment specific.
3. Select the cast units with the desired reinforcement content, or select the reinforcement.
4. On the File menu, click Export --> BVBS.
   The BVBS export dialog box is displayed.
5. Define the BVBS export settings:
a. On the **Parameters** tab, select which reinforcement to export, how to export drawing data, how and where to export the BVBS file or files, and which BVBS elements to export.

You can use saved selection filters to exclude reinforcement bars or meshes matching with the selected filter.

b. On the **Advanced** tab, select whether you want to make meshes out of rebars, select whether the detailed data of mesh bars is included in the exported data of the mesh, define the order of the items in the output file, and select whether the private data block is exported and select the data items for this additional block.

c. On the **Checking** tab, select whether you want to enter the required minimum and maximum cutting length of the reinforcing bars.

6. Click **Export**.

The BVBS file or files in .abs format are exported to the folder specified in the **Output file** area. You can check the export report by clicking the report link that appears at the bottom of the dialog box.

---

**Export settings**

Use the **BVBS Export** dialog box to control the BVBS export settings.

For instructions on how to export to BVBS format, see Export to the BVBS format (page 376).

**Parameters tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model objects to be exported</td>
<td>Select which reinforcing bars or meshes are exported.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Reinforcement of all cast units in the model</strong></td>
</tr>
<tr>
<td></td>
<td>Exports reinforcing bars or meshes in all cast units in the model. If there are cast units that do not have reinforcing bars or meshes, no empty files are created.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Reinforcement of selected cast units</strong></td>
</tr>
<tr>
<td></td>
<td>Exports reinforcing bars or meshes in the cast units you have selected in the model.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Selected reinforcement only</strong></td>
</tr>
<tr>
<td></td>
<td>Exports the reinforcing bars or meshes you have selected in the model or in the drawing. When you select this option, you can export only to a single file.</td>
</tr>
<tr>
<td><strong>Option</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Reinforcement of all cast units in the model (totals by all positions)</td>
<td>Exports reinforcing bars or meshes in all the cast units that have the same cast unit position as any of the selected cast unit positions. For example, if a cast unit with the cast unit position W-120 is selected, the reinforcing bars or meshes in all the cast units that have position W-120 are exported even though not all of them were selected.</td>
</tr>
<tr>
<td>Excluding reinforcement by filter</td>
<td>Exclude reinforcing bars or meshes by selecting any of the selection filters. Reinforcing bars or meshes that match the filter are excluded.</td>
</tr>
<tr>
<td>Drawing name source</td>
<td>In BVBS file each row/rebar has a data field for Drawing number of the respective drawing (drawing name) and Index of the respective drawing (drawing revision). With the option <strong>Drawing name source</strong> you can control how the values for these data fields will be set. <strong>Cast_unit_position</strong></td>
</tr>
<tr>
<td>Drawing Name</td>
<td></td>
</tr>
<tr>
<td>Drawing Mark</td>
<td></td>
</tr>
<tr>
<td>Drawing Title1</td>
<td></td>
</tr>
<tr>
<td>Drawing Title2</td>
<td></td>
</tr>
<tr>
<td>Drawing Title3</td>
<td></td>
</tr>
<tr>
<td>Fixed text: If you select this, enter the text in <strong>Fixed drawing name</strong>.</td>
<td></td>
</tr>
<tr>
<td>Reinforcement UDA Template</td>
<td>By selecting the option <strong>Fixed text</strong> you can enter the values in the dialog box and same (“fixed”) values will be written for every exported rebar. If any of the other options is selected, the drawing name and revision will be taken from the cast unit or cast unit drawing of the rebar. Note that it depends on the receiving system of the BVBS file how important and for what purpose this data will be used. From Tekla Structures perspective, using this data field is not obligatory.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Fixed drawing name</td>
<td>Enter a text string to be used for the drawing in the export. This option is available only when you have selected the option <strong>Fixed text</strong> in <strong>Drawing name source</strong>.</td>
</tr>
<tr>
<td>Position source</td>
<td>Define the source of the position. The options <strong>Reinforcement position</strong>, <strong>Reinforcement UDA</strong> and <strong>Fixed text</strong>.</td>
</tr>
<tr>
<td>User-defined reinforcement position</td>
<td>Define the reinforcement UDA position number. Exported item with the same position number but different UDA position number will be exported to different rows.</td>
</tr>
<tr>
<td>Rev</td>
<td>Drawing revision (index). This option is available only when you have selected the option <strong>Fixed text</strong> in <strong>Drawing name source</strong>.</td>
</tr>
<tr>
<td>Single file</td>
<td>Export all BVBS information into one .abs file. Enter the file name in the box or click the ... button to browse for the file. If you do not enter a path, the file is saved in the model folder.</td>
</tr>
<tr>
<td>One file per each cast unit</td>
<td>Export each cast unit reinforcement content to its own file. The files are created under the folder that you define in the <strong>Folder name</strong> box, or you can browse for the folder using the ... button. Use the <strong>File naming template</strong> list to select how the created files are automatically named. You can include revision into file name by selecting the <strong>Include revision into file name</strong> check box.</td>
</tr>
<tr>
<td>BVBS elements to be exported</td>
<td>Select which item types are exported. The options are:</td>
</tr>
<tr>
<td></td>
<td>2D reinforcement bars (BF2D)</td>
</tr>
<tr>
<td></td>
<td>3D reinforcement bars (BF3D)</td>
</tr>
<tr>
<td></td>
<td>Sprial reinforcement coils (BFWE)</td>
</tr>
<tr>
<td></td>
<td>Reinforcement meshes (BFMA)</td>
</tr>
<tr>
<td></td>
<td><strong>Lattice girders (BFGT)</strong></td>
</tr>
<tr>
<td></td>
<td>If you select <strong>Lattice girders (BFGT)</strong>, enter the class numbers used in the model for the lattice girder bars in the <strong>Class numbers for girder</strong> box. The lattice girder may contain two or three chord bars and one or two diagonal zig-zag bars. The lattice</td>
</tr>
</tbody>
</table>
girder length and other attributes are taken from the main chord (usually top chord).

**Advanced tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Try to make meshes of rebars**    | Select whether the export tries to automatically form meshes of a single reinforcing bar or of a group reinforcing bars and export them as a mesh instead of separate 2D bars. The options are:  
  Yes, group rebars by class  
  Yes, group rebars by name  
  Yes, group rebars by grade  
  Yes, group rebars by UDA  
  In order to form a mesh the reinforcing bars need to belong to the same part, be straight, be on the same plane, and have equal filtering attribute values. |
| **UDA name for grouping**            | If you selected the value Yes, group rebars by UDA for Try to make meshes of rebars, enter the UDA name for grouping.                           |
| **Exporting of mesh bar data (@X..@Y..)** | Use this option to control whether the detailed data on mesh bars is included in the exported data of the mesh. The appropriate option depends on the needs and capabilities of the receiving system. The data is needed if it will be used, for example, for mesh fabrication.  
  • Custom and cut catalog meshes only  
    Detailed bar data is included only for custom meshes and catalog meshes that have additional cuts, openings or skewed edges.  
  • All meshes  
    Detailed bar data is written for all meshes. |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>None meshes</strong></td>
<td>Detailed bar data is not written to any of the meshes.</td>
</tr>
<tr>
<td><strong>Export stepped bars as separate items</strong></td>
<td>By default a stepped group is exported as a single string with the stepping length defined in a certain data block. If you select the value Yes for Exporting of mesh bar data (@X..@Y..), all tapered reinforcing bar groups are exported as multiple separate reinforcing bar items even if they have regular spacing and could be exported as one single stepped reinforcing bar item. If all the tapered bars within the group have the same geometry and length, they will be exported within a single BVBS string as a regular group would, regardless of this setting.</td>
</tr>
</tbody>
</table>
| **Sort items** | Use this option to define the order of the items in the output files. The options are:  
  **No sorting**  
  **By diameter, smaller size first**  
  **By diameter, bigger size first**  
  **By position number** |
| **Private data block** | With **Private data block** you can control whether the private data block is exported (Export private data block) and select the data items for this additional block. Data fields can be any report properties, user-defined attributes, or object properties. Click the **New** button to add new predefined private data fields to the list. Enter information about the data item.  
  **Name in list**  
  The text shown in the **Private data block** list. |
### Option Description

- **Field identifier**
  
The field code which separates the individual data fields in the private data block. It can be any lower case letter. Typically, it is a good practice to use a different value for each data item but this is not required. The receiving system may also be able to read only certain data fields.

- **Property or UDA name**
  
The value defines which data will be inquired from the reinforcement object. Note that a non-existing property will be not exported.

- **Property data type**
  
The value has to match the actual selected property. The options are:

  - Report property - Integer/Float/Text
  - User-defined attribute - Integer/Float/Text
  - Open API object property

### Checking tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Check cutting length</strong></td>
<td>Select whether you want to run an additional check for the <strong>Minimum cutting length</strong> and <strong>Maximum cutting length</strong> of the reinforcing bars.</td>
</tr>
</tbody>
</table>

When you select the **Check cutting length** check box, and the cutting length of the exported reinforcing bar is less than the minimum cutting length or greater than the maximum cutting length, a warning is written to the export log file.

The log file entry contains the ID of the reinforcing bar. You can locate the
Option | Description
--- | ---
| | reinforcing bar in the model by selecting the appropriate row in the log file. Note that the reinforcing bar is still exported normally and only the additional warning is given.
| | Note that when the minimum/maximum cut length check is activated, the length of lattice girders is also checked. A warning is added in the log when the check fails. The length of the main chord defines the exported length of the lattice girder.

**UDAs tab**

On this tab you can define the UDA fields to be used, and the content to write into reinforcement, part, cast unit and pour object UDAs. You can tag UDAs based on release code, release status, release date and released by information. You can also select whether existing UDAs are checked and handled by using the setting **Check existing UDAs**. The options are **No**, **Prevent export**, **Report to log**, **Report to log and overwrite**, and **Overwrite only**.
Reinforcing bar length calculation in BVBS export

The length of the reinforcing bar is calculated according to the BVBS specification. The length also depends on the bending angle. Lengths L1 and L2 are exported.

If you set the advanced option XS_USE_USER_DEFINED_REBAR_LENGTH_AND_WEIGHT to TRUE, the user-defined length value is exported as the overall length for the reinforcing bar.

Note that the BVBS format specifications define that the overall length of the bar is ignored if the data contains actual geometry data. Some other software applications may still use the overall length values in the BVBS file for calculating quantities. The exported overall length in Tekla Structures is the same length as shown in reports.

See also

BVBS (page 376)
Export to the BVBS format (page 376)
ELiPLAN

Elematic ELiPLAN is a software for resource planning, scheduling, and management for precast concrete fabricators.

ELiPLAN import and export automates the data transfer between Tekla Structures and ELiPLAN. The data transfer consists of four parts:

1. Exporting ELiPLAN data file from Tekla Structures.
2. Importing ELiPLAN data file into ELiPLAN.
3. Exporting ELiPLAN status data file from ELiPLAN.
4. Importing ELiPLAN status data file into Tekla Structures.

The import of an ELiPLAN data file into ELiPLAN supports the incremental approach, which means that ELiPLAN is able to create, update, and delete parts in its database. This means that precast detailers can export the most up-to-date data files whenever the Tekla Structures model has been changed.

Similar incremental support is included in the import of an ELiPLAN status data file to Tekla Structures. To keep the status and schedule data up to date in a Tekla Structures model, we recommend you update the status data regularly.

**NOTE** The format and contents of the ELiPLAN status data file imported to Tekla Structures differs from the data file that is exported from Tekla Structures to ELiPLAN.

See also
- Import an ELiPLAN status data file (page 386)
- Export an EliPLAN data file (page 385)

**Export an EliPLAN data file**

Before starting the export, you need to know what has been exported before. If you are using a shared model, first check the situation by checking the drawings, for example.

1. If needed, add EliPLAN information to EliPLAN user-defined attributes of the parts.
   
   For more information about the UDAs, see EliPLAN user-defined attributes (page 386).

2. On the **File** menu, click **Export --> EliPlan**.
   
   The **Export EliPlan file** dialog box is displayed.

3. Define the ELiPLAN export properties on the **Parameters, Plotter data** and **Data content** tabs, see ELiPLAN export settings.
4. Set **Scope of export** to **All** or **Selected**.

You should always bring every element that is ready to EliPLAN with every round to ensure that any design changes are taken into the system as well. The model might have some non-relevant or not-ready cast units, which is why it is recommended to use **Selected** to control which ones are being exported. Conceptual cast units can be taken, but then you need to keep track of these elements, for example, by using a UDA.

5. Click **Create**.

By default, a file called eliplan.eli is created in the current model folder, in a .\EP_files subfolder. Export checks the **Set Top in Form Face** setting for all parts, if it is set, see set top-in-form-face. The opposite face will be towards the pallet.

**Import an ELiPLAN status data file**

If you have a status data file that has been created in ELiPLAN, you can import the status and scheduling information to your Tekla Structures model.

1. On the **File** menu, click **Import --> EliPlan**.
   
The **Import Eliplan status data** dialog box opens.
2. Click the **...** button next to the **Import file name** box to browse for the file to be imported.
3. Click **Create**.
   
Tekla Structures updates the status and schedule data for parts in the Tekla Structures model. When the data is read, a log file is displayed.

   The log file shows the parts whose data is updated correctly. It also provides information on possible problems that may have occurred. When you select a row in the log file, Tekla Structures automatically selects the corresponding part in the model. The overall status information is shown at the end of the log file.

Tekla Structures stores the actual status data in the user-defined attributes of the parts. To view the data, open the part properties dialog box, click the **User-defined attributes** button and go to the **EliPlan** tab.

**See also**

ELiPLAN (page 384)

Export an EliPLAN data file (page 385)

**ELiPLAN user-defined attributes**

In addition to normal model data, you can add additional information in the user-defined attributes of the parts. The additional information can be transferred from Tekla Structures and used in ELiPLAN.
Product type

The product type affects how ELiPLAN considers the part dimensions length, length2, deltaL, width, height, and thickness.

To set the product type, select a suitable product type option from the list. Normally you should be able to use the default **Auto**, but in some cases you may need to override the default.

If needed, you can override the product type value set in the dialog box in the following way:

- You can enter a value for the user-defined attribute `EP_TYPE` in the `objects.inp` file.
- You can enter a value for the user attribute `EP_TYPE` in the Profile Catalog.

In the Profile Catalog the attribute value is given as a number. The values are as follows:

- Slab = 1
- Beam = 2
- Column = 3
- Wall = 4
- Sandwich wall = 5
- Stair = 6

Product code

You have alternative ways to give the product code. The ELiPLAN export tries to define the product code in the following order:
1. You can enter a value for the product code in the ELiPLAN user-defined attributes dialog box.

2. You can enter a value for the user-defined attribute EP_CODE of the cast unit main part in the objects.inp file.

3. You can enter a value for user attribute EP_CODE in the Profile Catalog.

4. You can use the data conversion file to convert parametric profile names to a product code.

5. The main part name is exported as the main part name if none of the previous methods succeeded.

**Erection sequence**

Precast parts are erected in a certain sequence. Use the sequence to help the scheduling of the production in ELiPLAN. You can give the estimated erection sequence by giving the sequence number for parts.

**Ready for production**

Set this option to *Yes* when the designer or detailer has finished the part and the part is ready for production. The default is *No*, which means that the data is transferred to ELiPLAN for preliminary planning only, and the part is not sent for production until the attribute is set to *Yes* and a new file is transferred to ELiPLAN.

**Eliplan status data**

The **Eliplan status data** is meant to be read-only information and used to visualize the data in a Tekla Structures model.

**Set up your UDAs in the model or profile catalog for mapping object types, profiles and materials**

For more information on how to set up your UDAs in the model or profile catalog for mapping object types, profiles and materials to suit the EliPLAN export, see EliPLAN/ELiPOS export guide.

**See also**

Export an EliPLAN data file (page 385)

EliPLAN export settings (page 388)

**EliPLAN export settings**

Use the Export EliPlan file dialog box to control the ELiPLAN export properties.
For instructions on how to export the EliPLAN data file, see Export an EliPLAN data file (page 385).

In addition to normal model data, you can add additional information in the user-defined attributes of the parts. The additional information can be transferred from Tekla Structures and used in ELiPLAN. For more information, see EliPLAN user-defined attributes (page 386).

Parameters tab

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scope of export</td>
<td>Select whether all parts or only selected parts are exported. Because of the incremental import of EliPLAN, you need to select the same parts, and some additional parts again, if needed, when exporting the next time, to make sure that any design changes are taken in to the system as well. Otherwise EliPLAN assumes that the parts missing from the subsequent file have been deleted in the Tekla Structures model. We recommend you to always use the All option. Use the Selected option only in special cases or when you are exporting parts for the first time.</td>
</tr>
<tr>
<td>Numbering must be up to date to export</td>
<td>Set this setting to Yes to prevent export when the numbering is not up to date. This prevents the export of unfinished cast units.</td>
</tr>
<tr>
<td>Export version number</td>
<td>Select whether IDs, GUIDs or ACNs are used in the export. Use 2.0 GUID, because IDs will change when reopening the model, resulting in duplicates in export. The default is ID, but it should only be used when the export is done only once, because of the changing IDs. Select 2.00 ACN to export elements with ACN.</td>
</tr>
<tr>
<td>Output file name</td>
<td>The name and location of the export file created. The default name is</td>
</tr>
</tbody>
</table>
### Setting

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| eliplan.eli | You can import this file into EliPLAN. The eliplan.eli file includes, among other things, material information. The accessory code, which is the material description, is in the #Materials section. The accessory code is based on the material type as follows:  
• For concrete material the default accessory code is same as the material name.  
• For mesh, reinforcing bars, or strands the default accessory code is grade|size.  
• For embedded material the default accessory code is name|size|material. |

### Data conversion file

Data conversion file With this file you can convert the parametric profile names into the EliPLAN product codes, and the material descriptions into the EliPLAN accessory codes. You need to create the file yourself when necessary. The default file name is eliplan_export.dat, and this file can be located in any folder. The data conversion file eliplan_export.dat contains string pairs separated with one or more tabs. The string on the left side is the profile name or Tekla Structures material description and the string on the right side is the corresponding EliPLAN data. Note that the EliPLAN codes depend on the fabricator, and the codes that are valid for one fabricator are likely to be not valid for other fabricators. For an example of data conversion file contents, see eliplan_export.dat example.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter by part: Element data</td>
<td>Enter a list of classes or to be excluded from or included in the export. This contains the class numbers or names used for concrete parts. Separate the classes or names with a space.</td>
</tr>
<tr>
<td>Filter by part: Material quantities</td>
<td>Enter a list of classes or to be excluded from or included in the export. This contains the class numbers or names used for materials. Separate the classes or names with a space.</td>
</tr>
<tr>
<td>Filter by part: Secondary concrete</td>
<td>Enter a list of classes or names to be excluded from or included in the export. This contains the class numbers or names used for secondary concrete parts. Separate the classes or names with a space.</td>
</tr>
<tr>
<td>Create log file</td>
<td>Select whether a log file is created. Creating a log file is recommended to ensure that the exported file is correct.</td>
</tr>
<tr>
<td></td>
<td>The log will notify you about the number of exported cast units and, for example, if:</td>
</tr>
<tr>
<td></td>
<td>• Export failed because numbering not done.</td>
</tr>
<tr>
<td></td>
<td>• Some cast units could not be exported.</td>
</tr>
<tr>
<td></td>
<td>• Some cast units were ignored by filters, or they are CIP.</td>
</tr>
<tr>
<td></td>
<td>• Embeds or cuts to be plotted are completely outside the parts.</td>
</tr>
<tr>
<td></td>
<td>• Some of the material or product type data conversion mapping is not recognized.</td>
</tr>
<tr>
<td>Log file name</td>
<td>The name and location of the created log file.</td>
</tr>
</tbody>
</table>
Plotter data tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export of cutout data</td>
<td>Select how to export cutout data. The options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>All</strong>: Exports all data.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Full depth cuts only</strong>: Exports data only on the cuts that go through the whole part. Does not export recess data.</td>
</tr>
<tr>
<td></td>
<td>• <strong>None</strong>: Does not export any cutout data.</td>
</tr>
<tr>
<td></td>
<td>It is recommended to use <strong>Full depth cuts only</strong>, because otherwise small recesses are included in the plotting on both faces.</td>
</tr>
<tr>
<td></td>
<td>Overlapping cutouts are combined in the export file.</td>
</tr>
<tr>
<td></td>
<td>This setting exists for hollowcore and slab products, and for wall and sandwich wall products.</td>
</tr>
<tr>
<td>Export of embed data</td>
<td>Select how to export data of embeds. The options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Yes</strong>: Exports data on embeds.</td>
</tr>
<tr>
<td></td>
<td>• <strong>No</strong>: Does not export any data on embeds.</td>
</tr>
<tr>
<td></td>
<td>This setting exists for hollowcore and slab products, and for wall and sandwich wall products.</td>
</tr>
<tr>
<td>Plot cutout/embed as lines</td>
<td>Export cutouts and embeds as lines. The options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>None</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Class</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Name</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Material</strong></td>
</tr>
<tr>
<td>Exclude cut parts by</td>
<td>Use to exclude cut parts from export based on the cut part properties. The options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>None</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Class</strong></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>This setting is a handy filter for reducing amount of extra cuts in plotting.</td>
</tr>
<tr>
<td><strong>Material</strong></td>
<td></td>
</tr>
</tbody>
</table>

**Exclude embeds by**

Use to exclude embeds from exported plotting data embeds by:

- None
- Class
- Name
- Material

You can define one or more values for the selected property.

**Exclude above z position**

Select whether to exclude from exported plotting data embeds or cuts that are above the specified Z position. The Z position is the depth of the element on the pallet, that is how many millimeters the lowest point of the embed is above the pallet surface.

You can define one or more values for the selected property.

The options are:

- None
- Embeds
- Cuts
- Embeds and cuts

**Data content tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Product code</strong></td>
<td>Select a product code mapping.</td>
</tr>
<tr>
<td><strong>Export material data</strong></td>
<td>Select whether to include or exclude the detailed material data (receipt) of parts. If you have no use for material data in EliPLAN (you have no material handling module in EliPLAN), select</td>
</tr>
</tbody>
</table>

Import to and export from Tekla Structures 393 Concrete fabrication
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export rebar bending data</td>
<td>Select whether to include or exclude the detailed rebar bending information.</td>
</tr>
<tr>
<td></td>
<td>If you do not need this data in EliPLAN, select No to exclude the data from the file and to reduce the file size.</td>
</tr>
<tr>
<td></td>
<td>Note that once you have transferred the file with the rebar bending data (Yes) you should never switch off (No) the export of rebar bending data in subsequent exports.</td>
</tr>
<tr>
<td>Export embed Z position</td>
<td>Select whether to include or exclude the Z level of embeds.</td>
</tr>
<tr>
<td>Unit for rebar length</td>
<td>Select the unit for the length of reinforcing bars.</td>
</tr>
</tbody>
</table>
| No. of digits after decimal point | Select the number of digits after the decimal separator (0 - 3).  
The default is 1 digit after the decimal separator.                                                                                                                                                                                                                                                                                                                                                                           |
| Tag for lifters               | Use to identify lifting loops by their name. Enter the name of the lifting loop.  
When lifting loops are identified, the plotter instruction type is changed from WPL to LL.                                                                                                                                                                                                                                                                                                                                                                         |
| Prefix for ID                 | Enter a prefix (letter) to use with the ID number.                                                                                                                                                                                                                                                                                                                                                                                                                               |
| Notes                         | Use UDA or template attribute to add extra information to be viewed at the factory, such as design status, change status or general comment.  
Select what type of notes you want to export: UDA, a template attribute or UDA and template attribute.                                                                                                                                                                                                                                                                                                                                                                               |
## Option Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>your own text. Then enter the UDA, template attribute, or text.</td>
<td></td>
</tr>
<tr>
<td><strong>Position number type</strong></td>
<td>Select whether to export the cast unit position number, assigned control number (ACN), or cast unit position number and ACN.</td>
</tr>
<tr>
<td><strong>Remove numbering separator</strong></td>
<td>Select whether a position number separator is used in numbering. The default is <strong>No</strong>.</td>
</tr>
<tr>
<td><strong>Tag special elements</strong></td>
<td>Set this option to <strong>Yes</strong> to set a special tag for elements that have notch cuts. This option marks hollow-cores with notches with SK denominator (N for uncut slabs).</td>
</tr>
<tr>
<td><strong>Net area calculation</strong></td>
<td>Select <strong>Exclude all cuts</strong> to exclude all cuts or <strong>Exclude full depth cuts only</strong> to exclude full depth cuts only from the net area calculation, or <strong>Gross area</strong> to export gross area as net area. The whole assembly is checked.</td>
</tr>
<tr>
<td><strong>Weight calculation</strong></td>
<td>Select which weight will be exported.</td>
</tr>
<tr>
<td><strong>Decimal mark</strong></td>
<td>Set period (.) or comma (,) as the decimal mark depending on EliPLAN settings.</td>
</tr>
</tbody>
</table>

### HMS

HMS stands for Hollowcore Manufacturing System and it is developed in the Netherlands. You can export data of hollow core slabs from Tekla Structures to HMS. HMS uses the data in manufacturing processes.

Click the links below to find out more:

- Export to the HMS format (page 395)
- HMS Export settings (page 396)

---

**Export to the HMS format**

You can export model data of hollow core slabs to a HMS format. The result is a `.sot` file.

1. Select the model objects that you want to include in the export.
2. On the **File** menu, click **Export --> HMS**.
   - The **HMS Export** dialog box opens.
3. Define the export properties (page 396) as required.
4. Click the ... button to browse for the folder where you want to save the file.
   The \HMS folder under the model folder is the default.
5. Enter a name for the file.
   The file name extension is .sot.
6. Click Save.
7. Select the Add revision to file name check box and select the revision number if required.
   The revision number is added to the HMS export file as follows:
   hms_export_file<revision>.sot
8. Select the Open log file after export check box if you want to see the log after export.
   HMS Export creates the log file in the file export folder.
9. Click Export to create the HMS export file.

See also
HMS Export settings (page 396)

HMS Export settings
You can include project data, slab data, and steel part information in the HMS export.

Project data tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Name</td>
<td>You can include project data, such as customer name and site address, in the HMS export file.</td>
</tr>
<tr>
<td>Customer Number</td>
<td>The boxes have the following values available:</td>
</tr>
<tr>
<td>Contractor Name</td>
<td>• Empty The item is not included in the HMS export file.</td>
</tr>
<tr>
<td>Site Address</td>
<td>• Text Enter the text in the box next to the item.</td>
</tr>
<tr>
<td>Site City</td>
<td></td>
</tr>
<tr>
<td>Section Name</td>
<td></td>
</tr>
<tr>
<td>Project Status</td>
<td></td>
</tr>
<tr>
<td>Remark 1</td>
<td></td>
</tr>
<tr>
<td>Remark 2</td>
<td></td>
</tr>
<tr>
<td>Remark 3</td>
<td></td>
</tr>
</tbody>
</table>
### Option Description

<table>
<thead>
<tr>
<th>Export file</th>
<th>Define a name and location for the export file. The file name extension is <code>.sot</code>. By default, the export file goes to the <code>\HMS</code> folder under model folder.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add revision to file name</td>
<td>Add the revision number to the HMS export file: <code>hms_export_file&lt;revision&gt;.sot</code>.</td>
</tr>
<tr>
<td>Open log file after export</td>
<td>Open the log file after export. HMS Export creates the log file in the file export folder.</td>
</tr>
</tbody>
</table>

### Slab data tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position Number</td>
<td>Assigned Control Number (ACN) is the only option.</td>
</tr>
<tr>
<td>Slab Remarks</td>
<td>The options are:</td>
</tr>
<tr>
<td>Element Type</td>
<td>• Empty</td>
</tr>
<tr>
<td>End Label</td>
<td>The item is not included in the HMS export file.</td>
</tr>
<tr>
<td></td>
<td>• Text</td>
</tr>
<tr>
<td></td>
<td>Enter the text in the box next to the item.</td>
</tr>
<tr>
<td></td>
<td>• UDA</td>
</tr>
<tr>
<td></td>
<td>The data comes from the project’s user-defined attributes</td>
</tr>
<tr>
<td>Slab Name</td>
<td>The options are:</td>
</tr>
<tr>
<td></td>
<td>• Profile</td>
</tr>
<tr>
<td></td>
<td>Select to export the whole profile name.</td>
</tr>
</tbody>
</table>
### Option | Description
--- | ---
Thickness | Select to export only the profile height.

**Slab Mark**
The options are:
- **Assembly position**
  Select to export the complete cast unit position.
- **Assembly serial number**
  Select to export the cast unit serial number only.

**Bay number**
Select the default UDA or UDA of your choice. The value type of the default UDA is integer, and it must be type integer for any other chosen UDA as well.

**Slab Weight Units**
Select the weight unit.

**Live/dead load**
Enter the default live/dead load to be exported.
For hollow core slab calculation, you can define a default live load/ dead load (KN/m2) for slabs.
If you do not define this data here, you must enter the default values for each slab in HMS software later.

### Slab scope tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Exclude parts</strong></td>
<td>Enter the class or the name of the model object, text, UDA or a template attribute to exclude the data.</td>
</tr>
</tbody>
</table>

**Hook Points**
Select the data that is exported.
- **Empty**
  The item is not included in the HMS export file.
- **Name**
  Select to include the name.
- **Text**
  Enter the text in the box next to the item to include the text.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Class</strong></td>
<td>Enter the class of the model object in the box to include the class.</td>
</tr>
<tr>
<td><strong>UDA</strong></td>
<td>The data comes from the user-defined attributes.</td>
</tr>
<tr>
<td><strong>Template</strong></td>
<td>The data comes from a template attribute.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Hook point name</th>
<th>Select to include hook point name in export.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Select to include the name.</td>
</tr>
<tr>
<td><strong>Text</strong></td>
<td>Enter the text in the box next to the item to include the text.</td>
</tr>
<tr>
<td><strong>UDA</strong></td>
<td>The data comes from the user-defined attributes.</td>
</tr>
<tr>
<td><strong>Template</strong></td>
<td>The data comes from a template attribute.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Weld plate name</th>
<th>Select to include weld plate name in export.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Select to include the name.</td>
</tr>
<tr>
<td><strong>Text</strong></td>
<td>Enter the text in the box next to the item to include the text.</td>
</tr>
<tr>
<td><strong>UDA</strong></td>
<td>The data comes from the user-defined attributes.</td>
</tr>
<tr>
<td><strong>Template</strong></td>
<td>The data comes from a template attribute.</td>
</tr>
</tbody>
</table>
### Reinforcement tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export strand code</td>
<td>Select to include strand code in export.</td>
</tr>
<tr>
<td>Export strand pull force</td>
<td>Select to export pull force data.</td>
</tr>
</tbody>
</table>

### Options tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boundary line</td>
<td>Export the boundary line <strong>Along cut side of the slab</strong> or <strong>Along uncut side of the slab</strong>.</td>
</tr>
<tr>
<td>Export Hook Box</td>
<td>Select to include hook data.</td>
</tr>
<tr>
<td>Export HP name</td>
<td>Select to export hook point names. If you do not select this option, only the XY coordinates are exported.</td>
</tr>
<tr>
<td>Export inner cores</td>
<td>Select to include detailed information on hollow cores in export.</td>
</tr>
<tr>
<td>Include full cut to contour</td>
<td>Select to include in export full cut in the contour block (CO). If not selected, the full cut is written as an individual cut (SP).</td>
</tr>
<tr>
<td>Generate drain/weep holes</td>
<td>Select to include drain holes and weep holes in export. You can also specify the offset.</td>
</tr>
</tbody>
</table>

**See also**

*Export to the HMS format (page 395)*

### 3.14 CAD

The CAD import and export tools support several formats to import and export models. You can import a maximum of 10,000 parts. If the number of parts exceeds this, Tekla Structures displays a warning message, and does not import the model.
## CAD import and export formats

The table below lists the supported import and export file types.

<table>
<thead>
<tr>
<th>Option</th>
<th>Import</th>
<th>Export</th>
<th>Imports from/Exports to</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDNF</td>
<td>✔</td>
<td>✔</td>
<td>SDNF (Steel Detailing Neutral File) is used in importing to and exporting from several different CAD systems.</td>
</tr>
<tr>
<td>HLI</td>
<td>✔</td>
<td>✔</td>
<td>HLI (High Level Interface). IEZ AG Speedikon software</td>
</tr>
<tr>
<td>Plantview</td>
<td>✔</td>
<td></td>
<td>Plantview design system</td>
</tr>
<tr>
<td>SDNF (PDMS)</td>
<td>✔</td>
<td>✔</td>
<td>Plant Design Management System. Aveva 3D plant design software. Data is exported to PDMS via SDNF link. Tekla Structures writes the information of finish field in the member class attribute, whereas in SDNF export it omits the class information.</td>
</tr>
<tr>
<td>XML</td>
<td>✔</td>
<td>✔</td>
<td>ArchiCAD modeling system. There are some limitations in the export:</td>
</tr>
<tr>
<td>SCIA</td>
<td>✔</td>
<td>✔</td>
<td>SCIA is used for SteelFab interface</td>
</tr>
</tbody>
</table>

In addition to the CAD import tool, the import tools listed below are available in the **New Import Model** dialog box. The steps for importing these types are the same as for the CAD import.

- Import Steelfab/SCIA
- Import SFrame
- Import MicasPlus
- Import Eureka LPM
- Import Eureka LPM
- Import CIS2 status
- Import CIS model
- Import FEM

Import to and export from Tekla Structures 401 CAD
Tekla Warehouse is a service for collaboration, and for storing and sharing Tekla Structures content.

Tekla Warehouse provides centralized access to a wide range of content that you can use in your Tekla Structures models.

With Tekla Warehouse you can:

• Publish your content online.
• Use your company network or a commercial file storage and synchronization service to share content.
• Save content locally for private use.

In Tekla Warehouse, content is organized into *collections*.

Tekla Structures collections contain official Tekla Structures content that you can use in your models. The content is grouped by geographical area. There is also a global folder for content that is not location specific.

Tekla Warehouse has the following content categories:

• Applications
• Custom components
• 3D products
• Profiles
• Materials
• Bolts
• Reinforcement
• Model setup files
• Drawing setup files
• Report templates

**Accessing Tekla Warehouse**

To open Tekla Warehouse while using Tekla Structures, do one of the following:
• On the File menu, click Extend --> Tekla Warehouse.
• Go to Quick Launch, and start typing Tekla Warehouse.

Tekla Warehouse consists of the Tekla Warehouse web site (https://warehouse.tekla.com/) and the Tekla Warehouse Service.

You need Tekla Warehouse Service to benefit from all the features Tekla Warehouse offers, for example, easy installation of content into a Tekla Structures model, or local and network collections.

See also
For more information on Tekla Warehouse, go to Tekla Warehouse and click About, or see Getting started with Tekla Warehouse.
5 Disclaimer

© 2019 Trimble Solutions Corporation and its licensors. All rights reserved.

This Software Manual has been developed for use with the referenced Software. Use of the Software, and use of this Software Manual are governed by a License Agreement. Among other provisions, the License Agreement sets certain warranties for the Software and this Manual, disclaims other warranties, limits recoverable damages, defines permitted uses of the Software, and determines whether you are an authorized user of the Software. All information set forth in this manual is provided with the warranty set forth in the License Agreement. Please refer to the License Agreement for important obligations and applicable limitations and restrictions on your rights. Trimble does not guarantee that the text is free of technical inaccuracies or typographical errors. Trimble reserves the right to make changes and additions to this manual due to changes in the software or otherwise.

In addition, this Software Manual is protected by copyright law and by international treaties. Unauthorized reproduction, display, modification, or distribution of this Manual, or any portion of it, may result in severe civil and criminal penalties, and will be prosecuted to the full extent permitted by law.

Tekla, Tekla Structures, Tekla BIMsight, BIMsight, Tekla Civil, Tedds, Solve, Fastrak and Orion are either registered trademarks or trademarks of Trimble Solutions Corporation in the European Union, the United States, and/or other countries. More about Trimble Solutions trademarks: http://www.tekla.com/tekla-trademarks. Trimble is a registered trademark or trademark of Trimble Inc. in the European Union, in the United States and/or other countries. More about Trimble trademarks: http://www.trimble.com/trademarks.aspx. Other product and company names mentioned in this Manual are or may be trademarks of their respective owners. By referring to a third-party product or brand, Trimble does not intend to suggest an affiliation with or endorsement by such third party and disclaims any such affiliation or endorsement, except where otherwise expressly stated.

Portions of this software:

D-Cubed 2D DCM © 2010 Siemens Industry Software Limited. All rights reserved.
This product contains proprietary and confidential technology, information and creative works owned by Flexera Software LLC and its licensors, if any. Any use, copying, publication, distribution, display, modification, or transmission of such technology in whole or in part in any form or by any means without the prior express written permission of Flexera Software LLC is strictly prohibited. Except where expressly provided by Flexera Software LLC in writing, possession of this technology shall not be construed to confer any license or rights under any Flexera Software LLC intellectual property rights, whether by estoppel, implication, or otherwise.

To see the third party open source software licenses, go to Tekla Structures, click File menu --> Help --> About Tekla Structures and then click the 3rd party licenses option.

The elements of the software described in this Manual are protected by several patents and possibly pending patent applications in the United States and/or other countries. For more information go to page http://www.tekla.com/tekla-patents.
Index

3
3D DWG/DXF exporting................................................ 188

A
abs files........................................................ 376
access rights.................................................. 77
analysis & design direct links.............................................. 255
Robot...................................................... 262
SAP2000................................................ 262
systems...................................................254
ASCII..............................................................271
exporting................................................ 315
file description.......................................315
importing................................................ 315

B
base quantities............................................182
BVBS............................................................. 318
calculating bar length........................... 383
export settings.......................................377
exporting................................................ 376

C
CAD export file types.....................................400
exporting............................................... 400
import file types.....................................400
importing............................................ 400
change detection for reference models...129
change management..................................129
checking multi-user databases................. 69
checking reference model contents...........142
exported IFC model........................................ 182
CIMSteel design/manufacturing models exporting................................................ 307
CIMSteel conversion files................................. 307
exporting............................................... 307
exporting to an analysis model.............. 307
importing........................................ 307,308
CIS..........................................................263,400
cconversion files..................................... 307
exporting............................................... 307
exporting to an analysis model.............. 307
importing........................................ 307,308
CIS/2..............................................................307
CIS/CIMSteel................................................ 271
CIS2 status................................................... 400
CNC............................................................... 272
cnv files...................................................115,119
compatible software.....................................98
concrete fabrication....................................318
contour marking......................................... 272
conversion files........................................ 115
CIMSteel................................................. 307
creating............................................... 116
twin profiles........................................... 119
converting IFC objects................................ 153
converting multi-user model....................... 60
converting single-user model..................... 60
copying multi-user models........................... 66
create layout line.........................................242
create layout point......................................241
creating contour marking............................ 272
creating conversion files............................. 116
layers for DWG export.......................... 213
NC files in DSTV format......................... 272
pop-marks..............................................272
rule for DWG export................................. 213
selection filter for DWG export.............. 212

407
tube NC files.......................... 272

cxl.............................................. 256

d

defining

  custom line type for DWG export........ 214

  line types and weights for layers in DWG export.......................................... 215

deleting

  unnecessary drawing files........ 77

  design models.......................... 307

  DGN................................................. 218

  exporting..................................... 221

  inserting..................................... 219

  direct links................................ 98,255

  drawing export........................... 190

  defining customized line type mappings ................................................................. 207

drawing files.................................. 75

deleting unnecessary...................... 77

drawings

  default line types....................... 211

  export layers............................ 204,206,207

  exporting..................................... 201,203,207

  DSTV file description................... 293

  dstv2dxf.def.................................. 295

  DSTV.............................................. 272

  converting to DXF.......................... 295

  creating NC files.......................... 272

  importing....................................... 265

  DWG.............................................. 186

  drawing export layers........ 204,206,207

  export............................................. 190

  export example........................... 212

  exporting 3D.................................. 188

  exporting drawings.................. 190,201,203

  importing....................................... 187

  objects in export layers.............. 205

  DWG export................................. 190

  DWG/DXF files

  exporting drawings..................... 190

  DXF.............................................. 186,272

  drawing export layers........ 204,206,207

  exporting 3D.................................. 188

  exporting drawings.................. 201,203

  importing....................................... 187

  objects in export layers.............. 205

  DXF

  export............................................. 190

  exporting drawings..................... 190

  E

  EliPlan......................................... 318

  export settings........................... 388

  exporting...................................... 384,385,386

  importing....................................... 384,386

  error messages

  in multi-user mode....................... 67

  Eureka LPM................................. 400

  examples

  converting IFC objects................... 163

  creating layers for DWG export........ 213

  creating rule for DWG export........... 213

  creating selection filter............... 212

  defining custom line type for DWG export.......................................... 214

  defining line types and weights for layers ................................................................. 215

  exporting drawing to DWG............... 216

  setting up layers for DWG export....... 212

  export DWG..................................... 190

  export layers............................... 204,206

  assigning objects........................ 205

  copying to another project............. 207

  export to DWG.................................. 190

  export types................................... 114

  exporting.................................... 114

  3D DWG/DXF.................................... 188

  ASCII............................................. 315

  assigning objects to drawing export layers............................................ 205

  BVBS............................................. 376,377,383

  CAD.............................................. 400

  CAD export file types................... 400

  checking exported IFC model............ 182

  CIMSteel........................................ 307

  CIS.............................................. 307

  compatible formats........................ 96

  compatible software...................... 98

  DGN.............................................. 221

  drawing......................................... 216

  drawing export layers........ 204,206,207

  drawings....................................... 207

  drawings to 2D DWG/DXF files........... 201,203
drawings to DWG/DXF ....................... 190
ELiPLAN ........................................ 384, 385, 386
FEM ................................................. 265
IFC base quantities ................................ 182
into IFC ............................................... 172
into IFC4 ......................................... 172, 178
layers ................................................. 203
Layout Manager .................................. 235
MIS list ............................................... 306
PML .................................................... 400
SDNF .................................................. 400
SketchUp ............................................. 224
STAAD .................................................. 265
to a CIMSteel analysis model .............. 307
to CIMSteel design/manufacturing models ............................................. 307
to HMS ................................................. 395
Unitechnik................................. 319, 321, 325, 330, 341, 349, 359, 361, 364,
368, 369, 373, 375
XML ...................................................... 400

F

Fabtrol XML.............................................. 271
importing .............................................. 314
FEM ..................................................... 400
importing .............................................. 265
file formats ........................................... 95
files
conversion................................. 115, 116, 119
firm folders
exporting drawings ................................ 207
fittings in NC files................................. 272
formats
in import and export ......................... 96

H

HLI.......................................................... 400
HMS ...................................................... 318, 395
exporting from Tekla Structures .......... 395
project data in export ......................... 396
slab data in export ................................ 396
steel part data in export ....................... 396

I

IFC4
exporting Tekla Structures models ....... 172, 178
IFC .......................................................... 149
base quantities ...................................... 182
checking exported IFC model .......... 182
converted objects ................................. 153
defining property sets in export .......... 169
element of converting IFC objects ........ 163
export ..................................................... 168
exporting Tekla Structures models ....... 172
insert ...................................................... 152
object conversion limitations .......... 167
object converter ..................................... 153
profile conversion ............................... 162
property set configuration files ........... 183
reference model assemblies ................. 148
supported schemas .............................. 152
using Organizer spatial hierarchy in export........................................ 172
import types .......................................... 114
importing .............................................. 114
ASCII .................................................... 315
CAD import file types ......................... 400
CIMSteel ............................................. 307, 308
CIS ..................................................... 307, 308
compatible formats........................... 96
compatible software ......................... 98
DSTV .................................................... 265
DWG files ............................................. 187
DXF files ............................................. 187
ELiPLAN ............................................. 384, 386
FabTrol XML ........................................ 314
FEM ..................................................... 265
from Tekla Structural Designer ........... 258
Layout Manager ..................................... 235
industry standards ............................ 95
inquiring
reference model contents .................. 142
inserting
PDF to model ....................................... 223
reference models ............................... 119
reference models ............................... 152
reference models ............................... 121
interoperability
compatible formats.......................... 96
compatible software............................... 98
ISM.......................................................... 263

L

LandXML...................................................... 222
layers
assigning objects in drawing export... 205
copying to another project............. 207
in drawing export........... 203,204,206,207
Layout Manager
base point.............................................. 251
base points......................................... 236,243
benchmark point............................... 251
ccontrol point.................................... 251
coordinates........................................ 236
datum point........................................ 251
drawing scale...................................... 243
dexample............................................ 251
export.................................................. 243
exporting............................................ 235
groups................................................... 236
import.................................................. 246
importing............................................ 235
layout lines......................................... 242
layout points...................................... 241
line cuts in NC files............................... 272
line types
customizing...................................... 203
in drawings................................. 211
mapping.......................................... 203,207
locking
reference models......................... 128

M

manufacturing models......................... 307
mapping line types.............................. 203
mapping
line types for drawing export........... 207
markups.............................................. 83
master models..................................... 61
saving............................................... 69
matexp_cis.cnv..................................... 307
MicasPlus............................................. 400
MIS......................................................... 271
exporting......................................... 306

file types information.......................... 306
model history
collecting........................................ 65
model revision comments............... 65
viewing........................................ 65
multi-user models
copying........................................... 66
shutting down.............................. 66
multi-user mode
active multi-users............................ 67
advantages.............................. 57
autosave........................................ 64
changing the server of a multi-user
tool............................................... 58
checking databases.......................... 69
error messages.............................. 67
locking models............................... 63
locks for drawings............................. 77
multi-user server......................... 58
numbering......................................... 74,75
overview......................................... 57
recommendations......................... 68
saving in................................. 63,69
switching between single-user and multi-
user modes.......................... 60
multi-user server as a service............ 58
NC files
contour marking................................... 272
creating......................................... 272
creating contour marking.............. 272
creating pop-marks......................... 272
DSTV file description..................... 293
fittings......................................... 272
line cuts........................................... 272
NC file headers.......................... 272
pop-marks......................................... 272
tube NC files............................ 272
NC/DSTV.............................................. 271
numbering
in multi-user mode............... 74,75

O

object conversion.............................. 167
objects.inp ......................................................... 127

PDF
inserting to model ........................................... 223
PDMS/E3D ......................................................... 315
permissions ..................................................... 77
Plantview .......................................................... 400
PML
exporting .......................................................... 400
point clouds
attaching ....................................................... 225
detaching ...................................................... 225
limitations ........................................................ 225
point count ...................................................... 225
storage ............................................................ 225
supported file formats ....................................... 225
pop-marks
creating ........................................................... 272
prfexp_cis.cnv .................................................... 307
privileges .......................................................... 77
privileges.inp
changing access rights ....................................... 77
controlling access to lock and unlock objects .......... 77
controlling access to numbering setup .................... 77
controlling access to save standard files ............... 77
options ............................................................ 77
user-defined attribute Locked ............................... 77
project folders
exporting drawings ............................................. 207
property set configuration files
in IFC export .................................................... 183
property sets ..................................................... 183
defining in IFC export ......................................... 169

R
reference models
inserting .......................................................... 121
reference model
LandXML .......................................................... 222
reference models
locking ........................................................... 128
reference models
assemblies ........................................................ 148
checking contents ............................................. 142
detecting changes ............................................. 123, 129
downloading from Trimble Connect project .............. 83
hiding and showing ........................................... 123
hierarchy ............................................................ 144
highlighting in model view ................................... 123
inquiring contents .............................................. 142
inquiring native reference objects ......................... 144
loading ............................................................... 119
modifying details .............................................. 127
opening reference models list .............................. 123
reference model objects ....................................... 143
showing details ............................................... 123
showing layers .................................................. 123
Trimble Connector
exporting model objects to ifc files ......................... 83
synchronizing with Trimble Connect ....................... 83
updating ........................................................... 123
user-defined attributes ....................................... 123
Robot ................................................................. 262

S
S-Frame .............................................................. 400
exporting ........................................................... 264
importing ........................................................... 264
SAP2000 ............................................................. 262
saving
in multi-user mode ........................................... 63, 69
master models .................................................. 69
SCIA ................................................................. 400
SDNF
exporting ........................................................... 400
shutting down multi-user models ......................... 66
single-user mode
switching between single-user and multi-user modes .... 60
SketchUp
exporting ........................................................... 224
SLABDATE block ................................................. 366
software .............................................................. 98
STAAD.Pro ........................................................ 263
STAAD
exporting ........................................................... 265
table type specifications ..................................... 271
Steel fabrication

T

table type specifications
STAAD

Tekla Model Sharing
back up
baseline
best practices
browse shared models
cache
catalogs
conflicts
convert to multi-user
detect changes
drawing locks
drawings
editor
exclude
excluding model
introduction
join
joining
licenses
limitations
locks
model history
multi-user model
object IDs
object locks
object types
Organizer
owner
prerequisites
privileges
project viewer
read in
reserve write out
restore
settings
share
share a model
sharing automation tool
sharing changes
sharing history
sharing service
user roles
viewer

what is shared
write out
write out errors
Tekla Structural Designer
exporting to
importing from
re-importing from
Tekla Structures multi-user server
Tekla Warehouse
Tekla Warehouse Service
ToDo
assigning
attachments
creating
markups
notes
Trimble Connect for Desktop
Trimble Connect for Web
tube NC files
twin profiles

U
uni
Unitechnik
assemblies
classes
embeds
exporting
insulation
surface
UXML

W
working models

X
XML
exporting